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  و سپاسیقدردان
 

 یتوهايه در انستن کتاب رهنمود کي ایش و متناسب سازيد، آزمايم که در تولير سپاسگزاري زیادهاياز بن
روتِ لبنان يو ب) ٢٠٠٧( ، امانِ اردن ) ٢٠٠٤(  کابلِ افغانستان ی در شهرهای ملیآموزش فن آور

: دادندیاري، صورت گرفت، سخاوتمندانه ما را )٢٠٠٧(  

Ford Foundation 

National Endowment for Democracy 

Oxfam-Novib 

Shaler Adams Foundation 

ن يروت، و کابل را که به ما آموزش دادند والهام بخش ما در اي امان، بیر کارگاه ها شرکت کنندگان دۀهم
.مي کنیم مين کتاب رهنمود را به آنان تقديم و اي گزاریمانه سپاس ميراه بودند صم  
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باچهيد  
جه ياه ، نتن کارگيا.  درشهرکابلِ افغانستان آغازشدی کارگاهین کتاب رهنمود با برگزاريش ايداي پۀنيزم

در "  زنان افغانیآموزشت تويانست" و "  زنان ی آموزش و همکارین الملليسازمان ب" دو گروه یهمکار
ر ي غی را، که ازسازمانهای مهارت محور، مردان و زنان کنشگرۀن کارگاهِ هشت روزيا.  بود٢٠٠٤سال 
 گوناگون درهر سه سطح ی هایفن آوربا  گردهم آمده بودند، ی محلی، و گروه های، مراکز دولتیدولت
  .شنا کردشرفته آي، متوسط  و پیمبتد

 شده ی کارگاه  کابل طی برگزاری که براین رهنمود از مراحليس ايش نوي پۀن نسخي اولۀيدر ته
 که در آنجا به کار برده شده بودند، به یدستور کارها، جلسه ها، و مطالب کمک آموزش. ميبود بهره گرفت

 یکيالکترون ی هایورار فنينترنت و ساي درباره ای  مطالب٢٠٠٧در اواسط سال .دندن جزوه افزوده شيا
 ۀحاصل هم. ن رهنمود افزوده شديز به اي نی اجتماعی از وبلاگ ها و شبکه هایري بهره گیمانند چگونگ

 ی انواع آموزشهاۀرنديربود که همزمان دربرگيک چهارچوب منعطف و انطباق پذي ین کوشش ها طرّاحيا
  . باشدی و موضوعیهارت محور و ابزارم

ش گذاشته شد، همان سال و در شهر امان، اردن ي آزماۀ رهنمود به بوتۀن جزوي که این باريدوم
 آموزش و ین الملليسازمان ب" دو گروه ی بانوان آموزگار، و با همکاری آموزشی ملیتويدر انست. بود

ن ي برگزار شد که زنان از سراسر ایکارگاه" اردن/  زنانی جهانیموسسه همبستگ"و"  زنان یهمکار
ز ي خود نیلگري تسهی بر مهارتهای دانش نرم افزاریکشورگرد هم آمدند تا علاوه بر به روز رسان

ن يسازمان ب "ین بار با همکاريا. روت لبنان انجام شدي ودر شهر ب٢٠٠٧ش درسال ين آزمايسوم. نديفزايب
 ۀک کارگاه چهار روزي"  توسعهیمن پژوهش و آموزش کاربردانج"و "  زنانی آموزش و همکاریالملل

ن کارگاه هم يدر ا.  اطلاعات و ارتباطات زنان لبنان برپا شدیورا فنیت مهارتهاي به منظور تقویمنطقه ا
ز به شرکت کنندگان ي نیلگري  تسهینِ دانش نرم افزار، روشهاي نوی قبل، علاوه بر مهارتهایمانند بارها

  . آموزش داده شد

ن ي از همیده اي برگزین بخشهايروت و امان ، شرکت کنندگان به تمري بی آموزشۀدر هر دو دور
 را که آموخته بودند، آزمودند، بلکه یيب، شرکت کنندگان نه تنها مهارتهاين ترتيبه ا. رداختندپرهنمود 
  ی برایمنبع ارزنده ان بازخوردها يا.  رهنمود نظر دهندی ساختار و محتواۀافتند تا خود درباريفرصت 
پاسخ : م ازجملهيفزائيز برآن بي نیي شد و به ما امکان داد بخشهای آموزشۀن جزويشتر اي هرچه بیبارور

مان يد فرض هايي، تأ)رفاکس؟يا فاياکسپلورر بهتراست ( شرکت کنندگان درباره نرم افزارها یبه پرسش ها
مانند (وست ها ي کاربرد پی، بررس)ذاشته شود در رهنمود گیست از هر مرحله عکسين که لازم نيا( 

 ین جهاني زنان و مردان، و قوانیشرفت جوامع و آمار باسوادي پۀ سازمان ملل متحد درباریشاخص ها
 دادند تا یارين ها ما را ين، تمريافزون بر ا).  مطلوب شرکت کنندگان بودندیت از خانواده که همگيحما
 یدادهاي پرسشنامه روزانه ، قرار شد که آموزش گران روی مثلا به جا(م ي مطالب را بهتر کنۀ ارائۀنحو

 سازنده و مهم در ی نقشی آموزشۀن دوري شرکت کننده در ای سازمان هاۀهم). روزانه را ثبت کنند
  .فا کرده اندين رهنمود اي ای شکل   کنونیطرّاح

ار ارزنده بودند؛ ين رهنمود بسيا ۀجاد شالودي ایز برايروت ني در کابل، امان، و بیداني میآزمونها
ت منابع از جمله يمحدود.  سازگار کردیات بومي  که رهنمود را با بافت ها، تجربه ها و واقعیشالوده ا
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 یر مي مختلف در کار سازمان ها تاثینترنت کم سرعت به گونه هايانه ها و ايقطع و وصل برق، کمبود را
 که یهنگام. مي کنیر و خلاقانه طرّاحيد تا منابع را انعطاف پذختنيت امر ما را برانگيگذاشتند و در نها

 یزبر ضرورت بومي بر ما روشن شد، در رهنمود نیط بوميت سازگار ساختن محتوا و منابع با شراياهم
 یت هاي و چه در مورد برنامه ها و فعالیم فنِي، چه در مورد  محتوا و مفاهیري و انعطاف پذیساز

  .مي کردديشتر تاکي، بیآموزش
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  همکار یسازمانها ۀدربار
 

(WLP)   زنانی آموزش و همکارین الملليسازمان ب

 و یني بازآفری کوشد زنان و دخترانِ جهان جنوب  را برای است که میر دولتيک سازمان مستقل و غي
ن سازمان در ين هدف، ايل به اي نیبرا.  نقش شان در خانواده، محله، و جامعه توانمند کندیبازساز

از پرداخته ي و منابع مورد نی آموزشید برنامه هاي زنان در جهان جنوب، به تولی با سازمانهایمکاره
 چند ید برنامه هايبا تول. م کنديد اطلاعات و گسترش دانش سهيز در تولياست تا زنان و دختران را ن

 یمشارکت و رهبرن سازمان  ينترنت، ايون و ايزي تلو-دئويو، وي رادی و فرهنگ محور برایرسانه ا
.  کندیل مي تسهی مدنۀشتر زنان را در ساختن جامعيهرچه ب  

(AIL)   افغانی آموزشتتويانست

 و ی ابتکاری از روشهایري اش را برعهده دارند با بهره گی که زنان رهبریر دولتين موسسه غيا
ن منظور با يل به اي نی زنان وکودکان افغان است و برای و آموزشی بهداشتیازهايپاسخگو در صدد رفع ن

.  دهدی کندو آنها را آموزش می می همکاری و بهداشتی آموزشۀسازمان ها و افراد متخصص دردو حوز
ان و متخصصان بهداشت،آموزش بهداشت، اصول و ي شامل آموزش آموزگاران، مربی آموزشیبرنامه ها 

، ی محلی، سازمانهایس خانگير از تدیبانيق و پشتيتشو.  افراد استی، و حقوق انسانی رهبریوه هايش
. ن موسسه استي ایت هايز از جمله فعاليش از دبستان ني آموزش پیمراکز آموزش زنان، و برنامه ها  

(CRTD-A)   توسعهیانجمن پژوهش و آموزش کاربرد

، پژوهشگران و ی دولتی، نهادهایر دولتي موسسات غی لازم را برای و آموزشی فنیبانين انجمن پشتيا
ت ي فعالیتي جنسیه بر برابري، با تکی اجتماعۀ توسعینه هاي که در زمین المللي بیهاسازمان 

 است که با روش ی و کاربردین سازمان بر پژوهش ها نظريتمرکز ا.  سازدیدارند، فراهم م
ن پژوهش ها به نگارش و انتشار منابع و يا.  شوندی انجام مید علوم اجتماعي و با دیمشارکت
 ی،  مطالعات و آموزشهایتي جنسیت و توسعه ، برابري  جنسینه هاي در زم تازهینوشته ها

ر موسسات و ين انجمن به سايا.  شودی، منجر می اجتماعۀ ، فقرو توسعی مدنۀ،  جامعیتيجنس
. دهدی ارائه میزني کنند خدمات رایت مي فعالیتي جنسینه برابريز که در زمي نیيگروه ها  

(SIGI/J)    زنانی جهانی همبستگۀموسس

، حقوق دانان، و ی دادگستری به وجود آمد وکلا١٩٩٨ که در سال یر دولتي غۀن مؤسسيان گذاران ايبن
، و فن ی مهارتی، آموزشهای آموزشی احقاق حقوق بشرزنان، ابزارهایکنشگران حقوق بشر هستند که برا

آموزش حقوق : راستي زیمه هان مؤسسه از جمله شامل برناي ایبرنامه ها. ن را به کار برده اندي نویآور
ه زنان و دختران ي مبارزه با خشونت علیوه هايش" درطلب حقوق مان،" کتاب ی عربۀ ترجمیبشر بر مبنا

، فاوا ی مشارکت دانش که خود شامل آموزش هاۀو برنام" امن و مطمئن، " ی عربۀبر اساس ترجم
.  شوندی می است که در آن تجارب رهبران زن بررسی فرهنگی هایيوگردهم آ  



٥ 

 

  

  

 

شگفتاريپ  

  یرات اجتماعيي زنان و تغی توانمند سازی ارتباطات و اطلاعات برایهايفن آور
 

ار اثرگذار ي اطلاعات وارتباطات شاهدش بوده، بسی های فن آورۀنير در زمي اخۀ که جهان در دهیانقلاب
 ی زمانی ها با گذشتن ازمرزهاین فن آوريم که اي کنی می زندگیامروز ما در دوره ا. ربوده استيو فراگ
گران يم با دي توانیم مي دنبا که باشیما در هر جا.  ار کوچک کرده اندين را بسي زمۀ، کریائيو جغراف

م که چند سال يار تبادل نظر کني کم وسرعت بسۀنيم  و چنان با هزي اطلاعات بپردازۀم، به مبادليمرتبط شو
ع و مصرف، يد، توزيت قدرت و اقتصادِِ تولي جامعه، ماهیيايعصر اطلاعات پو. ر قابل تصور بوديش غيپ

 که انباشته از فرصت ها و یائيدارآورده است؛ دني پدیني نویايجه دنيکسره دگرگون ساخته و در نتيرا 
  .  و فرد فرد انسان های جوامع انسانی، بلکه برایتي چند ملی غول آسای شرکتهایخطرها است، نه تنها برا

. استين، گسترش به نسبت ارزان و آسان آن در سراسردني نویت بارز فن آور از مشخصایکي
 فراهم آورده است؛ ین المللي و بیمات ملي محروم را در تصمین فنون، امکان مشارکت افراد و گروه هايا

 ینه هايزند که درزمي برانگیت هائي توانند سرنوشت انسان ها را رقم زنند و به فعالی که میماتيتصم
 آموزش و ین الملليما، در سازمان ب.  به سود آنان باشدیاسي و سی، اجتماعی و مالیاگون اقتصادگون

شرفت يپ. مي آن بهره مند شده ایايک تجربه کرده و ازمزاي را از نزدین انقلاب تکنولوژي زنان، ایهمکار
ا، و يکشور دن ٢٠ در یاري بسی ما با سازمان ها و گروه هایهاي موجب گسترش همکاری فن آوریها

 خلق و ی اطلاعات و ارتباطات  بستر لازم برایفن آور. ، شده استی خاکۀن کري اۀپراکنده در چهار قار
ن امکان ، ما را در يا.  ما فراهم آورده استۀ شبکین اعضاي گوناگون را در بیتبادل اطلاعات و دانش ها

 ی ارتباطی شبکه هایداريانده وموجب پا رسیاريدن به اهداف و نقاط مشترک ي رسیا براي پویارتباطات
ام مان را به سراسر يم پي توانین است که ما مي نویابي از امکانات ارتباط یبا بهره جوئ. ن ما شده استيب
 یبانيم و از پشتي اجرا برسانۀن نقاط جهان به مرحلي خود را در دورتری آموزشیم، برنامه هايا منتقل کنيدن

 بر سر ی ارتباط که در گذشته مانع بزرگیمشکلات برقرار. م يگون بهره مند شو گونایافراد و سازمان ها
م که ي دانیالبته، م.  از سر راه بر داشته شده اندی و ارتباطی اطلاعاتی فن آوریاريراه ما بودند، اکنون به 

ن يها به ا ی دسترسین آن ها نابرابريزشده که مهم تري مشکلات گوناگون نۀمان سرچشمي براین فن آوريا
  . ان جوامع استي می فرهنگی و اختلاف هایفناور

 در ٥٨٫٦)  خانوار١٠٠نترنت در هر يتعداد کاربران ا(نترنت يبه عنوان مثال، نرخ نفوذ ا
زان استفاده از تلفن يم.  است١٠٫٢ در حال توسعه ی که در کشورهای است در حالی صنعتیکشورها
 در حال ی در کشورها٣٢٫٤ و ی صنعتی در کشورها٩٠٫٩) ار خانو١٠٠ن در هر يتعداد مشترک( همراه 

 ۀکا ، پنج برابر کل تعداد کاربران در قاري  آمرۀالات متحدينترنت در ايتعداد کاربران ا. توسعه است
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ون متعلق به يلي ب١٫٤ یعنيآن  ٥١%ش از يبدر جهان، . یپ.یون آدرس آيلي ب٢٫٧ از مجموع ١.قاستيآفر
ز ي نینترنتي ایشتر کنشهاي و قطب بیسينترنت زبان انگلي ایايزبان قالب در دن ٢.کا استيالات متحد آمريا

 هر ی برا١٥٨٣٫٥ زبانها و یسي انگلی برا١٫٥ وب  ۀ هر صفحنسبت تعداد نفر به. ن کشور استيهم
 ی سواد از توانائی چنان است که عملا افراد بیدانش محاسبه و سواد فناور ٣.ست ای وب عربۀصفح
 یبه عنوان مثال، دستگاه ها. ديا افزین موانع مي به ایسيندانستن زبان انگل.  به آن محروم شده اندیدسترس
 یسي دامنه ها تنها به انگلیدر حال حاضر اسام. ستي تمام زبانها موجود نید براي مانند صفحه کلیورود

 یديکل باصفحه ار com.google.www تواند یم چگونه ینيچ افردي و زبان عرب کي ٤.در دسترس اند
  کند؟ پيتا است شده نوشته اش یمادر زبان به که

ن فن ي با ساختار و زبان ایشتري بیي که آشنایيت آن است که افراد، گروه ها، و ملت هايواقع
ا يگانه اند و ي مدرن بی اطلاعاتی آور که با فنیيآنها.  برندیشتر از آن بهره مي دارند، بهتر و بیآور
 که ین، انقلاب فناوريبنابرا. افتين رقابت نخواهند ي در ایا گسترش آن ندارند، بختيد و ي در تولینقش

 برخوردارند یشتري آنان که از امکانات بی تواند همگان را بهره مند کند در حال حاضر تنها برایبالقوه م
 ی، نابرابریتاليجيشکاف د:  مانندیش مشکلات تازه ايداي باعث پیرابرن نابيچن.  استیقابل بهره جوئ

  . شودی فرصتها می، و نابرابریتاليجي دیتيجنس

د، نه ي و استفاده گسترده از آن کوشین فناوري همگان به ای فراهم آوردن امکان دسترسید برايبا
 فراهم ی، بلکه برای اطلاعاتیرتنها به قصد فراهم آوردن سخت افزار و آموزش طرز استفاده از فنآو

ه ين عرصه به حاشيآنها که در ا.  فرهنگ محور در چارچوب زبان مناسبیآوردن ابزار و امکانات بوم
د خود در يابند، بلکه بايشرفته را بيج در جهان پي راین فن آوريد توان استفاده از ايرانده شده اند، نه تنها با

. گران از آن بهره خواهند بردي که هم خود و هم دیرند؛ دانشيرار گن نوع دانش قيد کنندگان اي تولۀزمر
  .ميم شد اگر ازدانش و خرد و تجارب جوامع گوناگون جهان بهره بري تر خواهی غنیهمگ

 یيايم، دني همگان شویرايم و پذيري را بپذی جوامع بشرۀ با همی و همکاریستياگر چالش همز
، ی، شأن انسانی خواهند داشت که از رفاه، برابریشتريان، بخت بساخته خواهد شد که در آن زنان و مرد

را اهرمِ   يد دانست زين حرکت باي این را مبناي نوی اطلاعاتیورافن.  برخوردار شوندیو عدالت اجتماع
ن يا. شرفت مان وجود داشته استي که بر سر راه توسعه و پی از موانعیاري گذر از بسی است برایکارآئ
 دهد یبه آنان اجازه م. ار انسان ها گذاشته استي مرزها را در اختین تعامل فراسو امکایفناور

 و آموزش خود یريادگي ینند و روشهاي خواهند برگزی که میبيشان را به ترتيشان را، آرمان هايآرزوها
 یشارکتت مي بشری و اجتماعیر تکامل فرهنگي دهد تا در سی، به زنان امکان میفناورن يا. ن کنندييرا تع

 به ین فناورياز ابتوانند م که يز کني تجهیا را به گونه ايفه ماست که زنان دنيوظ.  سابقه داشته باشندیب
 گام برداشتن ی خود، بلکه برای و فرد ی شخصینه کردن زندگي بهی نه تنها براند،ين شکل بهره جويبهتر
  .  همگانی بهتر برایياي دنیبه سو

                                                            
١.  http://www.itu.int/ITU-D/ict/statistics/ict/index.html 
٢. http://www.domaintools.com/internet-statistics/country-ip-counts.html g IT Our Own   
٣. http://www.technologyreview.com/Wire/٢٠٣٠٥/ 
٤. http://www.andycarvin.com/archives/٢٠٠٥/٠٣/rss_local_langu.html   
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 اطلاعات و یهايفناور کامل از ی زنان در بهره جوئی توانمند سازی است برایکتاب حاضر  تلاش
 بزرگ از انسانها که   ی خاص به شمارین فنون از عده ايت اي انتقال مالکیتلاش ماست برا.  ارتباطات

 ،ی با مشکلات کنونیاروئي روید که، فراسوين امي گذرانند، با این کره روزگار مي مختلف ایدر فرهنگها
 . خواهند دادیاريده آل مان ي اۀندي تازه ما را در ساختن آیها یتوانمند

 

یمهناز افخم  
٢٠٠٨بهار   
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 مقدمه

 اهداف، مقاصد، اصول، و چهار چوبها

 اهداف
ژه کوشندگان حقوق ي، به ویز کوشندگان اجتماعي، تجهیرِآموزشين رهنمودِ انعطاف پذي ایهدف اصل

ن ي از امکانات ایريات و ارتباطات است تا با بهره گ اطلاعیفناور مدرن عصر یزنان، با مهارتها
م که بهره يدواريما ام.  موفق شوندین عدالت اجتماعي زنان و تأمیج حقوق انساني بتوانند درراه ترویفناور
د و يفزاي دانش بید اطلاعات و گستردن مرزهاين آموزشها ، توانمان را در تولي مکرر و مستمر از ایجوئ

 .  ابديز راه ي نی مجازی به فضای فرهنگی هموارتر کند تا غنایور نوآیراه را برا

 مقاصد
 در مؤسسات ی بهره جوئیه شده براي زنان تهی آموزش و همکارین المللين رهنمود که در سازمان بيا

ان آشنا ي از زنان و مربیشتريت تعداد بين آموزش تربيهدف ا.  استی مردمیان و کارگاه هايآموزش مرب
 و تجربه یلگرين تسهي نوی از مهارت های اطلاعات و ارتباطات است که بتوانند با بهره جوئیفناوربا 
  .  بپردازندیتي جنسیج برابري، به تروی و ارتباطاتی اطلاعاتۀديچيشان در استفاده از ابزار پيها

ان يرب کردن دانش، آموزگاران و مید بردو اصل آموزش مادام العمر و همگانين رهنمود ، با تاکيا
ن رهنمود، هر دوگروه يدر ا.  کندیهمکار آشنا م–از- همکاریريادگي ی با روشهایلگريرا در دوران تسه

ن راه ي شوند تا از ایق مي تشوفاوا از ی و فرهنگیکسان به استفاده ابتکاريلگران و شرکت کنندگان يتسه
ن قرار يد کنندگان دانش نوي تولۀزمرابند و هم خود در ي را بیفناور لازم دراستفاده از یيزنان هم توانا

  . رنديگ

 اصول
  ۀفيشبرد جنبش زنان، وظي پینه از آن براي بهۀاستفاد. ی آموزش و توانمند سازی است برای ابزارفاوا
.ک از ماستيهر  

 خواهد ی که می کس.ن رهنمود استي مطرح شده در ایانه ها، و مهارت هاي رایريادگيهمه کس قادر به 
ا بداند چگونه ي بداند و یسيباشد، زبان برنامه نو" متخصص" ک يست يگر لازم نيتفاده کند دانه اسياز را

.د مدار بستيبا  

د ي را بایرياد گي ین راه براي کوتاه تر. همانند آموختن زبان دوم استیانه اي رای مهارت هایريادگي
ر ي آموزش اجتناب ناپذۀوين شياادگرفتن از خطاها در ي خطا کردن، و ی برایآمادگ. ن مستمر دانستيتمر
ا يک ابزار و ي کند و راه آزمودن و آشنا شدن با ید مي تأکین عملين رهنمود بر  تمريل اين دليبه هم. است
ا در روبرو شدن با ير و ين مسيگر، رهنمود در هر مرحله از ايبه سخن د.  دهدی خاص را ارائه میمهارت
  . ردي گی شتابد و دست اش را نمینم شرکت کننده یاريات و مشکلات، به يجزئ
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 را به یفناور استفاده از ی که چگونگیلگريتسه. ن رهنمود استي ای اصلۀي بن مایآموزش مشارکت
اگر همگان در .  را از شرکت کنندگان خواهد آموختیاريز نکات بسي کند ، خود نیشرکت کننده منتقل م

 یريادگي ین قرار دهند، فضايريار ساي را در اخت مشارکت فعال داشته باشند و دانش خودی آموزشۀجلس
ن رهنمود يا. ش خواهد دادي شرکت کنندگان را افزاۀ همی هایيت تواناي بوجود خواهد آمد که در نهایا

  کند ی هموار می و آموزش مشارکتی همکاریجاد فضاي ای دهد که راه را برای را ارائه میيروشها

 تواند مادام العمر مورد استفاده ی آنها میريادگي یه دارند اما روشها کوتای عمریانه اي راینرم افزارها
 ی کسیامّا برا.ک مهارت استي یريادگي یک نرم افزار به سادگي از ی بهره جوئۀآموختن نحو. رديقرار گ

 یمودن راه دشوار به نظر ميش است پيت مهارت هاي تقویافتن راه هاي آموختن و یکه مادام العمر در پ
 دهد و آنان را یلگران و شرکت کنندگان ارائه مي هر دو گروه تسهی را براین رهنمود چهار چوبيا. رسد
.   دشوار و مهم اندی شوند که مصمم به انجام کارهایکند دانش پژوهان آگاهيق ميتشو  

 یم ،به اصل مشارکت و گسترش دانش هم پاي کنید مين تأکي نویهايفناور یريادگيما همانقدر که بر 
م ير مستقيا غيم ي مستقی آن است که شرکت کنندگان به گونه ایادين روش آموزش، اصل بنيدر ا. ميندب

ن به مشارکت يري اند با ساۀن رهنمود آموختي اۀا مطالعي کارگاه ی را که در جلسه هایدانش و مهارت
 را که آموخته یدانش شوند که فعالانه یق مين رهنمود شرکت کنندگان تشوي ای جلسه هایدر برخ. بگذارند

. ان گذارندياند با افراد خانواده ، محله ، و سازمان شان در م  

م که  يما بر آن. ر و تحول در سراسر جهان بوجود آورده استييم ازتغي عظی کوتاه موجی در زمانفاوا
ست ها و ازها، خواي نۀي ها را بر پایم دگرگونيم تا بتوانياموزين را بي نوین موج مهارتهايسوار بر ا

. .ميانتظارات مان شکل ده  

 چهارچوب رهنمود
 ۀک دوري ی لازم براین معنا که اجزايبه ا. همگذارانه دارد-خود ۀويشن رهنمود در مورد آموزش فاوا يا

، ی مشارکتیلگري تسهیراهنما:  دهد از جملهیلگر قرار ميار تسهيدراختفاوا را  یآموزش مشارکت
، و یدئوئيش وي نمای و نمونه هایريادگي، منابع یفناورک از ابزار ي هر یگام برا به  گامیراهنما

ن ين و  کارآتري تواند مناسب تریلگر مين منابع تسهي ایاريبه . ی کلی از دستور کارهایمجموعه ا
ار شرکت کنندگان و آموزشگاه ياز هر گروه سازگار شده است در اختي را که  با نی فناوریآموزش ها

.  ن قرار دهد آنای محله هایها  

مبتکرانه نسبت به محتوا و شکل آموزش اتخاذ  یافتيرهر يت اصول زين رهنمود توانسته است با رعايا
: کند  

 هر بخش ی تواند اجزاین روش آموزشگر مي از ایبا بهره جوئ: ري انعطاف پذی آموزشۀويش •
نوع مهارت ها، و ، یفناورا جا به جا کند تا تمرکز بر ابزارخاص ياد و ي را کم و زیآموزش

 . گوناگون باشدیاز گروه هايژه مورد ني ویموضوع ها

 ی در قالب تجارب زندگیريادگيند يسازگار کردن آموزش با فرآ: ت محوري واقعیويسنار •
ت و يزد که به کند و کاو مشکلات مربوط به جنسي انگی دانش پژوه را برمیا حرفه ايروزمره و 

 . بپردازدیفناور
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 قرار دارد و ی فناوری مهارت هاۀين رهنمود  برپاي ارائه شده در ایموزش ها آ:انباشت دانش •
 .  رساندیاري یتيشبرد عدالت جنسين به پي نوی از فناوری راهبردی تواند با بهره جوئیم

 ۀدرحوز که یعيسر راتييتغ با که ستيا گونه به رهنمود نيا یطراح: وتوسعه بسط تيقابل •
 تيسا در یدسترس قابل که را مناسب یوابزارها منابع تواند یم دهد یم یرو یفنآور دانش
:  قراردهد کننده اراستفادهيدراخت راستيز مکمل

http://www.learningpartnership.org/ictmanual 

 ساختاررهنمود
 است ی آموزشی جلسه های آموزش، و تعدادیلگر، مبانيه تسین رهنمود متشکل از سه بخش راهنما برايا

م شده يز خود به سه بخش تقسي نی آموزشیجلسه ها. یاني پایوست هايک لوح فشرده و بخش پيهمراه با 
، و متناسب یري، فراگیابي دستیب بخشهاي و مهارت شرکت کنندگان به ترتیيزان آشناياند که متناسب با م

  . نام گرفته اندفاوا یساز

 گرفته تا یکند، از فهرست موارد ضروريان ارائه مي مربیمنابع لازم را برا یلگري تسهیراهنما
 ی دهد تا فضای میاريلگران را ين راهنما تسهيا. ی مطالب آموزشۀ ارائیاطلاعات مربوط به چگونگ

  . متفاوت سازگار کنندی متفاوت شرکت کنندگان و با سطوح مهارتیازهاي را با نیآموزش

ن اجزا مطالب لازم يا.  استی کارگاه آموزشی برگزاری مهم و لازم برایشامل اجزا ی آموزشیانمب
 ی کارگاه در بر میابي و ارزیي نهایان هر جلسه، تا طرح هاي هر نوع دستور کار را از شروع تا پایبرا
  .رنديگ

کردن شرکت کننده با  آشنا ی صرفا برا به ابزار فاوایابيدست: بخش نخست، ی آموزشیدربخش جلسه ها
 و ی عملین هاي شود و سپس با تمرینترنت شروع ميانه ها و اي بر راین بخش از مروريا. انه هاستيرا

م ياگر بخواه. ابدي ی ، و وب ادامه میکي گسترده، پست الکترونی مانند واژه پردازها، جدول هایساده ا
اد گرفتن ضرب ين فصل را به ي توان ای، م و آموزش رقصفاوان بخش از آموزش ين ايم بي کنیسه ايمقا

  .ه کرديک رقص تشبيتم موزيدا کردن ري و پیقيآهنگ موس

 ی در زندگیيش کارآين ابزار را به منظور افزاي از ای بهره جوئۀنحو ابزار فاوا یريفراگ: بخش دوم
ر استفاده ش رفته دي پین بخش شامل مهارت هاي ای آموزشیواحدها.  دهدی آموزش می و حرفه ایشخص

د دانش و ين ابزار در تولي به کاربردن ایچگونگ د ول انيميا گسترده، و یاز واژه پردازها، جدول ها
  . دهندیاطلاعات را نشان م

دن به خواست ي را در جهت رسیفناور کند تا کاربر مهار یکمک م از ابزار فاوا یبهره جوئ: بخش سوم
 ی تفکررهبردیرا با روش هافاواشرفته ي پیموزش مهارت هان بخش آيا. رديش به دست گيها و آرمان ها

 و پخش اطلاعات توانا ی، ارتباط سازیجي ترویت هاي فعالی از فاوا  برایزد تا کاربر به بهره جوئي آمیم
 ی برایفناورن يگر چگونه از اي دی شود که سازمان های نشان داده میين در مثال هايافزون بر ا. شود
 را یفناورن ين بخش شرکت کنندگان دعوت شده اند  که ايدر ا. شابه استفاده کرده انددن به اهداف ميرس

سه با رقص، همانند آن است که ين بخش، در مقايدر واقع، ا. رندياز خاص خود به خدمت گيمتناسب با ن
. ارائه کندیص تازه اق ری برایني نوۀويپس از شناختن گام ها هر کس  ش  
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 روش کار را ی اصلۀ هر جلسه است تا هستی ممکن برایس دستور کارهاي نوشيرنده پي در برگوستيپ
ط موجود را يا شراياز گروه خاص و ير و رو شود تا ني هر جلسه، ممکن است کاملا زۀبرنام. نشان دهد

 یين پرسش نامه هاين بخش همچنيدر ا. ابدي را بیب دستور کار کاملا متفاوتين ترتيبرآورده کند و به ا
 یابياز کارگاه  و پرسش نامه ارزي مورد نی از اقلام فنی شرکت کنندگان، فهرستیازهاي نیابيرز ایبرا
 . آمده اندیي باز خورد نهای کارگاه به منظور جمع آوریينها

 یهال ي فا،ی است که شامل منابع آموزشیرنده مطالب کمک آموزشيدربرگ (compact disc) ی دیس
 یبي ترکیدهايت ها، ارائه مطالب، کلين ها و فعالي تمریازبرايرد ن مویکي الکترونینمونه، آدرس ها

  .  استیفنگر از امکانات ي دید و برخيصفحه کل
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  یآموزش یها جلسه
 ی آموزشۀن جلسه ها برناميدر ا. م شده اند که جلسه نام دارندي تقسی گوناگونی به بخشهایمطالب آموزش

ت ين رهنمود قابلي ای آموزشی واحدهایاز طرف. ن رهنمود آمده استيا شود که در ی دنبال میمنسجم
 ی سطح مهارت خاصیا بر مبناي از ابزارها تمرکز کرد و ی خاصیک سري دارند تا بتوان بر یيجابجا

 ۀک دوري ی همگذاریگام هال در ي به تفصی آموزشی بخشهایروند همگذار.  را دنبال کردیبرنامه درس
.ی قبل از همگذاریز دستورکارهاي ها نوستيپ در بخش  آمده است ویآموزش  

 که مورد یک مقدمه کوتاه که اهداف آن جلسه، مطالبينخست،  .  دارندیگانه اي جلسه ها ساختار ۀهم
 ی مهارت سازیت هايآنگاه فعال. کندي قرار خواهند گرفت و ابزار به کار برده شده را مطرح میبررس
 یتهاي از شخصیکي روزمره ی از زندگیيويت ها بر اساس سناريعالن فيک از ايهر .  شودیآغاز م
 بهره ی لازم براۀنيرد و زمي گیانجام م) ح داده شده استي توضتهايشخص یدر بخش بعد( ر شده يتصو
است افته ياختصاص  یفناور یريادگي به یمرحله بعد.  آوردی را فراهم می فنی از ابزارهایکي از یجوئ

: شودی انجام مريکه مطابق روند ز  

انه ي استفاده از رای برا(users)  کاربرانۀ است که همی گوناگونین روند در واقع شامل کارهايا •
ک نرم افزار يا وارد شدن به ي مراحل یک سريد گرفته تا انجام يک کليد، از فشردن ن دهیانجام م

  .  حروفۀا انتخاب نوع و اندازي نيمع

o  ،یبراد يلگر باي است که تسهیشامل رهنمودها و ابزارروند مورد نظر دستورالعمل ها 
 .ن شرکت کنندگان فراهم آورديتمر

  

  تجربه ها   ۀدربار یآگاه

 شود که معرّف ی افراد شرکت کننده ارائه می شغلی از سابقه وتجربه هایرآغاز هر جلسه، فشرده اد
 ی جلسه، شرکت کنندگان مدر طول.  آنان باشدی حرفه ای هدف هایايسطوح گوناگون مهارت ها و گو

در آغاز . ننديافريلند داشته باشند بي را که خود مایا مشخصاتي کنند و ین افراد را بازي از ایکيتوانند نقش 
ک  يابند هرين فشرده ها را مرور کنند تا دريد که اي کارگاه از شرکت کنندگان بخواهی جلسه هایبرگزار

؟ کند و چرای میگرهمزاد پنداري دۀاز شرکت کننده ها با کدام شرکت کنند  

نايم  
 در یاو مطالب.  مشغول به کار شده استیک سازمان هنديار ارتباطات در ي به عنوان دستینا به تازگيم

انه فراوان يد از رايط کار جديدر مح.  در عمل نداشته استی کافۀانه خوانده اما تجربي رایفناور ۀبار
ن بابت ياز ا.  خبره اندیفناورن ي از ای در بهره جوئیان او همگرسد همکاري شود و به نظر میاستفاده م

 آموزش ۀ آن گونه برنامیاو در پ. اموزدي لازم را بیم دارد اما مصمم است که مهارت هاي بینا اندکيم
 را را به کمک همکارانش ادامه یريادگيند ياموزد و هم بتواند فراي بی است که که هم کار عملیوتريکامپ
ن ي داند که این او ميافزون برا.  خواهد تلاش کند تا در آن موفق شودیناست و او مين شغل مياولن يا.دهد

.شه به دردش خواهد خورديمهارت هم  
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اسار  

ن يدر ا. ار حسابدار شروع کردي به عنوان دستیه ايجريک سازمان نيش کارش را در يسارا چهارسال پ
اما .  کردی آشنا می حسابدارین با نرم افزارهاي و همچن شرکتی درونیستم هايس اش او را با سيمدت رئ

 یانه مهارت کافي رایفناورنه يسارا در زم. ن اوستي بازنشسته شده واکنون سارا جانشیس اش به تازگيرئ
 را با ی محاسبات مالۀ تواند همیاو م. گسترده یمحاسبات ی جدول های نرم افزارهاۀژه در باريدارد به و
 کرده است ی طراحیگري که شخص دی محاسباتیاما هنوز ازهمان قالبها. انه انجام دهدي از رایبهره جوئ
شرفته تر ي پیدوار است با فراگرفتن مهارتهايام. د را نداردي قالب جدی طراحیي کند و خود توانایاستفاده م
  . را به کار بردیدتري جدید و ابزارهايده  برآيچي محاسبات پۀازعهد

 

  یسوف
. ل مشغول به کاراستي در برزی سازمانیر مرکز اسناد و پژوهش هايل است که در سمت مد دو سایسوف

از آنجا که .  سازمان استفاده کندی قادر است تا از نرم افزارهایانه ها دارد به خوبي که بر رایاو با تسلط
جستجو را  مدرن ی خواهد روشهای مینترنت انجام شوند، سوفي ایشتر رويد بيرشرکت بايقات اخيتحق

 از آنها یم گزارش است تا با بهره جوئي و تنظی مدرن مستندسازیافتن روشهاي ین در پيبداند و همچن
ل ين، او مايافزون برا.ش دهدي سازمان را نسبت به مسائل روزمره بخش خود افزای اعضای عمومیآگاه

 و ارائه مستندات مدرن بر یق ومستندسازين تحقي نوی تواند با استفاده  از روشهایاست بداند چگونه م
.دا کندي سازمان خود پی براینترنت، مخاطبان جهاني ایرو  

 

شهيعا  
 کند و از طرفداران ین سازمان کار ميک سازمان در اردن، هشت سال است که در اير برنامه يشه، مديعا

انه و ياستفاده از را بود که بر ین کسانياو از اول. دي آی در سازمان به شمار میفناورپرو پا قرص توسعه 
 ها یفناورن يز مرتب از اي خود نی و حرفه ای شخصی کرد و در زندگینترنت در شرکت پافشاريا

ل يدانند، به دلي ماهر مینه فردين زمين که همه او رادر ايبا ا. ن کار خبره شده استي کند و در ایاستفاده م
م ي خواهد با روشها و ابزارها و مفاهیاو م. تد دور مانده اسي جدیشه از ابزارهاياد عاي زی کارۀمشغل

.  برندیشان بهره ميگر چگونه از آنها در راه ارائه بهتر برنامه هاي دیمدرن آشنا شود و بداند که سازمانها
  . مشابه استی درکارهایفناورک کاربرد ي استراتژی او روشهایعلاقه اصل
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  لگرينقش تسه: یريادگي یآسان ساز
 ١٩-١٧، صص ٢٠٠٣،  زنانی رهبری برایيآموزه ها:  حق انتخابیدر جستجوتاب  ازکیده ايبرگز( 

)ی اصلۀنسخ  

 است که در یمنظور مدرسه هائ.  شوندی اداره می سنتۀوي عادت دارند که به شیشتر مردم به مدرسه هائيب
م سوال  که معلی رود و دانش آموزان سراپا گوش اند و تنها هنگامی واحد به شمار میآن معلم سخنگو

 ی مطلق معلم  و بیي که در آن فرض بر داناین روش آموزشيا.  کنندیدا ميکند اجازه صحبت کردن پيم
 هم ی مشارکتی آموزشۀک دوري ی  گذاشته شده است برای کامل دانش آموزان از موضوع  آموزشیاطلاع

 که در آن یاهد کرد؛ روش متفاوت تمام شرکت کنندگان را توانمند خویروش. ناکار آمد است و هم نامناسب
 ی متناسب با درک و دانش خود از موضوع آموزش بهره میهمگان شرکت فعال دارند و هر دانش پژوه

ز ي خود را نۀ روزمریط موجود در زندگيکند تا شرايت مي تربی انتقادیدي دی فرد را براین روشيچن. برد
.به هدف مشترک بپردازنددن ي در صدد حل مشکلات و رسی مشارکتی کند و به روشیبررس  

 اداره کردن بحث ۀ شرکت کنندگان تجربۀست بلکه همي معلم در مرکز توجه نیدر روش آموزش مشارکت
"  لفظ ی همکارین فضاينيدر چ.رندي گیدانش آموختن خود را به عهده م" تيمالک"  کنند و یدا ميرا پ

 شرکت کنندگان در ۀرا هميم زي کنیاستفاده م" لگريتسه " ۀ آن از کلمیست و به جايچندان مناسب ن" معلم 
پاسخ "دن به ي رسیهدف آموزش اشتراک. م اندي واحد و مشترک است سهی که منجر به هدفیت مشترکيفعال

. استی متفاوت به صورت گروهی آرا و نقطه نظرهایست بلکه بررسين" درست  

 آموزش ۀک دوريدر . لگراستيک تسهي یح از نقشين و درک صحياز به تمري نیلگريت در تسهيموفق
:ر استيلگر به قرار زيک تسهي ۀفي، وظیگر آموزش مشارکتي دۀا هر دوري، و یرهبر  

است اما » ن برابرهاين فرد بياول«لگري شخص تسه.ن شرکت کنندگاني بی ارتباط برابر و مشارکتیبرقرار •
 . کل گروه استۀ آموختن به عهدۀفيوظ

 است که در آن همگان با یيجاد فضايلگراي تسهۀفيوظ. د و احترام آکنده از اعتمایفراهم کردن فضائ •
 یز محترم شمرده مين حال بدانند که آراء مخالف آراء آنان نيند و در عيد خود سخن بگوينان از عقاياطم
 .شوند

 . امکان مشارکت تک تک افراد را فراهم کند. فعال دارندینان حاصل کند که همگان شرکتياطم •

ان جلسه و متعهد ي، شروع و پای جلسه، وقت نگهداریيساختار شامل بر پا. یختار آموزشفراهم کردن سا •
د همواره ي ساختار جلسه بایزان کارآمدي آگاه شدن از میلگر برايتسه.  دستور جلسه استیبودن به اجرا

 . با شرکت کنندگان مشورت کند

 لوازم، مرتب کردن ی و آماده سازیآور تواند شامل گرد یماز ها ين.  جلسهی تدارکاتیازهايبرآوردن ن •
 . باشدی قبلینان حاصل کردن از آمادگي به شرکت کنندگان، و اطمی جلسه، اطلاع رسانیمحل برگزار

  :لگري مثال تسهیبرا. ز کندي نقش ها پرهی برخید از اجرايلگر باين حال تسهيدر ع

ک دانش پژوه است برابر با ين يرين سايبلگر هم در يتسه.  داردیرياد گيت يتمام گروه مسئول. ستيمعلم ن •
 . گروهۀيبق
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ن ييد تعيلگر، نباي، بخصوص تسهیچ شخصي آموزش هی و مشارکتیط افقيک محيدر . ستيک داور ني •
 .است" بهتر" ايو " درست " یکند چه روش

 از شتري بیت جلسه را به عهده دارد اما الزاماً دانشيت هدايلگر مسئولين که تسهيبا ا. ستيمتخصص ن •
 .  گروه نداردیراعضايدانش سا

 کند ی می زند و سعیر افراد گروه حرف ميلگر با تجربه معمولا کمتر از سايک تسهي. ستيمرکز توجه ن •
 .زديگران را به اظهار نظر و سخن گفتن برانگيشترديب

ما تنها ت  هماهنگ کردن جلسه ها را به عهده دارد ايلگرمسئولينکه تسهيبا ا. ستي مسئول نیبه تنهائ •
 .  نگه داردی آموزشیت هايفه دارد فضا را همواره مناسب و مساعد فعاليست که وظي نیفرد

 یم ، و با انتقاد ازخود همواره در پين کنيد همواره تمريم باي شویلگربهترينکه تسهي ایر مهارت ها، برايمانند سا
  :  کندیابيشه کار خود را ارزيد هميلگر بايک تسهيبه عنوان مثال . ميشرفت باشي پیافتن راه هاي

ک معلم ي نقش یفاي ای کند که در پیشتر از گفتارش ثابت ميرفتارشخص ب. ديبه نقش خود کاملاً آگاه باش •
 .ستي نیسنت

 .ديا سخن گفتن به شرکت کنندگان نگاه کني است هنگام گوش دادن یضرور. ديمراقب نگاه تان باش •

لحن . دي هم نکنیيد، پرگويز حرف نزني آرام نیليد و خينکن بلند صحبت یليخ. دي تان باشیمراقب صدا •
 . احترام و اعتماد داردیجاد فضاي در ایيسخن گفتن شما نقش به سزا

 یزمان. است به شما بدهدي تواند حالت ری نشست و برخاست شما مۀ نحو. خود باشدیمراقب حرکانت بدن •
ن قرار يريت مشابه  سايد تا در موقعيباشد بهتر است نشسته ي کنی گفت و گو می موضوعۀکه در بار

 .ديريبگ

گران يد که هرکس بخت اظهار نظر داشته باشد و رفتار دينان حاصل کني اطم.ديت تان آگاه باشيبه مسئول •
ز ي را نیآنان. ديد امّا بحث و جدل تند را برنتابيق کنيقه ها را تشويد و سلياختلاف عقا. با او محترمانه است
 . ديند محترمانه و دوستانه  به بحث بکشي جوی میورکه از مشارکت د

حات و خلاصه مباحث را اگر لازم به نظر برسند يتوض. د که ساختار جلسات حفظ شده باشديدقت کن •
 .د که گروه از موضوع مورد بحث خارج نشوديمراقب باش. ديارائه ده

ر افراد گروه ي  ساۀ بر عهد را در صورت امکانیلگريف تسهيوظا. دي داشته باشیبه نقش خود آگاه •
 .ل گري جلسه به عنوان تسهۀ و اداری، وقت نگهداریادداشت برداريد، مانند يبگذار

  یفناور در آموزش یلگريتسه
 ی صدق میريادگي ی همه روش هاۀ مطرح شدند درباریلگري تسهین روشهاي بهترۀ که دربارینکات کل

اصولا در .  شوندی مطرح میفناور آموزش یلگريتسه هم هنگام یگري دیعلاوه بر آن، چالش ها. کنند 
است، " متخصص" ی فنۀنيکند در آن زمي که جلسه را اداره مین است که کسي، فرض بر ایهرآموزش فن

مطلب " سيتدر"د کاملا بر نقش خود واقف باشد و نا خودآگاه به يلگر باي تسهیين دوره هاين در چنيبنابرا
  .نپردازد
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ند آموزش يلگر و شرکت کنندگان در فرآينقش تسهۀ درباریحاتيروع هر دوره توضبهتر آن است که در ش
  . همگان روشن باشدیداده شود تا روش کار برا

  یلگري تسهیمهارت ها
ختن ي برانگیين مهارت ها توام با توانايشتر ايب.  شوندی ذهن مۀشتر ملکين بي با تمریلگري تسهیمهارت ها

 که یافزون بر مرور کردن مطالب. باط برقرار کردن با شرکت کنندگان استگران، درست گوش کردن، و ارتيد
  : ديرير را در نظر بگيد نکات زي کنی خود را آماده میک کارگاه آموزشي ی که براید ارائه شوند، وقتيبا

ازمندانعطاف و سازگار کردن دستور کار با سطح دانش و سرعت ي نیلگريتسه: انعطاف و ابتکار •
د، مانند قطع ي هم مواجه شوین، ممکن است شما با مشکلات فنيافزون برا. ت کنندگان است شرکیريادگي

د ابتکار عمل را به دست ين موارد بايدر ا. ک پروژکتوريا کار نکردن ي، ینترنتيبرق، اختلال در ارتباط ا
از يد که ني بپردازیگريد به بخش ديد بتوانيبه عنوان مثال، شا. د ي خلاق از موانع بگذرید و با روشيريبگ

 .نترنت نداشته باشديبه استفاده از ا

ح مطلب ين است که همزمان با توضين روش اي بهتری آموزش فنی برا:ديش دهيح دادن نماين توضيدر ح •
 کند تا یگام به شرکت کننده کمک م- به-ن روش آموزش گاميا. ديش دهيدئو نماي وۀ صفحیآن را رو

 .ردير را بهتر فراگروش کار کردن با آن نرم افزا

د آنان را يار شرکت کنندگان بگذاري آن که راه حل  ها را در اختیبه جا:  کامل شدن استۀن مقدميتمر •
. دي آیبا استفاده مکرر از آن به دست مفاوا مهارت در .  حل مسئله استفاده کنندیوه هايد از شيق کنيتشو
 . بپردازندیوراو کاو و سر و کله زدن با آن فند که افراد بتوانند خود به کند ين کنيي را تعیزمان

برعکس، بهتر آن است .  دان باشد-زي چ- رود که همهیلگر انتظار نميک تسهي از :ستيب نيندانستن ع •
ژه پس از ي را ادامه دهند، به ویافتن پاسخ باشند و خودآموزي ید که خود در پي دهیاريشرکت کنندگان را 

 .ان هر جلسهيپا

 سرعت روند آموزش و نوع مطالب نظر ۀ بطور مرتب از شرکت کنندگان دربار:ح  و اصلایبررس •
 .دي گروه سازگار کنیازهايط را با نيد و اگر لازم بود، شرايبخواه

 و فرصت ین شده از سوئييت وقت تعي از دستور کار و رعایروينان از پين اطمي ب:ديزمان را نگه دار •
 یرويپ. ديگر، توازن برقرار کني دیشتر بر موضوع، از سوي ب تسلطی دادن به شرکت کنندگان برایکاف

 ی شرکت کنندگان و آشنائی است اما احساس راحتی انجام کار خاص ضروریکامل از دستور کار برا
 . شتر آنان با ابزار کار مهم تر استيب

د تا ي کنید سعي بام ،ي کنیه مي تکیهمانقدر که ما بر لزوم آموزش مشارکت: ديم کني سهیريادگيهمه را در  •
گران در يشان را با دي دهد تا آموخته های شرکت کنند که به آن ها فرصت میتهائيهمه افراد گروه در فعال

 . ان گذارنديم

شرکت . دي خود را حفظ کنیخونسرد) که حتما خواهد آمد(د ي آیش مي پی مشکلیوقت: ديخون سرد باش •
 یفناور برند ، به همان اندازه از رفتار شما در قبال ی مکنندگان همانقدر که ازارائه مطالب شما بهره

 برطرف ی مشکل را به نحویلگر با آرامش و خونسردينند که تسهياگر شرکت کنندگان بب. خواهند آموخت
 دارد به کار ی چاره این که هر مشکلينان از ايابند و با اطمي ی میشتريز اعتماد به نفس بي کند، خود نیم

  . دهندیادامه م
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در . لگر، هر دو، لذت بخش باشدي شرکت کنندگان و تسهید براي کارگاه بای فضا:ديفضا را شاد نگه دار •
شتر بهره يشان بيت از آموزش و تجربه هاي هراسند و در نهای نمیفناورن صورت شرکت کنندگان از يا

 . خواهند برد

 یلگري تسهیروش ها
 گوناگون وجود دارد، از جمله ی در بحث ها  روش هان مشارکت همهيک کارگاه و تأمي فعال کردن یبرا

 یروش ها. ديت کارگاه خود، استفاده کنين روشها، متناسب با وضعياز ا. مي آوریر مي که در زیيروش ها
 که سه  یتا هنگام. دي کنند به کار بریشنهاد ميا شرکت کنندگان پيد و ي کنی را که خود فکر میگريد

  ."یح، و توانمندسازيم، تفريتعل: "شود کارگاه موفق خواهد بود یت ميرعا"  ت"استاندارد 

 توان از کد یمثلا م. دي استفاده کنیفناور یم کاربردهاي تفهی برای بومیو هاي از سنار:ديه و تقليتشب •
 . بهره گرفتليمياک ي فرستادن یک نامه به مقصد، برايدن ي و روند رسیپست

 که یانه کار کند در حاليد که با راي از شرکت کنندگان بخواهیکياز : ی بلورۀ در کاسینظاره کردن ماه •
. ی بلورۀ در کاسی کنند، مانند نظاره کردن ماهیچند تن از شرکت کنندگان او را احاطه کرده و نظاره م

 یانه مي را با رایشتري زمان بیانه ها کمتر از تعداد کاربرها باشد، همگي تعداد رایب، وقتين ترتيبه ا
 . کنندیدا ميگر تجربه کارکردن با دستگاه را پيکديشان با ي و با عوض کردن جاگذرانند

گر زودتر يکدي دهد تا با ی میاريخ، که به شرکت کنندگان يشکستن : ی بخشیه، انرژيخ اوليشکستن  •
لگر احساس ي که تسهی کارگاه هنگامیدر طول برگزار.  دهدی میآشنا شوند، اغلب در آغاز کارگاه رو

. ه دهديد و به گروه روحي بخش بهره جوی انرژی تواند از ترفندهای همه خسته و کسل شده اند، م کندیم
 . شده اندی آموزش چند ترفند معرفیدر بخش مبان

 ی کند با موضوع آشنائی دونفره شرکت کنندگان را توانا میکارکردن در گروه ها: مشارکت دو نفره •
 یدي گروه گرد هم آمدند، بهتر است تنها به مسائل  کلی اعضاۀ که همیهنگام. دا کنندي پیژرف تر

 . دونفره مطرح شدهیم هايبپردازند که در ت

 که در کار کردن با یي های با سختیيارويلگر در روي تسهیت تجارب شخصي روا:ی شخصیداستان ها •
د يق کني تشوافراد را. ن استيري سای برای حل کردن آنها، مشوق خوبۀ به آن ها برخورده، ونحویفناور

 . ندي خود سخن بگوۀک از تجربيتا هر 

د بدون ين کنيد تمري بایفناور  را که در استفاده از ی از کارهائیکي مراحل :مرتب کردن مراحل کار •
مثل مراحل ارسال .  کنندی که درست است شماره گذاریبين مراحل را به ترتيد ايافراد با. ديسيب بنويترت
د، ي جدۀد ناميپ کردن متن، فشردن کليستم، تايادن نامه، خارج شدن از سفرست: یکيک پست الکتروني

 .ار کارآمد استي مرور مطالب بسین روش برايا. د ارسالي، فشردن کلليمياورود به 

ند، به ي را برگزید موضوعيهر گروه با. ديم کني شرکت کنندگان را به چند گروه تقس:ديس کنيد، تدريبخوان •
 . ديب دهي ترتیلگريک جلسه تسهيقه ي دق١٥ کند و آنگاه در یآن را بخواند و بررسدقت مطالب مربوط به 

 را بشنوند و به بحث بگذارند ی دهد آرائی کردن به شرکت کنندگان امکان مینقش باز:  کردنینقش باز
از  گذارتد و یده اند مي که برگزی شخصیب خود را به جاين ترتيست و به ايکه الزاماً از آن خودشان ن

 را که در یيت هاي از شخصیکيممکن است افراد بخواهند نقش .  کنندید او به موضوع نگاه ميه ديزاو
 .رندين رهنمود آمده اند به عهده بگيا
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ک از آن ها ي شود و هری چهار نفر گزارشگر انتخاب مین جلسه ايدرچن: آموختن به شتاب و دوّار •
ر يسپس سا. ندي گزیر شرکت کنندگان برمي کوتاه به سایش گزارۀ ارائی را برایا ابزارينه يموضوع، زم

 از یکي که در ی گزارشگری هرگروه به سوی شوند و اعضایم ميشرکت کنندگان هم به چهار گروه تقس
به ) قهي دق٥در حدود ( خاص را ی استفاده از ابزارۀز نحوي روند و او نیستاده است مي اطاق ایگوشه ها

 زنگ به سراغ یدن صدايان گزارش هر گزارشگر، گروه شنونده با شنيپاپس از .  دهدیآنان نشان م
جان آور و  لذت بخش باشد و ي تواند هم هین گونه جلسه ميا.  رودیدن گزارش اومي و شنیگزارشگر بعد

 .  گوناگونی موضوع هاۀع در باري سریت مهارت گزارشگري تقوی برایديهم راه مف

د شما پاسخ آنها ي که شایيپرسش ها. د از شما سئوال کننديگان بخواه از شرکت کنند:ل گريج کردن تسهيگ •
د که يح دهيگران توضيد به ديافتي که آن را ید و هنگامي پاسخ پروید به جستجوي دانیاگر نم. ديرا ندان

 .ديدا کرده ايچگونه پاسخ را پ

 دهد در بحث ی امکان م کوچک تر به هر شرکت کنندهیم کردن شرکت کنندگان به گروه هايتقس: گروه ها •
 خواهند ی که میا به هر گروهي توانند یشرکت کنندگان م.  داشته باشدین ها شرکت فعّال تريها و تمر

شتر از شرکت ي هرچه بین کند تا با تعداديي گروه ها را تعی تواند قبلاً اعضایلگر ميا تسهيوند و يبپ
 .کنندگان تعامل و گفت و گو کند

 تعداد ۀم گرفتن در باريپس از تصم.  استیم بندين نوع تقسيوه اين شيتداول تر م:ی تصادفیگروه بند •
به عنوان نمونه، اگر به پنج .  شمرندیب عدد ها را مياز، شرکت کنندگان به ترتي مورد نیگروه ها
ک يب تمام ين ترتيبه ا.  کنندیک شروع مي شمرند و دوباره از یک تا پنج را مياز است از يگروه ن
 .رندي گی آخر، قرار میک گروه ، تمام دو ها در گروه دوم ، اليها در 

 کنند که بر اساس علاقه ی شرکت کنندگان انتخاب م: خاصی بر اساس موضوعیگروه بند •
 که به موضوع ی مثال، شرکت کنندگانیبرا. رنديک گروه قرار گي مشترک با هم در یها

 .  کنندی می همکاریجي ترویت هايگر در دوره فعاليکديحقوق کودکان علاقه مندند با 

 یدن موضوعي کارآ در فهمی توانند نقشی ساده میا طرح هايعکس و  :یري تصویکمک ها •
  توان با استفاده از ید چگونه ميک طرح ساده نشان دهي بابه عنوان نمونه، . ده داشته باشنديچيپ

 . انه ها را با وب مرتبط کرديرا)  modem(مودِم 

ک از يد که کدام ي شرکت کنندگان بپرسۀ آموزش از همۀان هر جلسيدرپا:  روزن موضوعيسخت تر •
در . دياه بچسباني تخته سید و بر رويسي بنوی کارتیآن موضوع را رو. شان سخت بوده استيمباحث برا
 . دين گونه موضوع ها بپردازيشتر از اي به تعداد هرچه بی بعدۀآغازجلس
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  ی آموزشۀ برنامی همگذاری لازم برایگام ها
لگران آسان ي تسهیدر آغاز کار ممکن است برا.  توان همانگونه که نوشته شده بهره بردین رهنمود مياز ا
در .  که در رهنمود آمده است استفاده کنندیشنامه ها و جلساتي، نمایلي تخیت هاين باشد که از شخصيتر ا

گر ي دهند در دی که در آن میراتيين رهنمود را با تغيح دهند ايلگران ممکن است ترجيشتر تسهيتجربه ب
  . ز به کار برندي نی آموزشیبخش ها

   : باشدیوه خاصي شی تواند دارای میهر آموزش، دستور کار یبه طور کل

 .شرفتهي گرفته تا متوسط و پی ابتدائیاز مهارت ها:  مهارت محوری آموزشۀبرنام •

 ابزار محور ی آموزشۀک برناميجاد ي ایا مختلف براياز ابزار واحد :  ابزار محوری آموزشۀبرنام •
و ) ٢٫٤وست يپ(، )word processor(ژه پرداز  وایراهنما: د بهيبه عنوان نمونه نگاه کن. دياستفاده کن
 ).٢٫٦وست يپ( جالب ی ابزارهایراهنما

.  کنندی توانا می مشخصۀدي اۀنيد که شما را در زمي را انتخاب کنیجلسات: ده محوري ای آموزشۀبرنام •
وست يپ (ی پژوهش و مستندسازۀا به برناميو ) ٢٫٧وست يپ (یجي تروۀک برنامي ۀد به نمونينگاه کن
٢٫٨ .( 

 

 ی تجربی هایژگي ویازها و بررسي نیابي ارزیک آموزش فناوري یزين گام در برنامه رينخست
 شرکت یريادگي ی متناسب با هدف های آموزشۀ انتخاب برنامی برایگام بعد. شرکت کنندگان است

 یش کارمندان وزارت ارتباطات بهتر است برنامه آموزۀژيبه عنوان نمونه، کارگاه و. کننده است
 ی متخصصان ارتباطاتۀژي ویک کارگاه آموزشي یگر، براي دیاز سو. مهارت محور را ارائه کند

 پژوهش ۀژيک کارگاه ويز ين.  ابزار محور متناسب تر استی آموزشۀ برنامیردولتيک سازمان غي
 مناسب یِتمرکز بر مواد آموزش. از دارديده محور ني ای آموزشۀک برنامي به یو مستندساز

  . کندیل ميژه را تسهي ویک کارگاه آموزشي ۀ و ارائیگذارکارهم

  

  ژهي ویک کارگاه آموزشي ی لازم برایگام ها

ن آموزش ي از ایيک جمله انتظار نهايدر . دي و چشم اندازآموزش را روشن کنی آموزشیسرفصل ها: گام نخست
  .گر وصل کنديکديبه  جلسات و مطالب را ۀک رشته همي که بتواند مانند ید؛ جمله ايان کنيرا ب

. ديب قرار گرفتن آنها را مشخص کني و ترتی عمده موارد آموزشی رئوس مطالب دستور کار و بخشها:گام دوم
ن شده در يي آموزش و وقت تعیده آل براين وقت اي بید تا اگر تفاوتين بخشها روشن سازين ايت را در بياولو

 . ديد مشکل را حل کنيرهنمود وجود داشت، بتوان

د يشان اجرا خواهند کرد، مشخص کني آموخته هاۀجي شرکت کنندگان به عنوان نتۀ را، که همیي پروژه نها:گام سوم
وست يپ(ان ي پروژه آموزش مربۀجيبه  عنوان مثال، نت.  ملموس با خود داشته باشندیئيتا بتوانند آن را به مثابه ش

ک ي که  ساختن ی شمرده شود، در حالیاختصاص ی آموزشۀک جلسي یل گري و تسهی تواند همگذاریم) ٢٫١٠
  . باشد) ٢٫٦وست يپ(  جالب ی آموزش ابزارهای نهائۀ تواند پروژی  می مشارکتیوبلاگ رسانه ها
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 مانند ی جنبید، با توجه به کارهايسي هر ساعت آموزش بنوی را به ازادستور کار هر جلسهات يجزئ:گام چهارم
 آماده ی براید زمان کافيد که باياد داشته باشيبه . هایابي و قهوه، و ارزیچا یان جلسه، استراحت برايآغاز و پا

  . شرکت کنندگان در نظرگرفته شودی برایي پروژه نهاۀ و ارائیساز

د از کتاب رهنمود يلي را که مایجلسات. ديم کني کوچکتر تقسی را به قسمت های طولانی آموزشی بخش ها:گام پنجم
 اختصاص یک جدول زماني هر جلسه یبرا. دي کارگاه خود سازگار کنیازهايد آنها را با ند و اگر لازم بوينيبرگز
 ۀ برجلسید که هر جلسه مبتني انتخاب کنی جلسات را به گونه این است که موضوع هاين روش ايبهتر. ديده
  .ل کندي را هم تکمیي نهاۀ از پروژین حال بخشين باشد و درعيشيپ

 یبرا. شتريم بين ها و کمک به تفهي تمریبرا)  نمونه و جزوه هایل هايفا (یکمک مطالب ی گردآور:گام ششم
ک و ي پست الکترونی از خبرنامه هایي است، نمونه های ارتباطیمثال، اگر موضوع آموزش تمرکز بر روش ها

 یونه ها را من نميا.  توانند به روشن شدن موضوع کمک کنندی مطلب، مۀ ارائی، و نمونه هایکيا اخبار الکتروني
  .د کندي مهم و مورد نظرتان را تأئیر داد که نکات آموزشيي تغیتوان طور

 که ازگروه شرکت کننده به یي های و نظر سنجیاز سنجيبر اساس ن. دي نمونه را هماهنگ کنیتهايشخص: گام هفتم
و يوه شما باشند و سنار افراد گرید تا معرف علاقه ها و مهارت هاي را خلق کنی فرضیتهايعمل آمده است، شخص

  :به عنوان مثال. دي سازگار کنیط بوميها را هم با شرا

. ابدي خواهد به آن دست یل نداشته است و ميمي ازشرکت کنندگان تا به حال آدرس ایکيد يفرض کن •
، ) استیت فرضيک شخصيکه "  (نايم " ید و به جاير دهيي را تغ٤٫٣ یابيد بخش دستي توانیشما م

 بابت ین فرد مشکليد که اينان داشته باشيد اطميالبته با. دين کنيگزيت کنندگان را جا از شرکیکي
 .گران در جلسه ندارديحضور د

. دي شده اon line)(ن ير آنلاي تصاوۀافتن جلسي: ١٫٨ یري مطرح کردن بخش فراگۀد آماديفرض کن •
شنهاد يام طرح مقدمه را پر هنگيدا کردن تصويا پير ياز به تصوي از شرکت کنندگان مشخصاً نیکس

ش از يد پي توانین صورت ميدر ا. ه کننديد گزارش تهينکرده است، اما چند نفر اعلام کرده اند که با
و را بر يسپس سنار.  ا نهياز دارند ير ني گزارش خود به تصویا برايد که آيشروع جلسه از آنها بپرس

 . دي کنیشان طراحياساس پاسخ ها

و ي ندارد، سناریک از شرکت کنندگان ارتباطيچ ي هۀي شما با تجریويکه سنار رسد یاگر به نظر م •
 یورا بازي سناریتهاي ازشخصیکيد که نقش ي بخواهیا ازداوطلبيد و يت ارائه کنيک روايرا همانند 

 شرکت کنندگان ۀاز هم)  (website"  ساخت وبگاهی برایزيبرنامه ر: "٦٫٣ یدر متناسب ساز. کند
 .ل گر سئوال کننديشه بگذارند و از تسهي عایود را جاد که خيبخواه

رات ييد و تغيريدتر کرد، ابتکار را خلاقانه به دست بگيو را مفي سناریراتيي که بتوان با تغیدر موارد •
 از شرکت یکيد که ي از جلسات بخش اول متوجه شویکيمثلا ممکن است در . ديلازم را وارد کن

 از آن مهارت قابل ی بهره بریافته است و برايار يجربه بس ت(Excel)کنندگان با نرم افزار اکسل 
 ی هایژگيو: "٦٫١ یابيدر بخش دست.ستيگر نرم افزارها چندان آشنا ني دارد، امّا با دیتوجه

ل گر جلسه يا کمک تسهيلگر يل است که خود تسهيا مايد آياز او بپرس" ،یصفحات جداول محاسبات
 .  و کمک کندیي نقش سارا شرکت کنندگان را در مراحل کار راهنمایفاي تواند با ای میباشد؟ و

 :ري دستور جلسه با در نظر گرفتن نکات ز و اصلاحیبررس: گام هشتم •
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o ن ي ای برایا جلساتياز دارند که شرکت کنندگان فاقد آن هستند؟ آي نیيا جلسات به مهارت هايآ
 نوع مهارت ها وجود دارد؟

o برقرار است؟ی و گروهی فردینهايتمرن ي بیا تعادل قابل قبوليآ  

o و مرور مطالب در نظر گرفته شده است؟یابي استراحت، ارزی برایيزمان ها ، 

o ان بُر، استفاده از کمک ي مید هاي، کلینسخه بردار:  مانندیه اي پایا لازم است مهارت هايآ
 ره در آموزش گنجانده شوند؟ي نرم افزار و غیها

o ا برقرارکردن ارتباط موثر، ي ارائه مطلب و ۀ، مانند نحویر فني غیا به آموزش مهارت هايآ
 از است؟ين

o را مشخص کرده اند؟ی بعدۀت ها و ابزار مرحليت فعاليوها محتوا و اهميا سناريآ  

o را یريادگيان کارگاه بتوانند يار شرکت کنندگان قرار دارد تا پس از پاي در اختیا منابع کافيآ 
 ادامه دهند؟-

وست يپ (ی فهرست نکات آموزشۀ شدیک جدول زمان بنديک کارگاه، ي یلگران در طرّاحيتسه کمک به یبرا
  .وست هاستي در بخش پ)٢٫٠وست يپ(  شده ی همگذارۀک دستور جلسيو )  ١٫٠
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  آموزش یمبان
  ٧....................................................................انيآغاز و پا: ١ یمبان
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  یمبان
 از یبهره  جوئ: ٢ فاوا، بخش ی به ابزارهایابيدست: ١بخش:  در سه بخش آمده اندیمطالب آموزش

 مختلف کنار هم ی توان به روشهایم را ن بخش هايا.  فاوایراهکار ابزارها: ٣، و بخش فاوایابزارها
ر ي زی از روشهایکي توانند ی میان آموزش فن آوريمرب.  شوندی متفاوت آموزشیوه هايد تا مناسب شيچ

  :را انتخاب کنند

. کسان قرار دارند مناسب استي یبا در سطح مهارتي که تقری شرکت کنندگانی برا:آموزش مهارت محور •
 .کندي گوناگون آشنا می کنندگان را با ابزارهان روش شرکتيا

 یا شماريو ) Excel(ا اکسل ي) Word(ک ابزار مشخص مثل نرم افزار وُرد ي بر :آموزش ابزارمحور •
 هر یريادگين روش يهدف ا.  کندی آمده است، تمرکز م٢٫٦وست ي مشابه، مانند آنچه در پیاز ابزارها
 . آنهاستۀنيبه ابزارها و کاربرد یک سريع تر يچه سر

 از یگر، چشم اندازي دی استفاده از ابزارها در سازمانهای با مرور روشها:آموزش موضوع محور •
 ی ابزارهای گذارد و همزمان به معرفیار مين  ابزارها در اختي خلاقانه و متفاوت  درکاربرد ایروشها

 . پردازدین مينو
  

ن دستورکارها وجوه ي اۀهم.  استیهر روش متناسب با ی از دستورکارهایيوست شامل نمونه هايپ
 یبخش ها.  شوندی به کار برده میي مبنای هستند که درانواع آموزش هایاشتراک دارند و عمدتا مطالب

 ین بخش به جاي توان از ای ها را میابي، و ارزی کارگاهیان، پروژه هاي مانند شروع و پایضرور
  .م، منتقل کرديکن ی که درست میديمناسب آن در هر دستور کارجد

 .ید آموزشي جدۀک دوري، در شروع یا خودماني ی آغاز دوره، رسمیاريجشن اخت •

o ا ي و ی منطقه ایر سازمان ها ي که از سای، بخصوص در مواردی آموزشۀبرگزار کنندگان دور
ک جشن ي شرکت در مراسم دعوت کرده اند، ممکن است بخواهند دوره را با ی هم برایکشور
 .نند آغاز کیرسم

  شروع آموزش ی لازم برای مقدماتۀجلس •

 ." مقدمات: "١٫١ ید به بخش مبانينگاه کن •

 .ازيا در طول جلسه در صورت ني زا در شروع هر روز آموزش و ی انرِژین هايتمر •

o ده محوري ای بخش ها و گزارش ها یانرژ: "١٫٢ ید به بخش مبانينگاه کن". 

  روز قبلیت هاي فعالیبررس •

o شنهادهاي پۀ بخش ها و گزارش در باریانرژ: "١٫٢ یبخش مباند به ينگاه کن". 

 د توسط شرکت کنندگان اجرا شوندي که بایيا پروژه هاي و یي نهایپروژه ها •

o آموزشیل گريتسه: "٣ یو بخش مبان" ی کارگاهیپروژه ها: "٢ ید به بخش مبانينگاه کن ". 

 یان هر روز آموزشي در پای مقدماتی هایابيارز •
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o گرد آوردن نظرات شرکت کنندگانی برایروزنگار آموزش: " ٤٫١ید به مبانينگاه کن ". 

 ی آموزشۀ در طول دوری دوره ا-اني می هایابيارز •

o یومبان" اشتراک دانش،: "٤٫٣ یمبان" آموختن مادام العمر،: "٤٫٢ ی مبانید به بخش هاينگاه کن 
 ."ی فن آوری از ابزارهایري بهره گیايمزا: "٤٫٤

 ی آموزشۀ دوریي نهایابيارز •

o که نشان ی  طرح پرسش نامه ایبرا" ی آموزشۀ دوریاني پایابيارز: "٥٫٠وست يد به پينگاه کن 
 توان آن را ی شرکت کنندگان موفق بوده و چگونه میازهايدهد دوره  تا چه حد در برآوردن  ن

 .بهتر کرد

 ان دورهي پایاريجشن اخت •

o که  یژه هنگاميان دوره را برگذار کنند، به ويلند جشن پاي مای آموزشۀبرگزارکنندگان دور 
 .   شرکت در دوره دعوت کرده اندیگر براي دیسازمانها
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اني آغاز و پا-١ ینمبا  
یيمراسم آشنا: ١٫١ یمبان  

 . کنندی میگر معرفيکديشرکت کنندگان خود را به  •

o ديسيز، بنوي میا روينه و ي سی کارت روینام خود و نام سازمان تان را بر رو. 

o نگاه .(ديسي بنویتان مهم است در روزنگار آموزشين کارگاه  براي را که در ایموضوع آموزش
 ).٤٫١د به بخش يکن

  ت هايفعال

  قهي دق٣٠

ار همگان ي را در اخت-شه ي، و عاینا، سارا، سوفي م-ت انتخاب شدهيمشخصات چهار شخص •
 .ند بلند بخوانین مشخصات را با صدايچهار نفر داوطلب ا. ديبگذار

 تخته یت را روين چهار شخصيک از اي هر ۀ درباریيد تا پرسش هايک داوطلب خواهش کنياز  •
 : دينير برگزي زید از نمونه هاي توانی از پرسش ها را میبرخ. سديبنو

o د؟ي کنی و علاقه میکيت ها احساس نزدين شخصيک از ايبا کدام 

o ا تجارب شما هستند؟ي مهارت ها و ۀت ها تا چه حدّ بازتاب دهندين شخصي ایتجارب و دانش فن 

o ست؟ي چی آموزشۀن دوريزه ها و انتظارات شما از ايانگ 

o د؟يري بهره گینه هائيد در چه زميدوارين دوره اميتان در اياز آموخته ها 

o د کرد؟يم خواهيد چگونه سهينجا به دست آورده اي که در ایگران را در دانشيد 

o ل، واژه پردازها، يميانه، اي مانند رای فنآوریزارها از ابیزان مهارت شما در بهره جوئيم
 ست؟يچ Power Point)(نت ير نرم افزارها مانند وٌرد، اِکسل، و پاورپوينترنت و سايا

o د و چقدر؟ي کنیشتر استفاده مياز کدام ابزار ب 

o د؟ي کنار گذاشته ایا آن ها را به کليد و ي اندک کرده اۀن ابزارها استفاديک از اياز کدام 

  .م شوندين سهيريسند و درآن با ساي بنویشرکت کنندگان پاسخ ها را در روزنگار آموزش •



٨ 
 

   زا و گزارش های انرژیت هايفعال: ١٫٢ یمبان
  .ن شرکت کنندگاني بی ارتباط خودمانی و برقراریک روز آموزشي آغاز یست براي زا مقدمه ای انرژیت هايفعال

   زا ی انرژیت هايفعال

  قهي دق١٥

ن پرسش ها يد به نوبت به اي شرکت کنندگان باۀهم. دي تخته آغاز کنی بر رویبا نوشتن پرسشروز را  •
 .پاسخ دهند

  زای انرژیت هاينمونه فعال •

 : چهار روزهۀک دوري یدو پرسش در روز برا 

 .است...  من یياينرم افزار رو. است... منیيايلات رويتعط: ايرو •

 کنم پس یمن آرزو م. اورميرا بدست ب...  کنمیآرزو ممن . بشوم...  کنم تا یمن آرزو م: آرزو •
 .را انجام دهم. .. ن آموزش بتوانم ياز ا

 را در ین فن آوريدوارم ايمن ام. اورميرا به دست ب.. دوارم تايمن ام. بشوم.. .دوارم يمن ام: ديام •
 .به کار برم.. . ۀرشت

 .ان گذارميدرم. . . م را بايموخته هان است که آيبرنامه ام ا. بشوم... من برنامه دارم: برنامه •

 : دو روزهۀک دوري یت برايدو نوع فعال 

شه با ي راهمیح دهد که چرا ابزار خاصي آن چه هر شرکت کننده همراه دارد، توضیبا بررس •
 ین ابزار برايبا ارزش تر(  رود و چرا؟ یرون نمي از خانه بیا بدون چه ابزاريخود دارد و 

 )هر فرد

 را  از لحاظ یح دهد که چرا شئ خاصي که هر شرکت کننده همراه دارد، توضیائي اشیبا بررس •
ا ي آورد و چرا؟ یش به وجود مي  برای چه احساسی همراه دارد و همراه داشتن آن شئیاحساس

 ست؟يش  دارد چي را براین ارزش معنوي که بالاتریشئ

  

پس از . ديفزائي زاها بیجاد انرژياگرد ام کردن آنان در فريت هارا با سهينقش شرکت کنندگان در فعال •
 مانده ی باقی روزهاید که براي زاها در روز نخست ازشرکت کنندگان بخواهی انرژۀني در زمیل گريتسه
 .ه و ارائه کنندي را تهی زاهائیانرژ

  گزارش ها

  . باشد ناظریگري زمان را نگه دارد و دیکيد تا يهر روز از دو تن از شرکت کنندگان داوطلب بخواه

 بهتر کردن  ی دهد و برای جلسه گزارش میت هاي فعالۀشرفت کار روز در باريضمن نظارت بر پ :ناظر •
 . کندی را مطرح میيشنهادهايت ها ، پين فعاليا
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 یان مي آن روز جلسه را به جری دارد و کارهایت ها و تنفس ها را نگه ميزمان فعال: وقت نگه دار •
 .  کندی میادآوري لازم باشد یبند در زمانیريياندازد و اگر تغ

 ی آن روز، ارائه می زای انرژیت هاي وقت نگهدار و ناظر در آغاز روز بعد، و پس از فعالیمعمولا گزارش ها
  .شود
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 بان گرفتن يانتقال وپشت: ١٫٣ یمبان
 ۀک نسخي  خودید از پروژه هاي، شرکت کنندگان بای گزارش نهائۀا بلافاصله قبل از ارائيان جلسه يدر پا
  .ه کننديبان تهيپشت

تيفعال  

قهي دق١٥  

 به تواند یم پوشه نيا یمحتوا. کنند یکپ انتقال قابل ۀپوش کي در هارا داده ۀهم ديبا کنندگان شرکت •
 :رباشديز شرح

o آموزش مورد استفاده بوده اندۀ که در طول دوریل هائيفا . 

o آن ها باشندۀگر شرکت کنندگان که مورد علاقي دیل هايفا . 

o نترنت اکسپلورريده از اي برگزیل هايمانند فا. (  شده اندی که خود به خود کپیل هائيفا( 

o ی آموزشۀ از پوشیل هائيفا. 

 . ار خود منتقل کنندي سۀا حافظي و ی دی قابل انتقال را به سیل هايشرکت کنندگان فا •

o ک روز يبهتراست .  نند خود استفاده کۀد از رسانيل ها باي گرفتن از فای کپیشرکت کنندگان برا
 .اوردي خود را به همراه بۀن نکته اعلام شود  تا هر کس رسانيان دوره ايمانده به پا

o نان حاصل ي در کارگاه اطمی دی سی رویک ابزارنوشتارين نکته، از وجود يقبل از اعلام ا
 .ديکن

 ۀنسخ و یساز رهيذخ: "٧٫١ یابيدست بخش به ديبنگر بانيپشت ۀنسخ ۀيته ۀبار در کامل حيتوض یبرا •
 ."داده بانيپشت
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  کارگاه یها پروژه: ٢ یمبان
 تمام نکات مطرح شده در ۀرندي رسند که در بر گی به هدف می ایي نهاۀ با پروژفاوا یشتر کارگاه هايب

 ی میي نهاۀن پروژيا.  شرکت کنندگان در کارگاه ارائه کندی برای کاملۀز بتواند نمونيطول کارگاه باشد و ن
  :د به اشکال گوناگون باشدتوان

 ا پروژهيک متن ي •

o ٢٫٤وستيد به پينگاه کن( پس از اتمام آموزش نرم افزار واژه پردازینترنتيک متن اي( 

o ٢٫٦وست يد به پينگاه کن(  جالبی پس از اتمام آموزش ابزارهایک وبلاگ واقعي( 

 :ک مهارتي •

o کي پست الکترونی ارتباطیوتيان آموزش انستي در پایک خبري الکترونی پست هاۀيمهارت ته .
 )٢٫٩وست يد به پينگاه کن(

 :ک فراگردي •

o نگاه (ان ي آموزش مربۀ پس از اتمام دوری آموزش فن آورۀ، ساختن و ارائی همگذاریچگونگ
 )٢٫١٠وست يد به پيکن

o  ن ي کمپیتويدر انستفاواان آموزش نقش يدر پافاوا   شامل ابزار یجين ترويک کمپيتدارک
 )٢٫٧وست يد به پيننگاه ک (یجيترو

  

.  باشدیا گروهي و ی تواند حاصل تلاش فردی میي نهاۀ ، پروژی آموزشۀک دوري یبسته به زمان و محتوا
 امکان ی فردی کنند؛ پروژه های توانا می کار جمعین مهارت هاي شرکت کنندگان را در تمری گروهیپروژه ها

 یمطلوب آموزش سه تا چهار روز.   آورندید فراهم م فریتجربه و کسب مهارت را در فنون تازه آموخته  برا
ح خواهند ي را تشری گزارش نهائی بعدین هايتمر.  ی فردۀ پروژیگري و دی گروهۀ پروژیکي. است با دو پروژه

  . کرد
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 یجي تروین هايکمپ: ٢٫١ یمبان
محتملاً انجام آنها ت هاست و ين نوع پروژه شامل انواع فعاليا. یجي تروین هاي آموزش کمپیپروژه برا

  . دي را نگاه کن٢٫٧وست ي نمونه دستور کار پیبرا.  بردیچند روز زمان م

  

  ن يک کمپي یزيبرنامه ر: الف

  قهي دق٣٠

 .دينيک موضوع مورد علاقه آن ها را برگزي هر ید و برايم کنيا پنج گروه تقسيشرکت کنندگان را به چهار و  •

o قابل انتخابیموضوع ها : 

 ه زنانيحذف خشونت عل 

 اسناد مربوط به حقوق زنان 

  زنانیاسيش مشارکت سيافزا 

 یجوانان و تحولات اجتماع 

 ن مربوط به آن ييت و کميحقوق تابع 

 ت کارآ يريمد 

o یزي آغاز بحث و برنامه ری برایيپرسش ها 

 ست؟ي چیجين ترويک کمپي یزيمراحل برنامه ر 

 :دينير ببيآدرس ز را در یجي تروین هايشبرد کمپي پی برایزي برنامه ر--

http://www.planning.continiousprogress.org/files/examplegraphic١.ipg 

  ز موجود استي نی دیر ها در سي تصو--

 ن مهم ترند؟ي در کمپیچه جنبه هائ •

  بهره جست؟ی توان از فن آورینه من ها  چگوين کمپيدر ا 

  قابل استفاده اند؟فاوا یک از ابزارهايکدام  

  

  Iن يک کمپي یبرگذار: ب

  قهي دق٣٠- ١٥

  . دهندی خود خود ادامه مۀدي موضوع برگزی گروه ها با بحث و تبادل نظر به بررسی بعدی در روزها •

 از آموخته ها، ی بهره جوئی چگونگۀارند و در بي آیا جلسه، گروه ها گرد هم ميان هر روز و يدر پا •
  . پردازندی خود به بحث میجين تروي که به دست آورده اند در کمپیابزار و مهارت
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  I Iن  يک کمپي یبرپائ: پ

  قهي دق٣٠

به  عنوان نمونه، .  کنندین شان را طرّاحي کمپی فن آوریند تا با استفاده از ابزارهاي آیگروه ها گرد هم م 
  .ن شان بپردازندي کمپی معرّفی برایک وبلاگ برايا يک بروشور ي ۀيه توانند به تیم

  ن هايگزارش کمپ: ت

  قهي دق٦٠

 ین، ابزارهاي مهم کمپی جنبه هایادآوري کند، با یر شرکت کنندگان ارائه مي سای خود را براۀهر گروه پروژ
 ١٥ تا ١٠.( ن ها آموخته استين تمري از اشاره به آن چه گروه دري از آنها، و نیل بهره جوئيمورد استفاده، و دل

  ) هر گروهیقه برايدق
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  ی و مستند سازقيتحق: ٢٫٢ یمبان
ن ي مختلف ایبخشها.  گردش درِ وبی لازم برای آموزش ابزارهایه، براي، در سطح مهارت پایپروژه ا

.٢٫٨وست يور کارپد به دستي مثال، نگاه کنیبرا.  توان در طول انجام دستور کار ارائه دادیپروژه را م  

 

ديموضوع پژوهش را انتخاب کن: الف  

قهي دق٣٠  

 . کنندی خود را انتخاب مۀ شوند و موضوع مورد علاقیم ميا پنج گروه تقسيشرکت کنندگان به چهار  •

o موضوعات نمونه: 

 ه زنانيحذف خشونت عل 

 اسناد مربوط به حقوق زنان 

  زنانیاسيزان مشارکت سيش ميافزا 

 یجتماعجوانان و تحولات ا 

 ن حقوقين اي تأمین برايت و کمپيحقوق تابع 

 ت کارآ يريمد 

o یزي آغاز بحث و برنامه ری برایيپرسش ها 

  ن؟يقوان ها، برنامه محل، در گريد فعال یسازمانها آمار، است، ازين مورد یاطلاعات گونه چه 

  افتن اطلاعات و منابع پژوهش ي: ب

  قهي دق٣٠

 . کنندیقه بند و طبیگروه ها اطلاعات را جمع آور •

o ديق را جستجو کنيمطالب مربوط به موضوع تحق. 

 .دي مناسب بگردیدر وب بدنبال داده ها 

 .ديره کنيده ها ذخي برگزۀد در پوشيافتي را که یيوبگاه ها 

o دي کنی گزارش طبقه بندۀ ارائیاطلاعات به دست آمده را برا. 
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   اطلاعاتۀ و ارائیمستند ساز: پ

  قهي دق٣٠

 یا با بهره جوئي مثال به صورت متن و یبرا.  کنندیه ميگر گزارش را تهيکدي ی همکارگروه ها با •
 Power Point).(نت ياز  پاور پو

  گزارش اطلاعات: ت

  قهي دق٦٠

 که به یافتن اطلاعات، ابزاريز نحوه يد و نن کنیگروه ها گزارش اطلاعات به دست آمده را ارائه م •
  ). هر گروهیقه براي دق١٥ تا ١٠( ته اند  که آموخیکار برده اند، و درس هائ
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  یليميارتباطات ا: ٢٫٣ یمبان
ت ها در يم فعالي تقسی از چگونگی آگاهیبرا. یليمي ارتباطات اۀ مؤسسی، در سطح دانش متوسط، برایپروژه ا

  . ٢٫٩وست يد به پي آموزش، نگاه کنۀسراسر دور

د ي انتخاب کنیليمي ارتباطات ای برایموضوع: الف  

قهي دق٣٠  

o  ند و يد موضوع مورد نظرش را برگزي شوند، هر گروه بایم ميا پنج گروه تقسيشرکت کنندگان به چهار
 .دين کند، مشخص نماي خواهد تمری را که مینوع  ارتباط

 

 :یشنهاديموضوعات پ •
 ه زنانيرفع خشونت عل 
 اسناد مربوط به حقوق زنان 
  بانوانیاسيش مشارکت سيافزا 
 ی اجتماعجوانان و تحولات 
 ن حقوقي احقاق این برايت و کمپيحقوق تابع 
 ت کارآيريمد 
 ل يمي استفاده از ایروش ها •

 یکي الکترونۀخبرنام 
 ی کمک مالیجمع آور 
 ی و اضطراریهشدار فور 
  یجي ترویت هايفعال 

 

 : شروع بحثی برایپرسشهائ •
س، شرح واقعه، عک:  ارتباط لازم اندی برقراری برایچه نوع اطلاعات و منابع 

  ام؟ي، و پونديپفراخوان، 
 

افتن اطلاعات ومطالبي: ب  

قهي دق٣٠  

o دا کنندياز را پيگروه ها اطلاعات مورد ن. 
 .ابنديام را بيا پي عکس، شرح واقعه ، و یمطالب لازم برا •
 . ارائه گزارش مرتب کنندیمطالب را برا •

 

ديسي را بنویليميام ايک پيمتن : پ  

قهي دق٣٠  

o ه کننديده شده تهي برگزی مناسب با موضوع هایگر متنيکدي با یگروه ها در همکار. 
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یليميام ايارائه متن پ: ت  

قهي دق٦٠  

o حاضران در جلسه ارائه یه کرده است براي تهیکي را که به منظور ارتباط الکترونیاميهر گروه متن پ 
زمان . ( ه شده آموختیدا کردن مطلب، ابزار مورد استفاده و درس هاي پۀدهد همراه با شرح کامل نحو

  ).قه استي دق١٥ تا ١٠ هر گروه یام برايارائه پ
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  ی مشارکتی و رسانه هایسيوبلاگ نو: ٢٫٤ یمبان
.  جالبی در بخش ابزارهای آموزش ابزاریا براي و ی مشارکتی در رسانه های آموزش موضوعی برایپروژه ا
  . ٢٫٦وست يد به پينگاه کن

انتخاب موضوع وبلاگ: الف  

قهي دق٣٠  

 را که به آن علاقه مند اند انتخاب ی شوند و موضوعیم ميا پنج گروه تقسيرکت کنندگان به چهار و ش •
 . کنندیم

o یشنهاديموضوعات پ: 

 ه زنانيرفع خشونت عل 

 حقوق زنان 

  زنانیاسيش مشارکت سيافزا 

 یرات اجتماعييجوانان و تغ 

 ت ين تابعيحقوق و کمپ 

 ت کارآيريمد 

o یزيحث و برنامه ر شروع بی نمونه برایپرسش ها: 

ا ي خاص، ی هدفین براي، کمپی رسانیآگاه: ستيهدف از درست کردن وبلاگ چ 
 گران در دانش و اطلاعات؟يم کردن ديسه

 مانند ی مشارکتۀک رساني یابزارها: ن وبلاگ شامل چه خواهد بود؟ دست کميا 
 .del.icio.us یوندهايا پي، RSS، اخباریلمي فیرهايوب، تصويوتي یدئوهايو

  ساختن وبلاگ: ب

  قهي دق٦٠

سندگان را در آن ي نوید و نام هايد، آن را به راه اندازيد انتخاب کني را که دوست داری بلاگیالگو •
 .ديبگذار

 .دي کنیک مقاله را گردآوري نوشتن یاز برايمطالب مورد ن •

o ز در آن ي مناسب را نیويدي نوشتن مقاله، عکس و وی اطلاعات برایضمن جمع آور
 .ديبگنجان

o شروع داشته باشدیسنده و دو مقاله برايد دست کم دونويهر وبلاگ با . 
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  ش وبلاگينما: پ

  قهي دق٦٠

د و ارتباط ي گوی شان را پاسخ می دهد، به پرسش هایگر گروه ها ارائه ميهر گروه وبلاگ اش را به د •
  )دقه زمان داري دق١٥-١٠هر گروه .(  کندیح مي که دارد تشرین ابزار را با هدفيا
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  یواژه پرداز: ٢٫٥ یمبان
  .٢٫٤وست يد به دستور کار در پينگاه کن. ی واژه پردازیا آموزش ابزارهاي و ی سطح مهارت ابتدائیمناسب برا

  تيفعال

  قهي دق٩٠

 که شرکت کنندگان با خود خواهند برد، یيد که پروژه نهايان جلسات آموزش واژه پردازها اعلام کنيدر پا •
 . پرداز درست شده باشد است که با واژهیمتن

o  ن متن باشديد در اير بايک تصويک جدول و يدستکم. 

 یا متن تجاري)  ا بروشوري یات کاريمانند تجرب( یک متن شخصيه يچنانچه شرکت کنندگان خواستار ته •
 .  آن بپردازندۀيت به تهين موقعيد که با استفاده از ايشنهاد کنيباشند، پ) هيا اطلاعي یمانند برگ آگه( 

 . کنندیه مي را تهیيشرکت کنندگان پروژه نها •

o ل گر کمک ي توانند از تسهین انجام کار برخوردند مي در حیشرکت کنندگان اگر به مشکل
 . درخواست کنندی توانند از مربیرند، مياد بگي را یدي جدیل باشند فن آوريا اگر مايبخواهند و 

o د است، آن را ي همگان مفید براي دهیده مک شرکت کنني یا تقاضاي که به پرسش و یاگر پاسخ
 .ديشگر نشان دهي نماۀ صفحیرو

ن ارائه يري کار خود را به ساۀجيقه وقت دارد تا نتي دق١٠ تا ٥ن يت، هر شرکت کننده بيان هر فعاليدر پا •
  . کند
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  یصفحات جداول محاسبات: ٢٫٦ یمبان
 را ملاحظه ٢٫٥وست يپ.  مناسب استیحاسبات صفحات جداول می مهارت سطح متوسط و با آموزش ابزارهایبرا
  .ديينما

  تيفعال

  قهي دق٩٠

 جدول ۀک صفحيجاد ي ایي نهاۀد که پروژي اعلام کنی آموزش صفحات جداول محاسباتۀپس از اتمام جلس •
 . خواهد بودیمحاسبات

o ا گراف داشته باشديک نمودار ي و ی کاربردۀد دست کم دو صفحين صفحه بايا. 

o از خواهند گرفتيز اضافه کنند امتيه فهرست کنترل داده ها را ن کیشرکت کنندگان. 

o مانند بودجه، ( بود ی منظور شخصی برای محاسباتۀک صفحي خواستار یچنانچه شرکت کننده ا
مانند  (ی منظور شغلیا برايو )  وام گرفته از کتابخانهیا فهرست کتابهاينه و يهز/ درآمدیابيرد
 ی براید که اکنون فرصت مناسبي کنیادآوريبه او )  پروژهۀني هزات، کنترليزان درآمد و ماليم
 . ه آن استيته

o ديشنهاد کنير را پي زیاز بود، موضوع هاي نیگري دیاگر به انجام پروژها: 

ت به ين مسئولي که ایل هرمرحله و نام افراديت و کنترل پروژه، شامل زمان تحويريمد 
 . آن ها محول شده است

 .افتهيص ي تخصۀنه ها با بودجي هزۀسيل، شامل مقا و کنتریبودجه بند 

o خود کار کنندیي نهاۀ پروژی کارگاه شرکت کنندگان رویانيدر روز پا . 

 یدي جدیل اند فناوريا ماي برخوردند و ین انجام کار به مشکلياگر شرکت کنندگان در ح 
 .  بطلبندیاري ی توانند از مربیرند، مياد بگيرا 

د ي همگان مفید براي دهیک شرکت کننده مي یا تقاضاي و  که به پرسشیاگر پاسخ 
 .ديشگر نشان دهي نماۀ صفحیاست، آن را رو

o کار خود را به ۀجيقه فرصت دارد تا نتي دق١٠ تا ٥ن يت، هر شرکت کننده بيان هر فعاليدر پا 
  .ن ارائه دهديريسا
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  گزارش ۀارائ: ٢٫٧ یمبان
  . گزارشۀ ارائی ابزارهاا آموزشيشرفته و ي پی مهارت هایمناسب برا

  تيفعال
  قهي دق٤٥

ن بخش و   ي ایي نهاۀ رود پروژید که از آنان انتظار ميدر آغاز جلسه به اطلاع شرکت کنندگان برسان •
 .گر انجام دهنديکدي یگزارش مربوط به  آن را با همکار

o قهي دق١٥.(  پروژهی گزارش گروهۀ ارائی برایزيبرنامه ر( 

لند ي را که مایا گزارشي کنند و ی دانند انتخاب می را که مهم میا هدفيگروه ها موضوع  
 . سازمانشانی معرفیا برايش و ي نماید برايبا خود ببرند مانند اسلا

o  قهي دق٣٠(آماده کردن گزارش( 

 .ر باشدير متحرک، و صفحات متغير، نمودار، متن، تصاويد شامل تصوين گزارش بايا 

o  شودين مييداد افراد در گروه تع تعیزمان بر مبنا( ارائه گزارش( 

د به نوبت يم باي تیک از اعضاي کنند و هریم گزارش را ارائه ميک تيگروه ها، مانند  
 . را ارائه کندیبخش

ن ي گزارش شرکت کنند تا اۀد تا در جلسه ارائيچنانچه امکان داشت چند نفر را دعوت کن 
 .  داشته باشدی رسمۀن جنبيتمر

ا نبودن ي مطلوب بودن ۀگر در باريکدي ها شرکت کنندگان با  گزارشۀان ارائيدر پا 
ن بخش آموخته ي آن چه در اۀ و در باریمي تیا ضعف همکاري مختلف، فائده یبخش ها

 .  کنندیاند تبادل نظر م
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  یلگريآموزش تسه: ٣ یمبان
ن ير آن است که ابهت). ٢٫١٠وست يد به پينگاه کن( ان مناسب است ي آموزش مربی برای چند بخشۀن پروژيا

ت ي خود را نقوی مهارت هایابند با همانند سازيآموزش ها در چهار روز برگزار شود تا شرکت کنندگان فرصت 
  .کنند
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  یلگري تسهی گزارش  ومهارت هاۀارائ: ٣٫١یمبان
  تيفعال

  قهي دق٣٠

 یپرسش هائ.  پردازندی  به بحث مین فن آوري آموزش و تمرین روش هاي بهترۀشرکت کنندگان دربار •
 :  تبادل نظریبرا

د  يکه شما در آن شرکت کرده ا) رآنيا غي و یمربوط به فن آور ( ی آموزشین دوره هاين و بدتريبهتر •
 .ديگر صحبت کنيکدي خود با ی آموزشۀا تجربي و ین مربّيبدتر/ ني بهترۀکدامند؟ در بار

o ن تجربه بود؟يد بهترين کیت داشت؟ چرا فکر ميتان اهمي برای آموزشۀن تحربيکدام بخش ا 

o کرد؟ی را نامطلوب می آموزشۀن تجربي ایچه عوامل  

 ی، آموزش ، مربیل گري تسهیت کرده اند مهارت هاي که شرکت کنندکان روای از خاطراتیريبا بهره گ •
ک ي گزارش مناسب ۀ ارائی برایيد که به چه مهارت هايح دهيتوض. دي، و ارائه گزارش را شرح دهیگر

 :ر باشندي تواند به قرار زیاز است؟ پرسش ها مي نی آموزشۀجلس

o در برابر جمع وجود دارند؟ی و سخنرانیل گرين تسهي بیچه نقاط مشترک  

  اشتباه کردن؟ۀت؟ دلهريترس از جمع 

o ا دلهره کدام اند؟ي غلبه بر ترس و ین راه هايبهتر 

o کنند؟ي شدن آن کمک می به جذاب شدن آموزش وتعاملیيچه روشها 

 که در خور ارائه یل گر هر دو مطلب ارزنده اي نکته که شرکت کننده و تسهنيدرک ا 
 .باشد دارند

گر اند،  يکدي یشنهادهاي پیرايل گر پذين نکته که هم شرکت کننده و هم تسهيدرک ا 
 .گر انديک دي آموختن از ۀند و آماديازمايين را ي نویمشتاق اند تا روش ها

ت ها و ي توانند فعالیا، شرکت کنندگان داوطلب م بردن به واکنش ها و نظرهی پیبرا 
 . ش ارائه دهندي نماۀ صفحینها را رويتمر

o اب و نشاط آور کرد؟ذّّ را جی آموزشید فضايچگونه با: مهمتر از همه 

  یل گري تسهیفصل رهنمودها - شرکت کنندگانیجلسه برا ف خارج ازيتکل •
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   آموزشۀ دورکي یهمگذار: ٣٫٢ یمبان
  تيفعال

  قهي دق٣٠

ت ين شخصيا.  کنندی گفت و گو میالي خیت هايو ها با شخصي مرتبط بودن سنارۀشرکت کنندگان دربار •
 . شرکت کنندگان باشندی و خواست ها و آرمان های آموزشیازهايانگر مهارت ها و نيد نمايها با

o جلوه دادن آموزش و کاربرد ابزار ها کمکی چگونه به واقعیالي خیت هاين شخصيمشخصات ا  
  کند؟ یم

o د؟ي دهی جلوه میط آموزش را واقعيمح" یاليت خيشخص" ک ي از یريچگونه با بهره گ 

o ی میشتري بیالي خیت هاي شرکت کنندگان، شخصۀتان در باريچگونه با استفاده ار دانسته ها 
 د؟يد بسازيتوان

 به یريادگي و سهم خود در روند یر فني و غی فنی ادغام آموزش های روشهاۀشرکت کنندگان دربار •
 . پردازندیبحث م

o تواند به آموختن و ینها چگونه ميت ها و تمريا انتخاب موضوع فعالي و یروش گروه بند 
  رساند؟یاري شرکت کنندگان یريادگي

o ازچه ) یمانند گروه بند (یر فني غیو مهارت ها) روش کارها (ی فنی آموختن مهارت هایبرا
 د؟ي کنی می بهره جوئیيروش ها

 .ديسه کني را مرور و با هم مقا٢٫٠وست ي پی دستور کارها ازیشمار •

o ست؟ين دستور کارها با هم چيتفاوت ا 

o توان کارگاه ها وروش ید ميبات جديدن ترکي و آفری آموزشیچگونه با جا به جا کردن بخش ها 
 جاد کرد؟ي ای تازه ای آموزشیها

 ی همگذاریگام ها تخته ید، روي خوانده ادر روز قبل یل گري تسهی راهنماهابا استفاده از آنچه در بخش •
  .ديسيرا بنو ی آموزشۀک دوري
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  یآموزش ۀجلس کي یبرگذار: ٣٫٣ یمبان
  تيفعال

  قهي دق١٨٠

 )قهي دق٣٠.(  کنندی  خود را برگذار مۀ مورد علاقۀ شوند و جلسیم ميشرکت کنندگان به چند گروه تقس •

o د که يشنهاد کني را به آنان پیجلسات. د اندن رهنمود آزاي جلسات اۀشرکت کنندگان در انتخاب هم
 :به عنوان نمونه. ديفزاي شان بیکه به مهارت ها

 شان ي و الگوی اسناد رسمۀيته: ٣٫٢ یريفراگ 

  و گزارش هایمستند ساز: ٤٫٤ یمتناسب ساز 

 ل هايحفظ و باز کردن فا: ٥٫٤ یابيدست 

 شرفتهي پیجستجو:١٫٥ یريفراگ 

 درست و قابل اعتمادافتن اطلاعات ي: ٣٫٣ یابيدست 

 ده هاي و برگزbook mark)(اب ها يمرتب کردن صفحه : ١٫٦ یريفراگ 

o از رهنمود ی اۀ توانند جلسیگروه ها م.  استیل گري تسهین مهارت هاي تمرۀن بخش درباريا 
 .زهمانگونه که هست انتخاب کنندي را نیآموزش

o ۀک جلسي یلگريساختن و تسه "٣٫٤ ی پروژه در بخش مبانی بعدیش از پرداختن به گام هايپ 
اد ي متناسب کردن آموزش انتخاب کرده اند به ی را که برایوه هائيد شيهمه با" ژه،ي ویآموزش

 . داشته باشند

o ا دو يک يگروه ها .  کندین ميي آموزش را تعۀ ارائۀوي مطالب جلسه شیهر گروه پس از بررس
 . ند کنی آموزش انتخاب مۀ ارائی خود را برایتن از اعضا

 )قهي دق١٢٠( خود را ارائه کند یشيقه وقت دارد تا آموزش نماي دق٢٠هر گروه  •

پرسش ). قهي دق٣٠( گزارش خود بحث کنند ۀ ارائۀ نحوۀ شوند تا درباریگروه ها دوباره دور هم جمع م •
 :ن بخشي ای نمونه برایها

o ن بخش آموزش کدام بود؟يبهتر 

o نه کردن ي بهیتم براي توانسی میگري دی چه کارهام؟يتم بهتر باشي توانسی میيدر چه بخش ها
 م؟يکار انجا م ده

o د؟ين آموختين تمري از ایچه درس هائ 

 آن یرات متعارف را رويينند و تغين رهنمود را برگزيک بخش اي فردا ید که برايف بدهيبه همه تکل •
  .اعمال کنند
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  یلگريوتسه ساختن: ٣٫٤ یمبان
  ی  سفارشی آموزشۀک جلسي 

  تيفعال

  قهي دق١٥٠ تا ١٢٠

 .  پردازدی را برگزار کند به مرور آن میهر شرکت کننده که قرار است جلسه ا 

o د ي که بر تخته نوشته شده است مرور کنی مراحلیک آموزش را از روي یهمگذار
 ")ک آموزشي یهمگذار: "٣٫٢ یمبان(

o ن جلسه کدام اند؟ي ای براین آموزشيعناو 

o د؟ي شرکت کنندگان برگزار کنیازهايجلسه را مطابق نن يد اي توانی میيبا چه روش ها 

 .قه داردي دق١٥-١٠ خود ی آموزش سفارشۀ ارائیهر شرکت کننده برا 

 : کنندیه ميگران دو فهرست تهي، دی آموزش سفارشۀهمزمان با ارائ 

o شرکت کننده استۀ ارائیابيفهرست اول ارز : 

  آموزش او کدام ها بودند؟ین بخش هايبهتر 

  خواهند؟ی میشتريها کار بکدام بخش  

o ارائه کننده استیشرفتِ شخصيع پي تسری برایفهرست دوم شامل نکات : 

 د؟ي آموخته این جلسه سفارشي از ایچه درس هائ 

 د گرفت؟ين را وام خواهيگران کدامي دیلگري تسهیاز روش ها و مهارت ها 

 د کرد؟يت خواهي را در خود تقویيچه مهارت ها 

o ۀ و واکنش صادقانی است که شرکت کنندگان بتوانند از داوریمن مرحله فرصت مغتنيا 
 ی گزارش، لحن کلام ، و حرکات بدنۀ ارائۀ، نحوی آموزشیوه هايگران نسبت به شيد

 .خود آگاه شوند

 . کندی اش را ارائه میلگر داوريان هر جلسه،  تسهيدر پا 

o  دي انتخاب کن اشی داورۀ  ارائیز برايگر را ني دۀک شرکت کنندياگر وقت بود . 

ا کاغذ تا يک پاکت يدر ( اندازند یشنهادات مي پۀ شرکت کنندگان نظرات خود را در جعبیمابق 
  . جلسه به شرکت کنندگان داده شودیتا در انتها) شده
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  ها یابيارز: ٤ یمبان
د سطوح گوناگون اطلاعات و دانش ها را در نظر ي اطلاعات و ارتباطات بای هایدر آموزش فن آور

، و ارزش یرات اجتماعييجاد تغي این، کاربرد آنها براي نویک فناوري از ی بهره وریچگونگ: رفتگ
 کارگاه یابيل گران با ارزي است که تسهیضرور. شرفت و آموزش مادام العمري آنها به منظور پیريادگي
 کنند و، اگر لازم بود،  کارگاه را برآوردهۀن شدييش تعيابند تا چه حد توانسته اند اهداف از پي خود دریها

  .ر دهنديي کار روش کاررا تغۀانيدر م

  . استفاده کنندیابين ارزي چنی مختلف برایل گران از روش ها و سنجه هاين است که تسهيبهترا

پرسش  ( یا رسميو ) یروزنگار آموزش(  است یر رسميا غيکه معمولا : ان روزي در پایابيارز •
 ) نامه

 ی بردن به سطح مهارت های پی ها برایابين گونه ارزيعمولا ام: یان دوره اي میابيارز •
 ابزار یايم کردن همگان در آموخته ها، و مزاي مادام العمر، سهیريادگي مانند یکيرتکنيغ

 .  برندی پیت اهداف درازمدت  آموزش فناوري است تا شرکت کنندگان به اهمی آوریفناور

شود تا يفاده از پرسش نامه از شرکت کنندگان انجام م با استیابين ارزيا:  دورهیاني پایابيارز •
 که شرکت کنندگان یراتيي برد و از تغی پیا ضعف دوره آموزشي  قوت و یبتوان به نقطه ها

د به ين گونه پرسش نامه ها بنگري اۀ نمونیبرا.  کنند آگاه شدینه کردن آن ارائه مي بهیبرا
  .٥٫٠وست يپ
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  یروزنگار آموزش: ٤٫١ یمبان
 است که هر شرکت کننده با استفاده از آن افکار و نظرات و ی دفترچه کوچکیزنگار آموزشرو
  . رساندی می آموزشۀگران و سازمان دهندگان دوري تسهیش را به آگاهيشنهادهايپ

  .ل گران و شرکت کنندگان استين تسهي بیک کانال ارتباطيجاد ين دفترچه ها اي ایهدف اصل

لگران ي آگاه کردن تسهین روزنگارها برايد از اي شرکت کنندگان باۀ که همديدر آغاز دوره اعلام کن •
 .استفاده کنند

o شرکت یادداشت هاي ی کوچکتر براۀدفترچ. دي متفاوت بدهیبه هر نفر دو دفترچه در اندازه ها 
 .ی درج مطالب مربوط به آموزش فناوری برایگريکننده است و د

 .ل او نوشته شوديمي سازمان و آدرس اد نام شرکت کننده وي اول باۀ صفحیرو •

 .یاستفاده از روزنگار آموزش •

o  را یا سه مطلبيد که دو ي، از شرکت کننده بخواهی آموزشۀدر آغاز هر جلس: یريادگيفهرست 
د ي توانین فهرست ميان جلسه پس از مرور ايدر پا. سديرد بنوين جلسه فراگيل است در ايکه ما

 . ديبران کنآن چه را که جا افتاده است ج

o ان روز خود را که در دفتر ي  پای هایابي توانند ارزیشرکت کنندگان م: ان روزي پایابيارز
 :  نمونهیپرسش ها. ان بگذارندين درميري نوشته اند با سایآموزش

  نبودند؟ی امروز لذت بخش بودند؟ چه جنبه هائی از آموزش هایچه جنبه هائ 

 ت ها؟يسرعت آموزش، زمان، حجم اطلاعات، فعال:  امروزیدادهاين روين و بدتريبهتر 

  .ديان گذاريلگران در ميد با تسهي خواهینه شدن آموزش و آن چه مي بهی برایيشنهادهايپ 
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  آموختن مادام العمر: ٤٫٢ یمبان
  ت يفعال

  قهي دق٣٠ 

 ی م رای آموختن دائمیک دفتر راه هاي ی برگ های شوند و هر گروه روی میشرکت کنندگان گروه بند •
 .سدينو

o از مسئول فاوا ینترنتي اۀک کافي آموزش چند ساعته در ۀک دوريدن از همکار، گذراندن يپرس ،
 ....ديرياد بگيدر سازمان خود 

o نرم افزارهای با خواندن بخش کمکیخود آموز . 

 .ديرا برو Internet Explorer> Content and Indexر ي مثال مسیبرا 

 : ديک کنير را کلير زيسپس مس 

Content > Working with Internet Explorer Favorites > Keeping track of your 
favorite web pages.  

o ديابي آموختن بی برایگريمنابع معتبر د. 

 از آن را ید و بخشي  بروhttp://www/bbcco.uk/webwiseوند ين پي مثال به ایبرا 
 .ديمرور کن

 را که ممکن است ی از دگمه ها و علائمی پاره ای تواند معنایت مين ساي برایمرور 
 .  کندیادآوريد يفراموش کرده باش

o نوشت شده خود را کنار هم بچسبانندیگروه ها فهرست ها . 

o  ديک فهرست مشترک درست کنيگر يکدي یاريبا.  
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اشتراک دانش: ٤٫٣ یمبان  
  

  تيفعال
  قهي دق٣٠

ن دوره آموخته اند، ي که در جلسات ای هائی فن آوری را که درمورد ابزارهایين مهارت هاشرکت کنندگا •
 . کنندیم شوند مرور ميگران سهيلند با دي را که مایو بخش هائ

 ۀسند به افراد خانواده و همکاران و ساکنان محلي نوی سه کارت پستال میک از شرکت کنندگان رويهر •
 . را آموزش خواهند دادی استفاده از ابزاریخود چگونگ

 . هایخانواده، همکاران، و  هم محله ا:  سه گروه ید براي تخته نصب کنی بزرگ روۀسه دفترچ •

 . مربوط بچسبانندۀ صفحی شان را رویشرکت کنندگان کارت پستال ها •

 ک از ابزارهايه بشمرند تا روشن شود کدام يک از صفحات را بلند بخوانند و بقيسه نفر داوطلب هر  •
  .گران خواستار داشته استيشتر از ديب
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  ی فن آوری از ابزارهایري بهره گیايمزا: ٤٫٤ یمبان
  تيفعال

  قهي دق٣٠

 :سندير را بنوي خود پاسخ به دو پرسش زیشرکت  کنندگان در روزنگار آموزش •

o دارد؟ چرا؟یشتريشان کاربرد بيک براي آموزش کدام یان ابزارهايدر م  

 . آنیح سودمنديط در توضک خيک ابزار را با ينام  

o ا محله بهتر است؟ چرا؟ي سازمان و یکدام ابزار برا 

 . آنیح سودمنديک خط در توضيک ابزار را با ينام  

 . همه بخوانندیشان به دو پرسش را براي شرکت کنندگان به نوبت پاسخ هاۀهم •

 .سنديل انتخاب آنها را بنويدو نفر داوطلب  نام ابزارها و دل 

 ی مربوط به محله را در فهرستیک فهرست و انتخاب هاي را در یخص شیانتخاب ها 
 .ديسيجداگانه بنو

 .ريا خيا دو فهرست قابل جابه جا کردن هستند يد آينيان ببيدر پا •

o م داد و برعکسي را به محله تعمی توان کاربرد شخصیچگونه م.  
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ابزار .  افراد و سازمانهاستی برای ضروری، در واقع بخش آموزش ابزارهافاوا به ابزار یابيبخش دست
ر در ن بخش، کاربَين ايايدر پا. ینترنت، واژه پردازها، و صفحات جداول محاسباتيانه، ايند را مانیيها

 در یشتري بی شود که به آموختن مهارت هایق ميابد و تشوي ین ابزارها اعتماد به نفس مي از اۀاستفاد
.کاربرد آنها بپردازد  

 

ازهايش نيپ  

 .ستي نیانه ها ضروري با رایيآشنا •

 .ردياد بگيانه ها را يواهد که کار با راد بخيفرد با •

  .انه و کار با آن ها را داشته باشديادگرفتن راي یاي مزاۀه درباريد اطلاعات اوليفرد با •
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انه هاي با رایيآشنا: ١ یابيدست  
 اهداف

  مانند نرم افزار و سخت افزاریجيادگرفتن اصطلاحات راي •

  (mouse) و ماوسدي صفحه کلۀليانه به وسيادگرفتن کاربرد راي •

 انه هاي آسان با رایاد گرفتن انجام کارهاي •

  

  م و ابزاريمفاه

 مانند چاپگر متصل است، ی جانبیل شده، و به ابزارهايانه که از قطعات سخت افزارتشکيک دستگاه راي
در . ا ماوس قابل کنترل استيد وي کلۀ مانند صفحی شده و با ابزاریزي نرم افزاربرنامه ریتوسط برنامه ها

اصطلاحات . مي کنی مید بدانند معرفيانه باي کار با رایران برا را که کاربَین بخش اصطلاحات اساسيا
  . اد گرفتي توان یزان مهارت کاربر، ميش مين دستگاه و با افزايه با کار با اي اولیيگر را پس از آشنايد

  

  لگري تسهیآمادگ

 .ديشگر را خاموش کني نماۀانه را روشن و صفحيقبل از شروع جلسه  را •

 .ديفزائيانبر به نرم افزار رنگ بيک ميانه ها ي تمام رایروز قبل از شروع دوره رو •

 ین جزوه  رويک اي الکترونۀنسخ. د که در آن منابع آموزش آمده باشدين جلسه آماده کني ای برایجزوه ا •
  .ديا را اضافه کناز بود، آنهي نیگري دیوندهايا پيچنانچه به منابع و .  موجود استی دیس
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  انهيرا دستگاه کي یاصل یاجزا: ١٫١ یابيدست
 یانه هاي راۀنا درباريم. ز کارش بودي میانه رويک دستگاه راينا شروع به کار کرد، ي که میروز اول
 ی از آنها را مینام برخ. ده استي شنید، نرم افزار، سخت افزار، و ماوس مطالبي و صفحه کلیشخص

ست ي هرکدام چۀفي خواهد مطمئن شود که وظیگر شک دارد و مي دی نام هاۀما دربارتواند حدس بزند، ا
  .د با آنها کار کرديو چطور با

  ت يفعال

  قهي دق٣٠

 .ديشگر را روشن کني نماۀصفح •

o ۀ است که همی پردازش واحدیبخش مرکز. ل شده استي گوناگون تشکیانه از اجزايک راي 
 ی ها و اجراليفا یره سازي کند از جمله ذخیا کنترل م آن ریت هاي فعالۀانه و همي رایاجزا

 یبرا.  نامندی مCPU)  (Central Processing Unit را ین مغز مرکزيا.  کاربرانیفرمان ها
م، دانستن يست که تمام اصطلاحات مربوط به آنها را بداني نیازيانه ها ني ازرایبهره ور

 . استی که به کار ما مربوط اند کافیاصطلاحات

o دي توان دیشگر مي نماۀ صفحی را روین واحد مرکزي درون ایت هايفعال. 

را ctrl+alt+del  یبي ترکیدهاي سپس کل.(log on)د يد ثبت ورود کني کلۀبا استفاده از صفح •
 .ديسي را بنو(code) د و گذرواژهيبفشار

o یت که براد اسي کلۀ از آنها صفحیکي. انه ها وجود دارندي کنترل رای برایدو ابزار ضرور 
 . رودیپ کردن متن به کار ميتا

o ی مختلفیب همزمان آنها کارهايترک. ا همزمانيک کرد و ي توان هم جداگانه کلیدها را ميکل 
 ثبت ورود لازم است و در ی برا ctrl+alt+delب ي از آنها ترکیمثلا در بعض.  دهندیانجام م
 .ستياز ني نیبعض

o  

 .ديک کنيد و آن را کليگذار نرم افزار رنگ بۀ نشانیماوس را رو •

o تواند نشانگر یانه ماوس است که مي کار با رای دوّم برایابزار ضرور (cursor)ی را رو 
 . که مورد نظر است بگذاردیدي کلیشگر حرکت دهد و بر روي نماۀصفح

o ن سخت افزار به يا.  وظائف آن را داردۀانه حکم مغز دستگاه و کنترل کننديسخت افزار هر را
ن نرم افزارها به ي از ایکي.  گوناگون با وظائف خاص استیخود شامل نرم افزار ها ۀنوب

 .  دهدیار کاربر قرار ميشگر را در اختي نماۀ کردن بر صفحیامکانات نقاش" رنگ"عنوان 

o ی جانبیانه وصل شده اند اجزايک راي که به یابزارهائ (peripherals)نام دارند  . 

 

د رنگ ي توانیک ميکلچپ با .  باز شودید تا نرم افزار نقاشيک کنيکل" رنگ"د ي کلیدوبار بر رو •
 . دي کردن را انتخاب کنی مورد نظر و ابزار نقاشیها
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o مشخص ین دو امکانيک از ايبا فشردن هر . هر ماوس معمولا دو دگمه دارد، راست و چپ 
معمولا . ه اندن دو دگمي بی چرخی از ماوس ها دارایبرخ. ردي گیار کاربر قرار ميدر اخت

 .کنديد دست چپ برنامه نرم افزار را باز ميدوبار فشردن کل

د و با حرکت دادن ماوس  ي که انتخاب کرده ایبا استفاده از ابزار نقاش. ديپ کنيک متن نمونه را تاي •
 .دي کنیدور آن متن را رنگ

o د رنگ يتوان ید ميني بی رنگ مۀ که در جعبی مختلفی ابزارهایک کردن ماوس رويشما با کل
 .  دي را انتخاب کنی نقاشی قلم موۀو نوع  و انداز

 . ديارشان قرار دهي در اختیشترين ابزار وقت بيشتر شرکت کنندگان با اي بی آشنائیبرا •
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انهي رایاصطلاحات و کاربردها: ١٫٢ یابيدست  
. شان گذاشته انديه هاانيشگر راي صفحات نمای را بر رویيباي زیده است که همکارانش عکس هاينا قبلا ديم

انه ي راید واحد مرکزي سازمان به او گفته بود که بایفناورمسئول . ن کاررا بکنديل است بداند چطور اياو ما
 ینا درست متوجه حرف هايم.  شگر بگذاردي نماۀل است بر صفحي را که مایرا به روز کند تا بتواند عکس

 آورد و نگران است که چطور یده که از آنها سر در نمي شنن روزهاي ایادي زیانه اياصطلاحات را. او نشد
  رد؟ياد بگيد ين همه اصطلاح را بايا

تيفعال  

قهي دق٣٠  

 .سندي خود بنوی خواهند بدانند در روزنگار آموزشی را که میشرکت کنندگان تمام اصطلاحات •

 . بازشده را کوچک کنندیتمام برنامه ها •

o د تا يک کنيشگر قرار دارد کلي نماۀ سمت راست صفحی بالاۀکه در گوش) -( علامت منها یرو
 یعني. (ابديشگر انتقال ين صفحه نمايي برنامه کوچک شود وعلامت مربوط به آن به پاۀصفح

 برنامه در ۀد دوباره صفحيک کنين علامت کلي ایاگر بر رو). برنامه بطور موقت بسته شده است
 صفحه  سمت ی علامت ضربدر بالایرواگر .  شودی که قبلاً بوده باز می اۀهمان صفح

 . شودید برنامه بطور کامل بسته ميک کني کل (X)راست

 .کي چپ کل(Properties) مشخصات یسپس بر رو. ديک کنيشگر راست کلي نماۀ صفحیبر رو •

o ن صفحه ين ايهمچن. نرم افزار را داردیانبر به برنامه هايانه معمولا علائم ميشگر راي نماۀصفح
 .دير دهييل خود تغيد آن را به مي توانین شده هم دارد که شما مييش تعير از پيصوک تيمعمولا 

با فشردن . ديرا انتخاب کن) (desktop ۀنيشگر ظاهر شده، گزي نماۀ صفحی مشخصات که بر روۀدر پنجر •
 یرهايان تصويد از مي توانیم. ديني را برگزیکي موجود ینه هاين پس زمي از ب)Browse( مرور ۀنيگز

 ۀنيد تا پس زميک کنير مورد نظرتان دوبار کلي تصویرو. دي را انتخاب کنیکيانه هم ي راۀموجود در حافظ
 .شگر شما شوديصفحه نما

o ی هاليفار کردن در ينه امکان سين گزيا.  از نرم افزار ها وجود داردیاري مرور در بسۀنيگز 
 . گذاردیار کاربر ميانه را در اختيموجود در حافظه را

o ر با انتخاب  ي تصویام جستجوهنگThumbnails Viewعکس ها را یري تصوی توان نمای م 
د تا فهرست شما يل ها انتخاب کني را در فهرست فاView Menu ۀنينکار گزي ایبرا. مشاهده کرد

 .ر کوچک نشان داده شوديبه صورت تصاو

 .رديش قرار گي نماۀ صفحیر انتخاب شده رويد تا تصويک کني کلOKد ي کلیرو •

 .ديک کنيشگر راست کلي نماۀ صفحی روMy Computer علامت ی بر رو •

o د تا انتخاب شوديک کني  مشخصات راست کلۀني گزیسپس رو. 

 یار کاربر مينه را در اختيک زمي ممکن در یک فهرست تمام کارهايمعمولا راست کل 
 . دهدی را انجام میک کار خاصياما چپ کل. گذارد
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o ۀنيگز Generalشوندی آن نشان داده مۀ نسخۀستم عامل و شماريس. دياب کن را انتخ . 

ندوز يستم عامل وي سۀن نسخي نمونه آخریبرا)    (Operating systemستم عامليس 
(Windows)است٨ندوز ي و . 

o  پردازش گر وRAM ( Random Access Memory)ديدا کني را پ. 

 . کنندین مييانه را تعيک راي، سرعت پردازش )(RAMن دو عامل،  پردازش گر و يا 

o ۀني گزی رو Cancel دي خارج شوليفا، از ید تا بدون انجام دادن عمليک کني کل. 

 Cancel ش از انجام يب، پين ترتيه اي.  شودیري کند که از کار اشتباه جلوگی کمک م
 . شودیم، خارج مي که در آن هستی خاص از پنجره ایکار

o یرو  My Computerیبه حجم  کلد تا يک کنيدوبار کل  Local Diskدي ببریپ. 

 .انه استي رایره سازيت ذخيحجم سخت افزار معرّف ظرف 

  Processor, RAM, Hard Disk, OSدستگاه شما ۀني و هزیي هستند که کارآیعوامل 
   ۀن اندازي، بزرگترRAMن ي ، بزرگترProcessorن يعتريمعمولا سر.  کنندین مييرا تع

Hard Disk شه ياما هم. ستم اندين سي بهتریستم عامل، نشان هايسل ن مديتازه تر و
 . از نداردي نین مدلير به چن هم کاربَیست و در مواردين مدل فراهم ني آخرۀيامکان ته

o را که در جلسه مطرح یيد و آنهاي را مرور کنی تمام اصطلاحات موجود در روزنگار آموزش 
 .ديح دهينشده اند توض
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  ی جهاننترنت و وبيا: ٢ یابيدست
  اهداف

 .نترنتي وب و ایاد گرفتن نکات اصولي •

 .دا کردن اطلاعات مورد نظري جستجو در وبگاه ها و پیيتوانا •

 . مرور گریح خطاهايزان ها، و تصحين ميره کردن اي مرورگر وب، ذخیزان کردن پارامترهايادگرفتن مي •

  م و ابزارهايمفاه

 توانند در یانه ها مين رايا. ها است که به هم مرتبط اندانه ي از رایقت محصول شمار بزرگينترنت در حقيا
ن يمعروف تر.  شوندینترنت به کار برده مي نرم افزارمتعدد در ایبرنامه ها. ا پخش شده باشنديسرتاسر دن

ن برنامه ي از ایکيد از ينترنت باي به ای دسترسیبرا.  اند chat)(ل، و گپ يمي ، ا(WWW) یآنها وب جهان
  . کردها استفاده

، ی از وبگاه ها است که توسط نهادها و مؤسسات گوناگون طراحیار بزرگي بسۀ در واقع مجموعیوب جهان
 ی، شرکت های، موسسات آموزشیر دولتي غی توانند سازمان هاین نهادها ميا.  شوندی میساخته و نگهدار

 کند، در یق مي وب تحقۀ که دربار(Netcraft) نت کرافت ۀموسس.  باشندی دولتی و سازمان هایخصوص
ا هزارها يک ده ها ، صدها و يون وبگاه وجود دارند که هر يلي م١٥٨ن زده بود که حدود ي تخم٢٠٠٨سال 
  . وب دارندۀصفح

 وبگاه ها گردش کند، ین صفحات وب، بر روي دهد تا بی است که به کاربر امکان میمرورگر نرم آفزار
 وجود دارند که امکان مرور وب را فراهم ی نرم افزارگوناگونیه هابرنام. آنها راباز و بسته کند و بخواند

 ین رهنمود برايدر ا. ن آنها هستنديرفاکس معروف ترينترنت اکسپلورر و فايدر حال حاضر ا.  کنندیم
  . نترنت اکسپلورر استفاده شده استيبخش وب از ا

  لگري تسهیآماده ساز

به عنوان نمونه .  باز شودی خاصۀ صفحید که رويم کنيظ تنیش از شروع جلسه مرورگر را به گونه ايپ •
 .ی محلی خبریت هايا در ساي، http://wwwbbc.co.uk.در

 . ل ها قابل استفاده استينه ها و وضع فايد که نمودار ابزارها، فهرست گزيمطمئن شو •

. ديار داري مرورگر را در اختۀد کدام نسخيني  ببHelp>About Internet Explorerر يک کردن مسيبا کل •
ر يا فاي با بالاتر و ٧اکسپلورر . (از دارديشرفته ني پی به مرورگرها" وبیخواندن دامنه ها": ٢٫٣ یابيبخش دست

.دي کنیز معرّفيگر را نيلسه امکانات دجدر ) دتريا جدي و ٢فاکس
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   به وب یابيدست: ٢٫١ یمبان
ند که ي گوین برنامه ها اغلب ميمسئول.  کنندینترنت صحبت مي اۀربارده است که همکارانش دينا شنيم

افت کرده اند يا دري که فرستاده و یل هائيمي از اشر همکارانيسا.دا کرده اندي وب پیاطلاعات لازم را از رو
جان ي وبگاه سازمان گذاشته اند هی که رویدي مطالب جدۀکارمندان بخش ارتباطات دربار. ندي گویسخن م

  .دي نمایبه مينا غري میست که برايگرينها انگار زبان ديتمام ا. ده اندز

  تيفعال

  قهي دق٣٠ 

 .ديک کني آن کلید و رويدا کني را پInternet Explorer د وي بروStart> Programsبه  •

 .کنندين شده شروع مييش تعي از پۀک صفحي وب از یشتر مرورگرهايب •

 .دين حرکت دهيش به طرف پائي صفحه نمایماوس را رو. ود شیف شده باز ميش تعري اول از پۀصفح •

o یبا حرکت دادن علامت رو. ن، صفحه قرار دارديحرکت در سمت راست، و گاه در پائ ۀاستوان 
 .دي صفحه حرکت کنیرواستوانه ن يا

o بالا ویمثلا برا. ديد انجام دهي توانی مختلف می مدرن، کار واحد را از راه هایانه هايشتر رايدرب  
ا يو ) اگر ماوس شما چرخک داشته باشد( د ي ماوس را بچرخانید چرخک روي توانین رفتن مييپا

 . ديه استفاده کنيکان دو سوياز پ

 .ديک کني آن کلیل به انگشت اشاره شد، روي که نشانگر نما تبدید و هنگاميوند ببريک پي یماوس را رو •

o وندي ابرپیک رويکل(hyperlink) ر صفحات وب داخل همان  وبگاه ي به سا شما رای داخلی ها
 شما را به صفحات وب خارج از آن ی خارجی ابرپبوندهایک رويکه کليدر حال.  کندیمنتقل م
 . بردیوبگاه م

ز ي وبگاه تمی و خارجی داخلیوندهاين پيد بي توانیا ميآ. ديک کنيوند کلي چند پی جستجو در وب رویبرا •
 د؟يقائل شو

o آدرسۀافته استوانيرس وب اختصاص  که در متن به آدیيفضا (Address Bar)   نام دارد و شامل 
URL ( Unified Resource Locator)  وب استۀا آدرس منحصر به فرد هر صفحي  . 

o ۀهر وبگاه حوز (domain)آدرس ۀ استوانی توان از روین حوزه را ميا.  خاص خود را دارد 
 www.learningpartnership.org است و ی سی بی بۀ حوزwww.bbc.co.ukمثلا، . خواند
خواندن حوزه  : "٢٫٣ یابيدر بخش دست. ( زنان استی آموزش و همکارین المللي سازمان بۀحوز
ن نام يک وبگاه با هميدرون آدرس تمام صفحات ).ن مورد صحبت شده استيشتر در ايب"  وبیها

 . شوندیحوزه شروع م

مرورگر . ديک کني سمت چپ صفحه کلیدر بالا)کان راست به چپي پ( (backward)  پس روۀ دگمیرو •
کان چپ به يپ( د يک کني را کل(forward)شرو ي پۀاگر دگم.  رودید مي که شما رفته بودی قبلۀبه صفح
 .دي گردی بر می قبلۀ دوباره به صفح)راست

o دي عقب و جلو رفتن استفاده کنین دگمه ها برايد از اي توانید ميهر بار که بخواه. 
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o یدگمه ها Refresh و Stopۀدگم. دهندي را انجام میگريد دي مفی کارها Refreshحاضر ۀ صفح 
را از  مرورگر Stop ۀدگم. د استين اخبار مفي آگاه شدن از آخریژه براي کند و به وید ميرا تجد
ا حجم ينترنت کم شده است و ي که سرعت ای دارد و در مواردی مطالب صفحه باز مۀ همیربارگذا

 .دي آین است به کار ميمطالب صفحه سنگ

 . بردی  م(home page) ی اصلۀد ، مرورگر رابه صفحيک کنيکلHome  ۀ دگمیرو •

o ۀدگم Homeبردی من شدهييش تعي از پی اصلۀشه شما را به صفحي مرورگر همۀ صفحی در بالا . 

 .حي تفری برایمرورگر •

o دي کنی خود مرورگرۀ مورد علاقی به موضوع هایابي دستیبرا. 



١٢ 
 

   اطلاعاتیدر جست و جو: ٢٫٢ یمبان
از .  کارکنانشان بهره برندی فنی زنند تا از کمک های نت ها سر می افراد به کافیده است برخينا شنيم
م ساعت استفاده ي نیهنگام پرداخت پول برا. اموزدياوا ب نت برود تا فیک کافيرد به ي گیم مين رو تصميهم

 یگري دیخانم خوشرو. اد کرده استينترنتش را زي سرعت اید به تازگي گویانه، خانم صاحب کافه مياز را
  . کندی میيانه راهنماينا را به محل رايم

  تيفعال

  قهي دق٣٠

 .ديرا باز کنInternet Explorer د و ي بروStart>Programsبه   •

 .دي بروWLPد تا به وبگاه يپ کنيرا تاorg.learningpartnership.www://http/آدرس  •

ک يد و آن را کليبرس" ت ازخانوادهين حمايقوان"د تا به يک کنيکلResources > Legislation   یبر رو •
 .ديکن

 .  کندیک کشور را انتخاب ميدواج زنان و مردان افتن سن ازي یهر شرکت کننده برا •

o یرو. ديک منطقه را با رنگ مشخص کني ین مربوط به سن ازدواج در کشورهاين قوانياختلاف ب 
 .ديسي منطقه را بنوین سن ازدواج در کشورهاين ترين و پائيک صفحه بالاتري

 کند صحبت ی خاص آگاه می موضوعۀ که جستجو در وب شخص را در باری گوناگونی روش هاۀدربار •
 .ديکن

o را ید وبگاه هائي کنیسع. ديسي کاغذ بنوی از آنها را بر روۀ از وبگاه ها و موارد استفادینام تعداد 
 .شان سازگارباشدي اۀد که موارد استفاد از آنها با شرکت کنندگان و کار و مشغليانتخاب کن

  .  در وب ادامه دهندی به مرورگرید تا به تنهائيار افراد بگذاري را در اختیزمان کوتاه •
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  وبیخواندن حوزه ها: ٢٫٣ یمبان
ن آنها ي اکسپلورر همزمان باز و بۀوستي پی وب را درپنجره هاۀن صفحينا متوجه شده که همکارانش چنديم

 بپرسد، بازتاب خوش ینگران است که اگر از کس. ن کار را بکنديست چطور ايمطمئن ن.  کنندیگردش م
.  گذاردیان مي از همکارانش در میکي کند و پرسش را با یاما بالاخره عزمش را جزم م. ته باشد نداشینديآ

نا از خودش خوشنود است يم.  دهدیح ميش توضي و حوصله براینا همکارش با مهربانيبرخلاف تصور م
ن به يمچن دهد هیح مي و نقش مهم اش در وب توضURL ۀنا درباريهمکار م. ديکه بالاخره سوالش را پرس

  .ن صفحات مختلف بچرخدي استفاده کند و ب(tab feature)" پرش "ۀوي آموزد چگونه از شینا ميم

تيفعال  

 قهي دق٣٠

د يد و کلي را در محل آدرس اکسپلورر وارد کن/http://www.learningpartnership.orgآدرس  •
 .ديا بزن ر(enter) ورود

o شوندیندو باز ميمعمولا برنامه ها در و . 

o  که یاز هر راه. گوناگون وجود داردی انجام هر عمل خاص، راه هاید که براياد داشته باشيبه 
 .ديتان آسان تر است عمل کنيبرا

پ ي  را تاhttp://www.harvard.eduد، آدرس  ي بروFile>New Tabد به ي جدۀ باز کردن پنجریبرا •
 .ديک کنيکان سبز سمت راست کلي پیرود و يکن

o وسته اند ي پی پنجره هایژگي ویدتر اکسپلورر داراي جدینسخه ها(tab windows) . با استفاده از
 .انه باز نگه داشتي مختلف را همزمان در راۀ توان چند صفحین پنجره ميا

o د با رفتن به ي توانی مرورگر نبود، مۀ مدل تازی شما داراۀانياگر راFile<New Window  
 .دي متعدد را جدا از هم باز کنیپنجره ها

o "اکسپلورر باز ی اصلۀ را در همان پنجریدي جدۀ توانند صفحیگراند و ميکديها هم مشابه " پرش 
 .کنند

 :د و آدرسي باز کنی پرش خالۀمگ دیک کردن روي رابا کلیگري دۀوستي پۀپنجر •

 http://www Informs.gove.lb/ديپ کنيرا در آن تا. 

را   http://www.bbc.co.ukد و آدرس يد باز کني جدۀوستي پۀک پنجريFile> New Tab با رفتن به  •
 .ديک کني کل News > South Asiaیبر رو. ديکان سبز سمت راست را فشار دهيد و پيسيدر آن بنو

 رادر آن  /http://www.cnn.comس آدریگري دۀد، و بازکردن پنجريک پرش جديدوباره با فشردن  •
 .دي را انتخاب کنInternational Edition > Arabic. ديوارد کن

 .دي پرش وبگاه ها را مرور کنۀمگبا استفاده از د •

 یک بنگاه دولتي و یک بنگاه تجاري، ی آموزشۀک مؤسسيک سازمان، ي ین پنج وبگاه، وبگاه هاياز ب •
 ا در لبنان؟يس است و ياد که کدام وبگاه در انگلص دي توان تشخید؟ چطور ميرا مشخص کن
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o دامنه مانند یپسوندها .com ,gov .eduین وبگاه ها ميبنابرا. گاه وبگاه انديت و پاي معرّف هو 
) انگلستان (ukا ي) لبنان ( .lb مانندیپسوندهائ. ره باشندي، و غی، تجاری، دولتیتوانند آموزش

 . وبگاه اندیيايمعرّف مکان جغراف

 .دي صفحه ببندیکوچک سمت راست بالاX  مربوط به هاروارد را با فشردن ۀفح ص •

o ۀ دکمیاگر رو  Xیاما اگر بر رو.  شودیم، تنها همان پنجره بسته ميک کني کلی پرشۀخروج پنجر 
 .م، کل صفحات بسته خواهند شديک کني کلی اصلۀ خروج پنجرۀمگد

 .ن کنندين بخش را تمري ایت هاي فعالد تايار شرکت کنندگان بگذاري در اختیزمان کوتاه •

  .دي توان دی می دی س را درمختلف یحوزه ها ی از پسوند هایفهرست : یمنابع اضاف
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  زنان و وب: ٢٫٤ یابيدست
 آن گذشته ۀقي دق٢٠.  است که بابت اش پول دادهیم ساعتي نت نشسته و حواسش متمرکز بر نینا در کافيم

 (computer terminals) یانه هاي شوند و تمام پای نت میوارد کاف جوان ین موقع عده ايدر هم. است
گر به يانه ها نشسته اند جمع شده اند و با همديه هم دور دوستانشان که پشت پايبق.  کنندی را اشغال میخال

نات او يتمر.  کندی نمیاما او خودش احساس راحت. ستينا ني متوجه میکس.   مشغول اندیصحبت و شوخ
 شود و یان وقتش مانده بلند ميقه به پايپنج دق. ردي است و واهمه دارد که مورد تمسخر قرار گیيدا ابتیليخ
  . رودیم

  تي فعال
  قهي دق٣٠

 /http://www/learningpartnership.org: ديسين آدرس را در آن بنويد و ايک پنجره باز کني •

 .ندي وبگاه برگزی اصلۀ  صفحیک کشور را از رويهر شرکت کننده  •

 .را مرور کند" ت زناني از وضعیفشرده ا"بخش  •

ن ين ترين و پائي بلند بخوانند و بالاتریشرکت کنندگان درصد زنان و مردان باسواد در هرکشور را با صدا •
 .سندي تخته بنویدرصد ها را بر رو

o یرا از رون آمار و ارقام ي اید نمونه هاي توانیست، مي نینترنتيا ارتباط ايانه و ياگر در کارگاه را 
 به ید که فهرست هاياما شرکت کنندگان را آگاه کن. دين ادامه دهيد و با آن به تمري چاپ کنی دیس

 . هم موجود استWLPن آمار در وبگاه ي اۀروزشد

 :ر قرار داردي در آدرس زین بررسيا. دي را با پروژکتور نشان دهی نت مالزیک کافي یشرح بررس •

http://www.iimahd.ernet.in/egov/ifip/apr٢٠٠٥/article٣.htm 

o در کارگاه ینترنتيد و، اگر ارتباط اي توان دیز مي نی دی را در سین بررسي از همینسخه ا 
 توان به تعداد شرکت کنندگان یست ميش نياگر امکان نما. ديش دهيد آن را نماي توانید، ميندار

 . آن را چاپ کردینسخه ها

 .دي نت ها نوشته شده پررنگ کنی کافۀ دختران در باری نظر منفۀ را که درباریبخش •

. دي نت صحبت کنیسه با کافيا مدرسه در مقاينترنت در خانه و يل دختران به استفاده از اي علل تماۀدربار •
ر  دختران دیسه با پسران، و عقب ماندگينترنت در مقاي عواقب ارتباط محدودتر دختران با اۀدر بار
 .دي به بحث پردازی شغلیر آن در استفاده از فرصت هاي به فاوا، و تاثیدسترس

  .سندي تخته بنوین بحث ها را روي اۀدي توانند چکیداوطلبان م •
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  ده هاي و افزودن گزی اصلۀساختن صفح:  ٢٫٥ یمبان
 با مرور آنچه بر ی و. دنبال کندیکينا علاقه مند است اخبار مربوط به زنان را از راه ارتباطات الکترونيم
 گرچه در یو.  برخورده استی نوشته شده به آمار و اطلاعات جالبWLP هر کشور در وبگاه ۀ صفحیرو

ره کند تا بتواند بعدا از آن ها ي ذخیيل است آن ها را در جاين آمار ندارد، اما ماي به ایازيحال حاضر ن
  .استفاده کند

  تيفعال

  قهي دق٣٠

 .ديبرو org.wwwWomensenews://http/به وبگاه  •

ره ي و ذخیقرار دادن وبگاه به عنوان صفحه اصل. ک وبگاه وجود داردي مکرر به ۀ مراجعیدو راه برا •
 .ده هايکردنش در بخش گز

• Tools > Optionsديک کني را کل. 

.  دهدی را نشان می کنونی اصلۀشده، صفح نوشته ی اصلۀ که درمقابل صفحی، متنGeneral ۀدر پنجر •
Use Currentوبگاه شما شودی اصلۀ اخبار زنان صفحۀد تا صفحيک کني را کل . 

o یانه هايدر را.  توان استفاده کردیط کار مي و هم در محی شخصیانه هاي راین امکان هم رويازا 
 . شودی مرتبا عوض می اصلۀ نت ها معمولا صفحیا کافي مثل کتابخانه و یعموم

 به وبگاه یوند خروجيک پيک بر يد و سپس با کلي زنان مرور کنی خبرهاۀ دو صفحه را درباریکي •
 .دي برویگريد

o آگاه ی و خارجی داخلیوندهاين پيد تا به تفاوت بي را نگاه کن" وبیدسترس": ٢٫١ یابيبخش دست 
 .ديشو

 .دي بروی اصلۀد تا به صفحيک کنيکل Home یدوبار رو •

o ۀ دگمیک کردن رويد با کلي که باشی ادر هر مرحله “Home”دي گردی بر می اصلۀ به صفح. 

در بخش Favorites > Add ک کردن يد و صفحات مورد نظرتان را با کلين اخبار زنان گردش کنيب •
 .ديره کنيده ها ذخيگز

ع به ي سرۀاب و مراجعيجاد صفحه ي  ای است برایده ها راهيره کردن در بخش گزيذخ 
 . نظر موردۀصفح

:  کردنکين بخش را با کليا. دي برو/http://www.learningpartnership.orgبه آدرس 
Resources > Legislation > Family Laws    صفحات مربوط به چند . ديره کنيده ها ذخير گز  د

 .ديره کنيز ذخيکشور را ن

ده يا دو گزيک يک کردن يبا کل. ره شده انديده ها ذخيد گزيد تا مطمئن شويک کني  کلfavorites  یرو •
 . دي رسیره شده ميوند ذخيماً به پيمستق

 .دي صحبت کنی اصلۀده ها و صفحين گزي بی تفاوت هاۀدربار •
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o  با صفحه ن صفحه راي توان چندیحفظ شود اما م یاصل ۀ تواند به عنوان صفحیک صفحه ميتنها 
 . گذاشتهنشاناب ي

 ست؟ين راه چيد که اگر بخواهند چند صفحه را مرتب مرور کنند، بهترياز شرکت کنندگان بپرس •

o ده هايره کردن آن ها در گزيذخ: پاسخ. 

لند در ي را که مایي بر صفحات وب آنهاید تا با مروريار شرکت کنندگان قرار دهي را در اختیزمان کوتاه •
 .ره کننديده ها ذخيگز

ک از شرکت کنندگان ياز هر . دي کنی نت است بازیک کافي را که در یقت اجازه دهد نقش کساگر و •
ده ي از آن ها را در گزید و برخين صفحات وب بگرديب.   نفر کنارخود عوض کندیش را با جايد جايبخواه
 .ديره کنيها ذخ

 ۀانيده ها در راي بخش گزیهاد که تفاوت يان بگذاريگر در ميکديبا . دي خود برگردی قبلیدوباره به جا •
 . شوندی شوند و با ما منتقل نمیره مي شما ذخۀانيده ها در راي و گزی اصلۀدوم چه بود؟ مشخصات صفح

o د به بخش متناسب ياب درست کردن نگاه کنيده ها و صفحه ي گزیره سازيادگرفتن روش ذخي یبرا
  ." مشترکیاب هايصفحه : "١٫١ یساز
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  یرگر مرویخطاها: ٢٫٦ یمبان
ل ي داند که دلی کند اما نمی بر خورد میبي گردد و گهگاه به موارد عجینا در وب ميچند ماه است که م

 ی از دست می در وب تمرکزش را بر موضوع اصلی در ضمن متوجه شده که هنگام مرورگریو. ستيچ
ت ي و فعالی همراه جلبی برایيراهنما: یر اجتماعييجاد تغيا "یدئوي ویکبار که در جستجويمثلا . دهد
نا با ساعت ها تماشاکردن يم.  سردرآورده استی جالبیدئو هاي با ویبود متوجه شد از وبگاه" ی اجتماعیها

  . اش دور افتادیدئوها از مقصد اصليآن و

  تيفعال

  قهي دق٣٠

 را enterد ويپ کني را تا/http://wwwlearningpartnership.org. در نوشتن هایپياشتباه تا •
 .ديبزن

o دا ينظر را پ  موردۀاگر صفح. ار مهم اندي وب بسیهاي در آدرس دهیگرينقطه ها و هر علامت د
 .ستي در آن نید اشتباهيد تا مطمئن شويد نگاه کني را که نوشته ایگر آدرسيد بار دينکرد

 .ديرا بزنenter  د و يپ کنيرا تا/http://www.womensnews.org .  در نوشتن هایپياشتباه تا •

o  سر یگري دۀاد از صفحيد، به احتمال زيسيک کلمه از آدرس وب را درست ننويا ينام دامنه و اگر 
 .دي افتاد، دوباره آدرس را به دقت نگاه کنین اتفاقياگر چن. د آورديدر خواه

.  در نوشتن هایپياشتباه تا. صفحات گم شده •
http://www.learningpartnership.org/afkhamiد و يپ کنيرا تاenterدي را بزن. 

o ش داده ي آن صفحات نماین صورتيدر چن.  کندی را از آن پاک میک وبگاه صفحاتيصاحب گاه گه
ن يدر چن.دي آی م(page not found)"  نشدهافتيصفحه " یام خطاي آن پیبه جا .نخواهند شد

 مطلب مورد ، آنیجستجو یتوانائا با استفاده از ي و ،ديبگاه برگردو یصل اۀا به صفحي یموارد
 .دينظر خود را جستجو کن

د و يک کني کلHub یبر رو. ديپ کنيرا تا http://www.witness.org: و انحراف از مطلبیسردرگم •
 .دينيدئوها را ببي ویکم

o نا افتاد، صحبت ي میرا که بی، همان اتفاقی سرگرم تماشا شدن و فراموش کردن کار اصلۀدربار
 ی نت ها، میژه در کافيم، به وي داریت زماني که محدودین مشکل بخصوص در موارديا. ديکن

 . باز داردی باشد و ما را از انجام کار اصلیتواند جد

 .دي کنیرا بررس URLپ مجدد ي و تای اصلۀ مختلف برگشتن به صفحیروشها •

o ک کردنيبا کل Homeۀساخت صفح": ٢٫٥ یابيد به دستيز نگاه کني ن.دي برگردی اصلۀ به صفح 
 "یاصل

o ۀچند بار دگم   Backديد تا به عقب برگرديک کني را کل. 

o  ا يک وبگاه و يدنبال URLاطلاعاتیدرجستجو": ٣٫١یابيد به دستينگاه کن. ديگم شده بگرد ."  
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  جستجو در وب: ٣ یابيدست
  هدف ها

 . جستجو در وبی روش هایبررس •

 .گري دیافتن رسانه هايج جستجو و يدا کردن نتايپ •

  .ج جستجوي نتای و احراز درستیبررس •

  :م و ابزاريمفاه

  ٢٠٠٥درسال .  شودی وب استفاده میدا کردن اطلاعات بر روي پی جستجو برایاز موتورها
ون  يلي ب٨شتر از يافتن بي گوگل در صدد یمز گزارش داد که موتور جستجويورک تايوي نۀروزنام
 ۀا داديافتن مطلب ي یاد است که براي وب چنان زیدر واقع حجم مطالب رو.  وب استۀصفح
 ی بر روی هر موضوعۀدر بار. افتي ی جستجو دسترسۀژي وید به برنامه هايان باين مي در ایخاص

د يري گیاد مين بخش يدر ا.  مناسب آن را به کار بردید روش جستجويوب مطلب هست اما با
  . دينان برسيج قابل اطمياص به نتا خی مطلبیچگونه در جستجو

در . اهوي، و MSN Live گوناگون وجود دارند، مانند گوگل، ین گونه جستجو موتورهاي ایبرا
ر يسا. م کردين دوره با گوگل کار خواهين رو در ايشتاز است و از هميحال حاضر گوگل پ

  . دارندی مشابهی هایز توانائي جستجو نیموتورها

  

  لگري تسهی آمادگ

شگر نصب ي نماۀ صفحی نرم افزار جستجوگر را رویانبر برايک علامت ميش از شروع جلسه يپ •
د که آدرس ييبه شرکت کنندگان بگو. انبر را دارندين مي دستگاه ها اۀد که هميمطمئن شو. ديکن

ره کنند ي خود ذخیده هايرا در فهرست گز http://www.google.com گوگل یموتور جستجو
  .ن فهرست استفاده کنندين صفحه، از همي مراجعه به ایو برا
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   اطلاعاتیدر جستجو: ٣٫١ یمبان
ه کند تا يا تهي از رهبران زن از سرتاسر دنی تا فهرست استنا خواهش کردهيک مسئول برنامه از مي

ن ي داند که اینا ميم. ئه شود زنان خواهند داشت ارایاسي که به مناسبت مشارکت سیدر برنامه ا
او نام چند نفر از نخست . د جستجو کندي داند در کدام وبگاه ها بای وب هست اما نمیاطلاعات رو

او با . ش شروع کندي دهد که از دانسته هایح ميترج.  داند ی می جنوبیايران زن را در آسيوز
  . کندی نام آن زنان کار را آغاز میجستجو

  تيفعال

  قهي دق٣٠

 .ديبرو http://ww.google.comبه  •

o ن يازهم. شرفته تر و توانا تراستي جستجو پیر موتورهاي گوگل از سایموتور جستجو
به " گوگل شده" ا يگوگل کردن و  "یل شده و واژه هاين موتور به فعل تبديرو، نام ا
 . افته اندي گوناگون راه یفرهنگ ها

o ني اکه یيجااز آن  URLده ها يهمواره مورد استفاده شما خواهد بود آن را به فهرست گز
 ".ده هاي وافزودن گزی اصلۀساختن صفح": ٢٫٥ یابيد به دستينگاه کن .دييفزايب

 .ديپ و وارد کنيرا تا"ی جنوبیايران زن آسينخست وز "ۀ جستجو جملۀدر جعب •

o از برنامه یاريو رخ داده باشد بس در نوشتن نام درست مطلب مورد جستجیاگر خطائ 
 مطمئن شدن یبرا.  کنندیشنهاد مي جستجو خود به خود نام درست را به جستجوگر پیها
 .ديسيگر بنوي دیرا به گونه ا ی جنوبیايران زن آسينخست وز، متن یين تواناياز ا

 . دهدی شما را نشان می موضوع جستجویدا شده برايج پيافته ها نتاي ۀصفح •

o از آدرس صفحات،یافته ها فهرستي ۀصفح URL ۀ آنها، شرح مختصر و پر رنگ شد 
 . دهدید، نشان مي را که با آنها جستجو کرده ایکلمات

o فهرست ی که در بالایيا آنهاي شوند و ی که در سمت راست صفحه نشان داده میيوندهايپ 
  سازمانش آنهايما نی هستند که برای تجارتیوندهاي شوند، پیش داده مي نمای رنگۀنيبا زم
 ۀاما به موضوع مورد علاق. ستندي جستجو نیج واقعينها نتايا. استه پول پرداخت یمقدار

 .اند شما مرتبط

 .دي کنی آن را بررسۀو صفحد يبزن جستجو ۀجين نتي اولیرو •

ن ي ای بعدی انتخاب هایبرا. ديک کنيانتخاب دوم را کل. ديو به عقب برگردد يکنک يکل دگمه یرو •
 .ديل را تکرار کنمراح

o ا يد ي به دست آوری جنوبیاير در آسي از زنان نخست وزین راه فهرستيد از ايا توانسته ايآ
 ر؟يخ

o دا کرد؟يا پير نقاط دني را از سایشتري توان نام رهبران زن بیا ميآ 
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شنهاد ي جستجو پی را برایا موضوع هائيا نام ها يشرکت کنندگان به نوبت کلمات : ک چالشي •
 ! افتدی مید چه اتفاقينيبب. د باشدي از آن ها نبای کنند در وب نشانیکه فکر مکنند 

o ن ي نداشته باشد؟ با ایجه اي آن نتیدا کند که جستجوي پی کلمه ا است توانستهیا کسي آ
 .دي صحبت کنی وب کمی حجم اطلاعات روۀن در باريتمر

 یي نهاۀ پروژیرا جستجو کند و براد تا هر کس مطالب مورد نظر خود ي به افراد بدهیوقت کوتاه •
 .اش آماده شود

  .ان گذاردين در ميرين جستجو ها با ساي خود را از ایهر شرکت کننده تجارب و آموخته ها •

ج
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   جست و جویروش ها: ٣٫٢ یابيدست
ن کشور ي خواهد آمار رواج خشونت را در ای کند و میق ميل تحقي در برزی خشونت خانگۀ درباریسوف
ن ين مطمئن است که اي همیدا کرده و براي را پیگري جستجو، آمار دی قبلا با استفاده از موتورهااو. بداند

  .بار هم موفق خواهد شد

  تيفعال

  قهي دق٣٠

 .دي کنیج جستجو را بررسي نتا.ديبه گوگل برول ي در برزیآمار خشونت خانگ به یابي دستیبرا •

o با مطلب مورد نظر دارندیه ارتباط اندکه ارائه کند کجيون ها نتيليک جستجو ممکن است مي  .
 . ديسيق تر و مشروح تر بنوي بهتر مطلب مورد نظر را دقۀجيافتن به نتي دست یبرا

 .دي کنیج را بررسينتا. دي برولي در برزیآمار خشونت خانگد و بدنبال ي باز کنیگري دۀپنجر •

o ینوشته شده را درنظر م ید واژه هاي کلۀ مورد نظر، همی انجام جستجویموتور جستجو برا 
 . آخری سوم، الۀکلم+  دومۀکلم+  اول ۀ کلمیعني. رديگ

 .دي کنیج را بررسينتا. ديل برويبرز" یآمار خشونت خانگ"د و بدنبالي را باز کنیگري دۀپنجر •

o ن عبارت يافتن عي جستچو به دنبال یومه قرار گرفته باشند موتورهاياگر مطلب مورد جستجو در گ
 جستجو ۀجيافزودن و کاستن آنها  نت. د واژه هاستير کلييگر جستجو با تغي دی هاروش.  روندیم

 . دهدیر مييرا تغ

 .ک تر استيد کدام به خواست شما نزدينيد تا ببيسه کنيج سه فهرست را با هم مقاينتا •

o ج مناسب تر را يکند نتا ید کمک مي آیج مي نتاۀوند در صفحير پي که در زیخواندن خلاصه ا
 . شودیي صرفه جوزي ند تا در وقتيب کنانتخا

افت که صفحه به چه فرد، ي توان دریوند و رفتن درون صفحه مي پیک کردن رويچگونه بدون کل: نيتمر •
  ارتباط دارد؟یا سازماني

o ۀ حوزخواندن URL٢٫٣ یابيبخش دست: د بهينگاه کن.  معرّف نوع وبگاه استیادي تا حد ز :
 ".وب یحوزه هاخواندن "

 . خود را جستجو کنندیيا مربوط به پروژه نهاي و ید تا مطالب شخصي به شرکت کنندگان بدهیکوتاهزمان  •

o ديل جستجو کني در برزی خشونت خانگۀدار شده است دوباره درباري که پدیيد واژه هاي با کل. 

o ديان گذاريآموخته ها را با گروه در م. ديل آن به بحث پردازيج و دلين نتاي بهترۀدربار. 

  . آمده استCDشتر در ي بی جستجویروش ها: ر منابعياس
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  قيافتن اطلاعات معتبر و دقي: ٣٫٣ یابيدست
 ی آنها پاسخ هایهر دو. از به کمک دارنديدا کردن مطالب خود ني جستجو در وب و پی براینا و سوفيم

 یقي خواستار آمار تطبیسوف.  خواهند به پاسخ مطمئن و قابل اعتماد برسندیدا کنند اما مي توانند پی میمتعدد
 افراد و یاز به همفکري نیين جستجويچن.  استیوين، و بوليل، آرژانتي برزی در کشورهایخشونت خانگ

  . متعدد داردی هایجستجو

  تيفعال

  قهي دق٣٠

ر ي زی پرسش های ممکن برایهر گروه به دنبال پاسخ ها.  شوندیم ميشرکت کنندگان به چند گروه تقس •
 کنند که یبا هم مشورت مگروه ها  مربوط به هر جستجو ید واژه هايادداشت کردن کليز پس ا.  گرددیم

 .چرا پاسخ آنها قابل اعتماد است

o دا کردند؟ي پی حق رایخيه در چه تاريجريزنان ن 

o برند؟ی رنج می از زنان پاکستان از خشونت خانگیچه درصد  

o شده است؟نگان زن اشغال ي توسط نمایجي در مجلس فیچه تعداد کرس 

o است؟یا چه کسيبريس جمهور ليئر  

o ه زنان يض عليثاق رفع تبعيا افغانستان ميآ(CEDAW)ب کرده است؟ي را تصو 

o ل به راه افتاد؟ي زنانه در برزین کلانتري نخستیخيدر چه تار 

د تا همه نن تخته بچسبایسند و آنها را کنار هم بر روي بنوی کاغذ بزرگی خود را رویهر گروه پاسخ ها •
 .ننديبب

اد يدا و ي در آن را پی را هم انتخاب کنند و آمار خشونت خانگیگرياگر وقت اجازه داد گروه ها کشور د •
دا کرده اند و يپ) ید واژه ايبا چه کل(کجا و چگونه  از سند که آن راي بنوی آمارۀ هر دادۀدربار. داشت کنند

 . کنندن اطلاعات ارائه ير دانستن اب معتیل شان را برايز دلاين

 :ج جستجوي و اعتبار نتای درستی در بررسینکات •

 .ديسه کنيگر مقايج منابع ديک منبع را با نتايج به دست آمده از ينتا 

 .دي را به دست آورید تا آمار کنونيد واژه ها اضافه کني را به کلیسال جار 

ا يد که آيبايد و دريق کنيه و ارائه کردند تحقي که آمار را تهی نهادها و مؤسساتۀدربار 
 ی توان نهادهائیعتاً ميطب. ريا خي هستند ی شناخته شده و معتبرینهادها و سازمان ها

 ی مانند سازمان ملل متحد را منابعیچون دانشگاه ها و موسسات بزرگ شناخته شده ا
 موضوع و یخ انتشار آن، کتابشناسيسندگان مطلب، تاريا نويسنده ي نوۀدربار. معتبر شمرد

  .ديق کنيقوندها تحيپ
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  گري دی رسانه هایجستجو: ٣٫٤ یابيدست
 ی از کشورهایکي خوانده است که یز در وبگاهين. دا کنديا را پيبريس جمهور لين رئينا موفق شده نام اوليم

 آورد و ی اما نه نام آن کشور را به خاطر م استس جمهور زن را انتخاب کردهين رئين نخستي لاتیکايامر
ابد و در گزارش مربوط به مشارکت ي بی هر دو مورد اطلاعاتۀل است در باريما.  راس جمهورشينه نام رئ

  . زنان بگنجاندیاسيس

  تيفعال

  قهي دق٣٠

 Ellen Johnson Sirleafف ي سرل- الن جانسونۀو دربار. دي بروhttp://www.google.com به •
 .ديجستجو کن

 .ديکند و اطلاعات به دست آورده را مرور يک کنيند کلوين پي اولیبر رو •

 .ديج را بررسي نتاImagesک کردن يد و با کليج بروي نتاۀبه صفح •

o ک کردن يبا کل.  گرددیجه ميدنبال نتر موجود يگاه ها و تصاون تمام وبيموتور جستجو در ب
Imagesشوندیدا مي مرتبط با موضوع پیرهاي تمام تصو . 

o جستجو استفاده ۀجي به دست آمده در نتیرهايد از تصوي توانیا ميآ: یادشنهيموضوع بحث پ 
 استفاده از عکس ۀن عکس ها اجازيا عکاس ايد که صاحب وبگاه و ي دانید؟ از کجا ميکن
 شان را به شما خواهند داد؟يها

د يد که کلياز شرکت کنندگان بخواه.  دي گوگل بروی جستجوۀ به صفح- جستجوین مشکل تر برايتمر •
 .  شنهاد کنندين پي لاتیکايس جمهور زن آمرين رئيدا کردن آخري پی را برایدي جدیواژه ها

o شل بشله يم: پاسخ)Michelle Bachelet (٢٠٠٦ سال یليدر ش. 

o د و سپس با ي جستجو کنني لاتیکايس جمهور زن آمري رئید واژه هاينخست با کل: سرنخ
ن خانم يد واژه، سال انتخاب شدن ايد به عنوان کلي آوریج بدست مي که در نتایاستفاده از نام

 .ديدا کنيرا پ

دا ي مختلف پۀ دو رهبر زن از دو قارۀدئو درباريا ويدا کردن خبر و ي پی برایج، روشي نتاۀدر صفح •
 .ديکن

o جستجو ۀ صفحیدر بالا Newsدئو هم يدا کردن وي پید و سپس برايک کني را کلMore را  
 .ديک کنيکل

o مثلا. دي از آنها صحبت کنۀگراطلاعات  و استفاديدا کردن انواع دي پ امکانۀدربار: 

: ٥٫٥ یابيدست: د بهينگاه کن.  گزارشۀي تهیبرامدارک ر در متن ياستفاده از تصاو 
 ." الگوهار، جداول، و يتصاو"

 موضوع مورد نظر در ۀدادها را دربارين روي توانند آخری می خبری گزارش ها 
 ".انهي رایکاربردهااصطلاحات و ": ١٫٢یابيدست: د بهيه کننگا. ار بگذارندياخت
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 ده هايگز ب کردن جستجو ويترک: ٣٫٥ یابيدست
از به کمک ي کند و نیانه جستجو مين، و خاور مي لاتیکايقا، امريا، افريخ رهبران زن در آسي تارۀنا درباريم

 مانند یاطلاعات.  است با آنمرتبط از رهبران زن در هر منطقه و اطلاعات یدنبال فهرسته او ب. دارد
 چند  ی قانونگذاری زنان در نهادهایزان مشارکت کنونيا مي به دست آوردند و ی که زنان حق رایزمان

 یازمند بحث و تبادل نظرين جستجو، ني علاوه بر انجام چندین اطلاعاتيافتن به چنيدست . کشور منطقه
  .د اطلاعات مطمئن شی است تا بتوان از درستیجد

  تيفعال

  قهي دق٣٠

ن، و ي لاتیکايقا، آمريا، افري از مناطق آسیکيم شوند و هر گروه يشرکت کنندگان به چهار گروه تقس •
 .دا کردن رهبران زن هر منطقه انتخاب کندي پیانه را برايخاور م

 .دير اطلاعات مرتبط با آن جستجو کني رهبران زن و سایبرا •

 . دينين شان را برگزيترد و معتبري مختلف برویبه وبگاه ها •

 .ديده ها اضافه کنين وبگاه ها را به گزيبهتر •

 .اد داشت کنديدا کردن آن را يدا شده و روش پيا منابع اطلاعات پيهر گروه منبع  •

 .ديده ها صحبت کني به دست آمده، و گزی و اعتبار داده هاید واژه ها، درستي کلۀدربار •

o د يج مختلف کلي به دست آوردن نتایا برايه دست آوردند؟ آج را بين نتاي بهتریيد واژه هايچه کل
 ر دادند؟ييواژه ها را تغ

o که یا منطقه اي را به کار برد یا روش بهترين اطلاعات را به دست آورد؟ آيشتريکدام گروه ب 
  داشت؟یانتخاب کرده بود اطلاعات جامع تر

o د؟ رسیق و قابل اعتماد به نظر ميا اطلاعات به دست آمده دقيآ 

o  ده ها افزودي توان آن ها را به بخش گزیوندها ميک از پيپس از مرور هر. 

o ديفزائيده ها بيد به فهرست گزي توانیز ميج به دست آمده را ني نتاۀ، همیبا همان روش قبل. 

o و منظم ی توان آن ها را طبقه بندین صورت  ميدر ا.  شودیده ها ممکن است طولانيفهرست گز 
ده ها و يسرو سامان دادن به گز": ١٫٦افت يره: د بهينگاه کن. ابل استفاده باشند قیکرد تا به آسان

 ".هااب يصفحه 
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ل يميا: ٤ یابيدست  
  اهداف

 . کار با آنۀل و نحويمياراه از  یابيآشنا شدن با ارتباط  •

 .ليمي فرستادن ای به اطلاعات و ابزار لازم برایآگاه •

  .ی و حرفه ایتباطات شخصدر ارل يميا از ی بهره جوئیاي مزایبررس •

  

  م و ابزارهايمفاه

 ی ارتباطیر برنامه هايسه با ساير کاربرد آن، در مقايدر چند سال اخ. اري بسیت هاي است با قابلی نرم افزارليميا
 بخش ی کنونیايدر دن. شتر رشد کرده استي آن، بی و سرعت بالای، ارزانی بهره جوئی، به خاطر آسانیکيالکترون
ک تولد گرفته تا ثبت نام در ي شوند، از تبریانجام مل يمي با استفاده از ای و حرفه ایارتباطات شخص از یبزرگ

  .یف درسي، و انجام تکالی حقوقیدانشگاه، عقد قراردادها

ود  خۀژيل ويميا، ی از سازمانها و موسسات آموزشیبرخ.  وجود داردليميا به ی دسترسی برای گوناگونیروش ها
گان ي رای از مردم از راه نرم آفزارهایاري بسیاما به طور کل.  کنندیان شان درست ميان و دانشجو کارکنیرا برا
 Gmailن بخش ما از نرم افزار ي ایبرا. ابندي ی دسترسليميا توانند به ی  مHotmail, Yahoo, Googleمانند 

  .  مي کنیاستفاده م

  

  لگري تسهیآمادگ

 ی وقفه اینترنتيش از آن که در ارتباط ايد پي بفرستليمياشگر را با ي نماۀ از صفحیرهائيتصو •
 .ديني ببی دیس را در ليميا از ید نمونه هائي توانیم. حاصل شود

د تا ين فهرست را محفوظ نگاه داريا. افتي ی دیس توان در یز ميد ها را نيد و نباي از بایفهرست •
روش کار با پست ": ٤٫٦ یابيژه در بخش دستين بخش کمکتان کند، به وي ایدر بحث ها
 ".کيالکترون

. ديادداشت کني استفاده از آنها در کارگاه وجود ندارد، ی برایرا که مانعل يمياا چهار آدرس يسه  •
ک يگر را به ي دیهال يميا ۀمتن هم.  ديرا به آدرس خودتان هم بفرستل ها يميان يد اي توانیم

ن ي اید از نمونه هاي توانیم.  دي نشان ندهی را به کسید تا ناخواسته متني موقت منتقل کنۀپوش
 .ديرهنمود هم استفاده کن

ن ها را با ي کنند، تمریا گوگل استفاده مياهو و ي مانند یگري دليمياشتر شرکت کنندگان از ياگر ب •
 یتنها برخ.  دهندی را انجام میکسانين ابزار ها کار يتمام ا. دي از آن ها انجام دهیبهره جوئ

  . داشته باشندی جزئی ها ممکن است با هم تفاوت هااصطلاحات آن
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  ل يمي ایايمزا: ٤٫١ یابيدست
 گردد، ی است که در وب می مدتیو. ردياد بگيانه ها را ي تواند کار کردن با رای کند که مینا احساس ميم

است روش ل يحال ما. دا کرده استيانه اعتماد به نفس پي در کارکردن با رای کند و کمیدا مياطلاعات پ
ن رو ي است و از همین روش ارتباطي بهترليمياده است که ياو شن.ردياد بگيارتباط برقرار کردن با وب را 

  . از آن استفاده کندی و حرفه ای هر دو منظور شخصی خواهد برایم

  تيفعال

  یقهي دق١٥

 . کندی خود را ثبت مۀگذرواژ و ینام کاربر ،omc.gmail.www://http/: لگربا بازکردن آدرسيتسه •

o از راه وب استی و حرفه ایافتن شخصي ارتباط ۀوين شي مهمترليميا . 

o د تا به يره کنير صفحات آنها را ذخي و تصوليمياد، از قبل چند متن يتنرنت ندارياگر در کارگاه ا
چ يحتا اگر ه. وجود است می دیس ی هم بر رویگري دینمونه ها.ديشرکت کنندگان نشان ده

 .ددن انيدر قابل ين تصاويها در ايگژي فعال نشود، تمام ویونديپ

 . ديرا نشان دهل يميانام فرستنده و محل ارسال . دي را باز کنی شخصليمياک ي •

o که چند روز لازم است تا یکند، در حال یبه هم مرتبط م ا را با سرعت نوريل سراسر دنيميک اي 
 .قه وقت لازم دارديک دقيل کمتر از يميک اي. کا برسدي از هند به آمرید عای هوائۀک نامي

  .ديد و فرستنده وعنوا ن را نشان دهي حساب باز کنی حرفه اليمياک يدر  •

o ت امور يريص منابع، دنبال کردن روند کار، و مدي تخصی است که برای رسمی ابزار ارتباطليميا
 . داردیادي شمار کاربرد زی بی سازمان هایداخل

ل و يميرندگان اي گۀنام هم. ديفرستنده و عنوان را نشان ده. دي را که به گروه فرستاده شده باز کنیليميا •
 . ديآنان را نشان دهل يمياآدرس 

o  ان هم ۀنيزما ن و هز.  در آن واحد ارتباط برقرار کردیادي توان با افراد زیل ميميک ايبا ارسال 
 .ستيسه نيل مقا قابیا تلفني و یبا جلسات حضور

ن افراد ارتباط ي اۀ توان با همی را که میوه ايو ش. ديک گروه فرستاده شده باز کني را که به افراد یليميا •
 .ديح دهيافت توضي

o  ی برایعنوان ابزاره  را هم دارد، بیع و ارزان است و امکان کاربرد گروهي سرليميااز آنجاکه 
 یفهرست آدرس ها.  رودیکار مه  هم بیه ساز و شبکی گروهی، آموزش هایارتباطات گروه

 . گر مرتبط کنديکدي مشترک را با یبا علاقه ها از افراد یاري تواند بسیل ميميا

 .دي بحث کنی و حرفه ای شخصی در هر دو سطح کاربرليميا کاربرد یاير مزاي ساۀدربار •

o سدي تخته بنویج بحث را روي بخواهد که نتایاز داو طلب.  
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ليمي ای اساسی هایژگيو: ٤٫٢ یابيدست  
 داند که ی مید شروع کرد ولي داند از کجا بایاما نم.  ارتباط استفاده کندیل برايميم دارد از اينا تصميم

 ین پرسش خود را مطرح مي رود و اولینا به سراغش ميم. انه خبره شده استيخواهرزاده اش در کار با را
د بکنم؟يل چه کار بايميک اي فرستادن یبرا: کند  

تيفعال  

قهي دق١٥  

 . کندی خود را ثبت مۀگذرواژ و ینام کاربر com.gmail.www://http/لگر با باز کردن يتسه •

o افت خواهد ين نامه را دري ای دهد چه کسی است که نشان مليمياک آدرس ين کار ثبت کردن ينخست
 ۀحوزنا در ي می با نام کاربری دهد که فردی نشان م”meena@gmail.com “مثلا . کرد

gmail.comوب ۀحوزخواندن ": ٢٫٣یابيدست. ن نامه استي اۀرندي گ." 

o ليميا از عرضه کنندگان خدمات یکيگان يد از خدمات راي توانی مین آدرسي ثبت کردن چنیبرا 
به . دي ثبت کنل هايميان يک از ايد در هر ي توانید ميلي را که ماید و هر تعداد آدرسياستفاده کن

 :عنوان نمونه

meena١@gmail.com  meena٢@gmail.com، Meena@hotmail.com 
meena@yahoo.co.uk meena@yahoo.com 

o اهو يست، مثلا ي تجارین شرکت هايگر اي دیورود به برنامه ها ۀچيل دريمي ا حسابFlicker 
متناسب ( You Tube ا گوگليرا دارد و ) "نير آن لاياشتراک تصاو": ٢٫١ یمتناسب ساز(

 ۀ همیآسان تر است که بران يبنابرا. را) "ني آن لایدئو هاي وۀلي بوسیجلب همراه": ٢٫٣ یساز
 . ميک حساب استفاده کنين ها از يا

o ن رو ياز هم.  بندندین خدمات آن حسابها را مين حسابها استفاده نشود، عرضه کنندگان اياگر از ا
 .ديبهره جوئن حسابها يبار از ا کي یحداقل ماهبهتر است 

 .ديل را بخوانيميک اي  تا(log in) دي را باز کنۀبرنام •

o یشگر خود آگهي نماۀن خدمت در سمت راست صفحيگان ايشتر عرضه کننگان رايد که بيتوجه کن 
 . گذارندیش مي به نمایتجار

 .د تا دفتر آدرس ها باز شوديک کنيکلContacts  یرو •

o  ليميا ید در آن علاوه بر آدرس هاي توانین برنامه است و شما مي ای از ابزارهایکيآدرس دفتر 
 .ديره کنيگر آن ها را هم ذخيافراد، مشخصات د

ن فرد يد با اي توانی گپ، مۀبا باز شدن پنجر. ديد و بعد علامت گَپ را فشار دهيک کنيک فرد کلي نام یرو •
 .ديگفت و گو کن

o ین ابزار برايهر دو ا.  شودیز مي نیام فوريا پيشامل ابزار گپ زدن  و ل يميا یشتر برنامه هايب 
نرم افزار با  یام فوريارسال پ": ٧٫٣ یابيدست. ( شوندیبه کار برده م ی فوریتبادل نظرها

 )."پست
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 .ديو ش(log out)  خارجل يميااز  •

د، ي فرستیام مي پی عمومی که از مکان هاید، بخصوص هنگاميد که از برنامه ها خارج شوياد داشته باشيشه به يهم
".من آني اۀاستفادل و يميا": ٧٫٢یابيدستد به ي بنگر. نتیمانند کاف  
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 ليميجاد حساب ايا: ٤٫٣ یابيدست
 ی برایحسابن ي چنرد کهي گیم ميد است و تصمي مفیلي او خی براليمياک آدرس يداند که داشتن ينا ميم

 خواهد حساب ینا مي میند تا وقتيکند  در کنار او بنش ینش خواهش م از همکارایکياز . خودش درست کند
 را از قلم نخواهد انداخت و ی مهمۀنا مطمئن خواهد بود که نکتيب مين ترتيبه ا.  کندیيباز کند، او را راهنما

.سد و بفرستديل اش را بنويمين اي تواند از همکارش بپرسد و با کمک او اولیوجه نشود متمچه هر   

تيلفعا  
قهي دق٣٠  

 .دي برو/http://www.gmail.comبه آدرس  •

o با ليميباز کردن حساب ا Hotmail و Yahoo یمراحل ممکن است کم. ه گوگل استيز شبين 
 داشتن ی لازم برایشگر گام هاير نمايتصو ی دیس یرو.  استیکي یمتفاوت باشند اما مقصد نهائ

 .ديگر هم تکرار کني دۀ دو برنامیهمان مراحل را برا.  آمده استیحساب پست

 .ديک کنيکل (sign up) بازکردن حساب ۀ دگمیرو •

 .ديک کنيد و بر دگمه ورود کليسيل خود را بنوينام و نام فام •

o را که هنوز گرفته ی نام ها نامۀ دگمیک کردن رويبا کل. ج قبلا گرفته شده اندي رایشتر اساميب 
اد يبه ). ن متفاوت وجود داردير عناوين امکان زي مختلف همیدر برنامه ها. (ديدا کنيت پنشده اس

 .کار برده  توان تمام عمر بی را مليمياک آدرس يد که يداشته باش

o ی و هم امور حرفه ای امور شخصید که هم برايني را برگزید نامي کنی، سعیدر انتخاب نام ورود 
 .ديزيپرهب عام وبگاه ها هستند، یا اسامي ، و ی ، فکاهی شخصیلي که خیياب نام هااز انتخ. قابل استفاده باشند

 .ديانتخاب کن code)(گذرواژه ک ي •

o شماره و حرف باشد٦ از یبي ترکید حداقل حاويمن باينان و ايقابل اطم واژهگذرک ي  . 

o پرسد ی از شما مد، برنامهيکن یگان ثبت نام مي رای از خدمات وبگاه هایکيدر   کهیاغلب هنگام 
 یغاتي تبلیام هايد وگرنه با پي دهید؟ بهتر است پاسخ منفياز داريز نين یگريا به خدمات ديکه آ

 .د شديبمباران خواه

o علامت یرو. دي بخواهیاريانه يد از راي توانیشه ميد، هميستيک از موارد مطمئن ني ۀاگر دربار 
 . شودد تا متن کمک متناسب با موضوع بازيک کنيسوال کل

 .ديد و به آن پاسخ دهي را انتخاب کنیمنيک پرسش اي •

o  ورود ۀن سوال ها به شما اجازيدن ايد، برنامه با پرسيخود را فراموش کرده باش ۀگذرواژاگر 
 ) مادرتانیمثل نام خانوادگ. ( دي را انتخاب نکنی شخصیلي خیپاسخ ها. خواهد داد

o شتر کاربران تنها يره، بيت و سال تولد و غي جنسده شوند مانندي هم ممکن است پرسیگريسوالات د
 .کنندي را پر میموارد اجبار
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o را هم ارائه کند، از یگريس دهنده ممکن است خدمات ديد، سرويکن ی که انتخاب میبر اساس محل 
 .گري دیجمله خدمات به زبان ها

 .ديک حساب بازکنيد و با زدن کليريد شده در موافقت نامه را بپذيمواد ق •

o در هر حال اگر . رندي پذیشتر کاربران نخوانده آنها را مي اند و بیما موافقت نامه ها طولانعمو
 .دي را ندارید امکان حرکت بعديريآنهارا نپذ

 .ديک کنيکل" مرا به صندوق پست ام ببر "ۀ دگمیرو •

o ليمي نوشتن ای است از جمله باز کردن صفحه تازه برای امکانات مهمیستون سمت چپ، دارا .
ا به ي ببرند و ها توانند از جمله شما را به دفتر آدرسین بخش هستند که مي در ای مختلفیوشه هاپ

 که با یيد و آدرس هاين مکاتبات خود را با صاحبان آن ها داشته ايشتري که بیيفهرست آدرس ها
 .دي مشخص کرده ایعلامت

o اه پررنگ يبا حروف س باز نشده یل هايميا. ده استي رسیل هايميستون بخش راست شامل ا
 . مشخص شده اند

o ۀ دهد از جمله نحویام و روش ارسال آن را نشان ميل امکانات مختلف در نوشتن پيمي ایبخش بالا 
 .اميک پيپاسخ دادن به 

o بخش . ليمين تر محل موضوع ايرنده است و سطر پائيل گيميام محل نوشتن آدرس اي پۀ صفحیبالا
 . ام استي پیا و بزرگ تر صفحه مختص محتویاصل

 مخصوص یرا در جا"  تازهليمياسنجش "عنوان . ديپ کنيژه اش تايآدرس تازه درست شده را در محل و •
 .ديک کنيرا کل (send)فرستادن  ۀل دگميمي فرستادن ایبرا. ديموضوع قرار ده

o حوزه و نام @ نام: یشگيد در قالب همي وجود ندارد و حتما بای خالیفضال يميا یدر آدرس ها
xxx. ام را يرد و پي پذیح نوشته نشده باشد، برنامه آن را نمياگر آدرس به شکل صح. گذاشته شوند
 .  گرداندید نادرست بودن آدرس برميبا ق

 .د در صندوق نامهي جدليميا •

o  نوشتن . کند تا به سرعت موضوع نامه را متوجه شود یرنده مي به گیاديها کمک زل يمياعنوان
 . آنیل همانقدر مهم است که محتوايمي ایعنوان مناسب برا

ا ي و ل هايميا از فهرست ليمياک ي پاک کردن یبرا. ديک کني عنوان آن کلی روليمياک ي خواندن یبرا •
 .ديک کنيکل (delete) حذف ۀمگ دی روليمياپس از بازکردن و خواندن 

 . هاليمياخروج از صندوق  •

o  ی که در محل های مهم است، خصوصا وقتليمياش از بستن برنامه ي پل هايمياخروج از صندوق 
د ممکن ياگر از برنامه خارج نشو. دين برنامه کار کرده ايا کتابخانه با اي نت و ی مثل کافیعموم

  . از نام و حساب شما سوء استفاده کندیاست کس
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  ل يميافت ايفرستادن و در: ٤٫٤ یابيدست
 یامي خواند پی درس میگريش که در کشور ديو خواهد به دختر عمیو مل دارد يمياحساب اکنون نا يم

 سازمان محل کار یسي از مسئولان برنامه نویکي ی برایليمي خواهد ایز ميو ن. بفرستد و حالش را بپرسد
  .   وبیش رويج جستجوي حامل نتایوستيخودش بفرستد همراه با پ

تيفعال  

قهي دق٣٠  

 .ديخود بشول يمياوارد حساب  •

ل ي از افراد فامیکيآدرس .  باز شودی خالۀک صفحيد تا يک کني کل(Compose Mail) نامه  ۀي تهیرو •
 .ديسيبنو(To) "به" علامت یرنده در جلوي گیا دوست خود را براي

o ن منظور استفاده کنندي ایلگر براي توانند از آدرس تسهیشرکت کنندگان م. 

 .ديسيمتن مورد نظر خود را بنو •

 .نباشد  در آنیاهد تا اشتبيکن یبازخوانام را يمتن پ •

o استیو حرفه ا  لازمیام قبل از فرستادن آن کاريح متن پيتصح  . 

 .ديک کني را کلفرستادن ۀمگپس از نوشتن نام تان د •

o ل يمي روش درست مکاتبه با ای خداحافظۀ مودبان به جا از اصطلاحاتۀ، استفادی معمولۀمانند نام
 .است

ا به عنوان  تان رهمکاران از یکي آدرس. گر بازشودي دیک صفحه خالي تا ديکن کيه نامه کلي تهیرو •
 .ديسيبنو رندهيگ

o کنند منظوراستفاده نيا یز برايلگر نياز آدرس تسه توانند یم کنندگان شرکت. 

 تان درمورد ینترنتي اید که جستجويد به همکارتان اطلاع دهي خواهین متن ميدر ا. د يسيمتن نامه را بنو •
متن . دي فرستین نامه ميوست ايج کار شمااست به پيرا  که معرّف نتا یرکمدده و يان رسيموضوع به پا
 . در آن نباشدید تا اشتباهيرا مرور کن

o  پس از . دي کنیري و غلط گیبازخواند که متن نامه را قبل از ارسال ي کنیادآوريمرتب به خود
 . شودی ذهنتان مۀن کار ملکي ایچند

د يوست کنيد پي خواهیرا که م یليد و فايک کني کل(Attach A File)ه شود يوست ضمي پۀ دگمیرو •
 . امتان فرستاده شوديد تا پيک کنيکلفرستادن  ۀمگ دید سپس بر روينيبرگز

o ن حد يبزرگتر از ال يفا ۀاگر انداز. وست دارنديل پي حجم فای برایتيمحدودل يميا یشتر برنامه هايب
 .ل شما را پس خواهد فرستاديميباشد، برنامه ا

 .ديسي تخته بنوین بحث را رويج اي کدام اند؟ نتای و حرفه ای شخصین نامه هاي بیاوت هاتف •
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o ی هاليميا در ی اختصاریاز به کار بردن واژه ها. دي شروع بحث ارائه کنیچند نظر مختلف برا 
ست اگر ي نیرعادي متفاوت اند و غی رسمیهال يميا با ی شخصیل هايميا. دي کنی خودداریکار

  . دوستانه باشدلحن شان 
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(Cc) رندگان با نام ي و گ Bcc)   نام یرندگان بيگ: ٤٫٥ یابي دست
 سازمان ۀمسئول برنام. ک سال نو بفرستديانش تبري تمام آشنای خواهد براینا ميک است و ميسال نو نزد
ن ينا اي که مشنهاد کردهياو پ. ده استيل کرده بود خوانده و آن را پسنديميش اينا برايوست را که ميگزارش پ

در  ین افراد ممکن است اطلاعاتيرا معتفد است که ايگر در سازمان هم بفرستد زي چند نفردیگزارش را برا
د با فرستادن ينا باين مي همیبرا.  موضوع داشته باشند که بتوان آنها را هم به گزارش افزود همانۀبار

. کندیز گردآورين افراد را ني ایگزارش بازخوردها  

تيفعال  

قهي دق٣٠  

o که در یل هائيمي از ایينمونه ها CDین نمونه ها در بخشهايا. دي موجودند باز کنTo ، Cc  وBcc  
 . از افراد را دارندیآدرس گروه

o ن يلان آۀک برنامي قطع است ازینترنتياگر ارتباط ا(offline)مانند Outlook Express    
ن را انجام ي توانند تمری شرکت کنندگان مۀهمکار  نيبا ا. ديل ها استفاده کنيميخواندن ا یبرا
 .ستيسر نين راه مي از اليمياالبته ارسال . دهند

o ۀويل را بااستفاده از سه شيميب فرستادن ايا و معايمزا  To, Cc, Bccوه ين که کدام شيز ايو ن
 ی رومباحث ران يمهم ترد کمک کنند وياز شرکت کنندگان بخواه. دي کنی است بررسیمناسب چه هدف

 .سنديتخته بنو

o  قرار دادن چند آدرس در بخشToد يکسان از آن افراد انتظاردارين معناست که بطور ي، به ا
 .پاسخ دهند

o بخشیآدرس ها Ccام يشان از موضوع پي ای آگاهی است که مطلب را تنها براین معناي به ا
 . ديبه آنها هم فرستاده ا

o گر آگاه يرندگان دي از نام گیرنده ايد هر گي ندارلياد است، و شما ميرنده ها زي تعداد گیوقت
 . دي استفاده کنBccشوند از

o آن مناسب یکه کدام روش برا نيک از آن ها و اي هر ۀدربار.  خواهد بفرستدیمل يمي انا دو گونهيم 
 .دياست صحبت کن

o د و تمام آدرس ها را دريوست گزارش را دوباره بفرستيپToبا ک را همي تبرۀنام. دي بگذار 
 .ديبفرست  Bcc آدرس ها درۀگذاشتن هم

o  به Sent Mailديدا و باز کنيوست گزارش را دارند پي را که پیيهال يمي ا.ديبرو. 

o دي جدۀرنديگ "یرو"(Forward) یگريا افراد دي فرد یده براي که به شما رسیليميد تا ايک کنيل ک 
 .هم فرستاده شود

o پاسخ "ۀاگر دگم "(reply)یل فرستاده ميمي اۀاسخ شما تنها به أدرس فرستندد پيک کني را کل 
 آنها که در ۀ همید  پاسخ شما برايک کنيرا کل (Reply All)"پاسخ به همه "ۀاگر دگم. شود
 . شودیل نخست نامشان آمده بود فرستاده ميميا
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o که ی هنگام.دي فرستیرنده مي گین نامه را برايد که چرا اي بدهیح کوتاهيدر اول نامه توض 
 ین بازرسانيل اي دلۀبهتر است در بار) Forward(د ي فرستی میگري را به آدرس دیمه  انا

 .ديح دهيتوض

o یروCompose تمام آدرس ها را در . باز شودیديام جدي پۀد تا پنجريک کني کل Bccام يد و پيسي بنو
 .ديک کنيد و دگمه ارسال را کليک سال نو را در متن بگذاريتبر

o  شرکت ۀي توانند از آدرس بقیان خود را ندارند، ميآدرس دوستان و آشنا اگر شرکت کنندگان 
 .کنندگان استفاده کنند

o و یر ضروري غی متعدد کاری به آدرس هایا تجارتي و یرضروري غیل هايميباز رساندن ا 
نگاه  .جاد مزاحمت کنديش ايرنده را هدر دهد و برايرا ممکن است وقت گينادرست است ز

 ." ليمي فرستان اآداب: "٤٫٦ یابيتد به بخش دسيکن

o و یسامانده": ٢٫٤ یبهره جوئد به بخش ينگاه کن. شوند یل به سرعت پر ميمي ایصندوق ها 
   ".ل هايمي ایجستجو
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ل يميآداب فرستادن ا: ٤٫٦ یابيدست  
 ی آنها که مۀم هی فرستند، او هم آنها را برایفه مي او لطیمردم برا. کنديح مي تفرليميانا با ي است که میمدّت

.  کند، مانند نوشتن عنوان مناسبی را فراموش میان، او گهگاه نکات مهمين ميدر ا.   فرستدیشناسد باز م
  . پ کرده استيام را با حروف بزرگ تاي متن پۀکبار او به خطا هميک از همکارانش اشاره کرد که ي

تيفعال  

قهي دق٣٠  

 .د ها دارديد و نباي از بایاز به فهرستيل نيميبا ا یابي از روش مناسب ارتباط ی آگاهینا برايم •

 .د ها صحبت کننديد و نباين باي اۀم شوند و درباريشرکت کنندگان به چهار گروه تقس •

 .ان گذاردين در ميريهر گروه فهرست خود را با سا •

 .ديسي تخته بنوی از هر چهار فهرست را بر رویده ايچک •

o دي نظرات مشترک گروه ها صحبت کنۀدربار. 

 .زين آمي نامناسب و توهی های شوخیبازرسان •

 .آنها ی ادعاهای درستۀق در باري بدون تحقیره اي زنجی پست هایباز رسان •

ر خواهند يدن تعبياد کشي شوند، عموما به فریپ مي که با حروف بزرگ تایمتون •
 .شد

 در  آورند،ی به بار نمیاني افراد زی و خصوصی که در رواط شخصی از رفتارهائیبرخ 
 . کنندیجاد مي مشکل ایارتباطات حرفه ا

 .فراموش کردن عنوان •

 .ی و ناگفتنی گفتنی های شوخیبازرسان •

ا افراد يل فرد يمي اۀسندي که مخاطب مورد نظر نویل به همه هنگاميميفرستادن ا •
 .  بوده استیمشخص

 موجود CDن ابزار در ي  در کاربرد ایسيل نويمي اید هايد و نبايل و بايمي از آداب ارسال ایفهرست: منابع افزوده 
  .است
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  یواژه پرداز: ٥ یابيدست
 اهداف

  واژه پرداز ی هایآ موختن الفبا، کاربردها و توانائ •

  گوناگون ی هدف های از واژه پرداز برای بهره جوئی به چگونگیآگاه •

 

م و ابزارهايمفاه  

. د از آن بهره مند باشدي بایزنده که هرانسان است اریک سازمان  و مهارتي یدي کار تولۀ شالودیواژه پرداز
. رفتيل خواهند پذيميان را تنها از راه اي دانشجویف و پروژه هاي تکالی امروز موسسات آموزشیايدر دن

 رد و یليمي ایام هاي در پی گرفته تا اخبار داخلی مرخصی مکاتبات، از تقاضاۀز همي نی اداریدرفضاها
. کند همان واژه پرداز استیل مي گونه ارتباطات و مکاتبات را تسهني که ایابزار.  شوندیبدل م  

 شوند، ی گوناگون در بازارها و فروشگاه ها عرضه می بزرگ از واژه پردازهای، شماری کنونیايدردن
 هم وجود دارند یگريگان دي رایابزارها. Microsoft Word , OpenOffice Write: ازجمله
  کند به نامی راهم عرضه میتر کروسافت مدل ارزانيما. Microsoft Word, OpenOffice Write:ازجمله

Works Word Processor .زچونين یمدلهائGoogle Docs و Zoho Writer نرم یراد اساسيا. گان انديا ر 
ن ي ایبرا.  داشتینترنتيد ارتباط اي استفاده از آنها باین هستند و براين است که آنلايگان اي رایافزارها

  .ميکن یکروسافت ورد استفاده مي ما از نرم افزار مای اموزشۀردو

لگري تسهیآمادگ  

د که يقبل از شروع دوره مطمئن شو.  شوندیش داده نمي نمای کمکیکروسافت ورد تمام ابزارهايدر ما •
 . صفحه قرار دارندی روی اصلیابزار ها

شگر قرار ي نماۀ صفحید و رويدرست کن" آموزش" با عنوان یک روز قبل از شروع آموزش پوشه اي •
 ید و در پوشه اي کنی را کپینمونه ا. ن واژه پرداز وجود دارد ي تمری برایينمونه ها ی دیسدر . ديده

 .ديد بگذاريکه درست کرده ا

o گوناگون و چند گزارش استی هایي گردهم آی براینمونه ها شامل آگه . 

 .ديانه ها بگذاريگر تمام راشي نمایکروسافت ورد را از روز قبل روي مایآدرس ها •

 یر و اشکال مختلف به کار ميو تصاو  جداول،یگذاري جایکروسافت ورد که براي نرم افزار مایهاالگو  •
 یهاالگوا ي که آديمطمئن شوروز قبل از شروع آموزش .  شوندی نمیصورت خودکار بارگزاره روند ب
 .ديد آنها را نصب کناگر نبودن. انهيانه ها هستند ي رایازتان بر رويمورد ن
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  ی واژه پردازیمبان: ٥٫١ یابيدست
کروسافت يده و متوجه شده است که نرم افزار مايمورد استفاده اند د  را که در سازمانشیينا نرم افزارهايم

 کارکنان سازمان همواره از آنها در داخل و خارج از سازمان ۀرا هميگر نرم افزارها بهتراند زيورد از د
.اموزدين نرم افزار را بيد کار کردن با ايشرفت اش باي پی داند که برایاو م.   کنندیاستفاده م  

تيفعال  

قهي دق٣٠  

 Start> programs>Microsoft Office>Word:  د بهيکروسافت ورد برويدر ما •

o با آن ها شروع به کار کردمدرک ک يجاد يد با اي دارند و بای ابزارها کارکرد مشابهۀهم. 

 .ان شونديرِ آن نماي زینه هايد تا گزيک کنيبرنامه ها کل ۀ پروندیرو
o نه ها مانندين گزين اي از مهم تریشمار :(new), (save), (open)ديني بین پنجره مي را در ا . 

د يد و بتوانين تر رويک سطر پائيد تا به يرا بزن (Enter).  ديپ کنيک سطر تاي را در ینام و آدرس •
 . ديسيآدرس را در چند سطر بنو

 .د تا نام پررنگ شوديرا بزن (B) ۀد و دگمي نام بکشیمکان نما را رو •

o ی را هم میگري دیاجزا. ره کردي و ذخی، شکل ده دادريي، تغ کرد توان اضافهیمتن را م 
 .نمودارر و جدول و يتوان به متن اضافه کرد مانند تصو

o ۀاستواندن، در يرخط کشيو ز، مانند پررنگ کردن، ی قالب بندی لازم برای ابزارهاینشان ها 
 . صفحه قرار دارندیابزارها در بالا

 .ديکنره ي با نام مناسب مطلب ذخیليفاد در ي را که نوشته ایمطلب •

 .ديباز کن file>open را دوباره با رفتن به ليفا •

o ره يره کرد، بهتر آن است که محل ذخيانه ذخي رایرا در هر جامدرک ن ي توان ایاز آنجا که م
 .ديادداشت کني ی جائرا در

 .ديپ کنينا را تاي می شغلی تجربه هاۀفشرد •

o را یرات قالب بندييتمام تغ. ديني ببی دید در سي توانین گونه فشرده ها را مي از اینمونه ا 
 .ديعمال کن اِی چاپۀمطابق نسخ

o بهتر آن است که قبل از نوشتن .  وجود داردی کاری نوشتن تجربه های برای مختلفیروش ها
 .ديق کنيرد تحقي پذیکه سازمان مورد نظرتان م یمدل ۀربارد

 . دي را در نظر داشته باش– مانند نوع خط نوشتار، اندازه، و رنگ -یيرات صفحه آراييتغ •

 .ديره کني را ذخمدرک •

o ن مراحل کار با واژه پرداز استي تریي ان ابتداۀرير و ذخييپ کردن متن، تغين مراحل تايا. 
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 file>exit  اا بيشگر ي صفحه نمای در سمت راست بالاx)( با زدن دگمه د،يبرنامه را ببند •

  .ديشتر به شرکت کنندگان بدهين بي تمری برایزمان کوتاه •
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  ک مدرکي ی و قالب بندیطراح: ٥٫٢ یابيدست
جان زده است چرا که قرار است با خانواده اش به ي هیلي ان خۀک است و او دربارينا نزدي مۀ سالانیمرخص

ک ماه قبل بفرستند تا ي خود را ی مرخصی تا تقاضاها است کارمندانش خواستهۀسازمان از هم .برودسفر 
مش ير مستقي به مدليميبا ا خود را ی مرخصیم دارد تقاضاينا تصميم.  کنندیزيران بتوانند برنامه ريمد

.بفرستد  

تيفعال  

قهي دق٣٠  

        یو روک يکلراست  Word ی رو. دي بروStart>Programs>Microsoft Office به  •
Create Shortcutديک کني کل. 

o آسان تر شدن کار، نشان یبرا. دي وُرد را باز و بسته کنۀد بارها برنامين شما باين تمريدر ا 
 یير برنامه ها و پوشه هاي ساینطور برايهم. م کرديم و ار آن استفاده خواهي سازیانبر را ميم

 ديانبر بسازيد نشان مي توانید، ميکن یکه مرتب از آنها استفاده م

 باز ۀد تا برناميک کنيانبر دوبار کلي نشان میرو. ديشگر بکشاني نماۀ صفحیانبر را بر روينشان م •
 .شود

o ی آنکه رویبه جا Startو   Programsو  Microsoft Office د تا يداگانه انتخاب کنج
 برنامه باز  تاديک کنيانبر کلينشان م یدوبار متناوب بر رود ي توانیمد، يبرنامه را باز کن

 .شود

 .ديسيان نامه را هم بنويد و متن و پايرا پر کنTo, From, Title  یبخش ها •

o  مختلف متفاوت باشدیممکن است در کشورها نامه ی زندگۀفشردشکل نامه ها هم مانند . 

o سفر انتخاب کندی برایالي خی تواند مقصدیهر شرکت کننده م . 

 .ديره کني نامه را ذخFile>Save  یبا رفتن رو •

o ره و ي ذخ":٥٫٤ یابيدر بخش دست. ديره کنيشگر ذخي نماۀ صفحی را بطور موقت رومدرک
 .دي شوی ها آشنا مليفا یي و جابه جایره سازي مختلف ذخی با روش ها" هاليفا یسامانده

 .دينامه را به شکل مناسب در آور •

o  ديبکنچشم نوازتر ا ر متن ی قالب بندیاز ابزارهابا استفاده. 

 .ديره کني را ذخمدرکctrl+s  یک کردن رويبا کل •

o کنندی میي دارند و در زمان صرفه جویادي زۀ استفادیبي ترکیدهايکل . 

 .ديک کنيکلTools>Spelling and Grammar  یرو •

o ح دستور ي تصحی برایح لغات و برخي تصحی برای ابزاری واژه پردازیشتر نرم افزارهايب
 . توان آنها را فعال کردیند که مزبان دار
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o ال با فعّ. گر هم دارنديدمدارک و ل يميا متن یح را برايافزارها امکان تصح ن نرميشتر ايب
 .دينان حاصل کنيد ، اطميپ کرده اي که در آن ابزارها تای متونیکردن آنها از درست

 ی مختلف قالب بندیز ابزارها کنند تا ایسع. ديرين شرکت کنندگان درنظر بگي تمری برایزمان کوتاه •
 .استفاده کنند

o کار برده اند، نشان دهنده  را که بی قالب بندید ابزارهاياز شرکت کنندگان بخواه. 

o  ن هم يريد تا آن را به ساي استفاده کرده از او بخواهیشرفته اي از افراد گروه از ابزار پیکياگر
 .نشان دهد

 .دي را ببندمدرک •

  

  .دي توان دیز مين ی دی س را دررانبُي میدهايز کل ایفهرست: گريع دمناب
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  ک بروشوري یطرّاح: ٥٫٣ یابيدست
در  یي گردهم آی آگهنايرا سازمان مياخ.  مدارک شده استیراستاريمشغول نوشتن و ونا يست که م ایمدت

.  استو حروف استفاده شده از اشکال مختلف اندازه ین آگهي ادر متن. افت کرده استيدر یگريدسازمان 
 یگونه مند چي خواهد ببینا ميم. کادر قرار داردک يگر در يد یبخش است و ی از متن در مرکز آگهیبخش
  . درست کندی مشابهیآگه

تيفعال  

قهي دق٣٠  

 .ديک کنيشگر است دو بار کلي نماۀ صفحی که در رویآگه Training > Word ۀ پوشیرو •

o با برنامه ل يفا. استل يفا یک کردن رويکل نرم افزار دوبار ۀک برناميگر باز کردن يراه د
 . شودی که توسط آن درست شده است، به طور خودکار باز میا

 . ديني مختلف حروف را برگزی رنگها و اندازه ها و مدل های آگهیپس از بررس •

o نکات مهم در کادرآمده اند. داد در مرکز صفحه وپررنگ نوشته شده استيبخش اعلام رو .
 ین آگهين هميما ع. م پرداختي در بخش بعد به آنها خواهقرار گرفته اند ون ر هم در متيتصاو
 .م کردي درست خواهیگريداد دي رویرا برا

•  File > Save Asديره کني را ذخليفاد تا يبرو. 

o Save Asشودی استفاده مليفاگر ي دیا نسخه هايد و ي جدیمدرک ه کردنري ذخی معمولا برا . 

o ن جا ما از يدر اSave Asیرات روييغم تا تيد استفاده کرده اي جدی با نامليفا ۀري ذخی برا 
 . بماندی دست نخورده باقی اصلۀن نسخه انجام شوند و نسخيا

د از ي جدۀ به نام آن ، نسخPlayو با افزودن د يابيب Training > Participant ۀ را در پوشليفا •
 .ديره کنيآن را ذخ

o ۀن که در پنجرييسمت پاکان يا پي فهرست و ی رویوقت  Save In د، تمام يک کني هست کل
ن ي اۀ درباریشتري اطلاعات بیبخش بعد. ديد ديانه را خواهي رای ها و پوشه ها ليفاساختار 

 .ساختار دارد

  را Format > Borders and shading کردن آن ید و پس از کپيمتن درون کادر را انتخاب کن •
 .ديک کنيکل

o امکانات ۀ نکات مهم در باریبرخ. ها را بردارنده يحاشد تا تمام ين بخواهاز شرکت کنندگا 
 .ديان گذارين بخش را با آنان درمي ایقالب بند

 .دي با شکل متفاوت انتخاب کنی اهيحاش •

o ی در بخش قالب بندید؛ و با انتخاب رنگ، پهنا، وانواع خطوط که همگيمتن را انتخاب کن 
 .دي کنیوناگون را بررس گیه قرار دارند، شکل هايحاش

 .ديره کني را ذخليفا •
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o وتر از کار افتاد ي کامپیلي است تا اگر به هر دلی ها رفتار درستليفا مرتب یره سازيذخ
 .ديد از دست ندهي را که اعمال کرده ایراتييتغ

 .ديک کني  را کل Page Borderد و يبروFormat > Borders and Shading یبر رو •

o Page Borderگذاردیه ميمام صفحه حاش تی برا . 

o مختلف کار کنندیه هايد تا با حاشي به افراد بدهیفرصت کوتاه . 

 Align Right, Align  چپ و راستی متنیترازها.  ديان صفحه انتخاب کنيمتن و محل آن را در م •
Leftديازمائي را ب. 

o ابزارها ۀاستوانر  دی قالب بندی لازم براید، انواع ابزارهاي کنی را انتخاب میکه متنيزمان 
. رديگي قرار مAlign Center  ان صفحهي مید که تراز رويد ديمثلا شما خواه.  شوندیده ميد

 .رود ید، متن هم متناسب با آن به سمت چپ ميچنانچه تراز چپ را انتخاب کن

o ده ي شرکت کنندگان محل ترازها را دۀد که هميد مطمئن شوينکه شکل را اصلاح کنيقبل از ا
 .اند

 .ديک کنيکلEdit > Cut  را انتخاب  وی آگهیخ رويزمان و تار •

o ده دانين متن در بريا. ديده اي از متن را برین کار شما تکه ايبا ا  (clipboard) یرار مق 
 .ديز بگذاري نمدرک از یگري دید آن را در جايتوان یرد و شما ميگ

 .ديرا فشار دهEdit > Paste . دي از متن قرار دهیگري دۀ نقطیمکان نما را رو •

 .ديرا بزنEdit > Copy  ۀد و دگميخ و ساعت را دوباره انتخاب کنيتار •

o ديده دان گذاشته اي بری از متن را بر رویکار شما تکه ا نيبا ا. 

 .دي انجام دهیگرين کار را در متن ديدوباره هم •

o دا کننديانبر را پي میدهايد که کلياز شرکت کنندگان بخواه. 

o انبر دارد که يد ميک کلي ید که هر عمليح دهيمثلا توض. دي لازم را به آنها بدهیهاسرنخ
  ctr+vا يدن و ي بریبرا ctrl+xشود مانند يد با هم درست ميب همزمان دو کليمعمولا از ترک

 . چسباندنیبرا

 د يک کنيکلNumbering  یرو. دي انتخاب کنی متن آگهیخ و ساعت را بر رويمکان، تار •

o ک فهرست يجاد ي ایبرا. دهندي مختلف انجام میک عمل را با روش هايفزارها عموما نرم ا
  در ستون ابزارها  Format > Bullets & Numbering ۀ دگمید بر روينواني میبيترت

 .کنند یک کار ميهر دو . ديکن را انتخاب Bullets & Numbering ۀني و گزديفشار ده

ن آنچه ي از بینه ايگزد و ي را بزن(customize)ارش دادن  سفۀ خاص دگمی درست کردن شکلیبرا •
 . ديدر فهرست آمده است انتخاب کن

 .ديره کني را ذخليفا •

o مي آن را حفظ کرده ای اصلۀم، اما نسخي داده ای در متن آگهیاديرات زييگرچه ما تغ. 
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 .ديکروسافت وُرد خارج شوياز م •

 .ديمطالب را مرور کن •

o کروسافت يم، اما نرم افزار ماي متن را آموخته ایراستاري و و اصلاحین بخش روش هايدر ا
 د کرد؟ي آموختن آنها چه بایبرا. ار کاربر گذاشته استيز در اختي نیگري دیورد ابزارها

 :ن پرسش ها آسانتر خواهد شديد پاسخ دادن به اي به شرکت کنندگان بدهیاگر سرنخ هائ 

 .یانتخاب فهرست یها نهيگز انتخاب د؟ بايدا کنيانبر را پي میدهايد کليچطور توانست •

 آمده ی از ابزارهاید؟ با بهره جوئياد گرفتيه زدن ها را يه ها و ساير دادن حاشييچطور تغ •
 .یدر فهرست اصل

 فهرست ی ابزارهایک رويد؟ با کليرا چگونه کشف کرد  (Bullets)اه نقطه هايفهرست س •
 .یاصل

 از یگري دۀادتان باشد که نسخي.  مختلف استیرهان کردن ابزايگرفتن، تمر ادين راه يبهتر •
 .دي نباشی اصلليفاا به هم خوردن يد تا نگران از دست رفتن و ي درست کنليفا

. موجود استی دی سیانبر روي میدهايفهرست کل: منابع افزوده  
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   هاليفا یره کردن و ساماندهيذخ: ٥٫٤ یابيدست
ره و ي ها را ذخليفا یاز جمله ورد کار کرده است و به راحت گوناگون ینا با نرم افزارهاين مدت ميدر ا
 را یجه زمان قابل توجهيو در نتاست ره کرده ي را کجا ذخليفا کند ی فراموش میاما گاه. ند کی میابيباز

.  کندیم داکردن اشيصرف پ  

تيفعال  

قهي دق٣٠  

 .ديک کنيشگراست دوبار کلي نماۀ صفحی که روی آموزشۀ پوشیرو •

o ن پوشه در چه يد که ايني صفحه ببی ستون آدرس بالایاز رو. انبر استيک مي یزشآمو ۀپوش
 . قرار داردیمکان

o  ليفا ۀن پوشه هستند و هميد در همين بخش از آن ها استفاده کرده اي که در ایي هاليفاتمام 
 .ره شده اندين جا ذخيز در هميد ني را که با آنها کار کرده ایيها

 . در آنهاستیي هاليفاد چه يني ببود يک کني تک تک پوشه ها کلیرو •

o دا يچگونه آنها را پ. ديدا کنيد پيگر با آنها کار کرده اي را که در جلسات دیي هاليفاد ي کنیسع
 :دير آغاز کني زید؟  بحث را با اشاره به نکته هاي کنیم

 .ديره کرده اي ذخی خاصۀآتها را در پوش 

ز ي مخصوص شرکت کنند گان نۀد که پوشيابيد دري توانی ها ملي فا ساختاریاز رو 
 .وجود دارد

o یچطور م. ديره کنيتان را ذخي هاليفان ي معیک جايشه در ين است که همين روش ايبهتر 
 ؟رددا کي گم شده را پليفاک يتوان 

 .ديک کنيا پوشه کلي و ليفاافتن ي یبرا Start > Search یرو •

o وجود دارد؟ل يفاک يدن دا کري پی برایيد چه راه هاي کنیبا هم بررس 

o  دي آغاز کنی آموزشۀ را با باز کردن پوشليفاک يافتن يکار. 

که  یليفا ی ها را در جستجوليفا پوشه ها و ۀاب هميواژه . ديرا بزن (search)اب يد واژه يکل •
 .  گرددید ميعنوانش را نوشته ا

o یقه براي از چند دقد و پسي بپردازیگريد به کار دي توانیبرد مبار ياگر جسنجو زمان بس 
 .ديگرداب بري کار به واژه ۀجي از نتیآگاه

 .دي را باز کنی آموزشۀپوش •

o گر را ي دید؟ راه هاي دانیدن آنها مي چی برای شده اند؟ را ه بهتری ها چطور سامان دهليفا
 .خي تاری از رو- مانند-ديشنهاد کنيپ
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o ی تازه اۀن، پوشيبنابرا. ديم کنيخ جلسات تنظين پوشه را براساس تاريد اي خواهید ميفرض کن 
 .ديمرتبشان کند و ي ها را در آن بگذارليفا ید و کپيباز کن

نام پوشه را به . ديک کني  کل< Newليفا اسم ید و بعد رويک راست کني کلی آموزشۀ  پوشیرو •
 .ديخ امروز عوض کنيتار

o ديکل.  اسمشان عوض کردیک رويکلراست  توان با یشه مي ها را هم ها و پوشهليفا یاسام-- 
Fن کار  استيانبر ايم ٢. 

 . باز شودیدي جدۀد تا پنجريک کني دوبار کلی آموزشۀ پوشیرو •

o ن دو پنجره که کنار هم باز هستند آسان تر استي پرونده ها بیيجابه جا. 

    Training>Date folder  به  راآن د وي راانتخاب کنیليفاTraining>Word Folder  از •
 .   ديبکش

o دي را عوض کرده اليفاک ي ین کار شما جايبا ا. 

o کرد و در هر یکپ  توانیز مي ها را نليفا وُرد، ۀو چسباندن در برنامکردن  یدرست مثل کپ 
 .د چسبانديل باشي که مایپوشه ا

o  ها را جا به جا کنندليفاشرکت کنندگان . 

  نامش یخ امروز در ابتداي را با افزودن تاریکيد و نام ينکک يکلراست  جا شده  جا بهی هاليفا یرو •
خ پس از يگر را با گذاشتن تاري دیکيو ) filename.doc ٠٦/٢٤/١٣: به عنوان مثال( د يعوض کن

 )doc.filename٠٦/٢٤/١٣:  به عنوان مثال( نام 

o یب الفبائيشماره و سپس به ترتن پوشه چطور سامان گرفته اند؟ نخست بر اساس ي ای هاليفا. 

 .دي ها و پوشه ها گفت و گو کنليفا ی ساماندهۀدربار •

o توان از ید؟ چگونه مي کنی میروي پی مرتب کردن کارها از چه روشی برای واقعیدر زندگ  
 انه بهره برد؟ي رای منظم کردن کارهاین روش برايهم

o ک رنگيد با يکن ی می واقعیدگ مرتب کردن در زنی را که برایي تخته فهرست کارهایرو 
 : نمونهیبرا. انهي رایاي از روش برابربا آن روشها اما در دنیگر فهرستيد و با رنگ ديسيبنو

 . خود را دارندیمثلا کارد و چنگال جا. ميکن ی می نگهدارینيرا در محل معء اياش 

 . خودشان باشندۀ در پوشی آموزشی هاليفا •

مثل . مي خود برگردانی و پس از استفاده به جامي خود نگه داری را در جاءاياش 
 . برگردان کتاب به کتابخانه

 ید پس از پابان کارتان اگر لازم مي داری برمیليفا ی آموزشۀاگر از پوش •
 ی آموزشۀد و سپس آن را به پوشي مختلف منتقلشان کنید به جاهايدان

  .ديبرگردان
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ر، جداول، و الگوهايتصاو: ٥٫٥ یابيدست  
ن يا. انگذاران پخش کرده استين بني دارد که آنها را بیمي قدیک بروشور دو صفحه اينا يمسازمان 

.  را به روز کندمدرکن ي خواهد ایسازمان م. ستيه شده و مطالب اش چندان تازه نيش تهيبروشور سالها پ
  .رات را انجام دهديين تغي ا خودشل استينا مايم

تيفعال  

قهي دق٣٠  

 .ديک کني است دوبار کلی  آموزشۀ که در پوشی آکهليفا ۀ نمونیرو •

o ز به شش بخش ي دارد و هر صفحه نی صفحه جایمطالب بر هر دو رو. ديصفحه را مرور کن
 . شودیل مي تبدی کوچکۀم به دفترچياگر آن را تا کن.  م شده استيتقس

o ۀفحک صين چاپتان امکانش را دارد در يا اگر ماشيا در دوصفحه و ي د،يصفحه را چاپ کن 
 .پشت و رو

  مدل هاۀني گز My Computerیرو. دي باز کنیدي جدۀد تا صفحي برو File > Folder یرو •
 .دي انتخاب کن را(Templates)الگوها 

o مورد علاقه است از آن جمله فکس و برچسب ی از قالب هایاري بسیکروسافت ورد دارايما 
 . ی پستی نامه هایبرا

o  قالب Brochureر را د Publicationsديانتخاب کن. 

o تواند کار شما را آسان کند ید که  مي را داری از بروشوریاکنون شما نمونه ا . 

 .ديره کنيد و آن را ذخياوري تازه بمدرکش را در ي از هدف هاینام سازمان تان و مختصر •

o د که در ي کنیعکسن ي مناسب کارها و اهداف سازمان خود را جانشیريد تصوي توانیم
 . وشور آمده استبر

 .دي عکس بروشور را پاک کن(delete) ۀک کردن دگميبا کل •

 .دي را انتخاب کنیکير موجود ين تصاوياز ب Insert > Picture > From Fileدر  •

د ينيت اش را ببيفيد تا کي را انتخاب کن Format Pictureد و سپسيک کنيکلراست ر ي تصوی بر رو •
 . ديرش دهييد تغيو اگر خواست

o ک بر ي کلباLayoutدير در متن را انتخاب کني گذاشتن تصوی جا . 

 .دير دهيير را تغي تصوۀا خارج اندازيدن آن به داخل و ير و کشي تصوۀک کردن بر گوشيبا کل •

o  .دن اضلاع، ي دارد اما با کشی عکس تناسب ها را دست نخورده نگه مۀدن گوشير با کشييتغ
 .دينيد و تفاوت را ببيش کني دو را آزماهر.  خورندین به هم ميشي پی هاتناسب

.  ديپ کنيرا تا" برنامه ها و خدمات " " ميک بروشور بسازيچطور  "یدر قسمت چپ بروشور به جا •
 . ديسي کند بنوی را که سازمان شما ارائه میسه نوع خدمت
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o ن را  شود تا متی تا می در چه جاهائین آگهيد که اين کنييقبل از وارد کردن متن، نخست  تع
 .دي بگذارید در آگهي خواهی که میآن گونه و با ابعاد

خ را ي تارۀد و در آن واژينيرا برگز" مي کنی را سفارشین آگهيچطور ا" بخش ی آگهی درونۀدر صفح •
 .ديپ کنيتا

o د که معرّف مراحل رشد سازمان باشدين بخش درست کني در ایجدول. 

 .ديف و سه ستون درست کنيبا دو رد ی جدولTable > Insert > Tableیک بر رويبا کل •

o که از خدمات یش تعداد کسانيز افزاي سازمان و نۀ بودجۀش سالاني تواند افزاین جدول ميا 
 . سازمان بهره برده اند نشان دهد

ف دوّم نمونه يد و در رديسياز خدمات سازمان را بنوان يبهره جوف اول سال ، بودجه، و تعداد يدر رد •
 .  از داده هایا

 ی برایشتري بیف هايد تامکان نما خود به خود رديبزنtab د ي کلیف دوّم روي سمت آخر رددر •
 . شتر باز کندي بیگنجاندن داده ها

 .ديک کني کل Table > Table Auto Formatیرو •

o Auto Format ی شروع مۀبه عنوان نقط.  کندی ارائه مليفا انتخاب شکل ینه برايچند گز 
 .ديفاده کنن شکل استيد از هميتوان

 .دين کنيکروسافت وُرد تمري مامدرکک ير را در يکار کردن با جداول و تصاو •

 .دياز ورد خارج شو •

 .یبحث و بررس •

o یانه اي رای از کار کردن با نرم افزارهایگريما علاوه بر آموختن واژه پردازها ، به نکات د 
 خود ی و حرفه ای شخصیرهان ابزار و امکانات در کاي از  ایيچه استفاده ها. ميز پرداختين

  د کرد؟يخواه
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یصفحات جداول محاسبات: ٦ یابيدست  
 اهداف

 .ی صفحات جداول محاسباتی برنامه هاۀدربار یاصلآموختن نکات  •

 ی جداول محاسباتیامکانات برنامه ها یادگرفتن و بررسي •

  م و ابزارهايمفاه

ن برنامه ها داده يا.  اندی صفحات محاسبات جدولی ها، برنامهی دفترداری برایار مهم کاربردي بسی از ابزارهایکي
 یين برنامه هايافزون بر آن با کمک چن.  کنندیل مي تبدی قابل فهم اطلاعاتیرها و متن هاي را به تصوی عددیها
  . ز کردين ی، و نموداری، ساماندهی توان اعداد و داده ها را طبقه بندیم

 توان در برنامه ی را مین صفحات جدولي از ایبرخ.  در دسترس اندیادي زی صفحات جداول محاسباتیبرنامه ها
ن در ي توان آنلایگر را مي دیصب کرد و برخ  نMicrosoft Excel, Open Office Calc  مانند یانه اي رایها

انه ها از يشتر راياز آنجاکه ب. گذاشتZoho Sheet  و Google Spreadsheet مانند یگري دیبرنامه ها
 ی خوبینترتنتياگر ارتباط ا. مي کنین جلسه از همان برنامه استفاده مي کنند ماهم در ایفت اکسل استفاده مکروسايما
  .ديد استفاده کني توانیهم م ني آنلاۀک برناميد، از يدار

  لگري تسهیآمادگ

د يومطمئن ش.  مرتب و قابل فهم باشدین سادگيد که در عيش درست کني را از پی جداول محاسباتۀک صفحي •
 .که قابل چاپ کردن هم هست

  . کار باشندۀد تا آمادي کارگاه بگذاریانه هاي رایآنها را رو. موجودند ی دیدر س اکسل ی هاليفا ینمونه ها
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  ی صفحات جداول محاسباتیهايژگيو: ٦٫١ یابيدست
در  ديکارمند جد. ک کند است کمیر مالي گرفته تا به او که مدیار ماليک دستيکند، ي که سارا در آن کار میسازمان
 صفحات جداول ۀک برناميست و تا به حال با يانه ها وارد نياد به رايار ماهر است اما زيات بسياضي و ریحسابدار
 یچه احساس بد. ن برنامه ها را بلد نبودي که کار با ایاد خودش افتاد هنگاميسارا .  هم کار نکرده استیمحاسبات

  . غ نکندي داند به او دریمان بسته است که در آموختن آنچه مين رو با خودش پيهماز . ديداشت و چه قدر آزار د

تيفعال  

قهي دق٣٠  

 .دي  بروStart > Programs > Microsoft Office > Excelبه  •

o در ی وجود دارند اما همگین گونه جداول محاسباتي کار کردن با ای برای متعددیبرنامه ها 
ف و ستون ي درست شده اند که ردین برنامه ها از صفحاتي اۀهم.  مشترک اندیديچند اصل کل

 ی خاص به محاسبات میرند و با استفاده از فورمول هاي گی میداده ها در سلول ها جا. دارند
 . پردازند

 . شودیش داده مين سلول صفحه نماين عدد در اوليا. ديرا بزنenter د و يپ کني را انتخاب و تایعدد •

o در هر . ن صفحه بزرگ درست شده اندي از چندیحات جداول محاسبات صفی برنامه هاتمام
در .  شده اندیها با حروف الفبا نام گذاراستوانه ف ها با اعداد و ين صفحات رديک از اي

 .  شوندین صفحات داده ها گنجانده مي ایسلولها

 یعدد پاک م. دين را بزDelete د وي در آن است بروی که عددیبا استفاده از نمابر به درون سلول •
د ين عمل ضرب را در سلول خواهيپاسخ ا. دي را بزنenter د ويپ کنيرا تا=  ٦٤*٢٣آنگاه . شود
 .ديد

o دست زندیاضي خاص به محاسبه ری تواند با فورمول هایاکسل م  . 

 .دين عدد محاسبه شده را پاک کنيا •

در . ديسيخانوار را بنو ۀدجبو) ١ف ي  و رد B، ستون (cell B١:یعنيف بالا، ستون دوّم يدر رد •
 ،(cell C٢)  د و درستون راستي را وارد کنیطبقه بند)  cell B٢(ن تر، در ستون چپ  يف پائيرد

   (cell B١٠)ن تر از آنييف پايد و هفت رديدرآمد را وارد کن) cell B٣ (یف بعديرد در . مبلغ را
 .نه ها رايهز

 .ديره کني را ذخليفاFile > Save  یک کردن رويبا کل •

o د تا به علت ييره نمايد، به تناوب آن را ذخيکن ی کار مليفاک ي ی روید که وقتيتوجه داشته باش
 .د از دست نرودي گوناگون آن چه نوشته ایها

o Ctrl+sد بدون قطع روال ي توانیبعد از چند بار استفاده م.  استیره سازي ذخیانبر برايد مي کل
 .ديره کني را ذخليفاکارتان به سرعت 

 .ديپ کني اجاره را تا، و درآمدید کشاورزيحقوق، عوادرآمدها،  ۀر طبقيز •
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 ،)ت دکتر، دارويزيو( ، خوار و بار، درمان و بهداشت )د کتابيه، خريشهر( ل يتحص  ینه هايهز •
 عنوان ريرا  ز) نير ماشين، اتوبوس، مترو، تعميبنز(اب و ذهاب ي، و ا)لمي فۀنما، اجاريس( ح يتفر
 .ديسي بنونه هايهز

o رون نزده يد که کلمات از ستون ها بينه ها توجه کنيقبل از وارد کردن مبلغ درآمدها و هز
 .باشند

م ي ستون را تنظۀدن آن، اندازيد و با کشيکند بگذار ی که دو ستون را جدا می خطیمکان نما را رو •
 .ديکن

o ر داديين روش تغي هما توان بیزميف و ستون را ني ردیاندازه ها. 

 .ديپ کنينه ها را در ستون مبالغ تايلغ درآمدها و هزمب •

o دياما جمع کل را ندار.دي دانی هر گروه را مۀاکنون بودج. 

 .دهد ی را نشان میريد آن ستون چه مقاديد، تا بدانيپ کني جمع کل را تاۀ کلمیدر ستون دسته بند •

o  صفحه ی بالادربا حرکت دادن ماوس Auto sumکه یپنجره ا. دينک کيدا و آن را کلي را پ 
 . دهدیح مين باره توضي شود در ایباز م

o رودی مجاور هم به کار میف هاي جمع بستن مبالغ ستون ها و ردی جمع براۀدگم . 

 .ديره کنين صفحه را ذخيا. ديبکن کار را ني همزين مخارج یبرا •

o دي درآمد بعد از احتساب مخارج را دۀماندي توان باقیاکنون م. 

 .ديپ کني را تایدر ستون مقدار علامت تساو. دي را بگذاری، جمع بندینددر ستون دسته ب •

o ی در آن نوشته خواهد شد و نه داده این است که فرمولي ایايک سلول گوي دریعلامت تساو. 

 جمع کل یرو. ديپ کنيرا در آن تا) - ( علامت منها. ديک کني که جمع کل درآمد را دارد کلی سلولیرو •
 .ديرا بزنenter و  ديک کنيکلمخارج 

o نه هاستي هزی درآمدها منهایاين سلول گويا. 

 .دينيطور کامل ببه  صفحه بی را در بالایيد تا فرمول نهاي سلول بگذاریدوباره مکان نما را رو •

o ري سال را خید اما کل آن در انتهايدان ی آخر ماه را مۀمانديمقدار باق. 

 .ديد و مبلغ را حساب کنيسي را بنوتراز سالانه، مخارجف ي ردیدر انتها •

 . م استي تقسیبرا/  ضرب و علامت یبرا* علامت : نکته •

د يکنک يراست کل . از قلم افتاده است-ه صرف شدهيري خی کارهای که برای مبالغ- نه هاي از هزیبخش •
 . وارد کردن راۀو دگم

o راست. ديف سمت چپ صفحه، انتخاب کني ردۀ شماریک کردن رويکل را با کل ف جمعيرد 
 . ديک و وارد کنيکل
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 . وه وارد کردين شي توان با همیف و ستون هر دو را ميرد •

 .ديد و مبلغ آن را وارد کنيه را بزنيري مخارج خۀطبق •

 شود و طراز یز ميه نيري خینه هايمخارج کل شامل هز. کند یاکسل تمام فرمولها را دوباره محاسبه م •
 .ن خواهد شديي مبلغ محاسبه شده تعیکل بر مبنا

 .کنديک طبقه خود به خود تمام محاسبات را به روز ميا افزودن و کاستن مبلغ يف يک رديحذف  •

o گذارندینه ها اثر ميد چگونه بر درآمدها و هزينيد تا ببير دهيير مبالغ را تغيسا  . 

o ديره کني خانوار را ذخۀج بودۀصفح . 

o دياکسل را ببند. 

 



٥٣ 
 

محاسبات ساده: ٦٫٢ یابيدست  
.  اکسل درست کندۀ نفر کارمند دارد با برنام٣٠ارد تا فهرست پرداخت حقوق سازمان را که سارا در نظر د

 خود هم آموزش دهد که چطور از ۀار تازين برنامه، به دستي خواهد همزمان با درست کردن ایاو م
قد است سارا معت.  فهرست حقوق کارمندان سازمان استفاده کنندۀي تهی برای محاسباتۀش ساختي پیابزارها
 ی هدف های مشابه برای جداول محاسباتۀک صفحي ساختن ی لازم را برایار او توانمنديکار دست نيکه با ا

  . گر به دست خواهد آورديد

  تيفعال

قهي دق٣٠  

ات وشکل  يمحتو. ديفشار ده دوبار  Payroll.xlsید و رويکنمرور را   Training > Excelۀپوش •
 .دي کنیصفحه را بررس

o ی ستون هاۀداده ها را در هم. ديد شما پر کنيگر را باي دیولها پر شده اند و برخ از سلیبرخ 
 .  ستون جمع کلید، به استثنايپرنشده بگذار

 . ديدا کنيا، جمع کل ستون اول را پيبا جمع کردن حقوق و مزا •

o ) =یبرا.) ديک کنيا کلين سلول مزاي اولیرو) + (د يک کنين سلول حقوق کلي اولیرو 
 ".ی صفحات جداول محاسباتی هایژگيو": ٦٫١ یابيدست: د بهيدن فورمول نگاه کنقراردا

 .دير بچسباني زید و در تمام سلولهاي کنیسلول جمع کل را کپ •

o ک ي سلول یبه عنوان مثال، رو.  کردن و چسباندن وجود داردی کپی برای مختلفیروش ها
 . دين بچسبانييد و در چند سلول پاينيرا برگز" یکپ"د، يک کنيراست کل

o د استيانبر صفحه کلي میدهايگرکاربرد کليراه د .Ctrl+C کانيد وپيرا بزن shift + down 
 .دي را بزنctrl+vد انتخاب شد ي خواهی آنچه میوقت. ديرا نگاه دار

o ديد و در کاربرد دوم فقط از صفحه کليد از ماوس استفاده کني توانیدر کاربرد اول فقط م . 

 .دي از سلولها را مرور کنی برخی محاسباتیفرمولها •

o هر یاما خود برنامه سلولها. دي کرده ای کل کپیر جمع هاي سایفورمول سلول اول را برا 
 .کند یسطر را محاسبه م

 داده ها یدر طبقه بند. ديرا انتخاب کنFormat Cells بعد . ديک کنيکلراست ن سلول ي نخستیبر رو •
 .دينين نوع را برگزياول

o  خ ي تارۀي مثال محاسبه بر پایبرا.  کردی توان قالب بندی مختلف میبه شکل هاداده ها را
 ٤ ی اولۀجينت .ستمتفاوت ا) ريال١٥+ ٢٠(  یبا محاسبه براساس واحد پول) ٢٠+ اوت١٥(

 . است٣٥ ی دومۀجيو نتسپتامبر 

ن  در ستو(Format Painter) نقاش قالب ۀ دگمی شدند بر روی که داده ها قالب بندیهنگام •
 .دير را انتخاب و رنگ کني زینه هايتمام زم. ديک کنيابزارها کل
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o  ک سلول را ي ی قالب بندینقاش قالب. ديخ محور داري تارۀ شدیک سلول قالب بنديشما اکنون
 .  چسباندی متعدد می کند و در سلول های میکپ

o واهد کرد سلول را عوض خیده شد قالب بندي سلول مجاور چسبی به خطا رویاگر قالب بند .
 .(ctrl+z): ان بر استي میدهايک راه اصلاح خطا استفاده کردن از کلي

o قالب یج محلي پول راۀي را برپای جمع بندی کارمندان و سلول هایايفهرست حقوق و مزا 
 . دي کنیبند

اکسل خود به خود . ديني پول محور را برگزیخ محور قالب بندي تاری همانند قالب بند •
 که معرف ین نماد را به گونه ايا.  کندیبه عنوان نماد پول انتخاب منه را ين گزياول

 . دير دهيي باشد تغیپول محل

o ره کرده اندي ذخیادآوري شان را بدون ليفاد چند نفر از شرکت کنندگان ينيبب. 

o رگول ي وۀ دگمید و سپس رويک کنين سلول پول کلي اولیرو)، .( 

 ی اعشاریرقم ها. ندسرراست اا يحقوق ها و مزامبلغ .  شده استینه قالب بندياکنون زم •
 . ديرا پاک کن

o ۀمگــ دیار روـوب د رار داردــوق قــول حق سلــی که صـفحـه نمـا رویـالدر ح     
Decrease Decimalديک کني کلهار جعبه ابزار د. 

،  متنی، ترازی اعشاریرند، مانند عددهاي گیوسته مورد استفاده قرار مي که پیيدگمه ها •
 .  واقع شده اندها، در ستون ابزاریو جمع بند

o ديا، و جمع کل بچسباني حقوق و مزاید و به سلولهاي کنی راکپی قبلیقالب بند. 

• Ctrl+cد سپسي شوند نگه داری که قرار است کپی سلول هائی را بر روctrl+vی را رو 
 . دي ها هستند بزنی گرفتن کپۀ که آمادیيسلول ها

 . د بزرگتر شودين ستون بايابعاد ا. ک بودن ستون استنشان کوچ##  علامت  •

o م ي ستون را بطور خودکار تنظۀاکسل انداز. ديک کنين ستونها کليب یمرز خطوط یدوبار رو
 .کند یم

ک يراست کل. ديني برگزیک کردن نشان الفبائين است که کل ستون را با کليگر ايراه د •
ده ي مطلب دۀد که همين کنيي تعیرا طور و پهنا (Column Width) ستون ید بر پهنايکن

 .  شود

o ن کنندي تمری قالب بندیر ابزارهايد تا با ساي به شرکت کنندگان بدهیزمان کوتاه. 

o دي  حقوق ها استفاده کنۀ هم از صفحی بعدین هاي تمریبرا. 

o ا  خود ری کارهاۀجيد چند نفر از شرکت کنندگان نتيدا کنين پين تمريان دادن به ايقبل از پا
 یشان را از رويد دستهايجاد تحرک در کلاس از همه خواهش کني ایبرا. ره کرده انديذخ

چه وقت د که يد که برق رفته و از هر شرکت کننده بپرسيسپس اعلام کن. د بردارنديصفحه کل
 .  استره کرده بودهي را ذخليفا
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  یم جداول محاسباتي و تنظیجداساز: ٦٫٣ یابيدست
تنها در ماه گذشته پنج نفر به کارکنان آن افزوده شده . قابل توجه داشته استیذشته رشدسازمان در سال گ

از آنجا که سارا سالهاست به .  حقوق و دستمزد اضافه شودۀد به برنامياطلاعات مربوط به حقوقشان با. اند
ار را انجام دهد، داند اگرخودش ک یاما م.نکار راانجام دهد ي تواند ای مین کار مشغول است، به آسانيا

م گرفته اند که با يجه آن دو تصميدر نت.  کندیدا نمين کار پين اي انجام و تمری براید فرصتيار جديدست
. از خواهند داشتي نیشتريگر کار را انجام دهند گرچه به زمان بيکدي یهمکار  

تيفعال  

قهي دق٣٠  

 .دي وارد برنامه کننام و شرح حالشان را. وسته انديد به سازمان پيپنج همکار جد •

o جه ي شوند و در نتید، سر لوح ها از صفحه خارج ميکنيد را اضافه مينطور که افراد جديهم
 . شودینه ها دشوار ميدا کردن زميپ

 فشار  Window> Freeze Panesید و رويف سرلوح را انتخاب کني پس از ردیف هاي ردۀهم •
 .ديده

o گوناگون  ینه هاي که زمیشود به خصوص وقت یده ميماند و د ین کار سرلوح ثابت ميبا ا 
 .ابندي یداده ها گسترش م

 . ديف ها را تا آخر نگاه کني ردۀن کار همي آگاه شدن از آثار ایبرا •

 .ديک کني کل Window >Unfreeze Panesیرو •

o ف و هم نام کارمندان قابل يد تا هم سرلوح ردي و ستون نام هارا ثابت نگه داریف بالائيرد
 .  نددن باشيد

 .ديک کنيکل Window > Freeze panes یز روير سلول سر لوح و نين تقاطع در زي اولیرو •

 .کند یمت ي و ستون نام ها را تثبیف بالائي محاسبات ردۀ صفح •

 کارمندان کارت ۀ همیرد برايگ یم مي تصمیبخش مال. ک نام اندي یدو نفر از کارمندان سازمان دارا •
 . د پرداخت حقوق ها آسانتر شود صادر کند تا فراگریشناسائ

 ید به عنوان کارت شناسائيک ستون اضافه کني اش در سازمان یخ آغاز همکارين نام کارمند و تاريب •
(identity card)  . 

o خ استخدام منظم  شونديب و بر اساس تاريد به ترتي بای شناسیکارت ها  . 

ب يخ استخدام را با حفظ ترتي تارۀني زم شودی که باز میدر پنچره ا. ديک کني کلData > Sortیرو •
 .دياستخدام انتخاب کن

 .انتخاب شده استMy data range has header row د که يمطمئن شو •

o برگشت به عقب ۀدگم ctrl+zتواند بلافاصله خطا را حذف کندیشه مي هم  . . 
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 . دي صادر کنیک کارت شناسائيک از کارمندان ي هر یبرا •

o از عدد و رمز یبيا ترکي . . .) ٣، ٢، ١(  خاص باشد یمل عدد تواند شاین کارت ميا 
 (WLP٠٠١):  به عنوان مثال. سازمان

o  با استفاده از جداگر (filter)در یزيچند نفر مسئول برنامه رد يدا کني داده ها، پۀ در صفح 
 .    سازمان اند

 .ديک کني کلData > Filter >Auto Filter ید و روين داده ها بگذاريمکان نما را ب •

o ن فهرست جدا کردن يا.  فهرست وجود داردیکان برايک پي سرلوح ی تمام سلولهایدر بالا
 دهد ی به شما امکان میجداساز.  کندی گوناگون ممکن میداده ها را بر اساس ملاک ها

 . دينيد ببي کنی که خودتان انتخاب می از داده ها را بر اساس ملاکیبخش

 . ديني را برگزیزيمسئول برنامه ر. ديک کنيون عنوان ها کل ستیکان در انتهاي پیرو •

o مختص مسئولان برنامه یف هاي ردی کند به استثنای میف ها را مخفي ردۀن صفحه هميا 
 .  رایزير

 .ف ها به قالب نخست خود برگردندي ردۀد تا هميرا بزنSelect All . ديک کنيکان دوباره کلي پیرو •

o شود امکان جداکردن ی که باز میره اجپن. اده ها در حرکت استن دو نوع نگاه به ديجداگر ب 
  کند ی گوناگون را فراهم مینه هايزم

  . استراحتی اندک برایفرصت •
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  ی و چاپ صفحات جداول محاسباتیقالب بند: ٦٫٤ یابيدست

ن بخش در قالب صفحات يشتر اطلاعات ايب . سازمان استی مسئول تمام امور مالیبخش مال
ن صفحات هنگام چاپ شدن، ي اوقات ایافته که بعضيسارا به تجربه در . استیتباجداول محاس

 خواهد یاو م.  شوندیم چاپ مينيب یانه ميشگر راي نمای متفاوت از آنچه رویبه شکل
.دا کندينان پيبل از چاپ، اطمق چاپ صفحه ۀوحن موضوع واقف شود و از نيارش هم به ايدست  
تيفعال  

قهي دق٣٠  

 .دي باز کنی دیسق نمونه را در  حقوليفادو  •

o ديسه کنيرا مقا د و آنهاييازمايب  رایامکانات مختلف قالب بند .File > Print   Review  را 
 .دي قبل از چاپ را مرور کنۀنموند و يبزن

o کند یش مناسب صفحات اعداد را خوانا تر مي نماۀنحو. 

 . نشدهیگري شده و دی قالب بندیکي. ديسه کني را با هم مقاليفادو  •

o ره؟يرامون و غيد؟ در رنگ، پيني بین دو صفحه مين اي بیا تفاوتيآ 

 صفحه ی بالاFont Size  حروف را با استفاده از ابزارۀانداز. ديف سرلوح را انتخاب کنيکل رد •
ر ييد تغيرنگ حروف را به سف .دي انتخاب کنیگريد و رنگ ديبزنFill Color  یرو .ديبزرگ کن

 . ديده

o ز خواهد شديه داده ها متماي بقسرلوحه از. 

 .ديني از آن ها را برگزیکيد و ي  را باز کن(borders)ها ه يحاش ۀنيد و گزيتمام جدول را انتخاب کن •

o دي کادرها دوباره شروع کنۀد با حذف همي توانی رخ دهد می که خطائیدر صورت. 

 .ديني ببید تا نمونه ايک کني کلFile > Print Preview  یرو •

o ن ي اۀحوند ي توانیشما م.  شودیم و سپس چاپ ميفحه بزرگ باشد به چند بخش تقساگر ص
 .ديم کنيرا تنظ شدن ميتقس

o ن يچن.  کارمندان سازمان استۀدن فهرست کامل هميل به دي سازمان مای از اعضایکي
 .ديش چاپ کني کارمندان برایايزان حقوق و مزاي را با حذف میفهرست

•  Print Preview ی روسپسد يب کنرا انتخا View > Page Break Previewدي بزن. 

o شودی نشان داده می آبۀبخش قابل چاپ با هال . 

 . ديببر وستن به سازمانيخ پي چاپ را تا تارۀ صفحیکادر آب •

  اندمتصلبه هم اگر چاپگرها .ديني خوهد شد ببپچاد تا آن چه را ي  بروFile<Print Previewبه     •
 . د که از چاپگر استفاده کنديه بخواهک شرکت کننديتنها از 
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ش داده ي نماید تا به حالت قبليبرو View > Normalیرو. ديرا ببند Print Preview ۀپنجر •
 .شود

o چاپ ۀه برگردانده شده اما چاپگر هنوز آمادير به حالت اوليد که گرچه تصويتوجه داشته باش 
 . ر کوتاه تر استيتصو

 .دي اکسل را ببند •

o  ره کند؟ي ذخش رايل هاي است فا فراموش کردهیا کسيد آينيببقبل از بستن  
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   نينو یها وموضوع ها یفناور: ٧یابيدست
 ی را رائه مینيم نوير است و مرتب ابزارها و مفاهييست که هر روز در حال تحول و تغي حوزه ایفناور
آمده است که به  ني نویها و موضوع هايورافن تحت عنوان ین رهنمود، قسمتيدر هر سه بخش ا. کند

. پردازدی ارائه شده میهايوران فني آخریمعرف  

 اهداف

 .بان از داده هاي پشتۀ نسخۀي و تهیره سازيت ذخيد بر اهميتاک •

 .ليميافت و ارسال ايمن در دريفراگرفتن رفتار درست و ا •

 .عي سریام رسانيبه منظور پل يمي ا کاربردیروش ها •

  

م و ابزاريمفاه  

 تمام یدر اثر سانحه ا. کار شما با آن داردۀانه، بسته به نحوي اطلاعات در رایمنيان ازي از میبخش عمده ا
ل يمياز ا ديه کرده باشيبان تهي پشتۀاما اگر شما بطور مرتب نسخ. د رویمانه از دست ي رایاطلاعات رو

شما ل يمياصندوق  ی توانند تمام فضایل ها ميمين گونه ايا. ديد دي نخواهیب چندانيس آ(spam)  مزاحم یها
د و با وسواس هرزنامه ها را نشان ياما اگر در گشودن و انتخاب نامه ها دقت به خرج ده. را اشغال کنند

ژه ي که به ویوبگاه هائ. د کرفت و از تعداد آنها کاسته خواهد شديد، کنترل امور را بدست خواهي کنیگذار
به  ني آنلای نام و ظاهرشان و در قالب فروشنده هارييوسته با تغي مزاحم اند پیل هايميدر کار ارسال ا

ت و يري مشغول اند، تنها با روش درست مدیکيغات الکترونيانباشتن صندوق ها و ارسال نامه ها و تبل
  . اثر خواهند شدیکنترل شما، ب

از . ددا کرده اني پیاديع و آسان و ارزان، رونق زيل کاربرد سريدله  بی فوریام هاي گپ و پیبرنامه ها
.  ن برنامه ها شرکت کنندي خواهند که مرتبا در ایاز کارمندان خود م  از سازمان هایارين رو بسيهم

 از آن ین دوره آموزشيو در ااند  گپ ی برنامه هایاهو همگيپ، و يکروسافت، اسکاي گوگل، مایبرنامه ها
  . دي کنیجوئر برنامه ها هم بهره يد از ساي توانیاما، شمام. ميکن یها استفاده م

لگري تسهیآمادگ  

د آنها را به دانش يد تا بتواني خود نگه داری صندوق پستۀ هرزنامۀ هرزنامه ها را در پوشی مدتیبرا •
 .ديپژوهان نشان ده

ک آدرس ي، "یپست افزار نرم با یفور اميپفرستادن ": ٧٫٣ یابي بخش دستید براي شرکت کنندکان با •
ن گونه ي با اید که حسابين جلسه از آنها بخواهيده اند؛ قبل از شروع ان نکرياگر تا کنون چن. درست کنند

 آنها را گام به گام در باز کردن "ليمي احساب جاديا": ٤٫٣یابيبا مرور بخش دست. شرکت ها باز کنند
  .دي کنیيراهنما حساب
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  باني پشتۀ داده ها و نسخۀريذخ: ٧٫١یابيدست
 اطلاعات ۀنترنت جستجو کرده، همياو ساعتها در ا.اخته است سخت به پژوهش پردی موضوعۀنا در باريم

 در یطبقه بندو  یکروسافت ورد گذاشته و آنها را پس از قالب بندي ماۀک پروندي یانتخاب شده را رو
 مربوطه ۀر برنامي مدیل برايميا را با ليفان ينا اين است که ميمانده ا یآنچه باق. ره کرده استيانه اش ذخيرا

در مقابل اش ظاهر  یبآ ۀک صفحيانه را روشن کرد تا پست را بفرستد تنها ينا رايروز بعد که م. بفرستد
دستگاه  یبررس از پسمسئول .  سازمان تماس گرفت و از او کمک خواستیمه با مسئول فنيسراس. شده بود

ست اما در ي او چنا متوجه نشد که منظوريم. است"  مرگ ی آبۀصفح"  کند ینا گفت آنچه را مشاهده ميبه م
.ده بوديش را فهمنا منظوري که داشتند میان مکالمه ايپا  

تيفعال  

قهي دق٣٠  

 را در یکي. ديچاپ کنل شان يميادو نسخه از فهرست نام شرکت کنندگان را همراه نام سازمان و آدرس  •
 .دي از شرکت کنندگان بدهیکي را به یگريد و ديف خود بگذاريک

 .ديند صدا کنينش ی را که کنار دست او مید، کسيده شده بدهيه فرد گزنکه فهرست را بيقبل از ا •

من به فرد مورد نظرتان ي ای نگهداری موجود است و آن را برامدرکن يک نسخه از ايد که تنها ياعلام کن •
 .ديبسپار

o د آن را ي خواهیک نسخه موجود است و چون نمين يد که هميتنها اعلام کن. دي سرو صدا نکنیليخ
افت ي که نسخه را دریاز شرکت کننده ا .د سپردي خواهی به کسی نگهدارید آن را برايست بدهاز د

 .د که آن را در آخر جلسه به شما پس بدهديکرده بخواه

 خواهد یگر  از او مي دۀد شرکت کنندي سپاری مین که فهرست را به شرکت کننده ايبلافاصله پس از ا •
 چشم همه آن را پاره پاره یافت فهرست، جلويد به محض دري بایاما و. ندازدي به آن بیاجازه دهد تا نگاه

 .کند

 .ديداد گفت و گو کنين روي اۀدربار •

 توانندموجب یگر مي عوامل دیاريروس و بسي، وليفاسک يانه، فاسد شدن دياز کار افتادن سخت افزار را •
 .ن برودي شما از بیکي الکترونۀشوند که نسخ

 یچ راهيفتد ممکن است شما هي و رفتن همه شرکت کنندگان بی آموزشۀان جلسياز پاپس   ین اتفاقي اگر چن •
 یدا نمي از فهرست پیگري دۀ نسخۀي تهیا براي و ی آموزشۀگر شرکت کنندگان در دوري دا تماس بیبرا
 . ديکرد

 ۀ تا در بارديف کنينا افتاده تعري می را که برای وجود ندارد، همان اتفاقینين تمري چنیاگر امکان اجرا •
 . ردي آن بحث درگی برایابيبان ي و پشتليفا ۀريذخ

 ین ها براي از تمریگر فهرستيکدي یمن اطلاعات و داده ها کدامند؟ با همکاري ای نگهداریروش ها •
 امن و یره سازي ذخید هايد و نباي از بایز فهرستيد و نيه کني ها تهليفاافتن يبان يره کردن و پشتيذخ

 .ه کردن هارين ذخيفاصله ب
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 . ديمن نگاه داريد و ايره کني ها را مرتب ذخليفا. ١ •

 . ديه کنيبان تهي پشتۀد و نسخي برداری مهم، کپی هاليفاژه ي ها، به وليفا خودتان از یبرا. ٢ •

ره يذخ همراه، ۀ، حافظ(USB) یب. اس. ويک يا ي و یسک فلاپيک دي یآن ها را رو. الف
 .ديکن

 . ديت بفرسیگريرور د سِیا برليمياآن ها را با .  ب

بان ي پشتۀ خود نسخی شخصۀاني رایرات رويي مشخص از تمام تغی با فواصل زمان-انهيبان رايپشت. ٣
 .گر مدارکير و ديد نظر شده، نامه ها، تصاويا تجدي یمي قدی هاليفاد، از جمله يبساز

 .ديريبان بگي پشتۀ مورد نظر نسخی ها و داده هاليفااز . الف

 .یب. اس. ويد، مانند يکنره يذخ همراه  ۀحافظک ي یرو را یپک کي. ب

 ی هایين شده از تمام داراييش تعي از پیع و با فواصل زماني در سطح وس-یدر سطح سازمان.٤
 .ديه کنيبان تهي پشتۀانه ها تسخي تک تک رایا روي و ی گروهی هاليفاو ل ها يمياک شرکت، يالکترون

 .دي کنی نگه داریگري دید و درجايريبان بگي پشتۀمرتبا نسخ. الف

 .ینترنتي ای و انبارهایره سازي ذخیل جانبي، وسای خارجیسخت افزارها. ب

 توان ی می دیس مربوط به آنها، در یوندهايبان، همراه پي نسخ پشتۀي تهی روش هاۀ در باریشرح: منابع افزوده
  . ديد
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  من از آني اۀل و استفاديميا: ٧٫٢ یابيدست
 از  وبگاه یاريبس. ردي آنها را بگی داند چگونه جلویاو نم. نا پر شده است از هرزنامه ها ي میتصندوق پس

چ يگر به هيده که دي رسیيکار به جا. ده از آب در آمده اندي فاینان اند، بيکرد قابل اطم ی که فکر میيها
. اعتماد نداردیوبگاه  

تيفعال  

قهي دق٣٠  

د تا تجارب خود را ياز شرکت کنندگان بخواه. ديس ها درست کني هرز نامه نویرنگ هاي از نیفهرست •
 .ديسي تخته بنوی بر روین تجارب را در فهرستينکات مشترک ا. ن هرز نامه ها مطرح کنندي اۀدربار

o بخت یط هايبل، برندگان ی جنسیي توانای بازار بورس، قرصهاۀخبر در بار:  متداولیترفندها 
 .یيآزما

 .د ي احتراز آز آن ها بحث کنی آشکار و نه چندان آشکار و راه هاین هرزنامه هايب نقاط اختلاف ۀدربار •

 رسند؟  ی به نظر مین هرزنامه ها واقعي از ایچرا برخ •

o دين شما بگذرند با علامت سبز نشان کنير ذره بي را که ممکن است از زیيآنها. 

o ونه هانم. د حذف شونديت شان روشن است در نگاه اول باي که ماهیيآنها: 

o ديهست.. . خوشبختۀ شما برند-. مردم ساده لوح استی اغوایگان تنها براي رای مالیوعده ها . 

o ازمنديمار و نير کودکان بيرستادن تصوف از احساسات مردم با یبهره جوئ. 

o شودی پول داده مید و به شما مبلغ هنگفتي نفر بفرست٦ن نامه را به يا . 

o ان شما فرستاده شده استي آشنا ازیام از طرف فرد معتبرين پيا. 

o ديان فرستاده شده اند با علامت قرمز نشان کني را که توسط آشنایيآنها. 

 .دي تخته درست کنید رويک فهرست جدي  کرد؟یري مزاحم جلوگیل هايميافت اي توان از دریچطور م •

o فهرستشان به آن  زدودن نامتان از یرا بید و درخواستيد، باز نکني مزاحم را پاسخ ندهیل هايميا
 .ديها نفرست

o دي مزاحم را فعال کنیل هايميشگرايپالا. 

 در .  کنندیمبطور خودکار فعال شگرها را ين پالايال ي میج:  وبیل رويمي ایبرنامه ها 
 یروJunk Mail  در بخشاهو يد و در يبرو Options > Filters   بهليهات م

Options > Mail Options > Spamديک کني کل. 

د گزارش ي کنیافت مي که دری هرزنامه هائۀسازمانتان در بارل يميارور خدمات سِبه  
 . ن هرزنامه ها را کاهش دهنديش خود شمار اي توانند با وسائل پالایآنها م. ديبفرست

د و ينترنت، و باي ای جستجویمني ایتمام گروه ها روش ها. م شونديشرکت کنندگان به چهار گروه تقس •
 .ان بگذارندي را فهرست کنند و با هم در م،نهين زمي در ای شخص رفتاریدهاينبا
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o ن يروس و افزار خبرچي، ووبگاه یمني ا:موضوع ها(spyware) من و خطرناک، ي ناای، وبگاه ها
 .   وست هايدانلود کردن و پ

 Secure Socket Layerی کردن داده های مخفیبرااست که وبگاه ها از آن  یوش ر 
د و فروش ي مربوط به خری کنند، از جمله داده هایاستفاده م انتقال ن نقل وي در حخود
چگاه رمزنشده يه خود را یاطلاعات شخص. ی اعتباری کارت هاۀن مانند شماريآنلا

 .دينفرست

 Phishingمقبول یهر که ظایل هائيمي ساختن وب گاه ها و فرستادن ایاست برا ی روش 
 ی ربودن اطلاعات مربوط به حسابهایبرا یرقانونيانه و غي موذیامّا مقاصددارند 

ن نوع وبگاه ها را يشتر مرور گرها اي ب.یقي افراد حقی شخصیا داده هاي و مشترکان
 .کننديش ميپالا

ا از ين ممکن است داده ها و برنامه ها را مختل کنند و ي خبرچیروسها و نرم افزارهاي و 
انه را ي شوند و اطلاعات رایصب من بدون اطلاع کاربر ني خبرچیبرنامه ها. ن ببرنديب

 و روسي ضد ویابزارها":٥٫١افت يد به بخش رهينگاه کن.  فرستندیرون ميبه ب
 ."رواليفا

 شما ۀانيب رسان به راي آسیوست هايق دانلود و پي مخرب از طری از برنامه هایاريبس 
. دي آنها را باز نکنديان نداريوست ها اطمنيام ها و پين پيا اگر از منبع ارسال.  کنندینفوذ م

 .کنندي هستند و برنامه نصب میي  مشخص شده اند اجراexe  که بایي هاليفا

 

 . موجود استی دیوند دانلود آنها در سيو پAnti-virus  وfirewall  یفهرست نام برنامه ها: منابع افزوده 
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  .ی با نرم افزار پستیام فوريفرستادن پ: ٧٫٣ یابيدست
. کند یافت ميا دري فرستد و یمل يميان برنامه يو از ا شود یمکروسافت وارد و خارج ي  ماۀرنام در بینا به راحتيم

 سبز را هم ۀمگک ديگهگاه، هنگام ورود . ن برنامه استيد کاربرد اي جدی روش هایدر حال حاضر او در جستجو
.اورديسر در ب خواهد از کارکرد آن ینا ميم.  آن نوشته شده گپیند که بالاي بیدر سمت چپ م  

تيفعال  

قهي دق٣٠  

 .ديوبر /http://www.mail.google.com  به •

 ندارند قبل از یسابحاگر . ل دارندي میاز به داشتن حساب جي شرکت کنندگان نیام رساني پۀ جلسیبرا •
انجام ن کار را يد ايکمکشان کن" ليمي احساب دجايا":٤٫٣ یابيبا مرور بخش دست. د باز کننديشروع جلسه با

 .ندده

 .  خود را مبادله کنندی پستیشرکت کنندگان دو به دو بشوند و آدرس ها •

سد و بر ي هم گروه خود را بنوی آدرس پست١ ۀ، شرکت کنندchat ر انتخاب ي، زۀدر سمت چپ صفح •
 .ک کندي کلInvite to Cahtیرو

o  ل ي می را در قسمت چپ جیاميگر پيطرف د. ت نامه را بفرستدن لازم است دعوي از طرفیکيتنها
 :ن صورت است يام به اين پيا.نديب یم

“wants to be able to chat with you. Okay?”.xxx@gmail.com” 

o  یک کردن رويپ فعال نشده با کلگَ ۀبرناماگر  Turn On Chatدي فعال کنن صفحه آن راييدر پا. 

 .ردي دعوت هم گروهش را با زدن بله بپذ٢ ۀشرکت کنند •

 یده مي سبز دۀر گپ  با نقطي هم در زیگريفرد دمربوط به ا اطلاعات يد آينيد تا ببيبخش چپ را نگاه کن •
 شود؟

o حضور ی سبز به معناۀنقط. ديخواهند دگر يطرف د در کنار نام ی سبزۀاکنون هر دو طرف نقط 
 . نام کنار ان استدن ز گپیو آمادگ

 . کوچک باز شودۀک پنجريد تا يک کني نام کلیبر رو •

 .دي را بزنenter د ويپ کنيام کوتاه تايک پي •

o ده خواهد شديگر دي دۀانيام بلافاصله در رايپ. 

o واحد ممکن استۀک برنامي یا چند نفر و بر رويک ين ينامند و تنها ب ی هم  میام فوريگپ را پ . 
 معروف ۀ هر سه برنامیشتر مردم رويب. دياهو مکالمه کنيد با حساب يتوان ینمل ي میمثلا با ج

 .ن استيل همي از دلایکي. ل حساب دارنديل و هات ميم.یاهو، جي

 .دين بخش به افراد بدهين اي تمری برایزمان کوتاه •
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o گپ مخصوص ۀبرنام نصب و کردن دانلود گريد راه است زدن گپ یازروشها یکي یفور اميپ 
 و "،یصوت فراخوان و گپ ۀبرنام": ٥٫٢ یابيدست بخش به ديکن نگاه شتريب اطلاعات یبرا. است

  ".نيآنلا کنفرانس راه از یهمکار": ٧٫٤ راهکار هي
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 بخش دوم
 

  فاوای از ابزارهایبهره جوئ
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  ومبخش د
١................................................... فاوای از ابزارهایبهره جوئ  

  ٣.............................................. و جستجو در وبمرور:   ١ یبهره جوئ
  ٤......................................... (plug-ins)ه هايافزامرور: ١٫١یبهره جوئ
٦...........ها ر برنامه يسا وب و ی مرورگرهایبه روز رسان: ١٫٢یبهره جوئ  
٨.....................................ه ها يافزا ی جستجویموتورها: ١٫٣یبهره جوئ  
١٠..................................................ک وبگاهيجستجو در :١٫٤یبهره جوئ  
١١.......................................................شرفتهي پیجستجو:١٫٥یبهره جوئ  
١٢............................اب هايده ها و صفحه ي برگزیسامانده: ١٫٦یبهره جوئ  
١٤.......................................................فعّال اب يصفحه : ١٫٧یبهره جوئ  
١٥..................................................نيرِ آنلايافتن تصاوي : ١٫٨یبهره جوئ  
  ١٧........................................................ني آنلایِدئوهايو: ١٫٩یبهره جوئ
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٢٧....................................ل هايميا در و و جستجیسامانده: ٢٫٤یبهره جوئ  
٢٩....................................ینيفه آفريل ها و وظيمي ایابيرد: ٢٫٥یبهره جوئ  
٣١................... و فهرست آدرس هایکي الکترونیخبرنامه ها:٢٫٦یبهره جوئ  
٣٣.................................................شرفتهي پی واژه پردازها:٣یبهره جوئ  
٣٤.......................................رات يي و چسباندن تغیابيرد : ٣٫١یبهره جوئ  
٣٦......................ش ساخته ي پی الگوهایاري به مدارک ۀيته: ٣٫٢یبهره جوئ  
٣٧............................... و برچسب های دستجمعینامه ها: ٣٫٣ ی بهره جوئ  
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، در سطح  یتنترنت، واژه پردازها و صفحات جداول محاسبايانه، اي فاوا مانند رای از ابزارهایبهره جوئ
 یق تر در برنامه ها و ابزارها، تلاش مين بخش با کاوش عميدر ا.  شودیسر مي می آموزشۀاني میمهارت
 چون واژه پرداز و جداول ینه از ابزارهائي بهی بهره جوئی برایشتر و فنون کارآتري بیم تا روش هايکن

 آموخته و ی استفاده از ابزارهای برایشترين بخش شرکت کنندگان مهارت بيان ايدر پا. ميدا کني پیمحاسبات
  .آشنا به دست خواهند آورد

ازهايش نيپ  

 ۀا شرکت در دوري، ینترنت، واژه پرداز، صفحات جداول محاسباتيانه، اي با رایي ابتدایتجارب کار •
 . فاوای از ابزارهای بهره جوئیآموزش

 .  سطح بالایرت هاافتن به کسب مهاي دست ی مکرر از ابزارها برای بهره جوئۀتجرب •

  .ستي نیده ضروريچي پی برنامه هایک براي الکترونی هاینترنت و فناوريتخصص در استفاده از ا •



٤ 
 

 مرور و جستجو در وب: ١یبهره جوئ

:اهداف  

 .ن برنامه هايه ها و روش به روز نگه داشتن اي در وب، با افزای مختلف مرورگری با مدل هایآشنائ •

 . جستجو در وبگاهدرک تفاوت جستجو در وِب و •

 . جستجو و موارد کاربردشانۀشرفتي پی روشهایموشکاف •

  .ندهي آیج جستجو و کاربرد آنها در جستجوهاي و انبار کردن نتایگانيبا •

 

م و ابزارهايمفاه  

 حفظ یافتن مقاله براي (ی مقاصد شخصی که علاقه مند به جستجو در وب هستند، چه برای کسانۀهم
ن ي انجام این روش هايازمند آموختن بهترين) ا آمارخاصيافتن داده ي (یر حرفه ا کایا برايو ) یتندرست
 توان به یبا مرور در وب م.  جستجو وجود داردیشرفته در تمام موتورهاي پیامکان جستجوها. کاراند

 ره ويشرفته و با ذخي پی جستجویب روشهايبا ترک.  هم دارندیگري دیافت که کاربردهاياردست يج بسينتا
.افتيد ينه دست خواهين زمي در ای ارزنده ایج جستجوها، به دانش هاي کردن نتایگانيبا  

ل گري تسهیآمادگ  

ر يدر غ.  گوگل را آماده کرده اندید موتور جستجويد تا مطمئن شوي کنی کارگاه را بررسیانه هايتمام را •
ش ي از پیور جستجود و گوگل را بعنوان موتيک کنيکلFind More Providers  ین صورت، رويا
 .ديني آن برگزۀن شدييتع

: ٤٫٣یبهره جوئ" نداشت با مرور بخش یاگر کس. د حساب گوگل داشته باشندي شرکت کنندگان باۀهم •
  .دي کنیاريحساب،  بازکردن یبرااو را " ليميک حساب ايجاد يا"
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ه هايمرور افزا: ١٫١یبهره جوئ  
ژه نامه ي بر خورد که وی گشت، به وبگاهیم"  به زنانخشونت نسبت"  اطلاعات ی در پی که سوفیهنگام

 از یکي ی رویوقت. دئو در آن بودي از عکس و مقاله و ویاد و متنوعين مورد داشت و مطالب زي در ایا
. لازم را نداردۀياب به او گفت که افزايام خطايک کرد، پيوندها کليپ  

تيفعال  

قهي دق٣٠  

 .ديبرو events/news/org.learningpartnership.www/٢٠٠٥/vawsymposiumبه •

o یکي شوند یش از همه استفاده مي که بیيه هايافزا  Adobe Acrobat Reader است که اسناد 
pdfیگريکند و دي را باز مFlash  ه يگر افزاياز د.  رودیدئو به کار ميش وي نمایاست که برا
 .هستندWindows Media Player, QuickTime, RealPlayer  ی کاربردیها

 pdf مدرک، Adobe Acrobat Reader ۀبرنام. ديک کني کل Read Symposium Reportیرو •
 . کندیک مرورگر باز ميشما را در 

o  Adobe Acrobat Readerمرورگر بهره جستۀ توان از آن در برنامیست که مه ايک افزاي . 

o یاغلب وبگاه هائ. از مرورگر بتواند از آنها استفاده کنديشوند تا هنگام نيه ها دانلود و نصب ميافزا 
به . ه را دانلود کندي هستند که بتواند افزایوندي پیه اند دارايازمند افزايشان ني از پرونده هایکه برخ

:   د، آن را ازي را ندارAdobe Acrobat Reader عنوان مثال، اگر 
http://www.adobe.com/products/acrobat/ ديد و نصب کنيري بگ. 

د واژه ين کليجستجوگر هرجا به ا. ديسيبنو" داکنيجستجو و پ"را در محل " یمهناز افخم "ۀد واژيکل •
 .  کندیبرسد آن را مشخص م

o  Adobe Acrobat Readerگر از فرمان ي دی برخیر ابعاد و اجراييره و تغيخ جستجو، ذیتوانائ
 .ها را دارد

د تا نوارصدا ي را فشار ده(play) ۀدگم. ديژه نامه خشونت نسبت به زنان بر گردي وی اصلۀبه صفح •
 .شروع به کار کند

o ر و ي پرونده ها ابزار پخش تصویدر برخ. ر و صداستي پخش تصوی از راههایکين روش تنها يا
 جداگانه یداري و شنیداري دۀک پخش کنندي به یازين موارد نين در ايرد و بنابراصدا وجود دا

 آن ۀن  نمونيبهتر. ن دسته انديک مرورگر کار گذاشته شده اند از اي که در درون یيآنها. ستين
 .وب استيوتي

o مانند یگري دیاز به برنامه هاي نیريتصو/یگهگاه نوع پرونده صوت  Real Media و    
QuickTimeد يشود، وگر نه بايصوت پخش م/ريانه نصب شده باشند، تصوي رای دارد که اگر رو
 . دانلود شوند

o شوندیافت مي ی دی روند در سیاد به کار مي که زیيه هايوند به افزايپ . 
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 را ی صوتیپادکست ها و پرونده ها د وي بروview/٥١٦٤٦٣/http://odeo.com/channel:  به •
 .دينيبب

د و ي صفحه را مرور کنیتا انتها. ديبرو tabou/org.learningpartnership.www://http:  به •
 .ديني درون صفحه را ببیدئويدر آخر صفحه و

را WLP یدئو هاي وۀد و مجموعيبروhttp://youtube.com/user/learningpartnership به •
 .دينيبب

o یدئوهاي گذارند تا ویار سازمان ها مي در اختیگاني  رایوب ، فضايوتين مانند ي آنلایبرنامه ها 
  )"ني آنلایدئوهايج کردن از راه ويترو": ٢٫٣راهکار . ( ش دهنديخود را در آن نما
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  ر برنامه هاي وب و سایبه روز کردن مرورگرها: ١٫٢یئبهره جو
 یمي قدۀد نسخيدهند که با یام مي از وبگاه ها پیبرخ.  رسدی به نظر نمی عادی مرورگر سوفیراً کارهاياخ

 به فکر یسوف. تواند بکار اندازد ی را که در صفحات وب هستند، نمیيدئوهاي از ویبعض. مرورگر را به روز کرد
نده به روز يدا کند تا در آي پیدهد راهيح ميالبته ترج .ل کندين نسخه تبديدتري مرورگرش را به جدۀسخافتاده که ن

  .کردن مرورگر به طور خودکار انجام شود

تيفعال  

قهي دق١٥  

 .دي  برو Help > About Internet Explorerد و بهياکسپلورر را باز کن •

o راه ی مشکلات مربوط به  نرم افزار و جستجو به رفعین آگاهيا.  برنامه مهم استۀدانستن نسخ 
دا کردن يروش متداول پ Help > About Internet Explorerرفتن به . کنديحل کمک م

 .ن مدل برنامه استيآخر

 .ديدا کني آن را پۀکروسافت وّرد را باز و نسخيما •

 .ديدا کني آن را پۀو نسخ ديز باز کنياکسل را ن •

 .دي برو/http://www.update.microsoft.com  به •

o یکروسافت تمام نرم افزارهاي مایبخش به روز رسان Officeنت، و ياکسل، ورد، پاورپو(   مانند
 . کندیبه روز مآنها ستم عامل يرا همراه با س) اکسپلورر

 .ديرا انتخاب کنر برنامه ها يستم عامل و ساي سی لازم برای هاید و به روزرسانيرا بزنCustom  ۀدگم •

o ن کار يا. کند یابد و آن ها را به روز مي یدا کرده اند مير پيي را که تغیيکروسافت تمام بخشهايما
 .دي طول خواهد کشیمدت

o دکنجاد يرا ممکن است مشکلات تازه ايد زي رانصب نکنیگرين فرصت نرم افزارديدرا . 

 .ديک کنيکل راست صفحه را در بخش Automatic Updates د يک جدي اتوماتینسخه ها •

o مربوط یژه در بخش هاي کند به وی وارد میراتييش تغيکروسافت همواره در برنامه هايشرکت ما 
 ۀزم به روز کردن برنامين است که مکانين کار اين رو بهتريازهم.  و کارکرد برنامه هایمنيبه ا

 .ديخود را همواره فعّال نگاهدار

 . دي کنید و آن را بررسيبرو Control Panel > Security > Automatic Updates به  •

o دي داری گوناگونینه هايرها شما گزيين مدل ها و تغي داونلود و نصب کردن آخریبرا  .
 ی شما چه مدلۀابد برناميکند تا دري میني مربوط به خودش را بازبیکروسافت تمام برنامه هايما

ر مدل چقدر ييد و تغياج داري احتیدل هائا نه، به چه ميدرست است ا فرم قرار داد ياست و آ
 . ضرورت دارد

o  
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 .ديتمام پنجره ها را ببند •

o به ین زمان بستگيا. ردي بگیادي تواند زمان زی برنامه ها مید که به روز رسانيتوجه داشته باش 
  . داردینترنتيد و سرعت ارتباط اي جدی هاpatch)(تعداد وصله 
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  اه هيزا افی جستجویموتورها: ١٫٣یبهره جوئ
شتر آنها يافته که بي هم دست یگريها به منابع ديتازگ . را با استفاده از گوگل آغاز کرده استیعيق وسي تحقیسوف
. کرده اندیگران به او معرفيرا د  

تيفعال  

قهي دق٣٠  

.  موتور جستجو استیاصل ۀحد که صفيبرو com.google.www://http/به . دياکسپلورر را باز کن •
 .ديبگرد" قاچاق انسان" آنگاه به دنبال 

o کندی را فعّال مد شده در گوگل موتور جستجوي قی در محل نشانیدي کلیپ کردن واژه هايتا  .  

 enterد و يپ کني تای راست صفحه، کنار محل نشانی بالای جستجوۀ قاچاق انسان را در جعبۀد واژيکل •
 .ديرا بزن

o پ نشان آن ي به تایازيد و نيني بی گوگل را میفحات مرورگر علامت موتور جستجو صیبر رو
د تا روش اضافه کردن ي کنیبررس.  توان اضافه کردیگر را هم مي دی جستجویموتورها. ستين
 .ديابيگر را بي دیک موتور جستجوي

o ی اکسپلورر م+٧ بالاتر از یر فاکس و به نسخه هاي فای جستجو را به تمام نسخه هایموتورها 
 .توان افزود

 .ديو اطلاعات آن را مرور کنک يکل (Wikipedia) ايديپ یکيوند وي پیج، روي نتاۀدر صفح •

o اما از آنجاکه همگان . ون مقالهيليک مين است با حدود ي آنلای از دانش نامه هایکيا يدي پیکيو
ر مراجع ياله ها را با سا آن را دارند، بهتر است اطلاعات آمده در مقیش مقاله هايرايامکان و
 .ديسه کنيز مقايمعتبر ن

  Find More Providers:دي مشابه بفرستیدا کردن برنامه هايموتور جستجو را به پ •

o ديگر را هم داري دی جستجوی برد که امکان انتخاب موتورهای میاکسپلورر شما را به صفحه ا .
 .دييفزاين موتورها بيا را به ايدي پیکيو

 از یکيد را به عنوان ي توانی شود و شما مینه ها باز ميفهرست گز. ديک کنيکلا يدي پیکيو یرو •
  .ديک کنيرا کل Ok . دي جستجو اضافه کنیدستگاه ها

o استی بهره برۀا آماديدي پیکياکنون و . 

 .ديا را انتخاب کنيدي پیکيدر فهرست آن و. دي مرورگر برویبه جعبه جستجو •

 .دينيا ببيدي پیکين جستجو را در وياج يد تا نتايواژه بزن ديک کلي •

o در . ابدي یش مي شما افزای جستجوگریي، توانایک جستجوگر اضافيا به عنوان يدي پیکيبا نصب و
 یيز صرفه جويد، در زمان جستجو ني گردیا هم ميدي پیکي ویم رويکه مستق یيضمن از آنجا
 .خواهد شد
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 ۀجي را که نتی خارجیوندهايد و اطلاعات آن و پيدا بگريدي پیکي خاص در ویا مطلبيافتن کشور ي یبرا •
 .ديور کن گذارد مریار شما ميرا در اختجستجو 

 یک دستگاه جستجوين يهمچن.  جستجو کنندیگريد تا درمورد دي به شرکت کنندگان بدهیزمان کوتاه •
  . خود اضافه کنندیگر را هم به موتور جستجويد
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  ک وبگاهيجستجو در : ١٫٤یبهره جوئ
اکنون . ش نسپرده بوديده هايده بود امّا آن را به بخش گزين خانواده در وبگاه دي قوانۀ را درباری قبلا صفحه اشهيعا
. خواهد در وبگاه دنبال اش بگرددیم  

تيفعال  

قهي دق٣٠  

 .دي بروorg.learningpartnership,www://http/به  •

o یج جستجويت جستجو و نتايفيت را هم دارند، اما کي درون سایشتر وبگاه ها موتور جستجويب 
 .اند مختلف متفاوت یموتورها

•  Family law د ويپ کني صفحه تای بالای جستجوۀرا در جعبenter ج را مرور ي نتاۀصفح .دي را بزن
 .ديکن

•  “Family law”ديج جستجو را مرور کنينتا. ديسيبار با دو علامت نقل قول بنو نيرا ا. 

o  ب جستجو ي شود تا آن واژگان به همان ترتیومه موجب ميا عبارات در گي واژه ها یک سرينهادن
 .شوند

 .ديره کنيذخ ده هايد و آن را در بخش گزينيمطالب صفحه را بب. ديک کنين خانواده کلي قوانۀ صفحیرو •

o سر نخ: Favorites > Add to Favorites 

o ساختن: ٢٫٥ یابيدست. (د يره کنيذختان يده هايتان جالب بود، آن را در گزي برایحه اچنانچه صف 
 )ها دهيگز افزودن و ی اصلۀصفح

د و يرا بزن“ org.learningpartnership.www”family law و دي باز کنیگري دۀگوگل را در پنجر •
 .دينيج را ببينتا

 .ت رابا فرمان مناسب محدود کرديک ساي توان  جستجو در درون یم 

o پ کردن يبا تا"  <Site URL>”search term د که در ي دهیابه موتور جستجو فرمان مشم
 .د واژه بگرددين شده بدنبال کليوبگاه مع

 .ن کوتاهيزمان تمر •

o یه زنان را در وبگاه ها مربوط بیکي توانند اخبار الکترونیب مين ترتيشرکت کنندگان به ا :
org.womesnews.www(Global News , )org.irinnews( IRINNews دا کننديپ. 

  . موجود استی دیس جستجو در ی ترفندهاۀ درباریصفحه ا: منابع افزدوه 
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  شرفتهي پیجستجو: ١٫٥یبهره جوئ
تيفعال  

قهي دق٣٠  

 .ن کننديشرفته را تمري پی جستجویم شوند و روش هاي چهار گروه تقسشرکت کنندکان به •

 .دي گوگل را باز کنۀشرفتي پی جستجوۀصفح •

o  ن خانواده در لبناني قوانۀ درباریعرببه زبان منابع. 

o رانيا در خانواده نيقوان ۀ درباری فارس به زبانمنابع. 

o  لي در برزی خشونت خانگۀ در باریپرتغالبه زبان مقالات. 

o  ني در آرژانتی خشونت خانگۀ درباریولياسپانبه زبان مقالات. 

 .ديک کني کلAdvanced Search optionsد و ي گوگل برویج جستجوي نتاۀ صفحیرو •

o ديدا کنيد پي اش هستی را که در پیبا تمرکز جستجو بر زبان و منطقه اطلاعات. 

شرفته ي پینات مختلف جستجود تا امکايک کني صفحه کلیدر بالا Advanced Search Tips  یرو •
 .بات مختلفي و نشانها و ترک-، + مترادف، علامات ید از جمله جستجو با به کار بردن واژه هاينيرا بب

o ديسه کنيج را با هم مقايب و نتايعلامات مختلف را با هم ترک. 

خود صحبت  یشرفته، روش استفاده از امکانات آن و آموخته هاي پی جستجویوه هاي شۀگروه ها دربار •
 .کنند

o ديسي تخته بنوی بحث ها را روۀخلاص. 

o ديشرفته را امتحان کني پیتمام امکانات جستجو. 

o افتيد ي را خواهی بهتریشتر، روش هاين بيبا تمر. 

  .افتي توان ی می دی را در س مختلف جستجو ی عملکردهاۀ درباریصفحه ا: منابع افزوده
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  اب هايحه ده ها و صفي برگزیسامانده: ١٫٦یبهره جوئ
.ره کنديش را ذخيج جستجوهاي خواهد نتایل بدست آورده و مي در برزی خشونت خانگۀ درباریادي مطالب زیسوف  

تيفعال  

قهي دق٣٠  

 .دينيج را ببيد و نتايل، در گوگل جستجو کني در برزی آمار خشونت خانگۀد واژي کلیبرا •

 .دي اضافه کنbook mark)(اب يد و چند صفحه يبرو Favorites > Add to Favorites به •

o اب آن ها را يا با استفاده از صفحه يد و ييفزايده ها بيد به گزي توانیج را ميتک تک صفحات نتا
 .دينده نگه داري استفاده در آیبرا

o ديد استفاده کني توانی بالا میوه هاير فاکس هم از شيدر مرورگر فا. 

o نکار به ي ایبرا. ده ها قرار داديرست برگز توان در فهیز ميانه را ني رایک از پرونده هايهر 
File> Open > Browse  ديبرو . 

 .ديني ببیک فهرست طولانيوند ها را در ي پۀد و هميده ها برويبه بخش گز •

o کند یرا دشوار مافتنشان ي آنها، یده ها بدون سامان دهيافزودن بر تعداد گز. 

 . شودیده ها باز مي گزی ساماندهۀنجرپ. ديک کنيکل Favorites > Organize Favorites یرو •

o ذهن تان بشود و آن را درمورد تمام برنامه ها و ۀد ملکيمرتب نگه داشتن پرونده ها و پوشه ها، با 
اسناد .  شوندیبهتر است در پوشه ها و بخش ها ساماندهز ي نهال يمياحتا . دياطلاعاتتان انجام ده

 )ال هيفا یوسامانده کردن رهيذخ": ٥٫٤اهکارر.(تگذاشپوشه در توان یکروسافت ورد را هم ميما

 .ديبنامResearch Documents د را ي جدۀپوش. ديک کني کلNew Folderیرو •

o ديگر درست کني دیک پوشه در درون پوشه ايد يتوان یم. 

 .دين پوشه بگذاريد و در ايد، آن را بکشيک کنيد کلي که در آخر اضافه کرده ایوندي پیرو •

o ۀوند و سپس زدن دگميک کردن بر پين کار راست کلي اگر انجاميروش د Move است. 

 .دي اکسپلورر برگردی اصلۀد و به صفحيده ها را ببندي گزی ساماندهۀپنجر •

 .ديک کنيده ها کلي گزیرو •

o د داشتي خواهی ساده ساختار خوانا تریيد که با چند جابجايتوجه کن. 

 .ديال کن آن را فعView > Toolbars > Links یبا رفتن رو •

   . ديوندها منتقل کني پۀره شده ها را به پوشي از ذخیکي. ديده ها را باز کني گزی ساماندهۀپنجر •
Linkbarدي کنیا بررس ر. 
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o  د داشت و ي صفحه خواهیف بالايوند را در رديک پوشه، نشان آن پيوند به درون يک پيبا انتقال
 .ده ها نخواهد بودي گزۀ به زدن دگمیازين

 .ديتان مرتب کنيازهايده ها بر اساس نيم گزي تنظۀ را در پنجرده هايگز •

o  ،یروش ها.  بهتر کار استی بازدهی برای اساسی ازمهارتهایکيمرتب نگاه داشتن منابع 
 .دين روش ها صحبت کني اۀدربار.  منابع وجود داردی ساماندهی برایگوناگون

مانند  (ینوع ی دسته بند،)ه زنانيمانند حقوق بشر، خشونت عل (ی موضوعیدسته بند 
  .).یت سازي زنان، ظرفیمانند توانمند ساز (ی پروژه ای، دسته بند)قيآمار، تحق
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  اب فعّال يصفحه : ١٫٧یبهره جوئ

 در ی نارنجۀک دکميگهگاه . م کرده استي خود تنظینترنتي ای فراوان درطول جستجو هایاب هاي صفحه یسوف
 ی آن دگمه می که مکان نما را به رویهنگام.  شودیمدار يپدرس وبگاه،  صفحه، و همراه آدی در بالایمحل نشان
. نبرده استیام پين پي ای به معنایسوف. دين صفحه شويمشترک ا:  شودیدار ميام پدين پيبرد، ا  

تيفعال  

قهي دق٣٠  

 .دي برو  /http://www.learningpartnership.org/citizenshipبه. دير فاکس را باز کنيفا •

o  یبهره جوئد به ينگاه کن اکسپلورر ام خواني پیبرا. ر فاکس داردين را تنها فاياب فعّال آنلايصفحه 
  (Feed Readers) ها  درير ديف": ١٫٢

ب فعّال  ايک صفحه ي یرا برا Add Atom     ٠٫٣.ديک کني رنگ اشتراک کلی نارنجۀ دگمیرو •
 .دي را انتخاب کنSubscribe Now شود ی که باز می صفحه ای رو . ديانتخاب کن

 

 وارد یدي جدۀوند را به پوشين پيد و ايبروBookMarks Toolbar Folder  باز شده، به ۀدر پنجر •
  Live Bookmarks.  د با نام يکن

o که در آن است مرتب و یاخبار یعنياست "فعّال" اب ين صفحه يد اي آیهمانطور که از نامش بر م 
 . د داشتي به بازکردن وبگاه نخواهیازي شود و شما نیخود به خود به روز م

 .دييفزاياب فعّال بيد و آن را به صفحه ي بروBBC > News > Middle Eastبه  •

با بردن . دينيد، ببيش افزوده اي پۀ را که چند لحظیونديد تا دو پي  بروLive Bookmarks ۀبه پوش •
 .ديد دين دو وبگاه را خواهين اخبار ايآخر  Live Bookmarks یمکان نما رو

o ک تا ي یرات را به فواصل زمانييکند، تغي مرتب اخبار را به روز میس.یب.یکه وبگاه ب یياز آنجا
 .دينيد ببي توانیدو ساعت م

 خود  یها ابي صفحه فهرست  وبهدي را جستجوکنی ناموسیقتلها.  دي برو/http://del.icio.usبه  •
 .ديفزائيب

o  آگاه شدن از ید براي توانیشما م. ستي نی خبری وبگاه هایاب فعّال تنها برايکاربرد صفحه 
اب مشترک ي صفحه یگاه هاي در پای موضوع مشخصی که کاربران برای تازه ایاب هايصفحه 
د به بخش بهره يشتر نگاه کني اطلاعات بیبرا. دياب فعّال استفاده کنيک صفحه ي کنند از ینصب م

 ".اب مشترکيصفحه ": ١٫١ یجوئ

 یيوندهاي مختلف بگردند و پین وبگاه هايد تا بي به شرکت کنندگان بدهین فرصت کوتاهي تمرۀ ادامیبرا •
  .ه کننداب خود اضافيرا که دوست دارند به صفحه 
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  ن يرِ آنلايافتن تصاوي: ١٫٨  یبهره جوئ
 گزارش ۀي تهیر رابراين تصاويا. کند یافت مي مختلف دریر و عکس هاي تصاوی برایادي زیشه درخواستهايعا
ر ي از تصاویشه مجموعه اين رو، عاياز هم.  خواهندیره مي مطلب، گذاشتن در وبگاه سازمان و غۀا ارائيو 

داند که يم. ن مجموعه اضافه کنديبه اهمچنان  خواهد یاکنون م. از آنها بهره جسته استدرست کرده و بارها 
.اورديست چطور مجوز آنها را به دست بيدا کرد اما مطمئن ني توان در وب پی را میارير بسيتصاو  

تيفعال  

قهي دق٣٠  

 استفاده کرده یريتصواز د؟ ي گشته ایا تا به حال به دنبال عکسيآ: ديک پرسش آموزش را شروع کنيبا  •
 د؟يا

o رآني گزارش، وبگاه، خبرنامه، بروشور و غیبرا. 

o ديار همه قرار دارد جستجو کنيگان در اختينترنت که راي ایر روي تصاوۀدر مجموع. 

 .ديبرو http://www.flicker.com/creativecommonsد و به ياکسپلورر را باز کن •

o Flicker ر استي اشتراک تصاویج برايابزار را. 

o  Creative Commons(cc)دهد از منابع به اشتراک  ی توافق نامه است که اجازه مینوع
 .ديگان استفاده کني به را،یط خاصيرفتن شراي، به شرط پذیقيگذاشته شده مانند عکس و موس

 .ديمجوز ها را مرور کنانواع  •

o مثلا . گان در دسترس اند اما کاربر موظف به انجام شرط هاستي راین مجوزها همگيگرچه ا
د ي را هنگام استفاده از عکس قید نام ويد بايسيت عکاس را بنوي از شما بخواهد هویاگر مجوّز

 .ديکن

 .دينيد و آنها را ببيک کني مجوز ها کلSee Moreوند ي پی بر رو •

o Attribution-Noncommercial-No Derivative Works ین مجوزهايج تري از رایکي 
ست که از يد، بد ني خود را به اشتراک بگذارید عکسهايم دارياگر تصم. مربوط به عکس هاست

 .دينه استفاده کنين گزيهم

 .دينر مجوز جستجو کي زی جستجوۀرا در جعب) گريدمعتبر ک مکان يا ي( Petra  ، ی عمومۀدر صفح •

o  یئعکسها مجموعه را مرور خواهد کرد از جمله ی عکس هاۀهم صفحه یدر بالاجست و جو 
 کهد ي هستیرهائيد شود به دنبال تصويتأئد تا يکنک يکلدوبار . که حق نشرشان محفوظ است

 . اندcc  مجوزیدارا

آن را Original Size . دير بزني تصوی را در بالاAll Sizes و ديک کنير مطلوبتان کلي تصویرو •
 .ديدانلود کن

o دهدی شما میرات احتمالييجه را بعد از تغين نتي بهتری اصلۀر در اندازيدانلود تصاو  . 
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o مانند. دير استفاده کنيش تصاويراي وی برازي نیگري دید از برنامه هاي توانیم: 

Microsoft Office Manager, Imaging, Google Picasa. 

ش يراير مربوط به موضوعات خود را جستجو و ويد تا تصاويبده یصت کوتاهفربه شرکت کنندگان  •
 .کنند

  . موجود استی دیس در یگريج دي رایوند به مجوزهايپ: منابع افزوده



١٨ 
 

  ن ي آنلایدئو هايو: ١٫٩یبهره جوئ
و از ه اند طنزآلود و یحيشتر آن ها تفريب. افت کرده استي را از دوستان و همکارانش دریادي زیدئو هاي ویسوف
 ین الملليسازمان ب -ک سازمان همکاري از یيدئوياما اکنون و. ندي بیم به نگه داشتن آنها نیازين رو او نيا

 از همکارانش اشاره یکين يهمچن. ره کندي خواهد آن را ذخیافت کرده است که مي در-  زنانیآموزش و همکار
و  ندي خواهد آنها را ببی میسوف. دي توان دیمحقوق بشر  ۀ درباریادي زی آموزشیدئوهايوب هم ويوتيکرده که در 

.ره کنديذخ  

تيفعال  

قهي دق٣٠  

 .ديبرو com.youtube.www://http/به. دينترنت اکسپلورر را باز کنيا •

o دئو استي اشتراک وین وبگاه هاي از محبوب تریکيوب يوتي .DoGooder.tv و   

, VideoEggکنندی خدمات مشابه ارائه م   .  

 .دي وارد شوGmail ۀگذرواژبا نام و  •

o اگر ندارند، قبل از شروع جلسه آنها را کمک . ل داشته باشنديم.ید حساب جيشرکت کنندگان حتما با
 ".ليميحساب ابازکردن ":٤٫٣اهکار ر. ک حساب باز کننديد تا يکن

 .خ تولدتان را لازم دارديت، و تاري، جنسیپست کشور، کد ،یبرد که نام کاريوب باز کنيوتيک حساب ي •

o ل متفاوت استي میدر ج" ینام کاربر"وب، با يوتي ۀد که نام کاربر در برناميتوجه داشته باش. 

o ا يا آن نام قبلا انتخاب شده يکنند که آ ی می معمولا بررسی انتخاب نام کاربریشتر برنامه ها برايب
 .ديک کنيکنار نام کاربر کلcheck link  ید رويوانتينان مي اطمیبرا. نه

  نام کاربریج، روين نتايب. ديرو بw  Women’s learning partnership یبه جست و جو •
learningpartnership ديک کنيکل. 

o وبگاه درانه ي خاور مۀ را درباری گوناگونیدئو هاي زنان وی آموزش و همکارین الملليسازمان ب 
 .اک گذاشته استوب به اشتريوتي

o  خود را دردسترس یدئو هايد ويگان بتواني و به رای فراهم کرده که به آسانیوب امکانيوتيوبگاه 
: ٢٫٣راهکار : د بهيوب نگاه کنيوتي در خود یدئويادگرفتن روش گذاشتن وي یبرا. ديعموم قرار ده

 ".ني آنلایدئوهاي از راه ویجلب همراه"

 .ديک کنيکلFavorites  ی رود وينيبرگزست  که مورد پسند همگان هیيدئويو •

o ديده ها افزوده بوديدئو را قبلا به گزين ويا. 

 .ديک کنيکلAccount > Video, Favorites, Playlists > My Favorites  یرو •

o بهتر ی ساماندهیاد شود براي تعداد آنها زیره کرد اما وقتيده ها ذخي توان در گزیدئو ها را ميو 
 .دئو ها را سامان دهدي تواند وی دارد و مید که کاربرد مشابهي استفاده کنPlaylists  است از
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تا آنها د ي بدهیفرصت کوتاه گردند یدئو مي موضوع مورد نظرشان دنبال وۀ که درباریشرکت کنندگانبه  •
 .ره کننديرا ذخ

 شياک فهرست نمي منتخب خود، یدئو هاي توانند از وی بود، شرکت کنندگان میاگر زمان کاف •
(playlists)درست کنند . 

o  ١گام - Account > Videos, Favorites, Playlists > Create Playlist 

o  ديش اضافه کنيد آن را به فهرست نمايکنيدئو تماشا ميکه و ی در حال- ٢گام.  
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 ل  يميق ايارتباطات از طر: ٢ یبهره جوئ
 اهداف

 . ارتباطات کارآمدی برقراریل برايميشرفته در ارسال اي پیآموختن ترفندها •

 .ل يمي ای و جستجوی متفاوت در ساماندهیکشف روش ها •

 . ثبت نام در آنهایاي و مزاMailing lists  ی پستیش در فهرست نامه هايپو •

  

م و ابزارهايمفاه  

.  استیکي ارتباط الکترونین ابزارهاين و ارزان ترين حال آسان ترين و در عي ترآ از کاریکيل يميا
ن معنا که يبه ا. ش از حد آنهاستي بۀ استفادۀجي پنهان هم دارد که نتینه هاي آن هزینسرعت و ارزا
 ی های و هرزنامه ها و احوال پرسی و کاری شخصیز از نامه هاي افراد معمولا سرریصندوق پست
 یاما مرتب کردن آنها برا. کندی طلب میادين نامه ها زمان زي و سامان دادن ایطبقه بند. دوستانه است

. درست لازم استۀاستفاد  

ا در دانش يم شدن مردم نقاط مختلف دني سهی از عوامل مهم برایکيل يمي، ایک راه ارتباطيعلاوه بر 
 ی که سازمان ها و مراکز آموزشیليمي این اشتراک دانش از راه استفاده از فهرست هايا . استیبشر

. ردي گی دهند صورت میانتشار م  

 ,Microsoft Outlook, Thunderbird:  نه وجود دارند مانندين زمي ا دریادي زی  برنامه ها
EudoraMozilla’s Thunderbird و Eudora .ما از ی آموزشۀن جلسي ایبرا Microsoft Outlook  

 Yahoo و Gmail، Hotmail:  مانندیگاني ران ويآنلا ین برنامه با برنامه هايا. م کردياستفاده خواه
 هم ینترنتين برنامه ها، حتا اگر ارتباط اين است که با اين تفاوت ها اين اي مهمتر ازیکي. تفاوت دارد

خود را دارند ژه يوسرور خدمات  از سازمانها یاريبس.  توان نامه را خواند وارسال کردیبرقرار نباشد، م
  .  استفاده کنندOutlook  مانندیي توانند ازبرنامه های هم میقيافراد حق. ل سازمان را دارديمي ایکه نشان

لگري تسهیآمادک  

 را با ین هماهنگيشتريد که بي را انتخاب کنیيآنها.  موجودندی دیسن جلسه در ي ای نمونه براینامه ها •
 .ط افراد گروه دارديشرا

سرور خدمات ن برنامه ي ایبرا. ديم و نصب کنيانه از روز قبل تنظي چند رایرا روoutlook  ۀبرنام •
 .م شونديد تنظيفت کتتده باايارسال کننده و در

ن و ي آنلاین کارها را با برنامه هايد هميتوان یکند اما شما م ی استفاده مOutlook ن جلسه ازيا •
از آنها کار  یبرخد با ياگر امکانش را دار. Hotmail و Gmail،Yahooمانند د، يانجام دهگان هم يرا
  . ديکن



٢١ 
 

  شرفتهي پیل هايميا ٢٫١یبهره جوئ
 خودش ۀژيو  (server) ل از سروِريميافت و ارسال اي دری کند برای در آن کار می سوف کهیسازمان

. خود شکل داده است (domain name) ۀ کارمندانش را با نام دامنۀل هميميکند و آدرس اياستفاده م
 یمسئول فن . استorg.orgname@nameست بلکه ي نcom.gmail@name یل سوفيميآدرس ا

  . خودش نصب کندۀاني رایرا روOutlook  ۀ کمک کرده است تا برنامیسازمان به سوف

  تيفعال

  قهي دق١٥

 .ديا باز کن  ر Outlook Expressا يOutlook  ۀبرنام •

o ی برنامه ها   Outlook،  Thunderbird و Outlook Expressمشترکان یهمگ 
 یمانند ج ني آنلاین برنامه ها با برنامه هايآ.  شوندیخوانده م(Email client)  یليميا
ازمند ارتباط ينل يمي مشترکان ایخواندن و پاسخ دادن به نامه ها. انداهو متفاوت يل و يم
 .ستي نینترنتيا

o به . دهند ی انجام می مشابهیش کارهاي کمابیل با هم تفاوت دارند اما همگيمي ایابزارها
    ۀ مشابه با پوشیعملکردOutlook  حذف شده در ی پرونده هاۀپوشعنوان نمونه، 

Trashو وارد کردن امضا یرين برنامه ها امکان غلط گيدر تمام ا .ل داردي میدر ج 
 .شوند یم مي تنظPreferences  که دریگريز امکانات ديدارد و نوجود 

 .ديک کنيکلInbox > Sent Items , Deleted Items, Address Book, Calendar  یور •

o د و در سمت راست هم  ينيد ساختار پوشه ها را ببي توانیدر بخش سمت چپ صفحه م
 پاسخ، پاسخ به همه، ی صفحه دگمه هایبخش بالا. دينمرور ک فهرست و متون نامه ها را

 . اندام نوشتن قرار گرفته يباز فرستادن و پ

o  ۀل دگميميان ي پاسخ دادن به ایبرا. ديرا بخوانل يمياک يمتن  Replyیپاسخ. ديرا بزن 
 .(send)د يد و بفرستيپ کنيتا

o ام انديافت کردن، خواندن، نوشتن، و فرستادن پيل توانا به دريمي ایتمام ابزارها. 

• Outlook  د و به يرا باز کن Tools> Optionsديبرو. 

o یه هابرنام Outlookِافت کنند و هم از ي توانند نامه دری می سازمانیرها هم از سرو
 . نيآنلا ليمي ایبرنامه ها

o ۀبرنام Outlookاطلاعات مربوط به دو پارامتر .  م کرديد تنظي را باPOP )  سرور
 . د وارد شوديبا)   ارسال نامه ها سيسرو(  SMTP و ) افت نامه هايدر

را Options  ۀ تمام شد، پنجر(spell checking)یري غلط گی وقت.ديبروSpelling سر لوح ه ب •
 .ديببند

o ۀصفح Optionsد از ي مثال اگر بخواهیبرا. م کردن داردي تنظی برای امکانات متفاوت
 .ديم کنيات زبان را تنظيد جزئيد باي بهره ببریريامکان غلط گ
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د تا  جعبه ابزار يکنک ي کلFind یدوباره رو. ان شوديد تا ابزار جستجو نمايک کني کلFind یرو •
 .بسته شود

o ۀ برنامۀن مرور فشرديا Outlook ینات بخش هاي  انجام تمریشرکت کنندگان را برا 
  . کندی آماده میبعد
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  امضا و نشانه ها: ٢٫٢یبهره جوئ
ن پروژه با يدر ا.  است که سازمان به عهده گرفته استیدي جدۀ پروژی به شدت مشغول کار رویسوف

 ی برایکاريل پيم دارد در برزي کرده، سازمان تصمی جمع آوریم سوفي که تیي از داده هایريگبهره 
 با امضا و یل هائيمي قبلا ایسوف.  به راه اندازدی ضرورت رفع خشونت خانگۀ زنان در باریآگاه ساز

ن ي از ا خود بگذارد ویها  خواهد مشابه آن را در نامهی هم میسوف. افت کرده استيک نقل قول دري
  .گران را آگاه کنديش دارند، دي که در پینيکمپ ۀراه دربار

  تيفعال

  قهي دق٣٠

 .د که هم امضا و هم نقل قول داشته باشديل نمونه را باز کنيميک اي •

o را همراه هر ی مناسبۀکند که به طور خودکار امضا و جمل ین امکان را فراهم ميل ايميا 
نقل قول معمولا .   و عنوان فرستنده و آدرس اوستامضا معمولا شامل نام. دينامه بفرست

 یادآوريا يج  و يل است آن را ترويل مايمي اۀ است که فرستندی ارمانۀا دو خط درباريک ي
 .کند

•  Outlookبه. ديرا باز کن Tools > Optionsیرو. ديبروMail Format > Signatures > 
New ديک کنيکل. 

o خود درست ی نامه های برای خواهند امضا و شعاریا ميد که آياز شرکت کننده ها بپرس 
 .ديدا کني پی دیسل را در يمينکات مربوط به ا. ريا خيکنند و 

o باز شده  ۀرجدر پن (start)دي  را بزن . 

o  ديسين بنوي کمپۀک نقل قول جالب در باريا ي کوتاه ۀک جملينام و آدرس تان را همراه با. 

 .باشند و جلب نظر کنندجزا د که سطرها از هم مي کنی شکل بندینقل قول، امضا و متن را به گونه ا •
 OKدي برگردی قبلۀد تا به پنجريا بزن ر. 

o ک کردن يبا کلFont و  Paragraphدين کنيي حروف را تعۀرنگ و نوع و انداز. 

o کوتاه و امضا ۀ جملی که برای حروفۀ رنگ، و نوع و اندازی برایتيکه محدود با آن 
 و یمعمول(ک نوع فونت يا دورنگ و يک يست، بهتر است تنها از يند ي کنیانتخاب م
 .دياستفاده کن) پررنگ

 ۀتا به برنام ديرا بزن OK .ديم کنيام ها، پاسخ ها و باز فرستادن ها تنظي تمام پید را براي جدیامضا •
 .ديل برگرديميا

o ديش کنيک نامه آن را آزمايبا ارسال . تان آماده استيامضا. 

 شما یام تازه باز خواهد شد که امضاي پیبرا یپنجره ا. ديک کنيکل New Mail Message یرو •
 Send د و يرنده را بگذاري گینشان. ديسيرا بنول يميا ۀبدن . شودیبطور خود کار در آن نشان داده م

 .ديک کنيرا کل
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o ر ييد تغياه خویامضا را آن گونه که مو د يسينول بيمي خودتان ایچند بار براش ي آزمایبرا
 .ل شما شوديتا مطابق مد يده

 توان از آن کرد؟ ی میي چه استفاده ها-.ديا شعار با هم صحبت کني نقل قول و ی کاربردهاۀ دربار •

o رهيک آرمان و غيغ ي، تبلی سازیآگاه. 

  . موجود استی دیس فرستادن  آنها در ی گوناگون برایل و وب هايمي مربوط به ایترفندها :منابع افزوده
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  ميفهرست آدرسها و تقو: ٢٫٣یبهره جوئ
 را که قبلا از او یرنده نامه اي را ارسال کند، از راه آدرس گیليمي خواهد ای می سوفیمعمولا وقت

با .  چسباندیرنده مي آدرس گۀژي وی کند و در جای می کند، آدرس را کپیدا ميافت کرده است پيدر
ل است بداند ين رو ماي است و از همیشتريند وقت بازمي نی سوفیافتي دریاد شدن شمار نامه هايز

 ارسال یم براي خواهد از تقوین مياو همچن. ش بگذارديچطور آدرس افراد را در فهرست آدرس ها
  .ش استفاده کندي قرارهایادآورينامه ها و 

  تيفعا ل

  قهي دق٣٠

•  Outlook در بخش. ديل را باز کنيميک ايو سپسPreview )  به View > Reading Pane 
 .ديرا انتخاب کن Add to Outlook Contacts . د يک کني فرستنده راست کلی نشانی، رو)ديبرو

o ل را انتخاب يا هات مياهو و يل ، ي می جی از برنامه هایکي توانند یشرکت کنندگان م
 .دي توان دی می دیل در سيمي ارسال اۀ دربارینکات. کنند

ن يد به ايد آدرس جدي توانید ميهرقدر بخواه.  شودیا باز مرنده، فهرست آدرس هي گیبا زدن نشان •
 . ديفهرست اضافه کن

o  متعدد استفاده ی آدرس هاۀري ذخی توان از فهرست آدرس ها براید که مياد داشته باشيبه 
 ۀرندي گی تلفن و آدرس پستۀشتر، از جمله شماري افزودن اطلاعات بین برايکرد و همچن

 .  اميپ

o کرد، به عنوان نمونه براساس نام پروژه یره شده را طبقه بندي ذخیس ها توان آدریز مين 
 . ها و سازمان ها

 .شان اضافه کننديفهرست آدرس ها  را بهیشرکت کنندگان چند نشان •

تا د يبزن  To ۀ دگمیرو. دي درست کنیدي جدۀد تا ناميک کني کل New Mail Message یور •
 .ز شودد باي که درست کرده ایفهرست آدرس هائ

ب ين ترتيبه هم. منتقل شودTo د تا به محل يک کني آن کلیرنده ها را انتخاب و روي از گیکيآدرس  •
 .ديرا بزنOK د و يک کنيکلBcc  و Cc ی بخش های را رویآدرس

o که  را ی آدرس هائۀهم  به  خودبرنامه خودرنده ين حروف آدرس گيپ کردن اوليبا تا
ع تر ي مورد نظر سریافتن نشاني دهد تا یش ميرند نماداآدرس مورد نظر شما  با یشباهت
 .شود

o کاربرد": ٤٫٥ یابيدست :د بهيشتر بنگريات بي جزئیبرا Cc, To, Bcc. "       

 . ها بودی نشان کردنرهيش ذخي آزماین تنها براين تمري ارايد زيآن را ببندل يميا فرستادن یبجا •

 .دينيد  و تفاوت آنها را ببينيختلف را برگز مینماها.  ديک کني  کل (calendar)مي تقویرو •
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o ر ييد آن را تغي توانی که میخيشود؛ تاريخ روز نشان داده ميم تاري تقوی اصلۀدرصفح
ن شده يي که تعیان وقتين آغاز و پاي بی مهم در روزهایدادهاي ها و رویيگردهم آ .ديده

 .    شوندینشان داده م

o وارد ی از چگونگی آگاهیبرا.  ر داديي توان تغی مزيرا ن ني آنلایل هايميم ايخ تقويتار 
 .ی دیل در سيمي اۀ ها درباریفهرست دانستن: د بهيرات نگاه کنييکردن تغ

o خشونت ۀ درباری بعد از ظهر، جلسه ا٤ تا ٢نده، از ساعت ي آۀد چهارشنبيفرض کن 
 .ديآن را در روزنگار خود وارد کن. د داشتي خواهیخانگ

، ساعت را ماوسبا استفاده از  .ديم کنيد و آن را تنظيسمت راست صفحه بزن خ، دري تاریاول رو •
 New Appointmentیک تا رويد وسپس چپ کليک کني بخش انتخاب راست کلیرو .دير دهييتغ
 .ديبرو

o ن مورد به يدر ا.  دردسترس استی گوناگونیانه، روش هاي در رای انجام هر کاریبرا
خ و ساعت يد تاري توانی صفحه میدر بالاNew Appointment خصوص،  با انتخاب 

 .دين کنييجلسه را تع

 یدر محل نشان. یخشونت خانگ: ديسي، در محل موضوع بنوAppointment ۀدر پنجر •
Location ديسيرا بنو. 

o یداد روزانه را با رفتن رويرو All Dayدين کنييد تعي توانی انتخاب ساعت می به جا. 

 .ديد و خارج شويره کني ذخ •

o ن جلسه را هم به يا.  دارندی هماهنگۀ هر هفته صبح کارکنان جلسۀ دوشنبیوزهار
 .ديروزنگار اضافه کن

 .د يجاد کنيگر در روزنگار ايداد ديک رويNew Appointment  یبا رفتن رو •

 ید بر توالي تأکیبرا. جلسات مستمر کارکنان: ديسي قرار ملاقات، و در محل عنوان بنوۀدر پنجر •
 .ديک کنيکل )Action > Recurrence (  یجلسات  رو

o روند، مانند  یز به کار مي گوناگون نیدادهاي رویاد آوري ی برای متوالیداد هايرو
 ۀا فرستادن خبرنامي سازمان ۀريئت مديه و فرستادن گزارش ماهانه به هي تهیادآوري

 توان آنها ی مخ تولد و سالروزها همي تاریاد آوري یز براي علاقه مندانش و نیسازمان برا
 .م کرديرا تنظ

ل گر را ي تسهینشان. ديد تا شرکت کنندگان جلسات را دعوت کنيک کنيکلInvite Attendees  یرو •
 .دي جلسه بدهۀ درباریح کوتاهيو توضد يسيرا بنود، موضوع يسيبنوTo در محل 

o ن مناسب د عنوايل دعوت نامه بايميدر ا. ديم کرده اي جلسات را تنظیکار زمانبند نيبا ا
 .  از برنامه آورده شودیداد و شرح کوتاهيرو

o  اد داشت خواهد آمد و زمان جلسه يک ي شما یرد، براين که دعوت را بپذيک از مدعويهر
 . شودی آن شخص هم ثبت میکيدر روزنگار الکترون
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o ی می زندگی که  افراد در مناطق مختلف زمانیدعوت از افراد جلسه، مخصوصا وقت 
 افراد اعلام یزمان جلسات به طور خودکار و براساس زمان محل. کارآستار يکنند، بس

 . شودیم

گر دعوت نامه بفرستند و دعوت يک دي یار  شوند و براي خود یشرکت کنندگان با فرد کنار دست •
 .رندي هم گروه خود را بپذۀنام

o دا زمان جلسه رخ دهد، همگان آگاه خواهند شي در محل و یريين روش اگر تغيبا ا. 

 درروزنگار خود را مرور ی افتد چند هفته آتی که هر دوشنبه اتفاق میدادي آگاه شدن از رویبرا •
 .ديکن

 .دي پربارتر از روزنگار و دفتر آدرس ها گفت و گو کنیري بهره گیوه هاي شۀدربار •

o ی توان قرار های، مین علاوه بر جلسات کاري آنلای از روزنگارهایبا بهره جوئ 
 .کردم يظتن را هم یشخص

o  تواند از یز دارد و ميان شما را ني آشناۀهم یآدرس هاره کردن يت ذخي، ظرفآدرسدفتر 
 .ک جا نگه دارديل آنان را در يميجمله آدرس خانه، محل کار، تلفن، ا

  . دي توان دیز مي نی دیج را در سيل رايمي ای مشابه در برنامه های کارکردهاۀسي از مقایصفحه ا: منابع افزوده
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ل ها يمي و جستجو در ایسامانده: ٢٫٤یبهره جوئ  
 او یل و همکاران اش برايان، افراد فاميدوستان و آشنا. ر شده استي کنترل ناپذی سوفۀصندوق نام

ن،از آن جا که خود را مشترک چند خبرنامه کرده است صدوق نامه اش يعلاوه بر ا.  فرستندیل ميميا
  .ه استج کنندير و گي وقت گیپر از نامه ها

  تيفعا ل

  قهي دق٣٠

•  Outlookۀ پوشیبر رو. ديرا باز کن  Mailboxید رويک کنيچپ کل. ديبرو New Folder 
 .ديبزن

o دي کنید و طبقه بنديده  مختلف سامانینامه ها را با برچسب و پوشه ها. 

o  یل امکان مشابه را با برچسب مي میج.  توان پوشه  درست کردیل  مياهو و هات ميدر 
 .دهد

o ن را انجام دهندين تمرين ايل آنلايمي ایرکت کنندگان با استفاده از برنامه هاش. 

 .ديباز کنICT TOT Project  با نام یدي جدۀپوش •

o ۀ الف، پروژۀپروز. (کنندي می پروژه گروه بندۀي خود را بر پایران نامه هااز کاربَ یرخب 
گر بر ي دی، برخ) داديخواندن، نوشتن، پاسخ، رو(  ها بر اساس نوع کار یبعض) . ب

 ین روش هايک از ايچ يت، امّا، هيدر نها).  الف، سازمان بۀموسس(اساس سازمان 
 اطلاعات را آسان یابي کاربر بازیهر کدام که برا.  نداردیگري بر دیتي ارجحیگروه بند

 .کند سودمند استيتر م

 ین پوشه جايد و در ايد بِکِشيافت کرده بودي فاوا دری آموزشۀ دورۀ را که درباریي تمام نامه ها •
 .ديده

o ام و سپس انتخاب ي پیک زدن رويگر راست کليراه دMove to Folderاست . 

 مناسب یم کرد که خود به خود به پوشه هاي تنظی توان به  گونه ای را میافتي درینامه ها
 یها هاهي وسیکيالکترون یها خبرنامه:  ٢٫٦  ید به بخش بهره جوئينگاه کن.  خود بروند

  .ديني را ببیپست

د خود به ي خواهی که می نامه ایرو. ديباز کن ICT TOT Mailing List د با نام ي جدیپوشه ا •
 . دي صفحه بزنیبالار د Create Rule  ۀمگ دیرو. ديک کنيخود به پوشه برود کل

م  ي خود به خود کردن تنظۀوي ش(Creating rule)قاعده ساختن ا ي filter)( شيپالا 
 به xل ها از صندوق يمي اۀبه عنوان نمونه فرمان فرستادن هم(ل هاست يميا

 .y)صندوق 
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ش در ي پالای برای بهترینه هاي معمولا گزSubject و From. ديرا مرور کن شيموارد پالا •
 ۀپس از مرور پوش. ديرا انتخاب کنMove e-mail to Folder .  دهندیدسترس کاربر قرار م

 .ديرا بزنOK د يجد

o  فرستدی مناسب آن مۀم نامه ها آن را به پوشيد، فرمان تنظي جدۀافت هر ناميدربا  . 

o با انتخاب فرمان :Run This rule on messages already in email inboxۀ، هم 
 . خواهند شدیش و دسته بنديز پالاي ن  قبلیل هايميا

      .ديد برويد بگــردياه خوی که می پوشه اید و بر روي را وارد کـنیمتن. ـديبزنFind  یرو •
Find Nowدي را بزن. 

o  با انتخابOptions > Advanced Findدست یگري دینه هايد به گزي توانیز مي ن 
 .دهي رسیل هايمي جستجو براساس آدرس ا،د، به عنوان نمونهيابي

ن شان را سامايد درست کنند و نامه هاي جدیتا پوشه هاد ي بدهیفرصت کوتاهکنندکان  شرکتبه  •
 .دهند

 .ديانه گفت و گو کني رای درست نامه ها و پرونده های ساماندهیاي مزاۀدربار •

o نداردی برتریگري بر دی ساماندهیک از روش هايچ يه . 

o شودیشتر آشکار ميم نامه ها بي تنظیيبا گذشت زمان کارآ .  
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  ینيفه آفريو وظ ل هايمي ایابيرد: ٢٫٥یبهره جوئ
همکارانش .  و اشتراک دانش فراتر رفته استی از ابزار ارتباطیوف سی برایکي الکترونینامه نگار

 جلسات برنامه یفرستند و برا یرند و مي گی پردازند، داده میف ميص وظاين ابزار به تخصيبا ا
ش را ين امکانات کارهاي از ای خواهد با بهره جوئی میسوف. گري دی کارهایاريو بس کنند ی میزير

  .د انجام دهدي بای را در چه موقعیم کند و بداند چه کاريظت آن ها تنيبراساس اولو

  تيفعال

  قهي دق٣٠

•  Outlookبه.ديک کني آن راست کلی را انتخاب و روینامه ا.ديراباز کن  Follow-up >د و يبرو
 .دي کنیام انتخاب و آن را نشانه گذارين پي ای برایک نشان رنگي

o د نشان ي توانی مثال میبرا.  روندیبه کار م یاد آوري ی گوناگون براینشان ها با رنگ ها
 .ديم کنيت بالا تنظي با اولوی کارهاینده و نشان قرمز را براي آیدادهاي رویبنفش را برا

 .دي گوناگون علامت بگذاریام را با نشان هايچند پ •

o یل ستاره مي می دهد، جی را میاهو امکان پرچم گذاريگان، ي رایان برنامه هايدر م 
 . کندینه ارائه نمين زمي در ایل امکانيم-اتگذارد و ه

 د تا نامه ها بر اساس رنگ نشان هايک کني سر ستون نشان کلیل ها رويميدر بخش فهرست ا •

 .منظم شوند

o خ ياگر تار. کند ی آنها را آسان تر میابي گوناگون بازی رنگیل ها درستون هايميم ايتنظ
 ستون نام مرتب یخ، و اگر نام آن را، روي ستون تارید رويل را به خاطر داريميافت ايدر
 .ديکن

 یرو. ديک کني آن راست کلیرو.  دي را که نشان قرمز دارد انتخاب کنینامه ا •

  Follow-up Add Reminder > Set due date and timeجل خ ضرب الايد و تاريک کنيچپ کل
 .د يسيرا بنو

o کند و هشدار ی  میاد آوريامه ها را د کارها و برنيخ سررسيام تارير رنگ پييبرنامه با تغ 
 . دهدیم

o م ي مختلف تنظیوه هايبا ش. م کرديا جداگانه تنظي توان همراه با نشان و یادآورها را مي
 .مين کنييت انجام کارها را تعيم اولوي توانیکارها، م

 .دي بروFollow-up > Clear Flag یرو. ديک کنيام راست کلي پیک نشان روي پاک کردن یبرا •

 .ديبروNew Task  ید و سپس رويک کنيراست کل د،يمت چپ بروس  (Tasks) در بخش وظائف  •
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o "است که در  ليمي در ارتباط با ایا اموريدر واقع فهرست کارها، برنامه ها و " وظائف
 یخ ميت ها ومشخص کردن زمان و تاريم اولوي تنظیاز آن ها  برا. رديد انجام گينده بايآ

 . توان بهره جست

 .دي را اختصاص دهیخ متفاوتيک تاري هر یو برا ديف کنيد تعري جدۀفيچند وظ  •

o ديش کنيخ گذشته رفتار برنامه را آزماي به تاریديبا نوشتن سررس. 

 .دي کنار آن علامت بزنۀ جعبیکار رو ني ایبرا. ديف را انجام شده اعلام کني از وظایکي •

o ماند ی می باقی انجام شدنی در فهرست کارها شود امّای میافته تلقيان يفه پايکار وظ نيبا ا 
 .د استيد مفي که تمام کرده ایي مرور کارهایو برا

 و حرفه ی شخصی در انجام کارهایل به عنوان ابزاريمي اۀ توان  از برنامید که چگونه ميبحث کن •
  استفاده کرد؟یا

o د کارها يخ سررسيتار ی نشان گذاری برای نامه رسانۀ توان از برنامیل ميميبا استفاده از ا
 .ز استفاده کردين

o اشخاص و تماس با آنها یليميا آدرس ايافتن شماره تلقن ي ی توان از دفتر آدرس ها برایم 
 . بهره گرفت

o تازه درست کردی از کارهای از وظائف فهرستیبا بهره جوئ . 

o م و روزنگار استفاده کردي توان از تقویلسات و ملاقات ها مج یابي ردیبرا.  
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   و فهرست آدرس هایکي الکترونیخبرنامه ها: ٢٫٦یهره جوئب
   ین رو، ويازهم.  کندیافت ميانش دري شمار ازهمکاران و آشنای بیکي الکترونی خبرنامه هایسوف

ش يشه براي آنها همیهاي مسائل زنان آگاه است و نوآورۀنيگر در زمي دی سازمان هایتهاياز فعال
و رد يبگن سازمانها و افراد تماس يل است تا با اي مایسوف. استن يو نیکارهاافتن ي ی برایزه ايانگ

  .جاد کندي از فعالان جنبش زنان ایشبکه  ا

  تيفعا ل

  قهي دق٣٠

 . ديني را ببی دی سی روینمونه ها .دي نمونه را باز کنیکي الکترونۀک خبرنامي •

o با هوادارانشان  نگه داشتن ارتباط سازمان های برایله ايوس یکي الکترونیخبرنامه ها 
 یکي الکترونۀخبرنام.  خود قرار دهندیشرفت هايع و پيان وقايهستند تا آنها را در جر

 از ی  که با شمار بزرگی سازمان هائی چند است، برا-به -کي تماس ی از ابزارهایکي
 . افراد ارتباط دارد

o ی خاصۀنيزمل اند در يکه ما سودمند است یکسان ی معمولاً برای پستیفهرست آدرس ها 
 دست ی ارتباط های است برایگر، ابزاريبه عبارت د. گر تبادل نظر و خبر کننديکديبا 

 شود ی حاصل می مشخصیبه صندوق پستل يميا از راه فرستادن ین ارتباطيچن. یجمع
 .  مشترکانش بفرستدۀام ها را به همي تواند پیکه م

ک ي کلNews & Events > eNews یرو. ديبرو/http://learningpartnership.org به  •
 .ديبزن  Subscribe to eNews ۀ دگمید و رويو را بخواني آرشیچند تا از خبرنامه ها. ديکن

o شود آگاه ی که در آن گروه مبادله مید از نوع مطالبي توانیمل يميا یوهايبا مرور آرش 
 .ديشو

o تد اما توانا به  فرسیام ها را مي پیعنيک طرفه است ي یکي الکترونیکار خبرنامه ها
 . ستيگرفتن پاسخ ن

 .ديد تا مشترک صفحه شويرا بزنSubmit د و علامت ياز را وارد کنياطلاعات مورد ن •

o دهندی اشتراک را به درخواست کنندگان اطلاع میافت تقاضايشتر خبرنامه ها دريب  . 

o کار  وب که یک فرم رويا يدارند و ل يمياک آدرس يا ي عموما ی پستیفهرست آدرس ها
افت پاسخ يک نامه به صندوق شما و دريشتر آنها با فرستادن يب. دهندي ثبت نام را انجام م

 .ابندي ینان مي بودن درخواست اطمیآن از واقع

o رگيد یراافتن از متناسب بودن مطالبشان بينان يل ها و اطميمي ایمعمولاً پس از بررس 
ده بدون مرور و نظارت بر ي رسی هاليميگر فرستادن ايراه د.  شوندیمشترکان فرستاده م
 . مطالب آن ها است

ن نامه اشتراک يدن اياعلام رسد با يبا.  شودیفرستاده مثبت نام شما اعلام  یه برايديي تاۀک نامي •
 .ن نامه کار ثبت نام تمام خواهد شديز ارسال ا پس ا.ديد کنيتان را تأئ
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o است از جمله رمز یات مهمرفتن درخواست اشتراک شامل اطلاعيد پذيي تاینامه ها 
ن يمتن ا. ام مربوط به عدم حضور کاربري فرستادن پیورود، روش ثبت نام، و چگونگ

 .ديره کني ذخیي در جای مرور بعدیه را براي اولۀنام

o ر ييرندگان آن تغيام به گيدن پيده به فهرست آدرس ها زمان رسي رسیام هايبسته به حجم پ
ک يام ها را به ي توان ارسال پیشتر از حد مطلوب بود ميافت ها بياگر حجم در.  کندیم

ک ياقت شده در ي دریام هاي پۀ همۀ، خلاصین صورتيدر چن.  بار در روز محدود کرد
 مانع متراکم شدن صندوق یوه اين شيت چنيرعا.  فرستاده خواهد شدان مشترکیل برايميا
 . رنده خواهد شديگ

o ی براین است که آدرس مخصوصيل ها ايمي از تراکم ایري جلوگی برایگريراه د 
 . ديافت خبرنامه ها بازکنيدر

 .ديم کني را تنظیام رساني پۀتان ارسال شده ورودتان را ثبت و نحوي که برایبا استفاده از اطلاعات •

o م کرديا دائم تنظيافت نامه ها را به صورت موقت ي توان دری می خاصیوه هايبا ش. 

o دي کنیام به گروه را بررسيک پيد و روش فرستادن يد اشتراک را باز کنيي تاۀنام. 

o ان ي خودکار مانند پای انجام کارهای برایکي. فهرست آدرس ها معمولاً دو آدرس دارند
 . مشترکانۀل به هميمي ارسال ای برایگريدادن به اشتراک و د

 .ديآمده است بفرسته يديي تاۀ  که در نامید و به آدرسيسي بنوی خود و سازمانتان نامه ای معرفیبرا •

o  مشترکان فرستاده خواهد شدۀام به همين پيد که اياد داشته باشيبه . 

 .ديل فرستاد گفت و گو کنيمي ای توان از راه فهرست های که می مطالبۀدربار •

د يت کنيرا رعا د ها و حرمت قلميد و نبايبا. دي فرستادن آن محتاط باشیام و چگونگي پی محتواۀدر بار •
اد يد، به يشناس ی مشترکان را نمۀاز آنجا که هم.دي افراد احترام گذاریمني و ایخصوصم يو به حر
ز فراموش يو ن. ان مشترکان باشنديز در مي نیتي و امنینان دولتيد که ممکن است خبرچيداشته باش

 . شما در گروه باشدیا آتين و يشي از همکاران پیکيد که ممکن است ينکن

 ۀه کردن خبرناميته": ٣٫٢ در بخش  راهکار ی سازمانیکي الکترونۀمک خبرنايه کردن ي تهۀويش •
  . آمده است"،یکيالکترون
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  شرفتهي پیواژه پردازها: ٣یبهره جوئ
 اهداف

  .(Mail Merge) ی دستجمعیل هايميکروسافت ورد، مانند اي در مای امکانات حرفه ایبررس •

  .ن ارتباطي ایآموختن روش ارتباط دو برنامه با هم و روش امن برقرار •

م و ابزارهايمفاه  

ن ياز ا. ا چاپ برچسب آن هاي و ی دستجمعیام هاي پۀيار دارند، از جمله تهي واژه پرداز امکانات بسیبرنامه ها
 ی توان بهره جست، مانند فرستادن دعوت نامه برای می متعدد و دستجمعیامکانات هنگام فرستادن نامه ها

 تبادل پرونده ها و داده ها را ین برنامه ها توانائيا. ک سازماني ی اعضاۀ همیا گزارش سالانه براي و یداديرو
.ز دارندين  

:   واژه پردازها انواع گوناگون دارند از آن جمله  

Microsoft Word, OpenOffice Writer, Microsoft Works Word Processor, Google Docs, 
Zoho Writer. 

گر واژه يشتر از دي بیتيشورها و مناطق گوناگون جهان شهرت و محبوبکروسافت ورد در کيان ماين ميدر ا
برنامه . م کردين برنامه استفاده خواهي، ما از همیکي الکترونی های آموزش فناورین رو  براياز هم. پردازها دارد

ز يد، از آنها ن نباشینترنت مشکلي و سرعت ارتباط ایابي هم هستند که اگر از لحاظ ارتباط ینيگان و آنلاي رایها
. توان بهره جستیم  

 

لگري تسهیآمادگ  

ک روز قبل از ي. افتي توان ی می دی سیاز اند روي مورد نین بخش آموزشي ای را که برایيپرونده ها •
 .دي کارگاه قرار دهیانه هاي راین پرونده ها را رويشروع جلسه ا

 . ديانه ها فعّال کني راۀز در همي را نیآدرس ها و ابزار بررس ۀاستوانروز قبل از شروع جلسات  •

د که ينان حاصل کنيش از آغاز آموزش، اطميروز پ. ستندي نصب نۀدر برنام ش آماده شدهي از پیالگوها •
  .دين صورت آنها را نصب کنير ايدر غ.  کارگاه نصب شده اندیانه هاي راۀ مورد نظر در همیالگوها
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  رات يي و چسباندن تغیابيرد: ٣٫١یبهره جوئ
 آخر ی کنند و تمام محاسبات مالیانه از اکسل استفاده مي سالی گزارش هایاران سارا معمولا براهمک

 ی کنند و روی میح را در اکسل کپيپس از اتمام محاسبات، نتا.  دهندین برنامه انجام ميسال را با ا
 ی سازمان م گوناگونی، آنها را به بخش هامدارکن ي شدن ایيپس از نها.  چسبانندیرد موُمدارک 

  . شوندیفرستند تا مجددا بررس

  تيفعا ل

  قهي دق٣٠

 .ديبرو Start > Programs > Microsoft Office> Word به  •

o یبرنامه ها. نميک یاف استفاده م. ید. ی ورد، اکسل و پین از برنامه هاين تمريما در ا  
 . مشابه وجود دارندی های هم با توانائیگريمشابه د

 .دينيد و ساختار آن را ببيباز کن Org Annual Report  ۀپرونده را در پوش •

o برنامه ها و پروژه هاۀ درباریتز اطلاعاي اند و نی از جداول شامل محاسبات مالیبرخ . 

 .دينيد و ساختارآن را ببيپرونده اکسل را را باز کن •

o روش . ه شده استي اکسل تهۀ برنامۀليورد آمده، بوسمدرک  که در گزارش یيداده ها
 .دي کنی اکسل در ورد را بررسیسباندن داده هاچ

 . Edit > Copy دي کنیجدول بودجه را در پرونده اکسل انتخاب و کپ •

 .دي ورد بروۀد تا به برنامياستفاده کن  alt+tabانبر ي میدهاياز کل •

o alt+tabاز آنها را یکي کند و به کاربر امکان انتخاب ی فعال حرکت مین برنامه هاي ب 
 .ک کردي مورد نظر رفت و آن را کلۀ برنامی توان رویم.  دهدیم

o Paste Special مونه ن.  دهدی مختلف چسباندن را در دسترس کاربر قرار میروشها
 . وردمدرکمانند چسباندن کل پرونده اکسل در . دييازماين روش ها را بي  از ایهائ

• Edit> Paste Special > Picture (Enhanced Meta File) 

o یرينکار جلوگيا ۀفائد.  چسباندیر مي انتخاب شده را به صورت تصویه داده هانين گزيا 
 .استمدرک  در یاز  دستکار

• Edit > Paste Special > Unformatted Text 

o چسباندیدول مج ی جدول را بدون خط و شکل بندینه تنها داده هاين گزيا . 

 .دي بروTools> Track Changeبه  •
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o کنند  ی میراستاري واحد را ومدرکک يه چند کاربر مختلف  کیرات هنگاميي تغیابيرد
راستاران يرات و شناختن ويي تمام تغی تواند، با بررسی میيراستار نهايو. کاربرد دارد

 . ا ردکنديرد يش ها را بپذيرايه، وياول

 .دي کنید و آن را شکل بنديا از آن بکاهيد يفزائيبه متن ب. دي بدهمدرکن ي در ایراتييتغ •

رات اندازه و شکل حروف را نشان ييرات تمام افزوده ها، حذف شده ها، و حتا تغيي تغیابيرد •
 . دهدیم

 .  با شماستیيش نهايرايو. رات را وارد کرده انديي سازمان تغید  تمام بخش هايفرض کن •

مکان نما . دي ها بزنیرا در ستون بررسAccept Change د و يرات بگذاريي تغیمکان نما را رو •
 .ديرا بزنReject Change د  و ي بگذاریگرير ديي تغیورا ر

o ب آن انجام داديا تکذيد و يير و بعد تايي مورد تغیک روي توان با راست کلیکار را م نيا. 

o در انواع . رفتيرات را پذييکباره تمام تغيا ي کرد و یک بررسيک به يرات را يي توان تغیم
Reviewing  با زدن ،Accept All ديريرات را بپذييتمام تغ. 

 ی استفاده خواهند کرد؟ در کجاها به دردشان میابيا از امکان رديد که آياز شرکت کنندگان بپرس •
 خورد؟

  .ديورد را ببند •
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  ساخته شيپ یالگوها یاري به مدارک ۀيته: ٣٫٢یجوئ بهره
شنهاد ي فرستد، از جمله پیگر مي دی سازمان های را برای گوناگون و متعددمدارکشه يسازمان عا

ن يا. ان گذاران، و خبرنامه هاي بنی، گزارش هایقي تحقی، گزارشهای مالیبستن قرارداد، گزارش ها
.  شهره استی حقوق زنان، حقوق بشر، و عدالت اجتماعینه هاي در زمیسازمان به داشتن نقش رهبر

 و یار حرفه اي از آنها بسیبرخ. ستي درشأن سازمان نمدارکن يکند که  مجموع ا یشه احساس ميعا
  . ابدينان ي اطممدارکن ي ایکدستي خواهد از یاو م.  درست شده اندیيگر ابتداي دیبرخ

  تيفعال

  قهي دق٣٠

 .ديکروسافت ورد را باز کني ماۀبرنام •

o داردمدارکدست کردن انواع  کي ی گوناگون برای ورد الگوهاۀبرنام . 

 یاز روTemplate on my computer . دي باز کنیدي جدمدرکد تا يبرو File  > New به  •
 .ديرا انتخاب کنProfessional Letter  یالگو. دينيرا برگزNew Document  انتخاب

o دهدیش آنها را هم شرح ميراي پرکردن بخش ها و ویوه هاي شیهر الگوئ . 

را Professional Fax, Memo, Report . دي درست کنیدي جدمدرکFile > New با رفتن به  •
 .ديکنانتخاب 

o را به صورت دلخواه مدرک توان شروع کرد و سپس ی وُرد مۀش ساختي پیبا الگوها 
 ".ی سفارشیالگوها": ٤٫٢راهکار .ر دادييتغ

o انتشارات را هم یژه الگوي را، به ویگري دید که شرکت کنندگان الگوهايشنهاد کنيپ 
 . کنندیبررس

 .ديورد را ببند •

 تخته ین نکات را رويشرکت کنندگان ا. ديبت کن صحمدارک کردن ی حرفه ای روشهاۀدربار •
 .سنديبنو

o ی واحد برایاستفاده از الگو. را و نه رنگ ها و حروف گوناگونيساختار همگون و گ 
  .  سازمانی فکس و گزارش های سرنامه های و مکرر، به عنوان نمونه برای جاریکارها
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   و برچسب های دستجمعینامه ها: ٣٠٣ یبهره جوئ
 یگروه سارا م.  آن آماده استیي نهاۀ شده و نسخی مختلف بررسینه توسط پروژه هاگزارش سالا

م دارد با استفاده از يگروه تصم. بانان سازمان بفرستدي از پشتیادي جمع زین گزارش هارا برايخواهد ا
 پ و چاپي آدرس آن ها را تایسد و برچسب هايافت کننده بنوي خطاب به هردریيابزار ورد، نامه ها

  .کند

  تيفعال

  قهي دق٣٠

مدرک د تا ي برو< Start > Programs > Microsoft Office > Word > File> New به •
 .دي درست کنیديجد

o رندگان متعدد و آدرس ي واحد  به گۀ است که در آن نامی روشی دستجمعیفرستادن نامه ها
: شته باشند دای توانند خطاب شخصی مینامه ها حتّ . شودی گوناگون  فرستاده میها

شود و  ید انجام ميک کلي با زدن ین کارينچ.  ------  یا جناب آقاي، و ----سرکار خانم 
 .ستيل ها نيميک از اي هر ۀپ جداگاني به تایلزوم

 .دينيگزر را بی دستجمعی نامه هایانه را انتخاب و سپس الگوي رایالگوها •

o د ي توانین الگوها ميبا ا. ندق ايدقو س ي برنامه معمولا مدرن، نفۀش ساختي پیالگوها
ادگرفتن ساختن الگو ي یبرا. دي آنها وارد کنۀش ساختيرات مورد نظر خود را بر فرم پييتغ

 ".ی سفارشیالگوها": ٤٫٢راهکار : د بهينگاه کن

 . ديک کنيد کليرندگان جدي فهرست گیرو •

o یسهاا در فهرست آدريد يابيد در دفتر آدرسها بي توانیرنده ها را ميفهرست گ Outlook. 

 .ديپ کنيا سه نام و آدرس را تايدو  •

o و عنوان در دسترس یرنده از جمله نام، نام خانوادگي مربوط به هرگیاطلاعات ضرور 
 .ه شده افزودي تهیتوان به الگو یشتر را هم مياطلاعات ب.  اند

 ها را خواهد ره کردن آدرسيبرنامه از شما مکان ذخ. ديافت کننده ها را ببندي افزودن درۀپنجر •
 .د يپرس

o ۀآدرس ها خود به خود در پوش  My Documentتواند یاما کاربر م.  شوندیره ميذخ 
ک يد آدرس ها را در يم گرفتياگر تصم.  انتخاب کندیره سازي ذخی را برایمحل متفاوت

 . کارمندان سازمان قادر خواهند بود از آنها استفاده کنندۀد، هميره کنيمحل مشترک ذخ

• Next Write Your Letterديد و اصلاحات لازم را وارد کني را بزن . 

o سنده، و ي نامه، عنوان شغل نوۀسنديش نام سازمان، آدرس، نام نويراي قابل ویبخش ها
 . نامه اندیمحتوا

 .دينيرا برگزEdit AddressBlock د و يک کنيراست کل<<Address Blocks >>  یرو •
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 .دي آدرس انتخاب کنیا را بریکي مختلف ینه هايان گزياز م •

 .دي کنیم آدرس را بررسي تنظی ممکن برایانتخاب ها •

o د تا ين که نام را در کجا قرار دهيد، از ايش کنيراي نامه را وی بخش هاۀد همي توانیشما م
 . ا نهيرنده لازم است يا نام کشور گين که آيا

 .ديک کني کلNext Preview Your Letter یرو •

o قبل از چاپ را ینيرنده ها در بازبيا حذف نام از فهرست گيدن نام و ن ابزار امکان افزويا 
 . دهدیبه کاربران م

o  سپسNext Complete the Mergeديک کني  را کل 

o چاپ استۀ کامل شده و آمادی دستجمعینامه ها . 

•  Printنامه ها چاپ شوندۀد تا هميرا بزن . 

o وارد کردیگريرات ديي توان تغیاز بود، مين مرحله هم، اگر نيدر ا . 

 .  فرستادن اندۀنامه ها آماد •

o د از يکار با ني ایبرا. ن برنامه استفاده کردي توان از همی برچسب آدرس میبرا
Mailing Labelی  که در الگو Letters and Faxesديقرار دارد استفاده کن. 

  .ديورد را ببند •
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  ی و شکل دهیآرائصفحه : ٣٫٤یبهره جوئ
 ی خود، گزارش های گروه کاریقات و مستندات سازمان، با همراهيش تحقس بخي به عنوان رئیسوف
 ی بررسین گزارش ها حاويگهگاه ا. ش دارندي صفحه گنجا٤٠  تا ٤ کنند که از یه مي متعدد تهیرسم
 جامع و مستند اند همراه با ین گزارش ها حاصل پژوهش هايگر از اي دیبرخ.  گوناگون اندیها

  .ونارجاعات و منابع گوناگ

  تيفعال

  قهي دق٣٠

 .دي بروStart> Programs > Microsoft Office > Wordبه  •

o و یک گزارش اداريه يشرفته است که هنگام تهي پی امکانات جستجوین برنامه حاويا 
 . د داشتي خواهی به آن ها دسترسیحرفه ا

 .ديرا باز کن Training > Word Folder  ۀق در پوشي گزارش تحقمدرک •

o دي ببریپامکانات جستجو به ق آن ي شما گذاشته شده که از طری برادرکم ۀک نموني . 

 .ديني گوناگون را ببینه هايتا گز ديبروInsert > Reference  یرو •

o س و فهرست ير نوي دارد مانند زیقاتيتحقل مدارک يتکم یشرفته براي ورد امکانات پۀبرنام
 .مطالب

 .دير متن بگذار د(endnote) سي نویپ و  (footnote) سيرنويز •

o استی و کتابشناسی ارائه کردن منابع اضافیس معمولاً برايس و پا نوير نويز  . 

 .ديک کنيکلFormat View > Header & Footer  یرو •

o ف، نام ي صفحه، حق تألۀ مانند شمارین صفحه محل قرار دادن اطلاعاتيي بالا و پایلوح ها
 . خ نگارش گزارش استيسازمان و تار

) وسط(سنده ي، نام نو)سمت راست(  صفحه ۀشمار .دين را در سمت راست سرلوح بگذارنام سازما •
 .ديسين بنوييرا در لوح پا) سمت چپ (مدرکخنگارش يو تار

o دي کنید شکل بنديتوان ین را هم ميي بالا و پای، لوح هامدرکگر ي دیهمانند همه بخش ها. 

 .دي برو Insert > Reference > Index & Tables پس از سر لوح به ی خالۀدر صفح •

 . ديک کنيکلTable of Contents > OK  یرو •

o ن يعناو.  شودیه ميفهرست مطالب با استفاده از امکانات نرم افزار و به نوع خودکار ته
 .  توان در سه سطح قراردادیسرصفحه ها را م

 .ديد و آن را فعال کنيبروView > Toolbars > Outlining به  •

o ديا خاموش کنيد جعبه ابزار مربوط به آن را فعال و ي که در دست داریبر اساس کار. 
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o  با استفاده از جعبه ابزار Outliningش ي آمده در فهرست مطالب روش نماینه هايو گز
 .دين کنييجدول فهرست مطالب را تع

 یارين ين تمري انجام ایران را بيري توانند سایف را تمام کرده اند، مين تکلي که ایشرکت کنندگان •
 . دهند

ه ين شکل تهي به بهتریي نهامدرکش کنند تا ي ها را انتخاب و آزمایشرکت کنندگان انواع شکل بند •
 . شود

o را که شرکت کنندگان به کار برده اند ی شکل بندی جلسه، ابزارها و روشهایدر انتها 
 . دي کنیبررس

  .ديديکروسافت ورد را ببنيما •
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  شرفتهي پیجداول محاسبات: ٤یبهره جوئ
 اهداف

 .ی جداول محاسباتی برنامه هاۀشرفتي پیهايژگيدرک و •

 .ی جداول محاسباتی مختلف کاربرد برنامه هاینه هاي زمیبررس •

  . مستقلۀک پروژي ۀي و تهی جداول محاسباتیاستفاده ازدانش کارکرد برنامه ها •

 

م و ابزارهايمفاه  

.  ، و گزارش دادن اعدادیابي محاسبه، ردی هستند برای سودمندی ابزارهای جداول محاسباتیبرنامه ها
 یار کاربر قرار ميخ، واحد پول، و متن را در اختي هرگونه داده، از جمله تاریابين جداول امکان رديا

ن جداول ين، ايافزون بر ا. ق ارقام و اعداد ارائه شده راي گزارش محاسبه و تلفۀيز امکان تهيدهند و ن
   گذارندیارکاربران مي کردن اعداد را به شکل نمودارها و گراف ها در اختامکان مصور

 و ی شخصیکرو سافت اکسل است با کاربردهايا ماي در دنی جداول محاسباتین برنامه هايجتري از رایکي
    OpenOffice Calc, Google Spreadsheets, Zoho Sheet هم ز مانندينگري دیابزارها. یحرفه ا

  .ب خود را دارنديا و معايد که هر کدام مزادردسترس ان

لگري تسهیآمادگ  

روز قبل از شروع . کنند یرا نصب نم" یکمک "یهال يفا اکسل ۀ برنامۀشرفتي پی از نسخه هایبرخ •
افزار اکسل آنها بخش  د که  نرميد تا مطمئن شوي کنی کارگاه را بررسیانه هاي، تمام رای آموزشۀجلس

د که برنامه ممکن است تنها از يتوجه داشته باش. دياگر نداشتند، آن را نصب کن .را داشته باشد" یکمک"
 . قابل نصب کردن باشدی اصلی دیراه س

 آموزش ۀروز قبل از شروع جلس. طور خودکار نصب نشده باشده ز ممکن است بين "یکمک دفتر"ل يفا •
ن صورت آن را نصب ير اي در غ. آن را دارندید که همگيد تا مطمئن شويک کنيانه ها کلي راۀ همیرو
 .ديکن

 تواند آنها را در شروع کار به یلگر ميتسه.  موجود استی دی اکسل در سۀ کامل شدی پرونده هاۀنمون •
لگر ي مخصوص تسهۀها در پوشل يفان يا.  به چه شکل خواهد بودیينند که کار نهايهمه نشان دهد تا بب
  .ره شونديخ او ذۀاني راید تنها بر رويقرار دارند و با
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  دهيچيمحاسبات پ: ٤٫١یبهره جوئ
ش با استفاده از صفحات جداول يکند که سال ها پ ی کار می ای محاسبات حقوقۀسارا با برنام

ا، عنوان ي تمام کارکنان سازمان را همراه حقوق و مزاین جداول اساميا.  نوشته شده استیمحاسبات
ن جداول بهره جسته آن چنان که يان مدام و مکرر از اسازم. دهديخ  استخدام شان نشان مي ، وتاریشغل

 نفر ٣٢ نفر به ٤ن سال ها تعداد کارمندان سازمان از يدر طول ا. ده شده استي کاغذ ها سائیکناره ها
  .دا کرده استيش پيافزا

  تيفعال

 قهي دق٤٥

 ۀ را که در پوشیليفا. ديبرو Start> Programs > Microsoft Office . Excel به  •
Training > Excel Folder دياست باز کني حقوق و مزاۀ است و نام  آن خلاص. 

o ن يدر ا .ا، و جمع کل دارديخ استخدام، حقوق، مزاي نام، عنوان، تاری برایيصفحه ستونها
 .ديد را هم به آن اضافه کني جدی سازمان را حساب و اعضایصفحه جمع حقوق پرداخت

o را نگذرانده اند، ی جداول محاسباتۀيند که آموزش اولن شرکت کنندگان هستي بیاگر گروه 
 را ی مقدماتۀ گروه دوری اعضاۀاگر هم. دين با آنها همراه شويگام به گام در طو ل تمر
 . کنندیرا ط یبعدد خودشان مراحل يگذرانده اند، اجازه ده

 .دي و فرمول محاسبه آن را مرور کنی جمع کل حقوق را بررسی از سلولهایکي •

o با .  سطر درست شده استۀب نام ستون و شماري خود دارد که از ترکۀژي ویلول نامهر س
ن محاسبات استفاده شده يد که از کدام سلولها در ايابي ی سطر اول، در میمرور فرمول ها

 . است

 .ديک کني سلول  جمع کل دوبار کلیبر رو •

o یه هايه شده اند با حاش فرمولها به کار بردۀ را که در محاسبیي سلولهاۀ اکسل همۀبرنام  
 .کند ی مشخص میرنگ

 یابند براي شرکت کنندگان درۀد تا هميشگر بزرگ نشان دهي نمای اکسل  را روۀپرونده کامل شد •
 . کنندی میگر همکاريکدي با یدن به چه مقصوديرس

o ن ي اطلاعات مربوط به حقوق ها را بر اساس عناوۀد که خلاصي درست کنیگري دۀصفح
 ".دينيوگرافها بب نمودارها": ٤٫٢  ینمودارها را در بخش بهره جوئ. باشد داشته یشغل

"  فهرست حقوقها" به ١ ۀد و نام آن صفحه را از صفحيک کنين صفحه دوبار کليي لوح پایرو •
(Payroll)دير دهيي تغ. 

 ی برای چند صفحه جمع شده اند پس از مرور آن ها نام مناسبیک جدول محاسباتيدر   کهیهنگام •
 .شتر شودي آن ها بید تا کارآئيک انتخاب کنيره
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ستون جمع معرف حقوق . ديپ کنيرا تا" سالانه "ۀواژ"  جمع"پس از ستون : فهرست حقوق ها •
 . دي کارمندان را محاسبه کنۀ همۀحقوق سالان. ماهانه است

o فرمول سطر اول را :(=G١٢*٣)ی بعدیف هاين فرمول را در ردي همید و کپيپ کني تا 
 .دينبچسبا

: د و سپس بهيپ کني را تایخ استخــدام و حقوق عنوان شغليعنــوان، تار: فهرست حقــوق ها •
Data >Data> Filter > Auto Filter دي برو. 

o ش خودکار يپالا( Auto filtering)ا در چند ي توان در کل صفحه اعمال کرد ی را م
 .ها م دادهيو تنظ یجداساز": ٦٫٣ یابيدست: د بهيبنگر. ستون مجاور هم

 ۀن صفحيا نام name> Insert > Worksheet . د يک  کني فهرست حقوق ها راست کلۀبر دگم •
 .ديبگذار" خلاصه"د را يجد

o ق و يتلف.  اعداد و اطلاعات مربوط به حقوق هاۀق کردن و محاسبيلفتد به يشروع کن
 .دنن همگون باشي عناوید بر مبنايگزارش ها با

 آخر سال، و یديگروه، جمع حقوق سالانه، ع: ديون ها را درست کنن ستيا" خلاصه "ۀدر صفح •
 .د مسئول برنامهيسي بنویر سر ستون گروه کاريز. جمع کل 

ر يده شوند و نه سايزان ديد تا فقط برنامه ريش کنيعنوان مسئول برنامه را پالا: فهرست حقوق ها •
 .افراد

o جمع . ديد ديک از آن ها را خواهي هرۀنزان و حقوق سالايکار تنها تعداد کل برنامه ر نيبا ا
 .د و نه در فهرست حقوق هايبگذار" خلاصه "ۀکل حقوق ها را در صفح

ز يد و نيک کني حقوق کلیرو. ديپ کنيرا تا(=) یدر ستون جمع کل سالانه علامت مساو: خلاصه •
 که ی را تا حدن کاريا. ديزان تا جمع آنها به دست آين برنامه ريسوم+ ن يدوم+ ن ي حقوق اولیرو

 . دي  را بزنenterد و سپس يلازم است تکرار کن

o آموخته اندیک ها را به درستيپ کردن و کليتا ید که شرکت کنندگان تواليمطمئن شو   .
 . ل خواهد شدي تکمenter  ۀفرمول با زدن دگم. پ شونديتمام نمادها درست و به جا تا

o توجه . مي استفاده کرده ایده ايچي پیان دو صفحه از فرمولهي بی ارزش هاۀ محاسبیبرا
 که یي سلولهاید بلکه شما بر روياموخته ايک فرمول را نيوه ساختن يد که شيداشته باش
 .ه است اکسل فرمول را ساخت.ديک کرديد کليرشان را لازم داشتيجمع مقاد

 . دي آخر ادامه دهیرا تا گام ها" خلاصه "ۀن در صفحيتمر •

 .دينيد تا فرمول محاسبه را ببيکنک ي جمع کل دوبار کلیرو •

 . انيزان، و مربياران برنامه ريدست: ديگر را محاسبه کني دو گروه دۀجمع حقوق سالان •

 .ديپ کني را تا١٠% سالانه یدي سلول عی سلول بالایرو •
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o ن درصد يجمع ا.  خواهند گرفتیدي است که امسال کارکنان به عنوان عین درصديا
 .دي سه گروه محاسبه کنیرابرا

 و جمع یدي را با حاصل ضرب درصد عیدي، عیزي مسئول برنامه ریدي سلول عیرو": خلاصه" •
 .ديحقوق سالانه محاسبه کن

o دهدین محاسبات را خود به خود انجام مياکسل ا  . 

 . ديز به کار بريار برنامه ري دستۀ حقوق سالانۀ محاسبین فرمول  را براي هم •

o د که يدان یم.  نخواهند گرفتیديز امسال عيه راران برنامي رسد که دستیبه نظر م
 .ديابيد تا علت را بيد دوباره آن را مرور کنيد درست بوده باشد، پس بايمحاسبه نبا

 . ديني شده را ببید تا سلول کپيک کنيز دوبار کليار برنامه ري دستیدي سلول عیرو •

o اکسل فرض کرده .کند ی ماني را که در محاسبه به کار رفته اند با رنگ نمایاکسل دو سلول
ن فرض اشتباه ين مورد خاص اياما در ا.  استی بعدیف هاياست که محاسبه بر اساس رد

 .ديح کنيد که خطا را با دست تصحيشما مجبور. است

. ديک کنيز کليار برنامه ري دستیديدن به محاسبه عي رسی صفحه برای فرمول بالاۀاستوان یرو •
 .ديح کنيک کردن بر سلول درست تصحيو کلفرمول را با حذف سلول نادرست 

o درست استیدن فرمول محاسبه به سلول هايگر اصلاح خطا کشيراه د  . 

o ر داديي توان آنها را با دست تغیپس م. ف خلاصه وجود دارندين صفحه تنها سه رديدر ا .
 .ستيده تر کارساز نيچي جداول بزرگتر و محاسبات پی برایوه اين شياما چن

د و آن را ي صفحه بروی فرمول بالاۀاستوان یرو. ديز برگردي آخر سال برنامه ریديبه سلول ع •
 .دي سالانه اضافه کنیديرا به سلول درصد ع$ و .  دياصلاح کن

o ا در ياگر درصد مزاDاست آن را به ٢ $Dد و اگر در ير دهيي  تف$٢Cاست آن را به ٤ 
$C٤$.  

 یار برنامه، و مربي دستیدي عۀر دو سلول محاسبو در هد ين کی مسئول برنامه را کپیديفرمول ع •
 .ديبچسبان

o یبي ترکیدهايکل  ctrl+cکردن وی کپیبرا ctrl+vروند ی چسباندن بکار می برا. 

 .دي کار محاسبات مطمئن شویاز درست •

o ارجاع $ ن است که با اضافه کردن علامت يل آن ايکند و دل ین فرمول درست عمل ميا
ن آن يري زیف هاي ردۀ شود که از سلول در همی علامت باعث منيا.  شودیم داده ميمستق

 .استفاده شود

o شان استي بالایياد آنها و کارآي کارکنان تلاش زیايمزا% ١٥ش يل افزايد که دليفرض کن. 

 اکسل چگونه محاسبات را به تمام گروه ها ۀبرنام دينيد و ببير دهيي تغ١٥% را به یديدرصد ع •
 . دهدیانطباق م
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ان سال هر ي سالانه و پاداش پایافتيافت سالانه هرگروه  را با جمع کردن دري و دریديام عجمع ارق •
 .ديگروه محاسبه کن

  .دياکسل را ببند •
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  نمودارها و نقشه ها: ٤٫٢یبهره جوئ
هر دو با .  کننديکسان، کار مي یک سازمان، با استفاده از ابزارهاي از ی مختلفی وسارا در بخش هایسوف

 با آمار و ارقام در بخش ی و سوفیسارا با واحد پول و بودجه در بخش حسابدار.  کار دارنداعداد سر و
 آنها ۀ مورد استفادی محاسباتی به هم ندارد، اما ابزارهاین دو ربطيرسد که کار ا یگرچه به نظر م. پژوهش

ان بگذارند يگر درميکدي با ن ابزارها راي خود در کاربرد بهتر ای توانند آموخته هایجه ميمشابه است و در نت
  .اموزنديو از هم ب

  تيفعال

  قهي دق٤٥

د ي نمودار حقوق را باز کنليفا. ديبرو Start >Programs > Microsoft Office > Excel به  •
 .قرار داردTraining > Excel Folder  ۀکه در پوش

o اسباتمح": ٤٫١  یبهره جوئ- ین قبلي است که تمری شرکت کنندگانین براين تمريا 
خود ل يفا توانند از یان رسانده اند مي که آن را به پایکسان.  را انجام نداده اند-"دهيچيپ

 .استفاده کنند

 .ديفهرست حقوق و برگ خلاصه را مرور کن •

o در ی شغلۀهر سه رد. ديابيد در فهرست حقوق بي توانیتمام اعداد مربوط به حقوق را م 
 .برگ خلاصه قرار دارند

 .ديک کنيکلInsert > Chart  یرو •

o محل نمودار وجود داردی برای کافید که فضاينان حاصل کنياطم . 

 .ديک کني را کلNext. دينيبرگزمرحله را  نينمودار اولان چهار بخش ياز م •

o د ير دهييد آن را تغي توانید همواره مينه را نپسندين گزياگر بعداً ا. 

.  افت سالانه رايگروه و کل در: تون مجاور هم راد و دو سيني داده ها را برگزۀ ، دامنیدر گام بعد •
 .ديک کنيکل Data Range  یرو

o و ) زيمثل برنامه ر( د يشان انتخاب کنيتنها نام گروه را برا. نمودار ها سر لوح لازم ندارند
 .  رایافتيمقدار حقوق در

o  فشردن ن قبل از يد، بنابرايد دي کوچک از آن را خواهۀک نمونيبه محض انتخاب نمودار
Nextديد خطاها را رفع کني توانی م. 

 را ید و مکانيبرو ) Legend( راهنما یرو .دي نمودار خود انتخاب کنی برایدر گام سوم عنوان •
 .ديش انتخاب کنيبرا

 . ديني خلاصه برگزۀ در صفحیک شئي نمودار ساخته شده را به عنوان ،در گام آخر •
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o اگر بزرگتر یرد ولي گی می خلاصه جاۀکه نمودار کوچک است در همان صفح از آنجا 
 .دي جداگانه بگذارۀک صفحيد آن را در ي توانیبود م

 ني ایبرا. دير دهييد تغيتوان ینوع نمودار را هم م. دير دهيي نمودار رنگ را تغید روي توانیشما م •
 .دينيد تا انواع آن را ببيک کنيکار راست کل

 مورد نظر را ۀيرا باز و ناح UNHDR_womenpoliticalparticipation.xls_٢٠٠٧ ل  يفا •
 ).رهيا و غيقا، جنوب آسيانه، شمال افريخاور م(  ديانتخاب کن

ه ين آمار تهي ای برایقي تطبینمودار. ديسي زن هر کشور را بنوی جداگانه درصد وزرایدر صفحه ا •
 .ديکن

 یش ها و نمودارهاي تفاوت نماۀدربار. ديش دهي پرده نمای از گروه ها را روی کار برخۀجينت •
 .ديمختلف صحبت کن

o دهندیت را روشن تر نشان مي کنند واقعیدا مي پیري اعداد نمود تصویوقت  

  .دياکسل را ببند •
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  زيبرنامه ر–ر کاربرد هايسا: ٤٫٣یبهره جوئ
.  کندی سازمان استفاده می انجام امور حسابداری برای صفحات جداول محاسباتیسارا از برنامه ها

 شرکت کنندگان ی هم برای محاسبات بود، جدولی برایديمشغول درست کردن جداول جد که یهنگام
 سازمان  کاربرد یدادهاير روي مدین جدول برايدوار است که  ايسارا ام.  سازمان ساختیداد هايرو

.  شود ی انجام می دفتر و قلم به دشواریاريداد ها به ين رويت ايدريدر حال حاضر مد. داشته باشد
ن جدول پس از چندبار دست به دست يا.  شناخت فرستاد ی که می کسانید را براي جدول جدسارا

ن جدول، اصول کار با صفحات جداول ي ای خواهد با بررسینا ميم. دينا رسيگشتن به دست م
  .ردياد بگي را یمحاسبات

  تيفعال

  قهي دق٤٥

 .ديز کن ضبط شده است، بای دیداد را که بر سيت رويري مدیجدول محاسبات •

o مختلف ی خواناتر شدن آن ها با رنگ هاین را برايدادها فهرست مدعوي روۀدر صفح 
ن صفحه درج يز در اي که انتخاب کرده اند نیپاسخ آنها به دعوت و نوع غذائ .نوشته اند
 . شان در صفحه خلاصه قرار دارديتعداد کل شرکت کنندگان و غذا. شده است

 .ديرياد بگيه يد و از کار بقي معکوس انجام دهیسد مهندي خواهید که مياعلام کن •

o ده ي دارد که شما تا کنون ندیژگيد، چند وي گرفته این جدول، که آن را از کسيد ايفرض کن
د از ي توانی معکوس چگونه میبا مهندس .ديرياد بگي ها را یژگين وي کار با اۀنحو. ديبود
 د؟ياموزين جدول بيا

 .ديد و آن را پر رنگ کنيک کنيکلTotal Responses  ی خلاصه روۀدر صفح •

COUNTIF ديازمائيدر ستون فرمول قرار گرفته است، آن را ب اکنون.  

 .ديک کني کلHelp > Microsoft Excel Help یرو •

o ار ياز اطلاعات لازم را در اختي تواند هنگام نی اند که می کمکليفا یتمام برنامه ها دارا
 . شما قرار دهد

 .دي را بزن enter و سپس COUNTIF ۀد واژيل جستجو کۀدر جعب •

 .ديش را بخوانيد و محتواي بزنCOUNTIFف ي تعریرو •

o  اکنون عملکرد COUNTIFیک سريک ارزش را در يد که تعداد تکرار ي دانی را م 
را شمرده است، " نه" و " یآر "ی خاص تعداد پاسخ هاۀن صفحيدر ا.  شماردیسلولها م
 مطالب یاريبا . را"  ندارمی خاصۀنيگز"و " یاهير گيغ"، "یاهيگ "ین تعداد غذايهمچن
 . کندی مید که سلول ها را جمع بنديدان ی را هم مSUMIF برنامه، کارکرد یکمک

o شودیاهي گین تلفن کند و ضمن اعلام حضورش خواستار غذاي از مدعویکيد يفرض کن  . 

 .دير دهييتغ" یاهيگ"  به و ستون غذا را" یآر" پاسخ ها، ستون پاسخ ها را به ۀدر صفح •
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o د کرديدا خواهي ممکن پی پاسخ های برایدر ستون پاسخ ها فهرست. 

 .ديپ کنيست تاي را که در فهرست نید متني کنیسع •

o با مرور .  ستيکند که پاسخ داده شده درست ن ی میاد آوري شود و یان ميعلامت خطا نما
 .ديابيام را درين پي ای اکسل معنایپرونده کمک

 .د ي برو Help > Show Office Assistantیرو •

 .ديمطلب آن را بخوان. دي بروRestricted Value یرو •

o د؟يکن یدا ميا پاسختان را پيد آينيد و ببيوند بروي چند پیرو 

o یر مي زی کمکیل هاي فا.ديدا کنين مطلب، پاسخ موردنظرتان را پين چنديد از بيباهگاه گ 
  : ن پاسخ را ارائه کننديتوانند ا

  Enter Data in a cell from a list you specify و  Designate Valid entries  

 یي بعد از گرد هم آی صرف غذای از شرکت کنندگان برایادير برنامه متوجه شده که تعداد زيمد •
ق تعداد يرا هم به انواع غذا اضافه کند تا شمارش دق" امدن ين"  خواهد انتخاب یاو م. نخواهند آمد

 .ا را بداندغذ

o ر مورد نظرتان را به آن يد مقاديد تا بتوانيح را بخوانير صحي فهرست مقادیکمکل يفا
 .دياضافه کن

o د و ي کنکي کلن دو عدد در فهرست راستير قابل قبول و بي فهرست مقادیرو: انبريم
 .دي خلاصه بگنجانۀدر صفحز يد و آن ها را نيفزائيبد را ي جدريادمق

o  مطلب مربوط بهCOUNTIFدي خلاصه به کار برۀد و آن را در صفحي را بخوان. 

o  شما . ديد بچسبانيک سلول جديو در د ين کیبالا کپفرمول  ۀاستوان یفرمول را از رون يا
 .ديد را در آن وارد کنيد و ارزش جديفرمول را بخوان. ديک فرمول شده ايقادر به خواندن 

o  ديالب را بخواند و فهرست مطي را باز کنی کمکليفادوباره. 

 .دياکسل را ببند •

  . استی قابل دسترسی دی اکسل در سی ترفندهاۀدربار ی اصفحه: منابع افزوده
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  ني نوی هاها و موضوعيفناور: ٥یبهره جوئ
در   ینيم نوين رو همواره ابزار و مفاهياد است و از ايار زي مدرن بسی فناورۀرات در حوزييسرعت تغ

 به ین رهنمود، قسمتيدر اراهکار  و یبهره جوئ ،یباي دستیه بخش  آموزشدر هر س. ندي آید ميآن پد
.افته استيبا آن ها اختصاص  مرتبط ی هاین فناوريو آخرن ي نوی هاموضوع یبررس  

 اهداف

 .انهيغات مزاحم به منظور محافظت از راي تبلۀ سدکنندیروس، وابزارهايوال، ضد و-ري فاۀآموختن دربار •

  .گرانيگان با دي و رایارتباطات آنصدا و   گپ بایبررس •

م و ابزارهايمفاه  

. ت اطلاعات استي از الزامات حفظ امنی وب، همگۀل، و مرور محتاطانيميارسال ا یمنيت اي، رعایت فرديمسئول
 یارين و از آن به يامتن شما را ي آنلایت هايانه و فعالي رایمني هم در دسترس اند که ایين، برنامه هايعلاوه بر ا

 ی میري مخرب جلوگی گوناگون از حمله هایوه هاين ابزارها با شيا. کنند ی محافظت میرومند دفاعي نیبزارهاا
روس ي ویا آنتيکنند و  یانه ممانعت مير وال ها که از نفوذ خصمانه به درون راي چون فای ابزارهائ از جملهکنند

وسته از داده ي هم دارند و از جمله پیريشگي پینامه هان ابزارها بريشتر ايب. ندشو یروس ها ميتهاجم ومانع ها که 
.دهند ی مخرّب و مزاحم را هشدار میا نفوذ برنامه هايرند ويگ یبان مي پشتۀها نسخ  

 ۀنيت آنها هزين مزيمهم تر. کنند یا مين را مهيپ امکان مکالمه آنلايل و اسکاياهو و هات مي گپ مانند یبرنامه ها
 تواند به هر ین حال کاربر ميدر ع. گان استيپ راين دو کاربر اسکاي بۀ نمونه، مکالمبه عنوان. ز آنهاستيناچ
برنامه . ن آن هاستيرا مطلوب تريم زيکن یپ استفاده مين بخش ما از اسکايدر ا .نه تلفن کنديا با حداقل هزي دنۀنقط
. مشابه دارندیيل هم کارآياهو و هات ميگر مانند ي دیها  

لگري تسهیآمادگ  

روال  نصب شده باشند و درست کار يروس و فاي ضد ویانه ها برنامه هايد که در تمام رايمئن شومط •
 . کنند

 ید که امکانات اصليرا دانلود و نصب کنAVG روس ي ضد وۀن برنامه ها نصب نشده باشند  برنامياگر ا •
   : کندیگان را ارائه مي رایحفاظت

  http://www.zonealarm.com/store/ content/catalog/products/ trial_zaFamily/trial_zaFamily.jsp). Alarm 
Firewall (  http://www.zonealarm.com/store/  

 .ديبگذارشگر ي صفحه نمایانبر را روين ابزارها نشان مي ای هر دویبرا •

انه ها نصب ي راۀدانلود و در هم http://www.skype.com یپ را از رويروز قبل از شروع جلسه اسکا •
  .ديکن
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  وال-ريروس و فاي ضدّ ویابزارها :٥٫١یبهره جوئ
انه اش بطور ير رااما چندبا.  کرده استی مجازیت را در فضايت امنيت دقت ورعايشه نهاي همیسوف
، ی سوفۀانيش رايپس از پالا.  خواسته استیاري ی به ناچار از مسئول فنی کند شده و سوفیرعاديغ

  .  یروس، و ضد جاسوسير وال، ضد وي فا-- آن نصب کرده است ی سه برنامه را رویمسئول فن

  تيفعا ل

  قهي دق٣٠

 . باز شودAVGا مرکز کنترل د تيک کنيشگر دوبار کلي نماۀ در صفحAVG انبري نشان میرو •

o ۀبرنام AVGاست که یمنيگان، معروف و معتبر اي راۀک برناميد ي آن رفته ای که بر رو 
گان ي رایارند، برخي بسیمني ایبرنامه ها. م کردين بخش از آن استفاده خواهيدر ا

(Avast)گان يرراي و اغلب غ(Nrton, McAfee, Trend Micro)مشابه ی برنامه ها 
 .ن رده موجودندين هم در اير به آنلاو منحص

o AVGروس،يضد و:  گوناگون داردیبخش ها Shell extension, Email scanner 
email scanner .سک ي و دی اصلۀروسها به حافظي توانند از نفوذ وین بخشها مي اۀهم

 .کندينه ميروس ها را قرنطيو Virus Vault بخش.  کنندیريانه جلوگيرا

 .ديک کنيکلScheduler > Scheduled Tasks  یرو •

o Scheduler روس يف ويو تعار انه داردي مرتب رای به روز رسانی برایمکان زمانبند ا
 . کندید را وارد برنامه مي جدیها

  و به روز کردن کدام است؟(scan)اسکن   ی مناسب برایزمانبند •

o د تا حد يس ها بارويف ويتعار  وجود دارد،یديروس جديش ويداياز آنجا که هرآن امکان پ
رد، يد روزانه انجام گيبااسکن در صورت امکان .  شودیزيممکن همواره برنامه ر

 . نترنت روبروستيل و ايمي مدام ایت هايانه با فعالي که رایبخصوص هنگام

o د که يم کني تنظین را به گونه اآکبار حداقل ي یست هفته اي روزانه نیاگر امکان بررس
 .انه آغاز شوديرا اسکن ه روز شده دانلود شوند و سپس کار بینخست همه برنامه ها

 .ديبروTest Center  بخش چپ یرو •

o  در Test Centerی است که گزارش هایو مکان ديني بی را می قبلیهااسکن ج ي شما نتا 
 . دهدی را نشان میمني ااسکنمربوط به 

د تا يک کني توقف را کلۀمقه دگيپس از چند دق. را شروع کنداسکن د تا ي بزن(scanner) یرو •
 . متوقف شوداسکن

انه يان است، سرعت راي در جراسکن هم که یهنگام. ردي کامل ممکن است ساعتها زمان گاسکن •
 . شودیار کم ميبس
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. ديک کني دانلود شده کلۀک پروندي یرو.  دي  بروMy Documents>My Downloads folderبه  •
 . دي کناسکن شروع به AVGبا  

 .ستي فعّال نیچ برنامه اي است که هیهنگاماسکن  انجام یت بران وقيبهتر •

 . شونداسکند حتما قبل از نصب ي که قابل نصب هستند، بایيپرونده ها ، به خصوص آنها •

 ۀ دهد از جمله در باری از عملکرد خود می، گزارش کاملی وبه روز رساناسکن بعد ازاتمام ۀبرنام •
 . پنهان شدهیخطرها

 .ديد تا آن را به کار اندازيک کنيدوبار کل ZoneAlarm انبري میبر رو •

 ینترنت مرتبط مي است که از راه آن ها برنامه ها با ای گوناگونیره هاج روزنه ها و پنیانه دارايرا •
 ارتباط ۀکند و اجاز ی ورود و خروج را کنترل میر وال تمام روزنه ها و پنجره هاي فاۀبرنام. شوند

 . دهدیمجاز هستند م که یيرا تنها به آنها

 .نترنت وصل استيانه مدام به اي است که رای ضروریژه هنگاميروال به وي از فایبهره جوئ •

 مطمئن مانند به یتمام برنامه ها. کنديانه عمل مي رای و خروجیر وال مانند نگهبان ورودي فاۀبرنام •
 ۀمثل برنام(  دن پرسیربر م ناشناخته ها از کایدهد و برا یستم عامل را اجازه مي سیروز رسان ها

 ) گپی برایديجد

 .دي کنی آنها را بررسیمنيزان ايد و ميني در دسترس را ببید تا منطقه هايک کنيروال کلي فایرو •

ن سطح يشتري بینترنتي اۀ منطقیبرا. دهدي هر منطقه میمنين اي تأمیبرا یهائشنهاديخود برنامه پ •
 .دين کنيط را تأم متوسیمني آشنا، سطح اۀ منطقی و برایمنيا

 درصدد برقرارکردن ارتباط یيد چه برنامه هايد تا آگاه شويک کنيل کProgram Control ی رو •
 .ريا خيا به آنها اجازه داده شده ي اند وآینترنتيا

مثلا اجازه داد که اکسپلورر به ( ر فعال کرديا غي توان فعال و ی در سطح برنامه را می دسترسۀاجاز •
 ). کرد ید بررسيکروسافت ورد نخست باي قصد ماۀ امّا در بارنترنت وصل شوديا

 .ديروس صحبت کنير وال و ضد وي فاۀدربار •

o ۀبرنامZoneAlarm ی هم دارد اما نه در حد توانائیروسي ضد وی  هم توانائAVG  .
 . ستيگان ني مطمئن تر آن راۀنسخ

o من بمانديانه اي تا راشه فعال باشنديد همير وال بايروس و فاي ضد ویهر دو برنامه ها .
 د؟يد از فعال بودن آنها مطمئن شوي توانیچطور م

 .ديد ديشگر خواهير نمايز ۀاستوان یاگر هر دو باز و فعال باشند نشان اش را رو 

اما . ر وال استيروس و فاي مزاحم مشابه کار ضد ویل هايمي ضد نفوذ و ضد ایکار برنامه ها •
 . مزاحم قرار داردی و برنامه هایغاتيل تبیتخصص و تمرکزشان بر روزنه ها

o کنند ی میريانه جلوگي رای  بر رویغاتي تبلین برنامه ها از نصب موتورهايا. 
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o Ad-Aware ديانه نصب کني راید آن را رويتوان یگان است و شما ميعموما را. 

o دين برنامه ها را روزانه اجرا کنيست ايروس ها، لازم نيبرخلاف ضد و . 

o د زمان نصب کردن ضد ي روبرو شدیغاتي تبلی پنجره هاۀانفجارگون گسترش ااگر ب
 .ده استي رساسکنروس بر يو

  .  استی قابل دسترسی دی در سینترنتي ایمني ای برنامه های برایيوندهايپ: ر منابعيسا
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  نترنت ي در ای گپ زدن گروهۀبرنام: ٥٫٢یبهره جوئ
 در ین همکاريا.  کند ی می همکاریو جنوب ی مرکزیکاي سازمانها در آمری با برخیسازمان سوف

 ین آگاه سازيم گرفته تا کمپين سازمان تصمي ایبه تازگ.  حقوق زنان استی منطقه ایجهت برنامه ها
ن برنامه است ي اۀ هماهنگ کنندیسوف. ج در منطقه را برگذار کندي رای نسبت به خشونت خانگیعموم

ست که ارزان يله اياو بدنبال وس. اطق مختلف گفت و گو کندد با افراد گوناگون در منين رو بايو از هم
  .و آسان باشد

  تيفعا ل

  قهي دق٣٠

 .ديک کني دوبار کلیشگر اصلي نماۀ در صفح Skypeیرو •

o ماً با هم صحبت کننديتوانند مستق یپ دو نفر، اگر حساب باز کرده باشند، ميبا کمک اسکا .
 . ل در دسترس انديت ماهو و هاي هم مانند یگري مشابه دیبرنامه ها

o ی نصب آن بر رویبرا.  کارگاه نصب شده باشدیانه هاي راید رويپ باي اسکاۀقبلاً برنام 
 .ديبرو com.skype.www://http/ به وبگاه ی خانگۀانيرا

 .ديکنباز ب ک حسايتا ) پير نام اسکايدر ز( د يک کنيکلDon’t have a Skype name  یرو •

o ی هم برایکند که نام یه ميپ توصي اسکاۀد، برناميکن ی اسم کامل خود را وارد میوقت 
 .ديپ انتخاب کنياسکا

 .دي را بزن Nextد ويري را بپذ End User Licence agreement موافقت نامه یشرط ها •

o شتر کاربران يب. ديد آن را بخواني توانید مياگر بخواه. متن کامل موافقت نامه موجود است
 . توان حساب باز کردیرش آنها نميرا بدون پذيرند زي پذیط را ميبدون خواندن آن شرا

    ۀنيگز. ديک، کشور محل اقامت، و منطقه را وارد کنياطلاعات مربوط به آدرس پست الکترون •
Skype News & Offersدي پنهان کن را . 

o گران آسانتر ياما با وارد کردن آنها د.  استیاريدادن اطلاعات مربوط کشور و منطقه اخت
 .دا کنندي توانند شما را پیم

• Sign In دي را بزن. 

o کروفون را يصدا، بلندگو و م. ديد شروع کني توانید و مي حساب شده ایاکنون شما دارا
 . ديامتحان کن

 .دي برو Tools > Options > Audio Settingsبه •

o ديم کنيکروفون و بلندگو را تنظيصدا و م. 

 .ديازمائيت مکالمه را بيفيک Make a Free Test Call  یبا فشردن رو •

o کند ی میگام به گام راهنمائ پين ورود به اسکاي شما را در نخستی صوتیک راهنماي. 
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 .شرکت کنندگان دو به دو گروه شوند •

o د تا افراد به نوبت وارد ي درست کنیگاهيست جاي نیکروفون و بلندگو کافياگر تعداد م
 .ن کننديبا آن تمرشوند 

 .ديد و مکالمه را شروع کني سبز بزنۀ نام هم گروه خود و دگمیرو •

o ید، ميم داري سی وبینترنتيجاد کرد، و ارتباط اي درون کارگاه مزاحمت ایاگر سر و صدا 
 . دين کنيرون از سالن تمريد بيتوان

 .دين را شروع کنيد و گفت و گو در آنلاي  بزن Start Chatید و رويک کني نام راست کلیرو •

o ق منتقل يد دقي خواهی را میرود که مطلب ی به کار می مواقعیگپ و نوشتار همزمان برا
 .ک متنيا ي وب و یمثل نشان. ديکن

 .دي گپ بروۀدر پنجرSend > Send File   ی در طول مکالمه روليفاک ي فرستادن یبرا •

o د استيفع مي سریا بررسي و مدرک مشترک از ۀ استفادین کار برايا. 

 .ن کوتاهيزمان تمر •

 .ديسه با تلفن گفت و گو کنين در مقايب گپ آنلايا و معاي مزاۀدر بار •

o ازمند ين باشند و به هر صورت نيد همزمان در آنلاي دارد اما هردو بایمت ارزان تريق
 .اند ینترنتيع و قابل اعتماد اياط سريارت

o مدرک تبادل عکس و یز جمله توانائ دارد، ایشتري بی هاین امکانات و توانائيگپ آنلا. 
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  ٣بخش 
  ١........................................................ا فاویابزارها راهکار

  
  ١.................................................فاوا یر ابزارهااهکار: بخش نخست

  ٤.......................................... ..........استفاده هدفمند از وب: ١راهکار 
  ٥...................................................یاب اشتراکيصفحه : ١٫١راهکار 

 ٧.................................(feed readers)ها ان رسانه خو: ١٫٢ راهکار 
  ٩.....................................ی اجتماعی شبکه هایابزارها: ١٫٣ راهکار 
  ١١.......................................ی شخصی اجتماعیشبکه ها: ١٫٤ راهکار 
  ١٣.....................................................ر وبدانتشار مطلب : ٢راهکار 
  ١٤..........................................رياستفاده مشترک از تصاو: ٢٫١راهکار 
  ١٥..........................یجي تروی هدف هاین براير آنلايتصاو: ٢٫٢راهکار 
  ١٧...................ن ي آنلایدئوهاي از راه ویجيترو یت هايفعال: ٢٫٣راهکار  
  ١٩...................................... ی سازمانی اجتماعیشبکه ها: ٢٫٤ راهکار 
  ٢١.....................................یسي و وبلاگ نویوبلاگ ساز: ٢٫٥ راهکار 
  ٢٣.........................................................یوبلاگ گروه: ٢٫٦ راهکار 
  ٢٥..................................ني مطالب آنلایايچالش ها و مزا: ٢٫٧ راهکار 
  ٢٦.....................................................ل يمي کاربرد هدفمند ا:٣راهکار 
  ٢٧..................................یکي الکترونیخبرنامه ها یبررس: ٣٫١راهکار 
  ٢٩............................................یکي الکترونۀ خبرنامۀيته: ٣٫٢  راهکار
  ٣١..........................................یکي الکترونۀنوشتن خبرنام: ٣٫٣راهکار 
  ٣٢............................................ هدفمند از واژه پردازۀاستفاد: ٤راهکار 
  ٣٣................ ..............نيمدارک در آنلا ۀيته ی برایارهمک:٤٫١راهکار 
  ٣٦......................................................ی سفارشیالگوها: ٤٫٢راهکار 

  ٣٨.....................................ی سفارشیآرائسبک و صفحه : ٤٫٣ راهکار 
  ٤٠........................................... و گزارش هایمستندساز: ٤٫٤ راهکار 
  ٤١.......................................................... ...گزارش ۀ ارائ:٥راهکار 
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   ٤٢.................................... گزارشۀ ارائۀ عمدی هایژگيو: ٥٫١راهکار 
   ٤٤....... ...............شگزار ۀارائر، و جداول در يمتن، تصاو: ٥٫٢ راهکار 
  ٤٧.....................................ک گزارش ممتازي ی هایژگيو: ٥٫٣راهکار 

  ٤٨..... ........................ر متحرکي، و تصاویالگو، دگرگون: ٥٫٤ راهکار 
  ٥١...............................................................ی وب سازمان:٦راهکار 
 ٥٢.......................ني آنلا(petition) ۀ درخواست نامیامضا: ٦٫١راهکار 
  ٥٤...........................................ني آنلاۀ درخواست نامۀيته: ٦٫٢ راهکار
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 هدفمند از یشرفته در بهره جوئي پی فاوا آموزش مهارتهایابزارها(appropriation) منظور از راهکار
 یي سازمان هایح الگوين بخش به تشريا.  استیانه، وب، واژه پردازها، و صفحات جداول محاسباتيرا
ن الگو يا.  برندیشان بهره ميشبرد کارهاي به اهداف و پیابي دستی ها براین فنآوري پردازد که از ایم

  وی؛ صوتیري، تصوی متنی شوند مانند ابزارهای وب می روی انتشاراتی گسترده از ابزارهایفيشامل ط
 ی انتشاراتیوب و ساختارهايوتيبلاگر، : م کرد ماننديز استفاده خواهيج ني رایاز نرم  افزارها. یيدئويو
  .گريد

  

  ازهايش نيپ

 ).Office(ندوز يستم عامل وي سی دفتری مانند نرم افزارهایيانه و با ابزارهاي در کار با رای کافۀتجرب •

 ی آموزشی شرکت در برنامه هاۀجي کار چه دانش حاصل از تجربه و چه نتی مبانۀ درباریدانش کاف •
 . انهيه و ميسطح اول

 و یدن به اهداف سازماني رسیا و کاربرد هدفمند آنها برا استفاده از ابزارهیريادگي یعلاقه برا •
  .یاجتماع
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   هدفمند از وبۀاستفاد: ١راهکار 
  اهداف

 :نترنت تاي کار با ای موجود برای هوشمندانه و هدفمند از ابزارهایآموختن بهره جوئ •

 .ميم و به روز باشيابياطلاعات را ب •

  .مي به شراکت گذاراياطلاعات خود را با علاقه مندان در سراسر  دن •

 م و ابزارهايمفاه

شتر کاربران و يبا تعاملات هر چه ب.  است که مرتب در حال گسترش و نوشدن استی ساختاریوب جهان
 ین ابزارهايدتري که آشناشدن با جدیراند به گونه ايي هم در حال تغی کاربرید آنها، ابزارهاي جدیازهاين

د که از يد ناچاري کنین عرصه رقابت مياگر در ا.  استیرورر ممکن شده اما هنوز ضيبا غيموجود تقر
 هوشمندانه از آنها را ۀد و استفاديافته اند خبر داشته باشي ی که شهرتیيا حداقل آنهاين ابزارها و ين ايآخر
  .ديبدان

 ی می شوند معرفی به کار برده می و حرفه ای هر دو منظور شخصی را که برایين بخش ابزارهايدر ا
م و در صورت امکان ي آن هم پرداخته ایم ، به کارکردهاي علاوه بر مفاهی هر ابزاریدر معرف. ميکن

  .مي آورده ای مشابه را هم در فهرستیابزارها

 

  لگري تسهیآمادگ

اگر . ل داشته باشنديم. ید حساب جيشرکت کنندگان با  (Google reader)ی گوگل شناسۀ جلسیبرا •
از آنها را گام به گام ي باز کنند و در صورت نی قبل از شروع جلسه حسابد کهيشان بخواهيندارند، از ا

  ".ليميک حساب ايجاد يا": ٤٫٣ یابيدست. دي کنیيراهنما
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  یاب اشتراکيصفحه : ١٫١راهکار 
اب ي آنها را با صفحه ۀ پروژه اش همیق براي وب دارد که هنگام انجام تحقیوند روي پیاديشه تعداد زيسازمان عا

زمان . دا شده انديستند و پس از ساعتها جستجو پيافت ني قابل بازین منابع به آساني از ایبعض. کرده استره يذخ
 که علاقه مند ین منابع را با کسانيل است کل ايشه مايعا. آنها شده استی هم صرف منظم کردن و دسته بندیاديز

  .هستند به اشتراک بگذارد

  تيفعال

  قهي دق٣٠

گام به گام با . ديک از آنها بروير در هر ي زیوندهايد و به پياکسپلورر را باز کننترنت يچند سرلوح ا •
 .دين کني را تمریاب اشتراکيشرکت کنندگان روش کاربرد و مرور صفحه 

رات ييجاد تغي ای ها برای زنان در کاربرد بازی آموزش و همکارین الملليق سازمان بيتحق •
 http://del.icio.us/olderock/games: یاجتماع

 http://del.icio.us/delphi/webdesign: وبگاهی طراحی برای آموزش فردیابزارها •

 http://icio.us/popular/tools:یابزار اکتشاف گروه •

 .ديبرو  /http://del.icio.usد و بهينترنت اکسپلورر را باز کنيا •

 هم هستند یگري دیابزارها. اب ها ستيره و اشتراک صفحه ي ذخیک ابزار مطلوب براين يا •
 .Digg, StumbleUppon, Ma.gnolia, Reddit:مانند

 .ديل باز کنيمي، گذر واژه، و آدرس ای با نام کاربریحساب. ديبروRegister  یدر سمت راست رو •

 .کسپلورر را در صفحه بعد نشان خواهد دادنترنت اي ایوند دگمه هاين پيا •

نترنت اکسپلورر آن يپس از نصب ا. دي را اضافه کنInstall Now ،Adds-on یک کردن بر رويبا کل •
 .ديرا بسته و دوباره باز کن

• Adds-on ا ي و Extensionsه ها ي مانند افزا(plug-ins)ش ي افزای برایگري هستد و روش د
روس يد، امکان دارد حامل ون برنامه ها قابل نصب انيز آنجا که اا.  مرورگرۀ برنامیيکارآ
 . دياز راه منابع مطمئن آنها را نصب کنن رو، ياز هم. باشند

 (Tag This).  بالا نصب کرده استۀاستوان ی دو دگمه بر روdel.icio.usد که يتوجه کن •
اب ها را نشان يفحه  تمام صMy del.icio.us  ۀ کند و دگمیره مياب را ذخيبرچسب  صفحه 

 .دهد یم

 ابيا صفحه ي برچسب و ۀ دگمیک کردن رويبا کل. دي بگردیقتل ناموسا به دنبال ي پدیکي در و •

  . دي به آن بزنید برچسب قتل ناموسيره کني  آن را ذخ

 . کردن اطلاعات استی طبقه بندی برایگريروش د برچسب زدن •
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 .ديک کني کل My del.icio.usیره شده روي ذخیاب هاي به صفحه ی دسترسیبرا •

د ي توانید، مي بشوdel.icio.us ت ي که شما وارد سایانه اي هر رایا و بر روي دنیدر هر جا •
 .ديني خود را ببیاب هايصفحه 

 .دي بروMy del.icio.usد تا به يک کنين صفحه کليي در پای نام کاربریرو •

 ین ميهمچن. دينيد ببي توانیته اند م را که همان صفحه را نشان گذاشیگريشما نام کاربران د •
دا ي خود پۀ موضوع مورد علاقۀ درباریشتري آن ها منابع بیاب هاير صفحه يد با مرور سايتوان
 .ديکن

د چه يني ببsaved by # other people یک کردن  رويد و سپس با کليوند اضافه شده را نگاه کنيپ •
 .ره کرده اندي آن را ذخیافراد

 . کندی را فراهم میق جمعياب ها امکان تحقي از صفحه ی اشتراکۀاستفاد •

ره و به اشتراک يابند و آنها را ذخي را بیشتريتا منابع بد يدهرکت کنندگان ب به شیفرصت کوتاه •
 .بگذارند

 گروه در ۀي آشنا شده اند آن را با بقیديا کارکرد جديد تا اگر با روش و ياز شرکت کنندگان بخواه •
د است آن  را در ي همه مفید براي کرد که گمان کردی پرسشی شرکت کننده ااگر .ان بگذارنديم

  .ديجمع مطرح کن
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 (feed readers)رسانه خوان ها : ١٫٢راهکار 
 ی کنند که برایشنهاد مي از آنها پیاريبس.  کندی متعدد مراجعه می از اخبار به وبگاه های آگاهیشه برايعا

ک رسانه خوان يافتن ي ین استفاده کند اما هنوز فرصت مناسب برا از رسانه خوایخواندن مرتب اخبار و
  . دا نکرده استيمناسب پ

  ت يفعال

  قهي دق٣٠

 .دي برو http://www.google.com/reader :به. دينترنت اکسپاورر را باز کنيا •

شان ياگر ندارند، از ا. ل داشته باشنديم. ید حساب جي شرکت کنندگان بای گوگل خوانۀ جلسیبرا •
 یياز آنها را گام به گام راهنماي باز کنند و در صورت نید که قبل از شروع جلسه حسابيبخواه

 ".ليميک حساب ايجاد يا": ٤٫٣یابيدست:د بهيبنگر. ديکن

 گر مانند ي دیرهاابزا. ج استي رایم ابزاري برین جا به کار مي گوگل که ما در ایرسانه خوان •
Bloglines, Newsgator, Sage, Rojoن ابزارها نقاط قوّت و يک از ايهر . ز وجود دارندي ن

 ۀسي و جدول مقای دید به سي آنها به بخش منابع اضافه نگاه کنۀسي مقایبرا. ضعف خود را دارد
 .دينين ابزارها را ببيا

 .ديم کني تنظی رسانه خوانۀد در سه پوشي شش وبگاه را بایرسانه ها •

 http://news.bbc.co.uk/middle_east/default.stmخبر •

 /http://www.magharebia.comخبر •

 /http://womensnews.orgخبر •

 /http://Arabic.irinnews.orgخبر •

 /http://hrw.orgحقوق بشر •

 /http://learningpartnership.org/citizenshipن يکمپ •

 /http://www.amanjordan.orgمسائل زنان •

 RSS  اما رسانه.  است HTML د معمولا به صورتي خوانی را در وبگاه می شما خبریوقت •
 RSS که یگريد ديف.  کندی گوناگون آسان می است که انتشار خبر را در وبگاه هایگرينوع د

 ی بر رویديهر زمان که خبر جد.  دهدیک وبگاه را مير ت دي عضوۀهم نام دارد به شما اجاز
 .دي باشد شما به آن وبگاه برویازينکه ني شود بدون ایرد، خبر شما هم به روز ميآن وبگاه قرار گ

 .ديرا اضافه کنBBC URL  شود ی که باز میره اجدر پن. ديک کنيکل Add subscriptions  یرو •

ن يخبر به ا. ديبگذارNews نام پوشه را . ديک کنيکل< Add to a Folder > New Folder  یرو •
 . نام دارد اضافه خواهد شد Newsد کهي جدۀپوش
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 .ديب در پوشه ها بگذارين ترتيتمام شش وبگاه بالا را به هم •

ت در ي عضویبرا. د داشتي از اخبار مورد نظر خودتان خواهی سفارشۀک صفحين کار يبا ا •
 .دي نداریتين صفحه محدوديد و افزودن به اي جدیخبرها

 . رودی خوانده شده ها مۀ اخبار به پوشۀد که چطور از پوشينيد و ببيچند خبر را بخوان •

 خود ید مورد نظرشان را به رسانه خوان هاي جدۀ شرکت کنندگان تا چند رسانین کوتاه برايزمان تمر •
 .اضافه کنند

 .دهديد را خبر ميک في  رنگ، وجودیک نشان نارنجي •

 .ديان بگذاري قابل استفاده را با گروه در مید و پرسش هاي جدیافته هاي •

 

  ]یارياخت[ت يفعال

  قهي دق٣٠

   د ويک کـنيکل Google Gears  نصــب یرو. ــدي برو/http://gears.google.comبه  •
Terms of Agreement ديري را بپذ. 

o Google Gearsاز برنامه ید از برخيد بتوانيستينترنت هم وصل نيه ا بی دهد وقتی اجازه م 
 . ن توان را ندارنديل اي می برنامه ها از جمله جۀالبته هم. ديها استفاده کن

 .ديد و دوباره باز کنيپس از نصب، مرورگر را ببند. دي نصب کننده را فعّال کن •

o م يهمانطور که گفتGoogle Gearsاز آن .  اجرا کند تواند برنامه ها را دانلود وی م
شود به دقت  ی نصب برنامه باز مۀ کسب اجازی را که برایاميپ. ديمحتاطانه استفاده کن

 .دي نصب بدهۀد اجازينان داري که اطمید و تنها به منابعيبخوان

ان سبزکه در کنار نام کي پیرو. ديبرو reader/com.google.www://http/در يبه گوگل ر •
 .ديک کنيکاربر در بالاست  کل

o دهد و حتا ی رسانه خوان شما قرار مین خبرها را بر رويکان سبز آخري پیک کردن رويکل 
کان نشان قطع ارتباط شما با ي شدن پیخاکستر. ديد آنها را بخواني توانید مي وصل نباشیوقت
  .نترنت استيا

 .ديک کني رنگ کلیکان خاکستري پید روي شویمن ي که آماده رفتن به آنلایهنگام •

o د ي انجام دهیا کار خاصيد و يد ببنيد خبر جدي توانید، نميستينترنت وصل ني که به ایهنگام
  .ديد و آنها را نشان بگذاري موجود را بخوانید خبرهاي توانیاما م
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  ی اجتماعی شبکه هایابزارها: ١٫٣راهکار 
 یده است و دعوت نامه هايار شنيمطالب بس " ی اجتماعیبکه هاش " ی ابزارهاۀرا درباري اخیسوف

ن دعوت نامه ها از ين ايشتريب. افت کرده استي شناسد دری که نمیي از ابزارهای متعددیکيالکترون
  .ند چه خبر استيم گرفته عضو آن شود و ببي تصمیسوف.  شودیس بوک منتشر مي به نام فیوبگاه

  تيفعال

  قه     ي دق٣٠

 ./http://www.facebook.comد بهيبرو. دينترنت اکسپلورر را باز کنيلوح اچند سر •

 MySpaceو Orkut  شتابان دارد ین است که رشدي آنلای اجتماعی از شبکه هایکيس بوک يف •
 . پرخواستارندی اجتماعیگر شبکه هاياز د

لبته .   اندینترنتي ارتباط و تعامل با کاربران ای برایني نوی روشهای اجتماعین نوع شبکه هايا •
 . آن زمان بر است ی ارتباط و نگهداریبرقرار

 است که عموما از دوستان و اقوام کاربر ین جوامع کوچکي، صورت آنلای اجتماعیشبکه ها •
ت يماه. رديگ ی صورت می مجازیاي است که در دنیي گرد هم آیقت نوعيدر حق. ل شده انديتشک
لان ي فارغ التحصی مانند سازمانها، شبکه های عمومیدها نهاین شبکه ها، کاربرد شان را برايا

 . سازدی ممکن میو موسسات آموزش

در سپتامبر  .دي کنیدا مي شبکه را پین نوع ابزارها، امکان ارتباط با تمام اعضاي از اۀبا استفاد •
 ٦٩٢٩٦٩١٥ MySpaceکه ازيدکننده داشت در حالي بازد٢٦٢٢٤٤٨٦س بوک ي فۀ شبک٢٠٠٧
-facebook-third-biggest/٢٠٠٧/٠٩/١١/http://blog.compete.com).کردندد يبار بازد

site-page-views-myspace-down/) 

 .ديک کني کل Sign Upیرو •

د يرا بزنsecurity check . خ تولديل و تاريميد، مانند نام کامل، آدرس اياز را وارد کنياطلاعات مورد ن •
 .ديريط ثبت نام را بپذيو شرا

• security checkکاربر .  مزاحم و ناخواستهی از نفوذ برنامه هایري جلوگیست براا ی برنامه ا
 .پ کندي تاینينا در محل معيد آن را عيبا

د آن را ي است که کاربر بای و پر از اصطلاحات حقوقی طولانیط ثبت نام معمولا متنيشرا •
 .کننديل مشتر کاربران نخوانده آنها را قبويب. بخواند و امضا کند

خ تولد عموما يد که تاريتوجه داشته باش.  برندیخ تولد و نام مستعار به کار ميشتر کاربران تاريب •
 . شودیده ميافراد پرس)  سال بودن١٨ یبالا (ی قانونۀن اجازيي تعیبرا

• Nationality Campaignگروه یرو .دي راجستجو کن  Nationality Campaignديک کنيکل .
 .ديوار را مرور کني دی رویام هايدئو ها و پيام اعضا، گفت وگوها، ون خبرها، نيآخر
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 ی آن میا اعضايسازمان .  استی ارتباطی از وبگاه و ابزارهایبيس بوک ترکي فیگروه ها •
 .  گفت و گوها قرار دهندۀا مطالب را بر صفحيافت کنند و يام بفرستند و دريگر پيکديتوانند به 

ن يبا استفاده از چن. ت گروه دعوت کنندي را به عضویگرياد د توانند افری گروه میاعضا •
 .  توانمند کنندیجي ترویت هاي توانند هواداران شان را به فعالی سازمان ها میامکان

 سازمانها و ی برایيچه معنا. دين گفت و گو کني آنلای اجتماعی شبکه های زنان وابزارهاۀدربار •
 فا کنند؟ي توانند ای می نقشیاع اجتماترييا در تغيکنشگران دارند؟ آ

 قابل ی رشدی اجتماعین است که درصد کاربران زن در شبکه هاي از ای حاکیقات آماريتحق •
  .ن شبکه ها زنان هستندي ایشتر اعضاي از کشورها بیدر واقع، در برخ. توجّه دارد
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  یشخص یاجتماع یها شبکه: ١٫٤راهکار 
 ۀن شبکيز گفتند که عضو ايکارانش خبر داد چند تن از آنها ن به همیوقت. س بوک شده استي عضو فیسوف

ن ي  ای دارد وبهتر از سوفی فن آورۀ درباریاديشه هم بود که اطلاعات زيان آنها عايدر م.  هستندیاجتماع
 یدا کند و به جمع دوستان مجازيس بوک پيانش را در فيم دارد تمام آشناي تصمیسوف. شناسديابزارها را م

  .ديفزاياش ب

  تيفعال

  قهي دق٣٠

 .دي  بروcom.facebook://http/به . دينترنت اکسپلورر را باز کنيا •

 . ديفزائي خود بۀد به شبکي کنیدا ميس بوک پي را که در فیدوستان و همکاران •

رکت کنندگان را به ر شيلگران و ساي تسهین برنامه آموزشيد که شرکت کنندگان در ايشنهاد کنيپ •
 . خود اضافه کنندۀشبک

د اطلاعات آنها را ي توانیرفته نشود، نمي شما از طرف فرد مورد نظر پذیتا درخواست دوست •
 .دينيبب

 .دي خود بگذارۀ دربارید و اطلاعاتيک کنيکل)  نامهیفشرده زندگ(Profiles  یرو •

خ تولد و آدرس يمانند تار. ن استار خودتايد در اختي گذاری خود مۀ که درباریزان اطلاعاتيم •
 .  تلقنۀا شماريل يميا

 . ديابيب  Women’s Learning Partnershipد ويک کنيکلCauses  یرو •

ن است که يدر ا) ی عادیسازمان ها(Groups و ) یر انتفاعي غیسازمان ها (Causes تفاوت  •
الات ي و طبق مقررات ا اندی و آرمانی مشترک اجتماعی هدف های دارایرانتفاعي غیسازمان ها
 ی عادیسازمان ها. ات معاف هستندي از پرداخت مال ٣(c)٥٠١ کا و بر اساس ماده يمتحد آمر

 . جاد کنندي توانند ایرا همگان م

 ی را که براید افرادي توانیکار م نيبا ا. ديونديبپWomen’s Learning Partnership   ۀبه صفح •
 .  ديت سازمان خود دعوت کنيل اند به عضوي را که مایآن هائد و ي کنند بشناسی تلاش میهدف مشترک

 ی کسانیمعرّف.  دي با خود دعوت کنیگران را به همکاري دهد که دین برنامه به شما امکان ميا •
در بخش .  دهندیاريزد که به شما ي انگیز بر مي را نیگريکه به شما کمک کرده اند افراد د

 . دي توان دی دهندگان را میارين يد ترنام و عکس سخاوتمن» ريسالن مشاه«

 .ديونديتان جالب است و به آنها بپيد که براي بگردی گروهیس بوک به جست و جوي فیرو •

 را یگر اعضا اطلاعاتيد. س بوک درست کندي در فیک گروه خصوصي تواند ی میهر عضو •
 . دي آورده شده است نخواهند دین گروهي چنیام هاي پۀکه در صفح
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 خود اضافه ۀ نامی زندگۀ به خلاصید تا اطلاعات تازه اي به شرکت کنندگان بدهین کوتاهيفرصت تمر •
 .کنند

شگر به همه نشان ي نماۀ پردی جالب را که شرکت کنندگان نوشته اند روۀ نامی زندگۀچند خلاص •
 .ديده

  . خود افزوده اند و چه جست وجو کرده اندۀاراني را به یيد چه برنامه هايدا کنيپ •
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  انتشارمطلب در وب: ٢هکار را
  اهداف

  وبی انتشار مطلب رویآموختن توانائ •

o  ی شخصۀک رسانيبه عنوان  

o یبه عنوان ابزار نشر و پخش اطلاعات سازمان.  

  

  م و ابزارهايمفاه

ز ي در نشر و پراکندن داده ها و اطلاعات نیيوب علاوه بر آسان و ارزان کردن ارتباطات، ابزار توانا
 و ی، نوشتاریري تواند هر گونه اطلاعات تصوینترنت ميانه و ارتباط با ايک رايداشتن هرکس با . هست

د يد و از آنها بهره مند شوي وب را به کار بری هایيد تمام تواناي خواهیاگر م.  را منتشر کندیحتا صوت
  .ديز شرکت کنيد اطلاعات نيد بلکه در توليک مصرف کننده نباشيد تنها يبا

  

  گرلي تسهیآمادگ

ا ياهو داشته باشند و يد حساب ي شرکت کنندگان با (Flickr)کري از فلی علاقه مندان بهره جوئیبرا •
 کي جاديا": ٤٫٣ یابيدست: د بهيبنگر. ديکن یيراهنما راگام به گام آنها ازين درصورت .حساب باز کنند

  ".ليميحساب ا

وب داشته باشد و هم حساب يوتيساب د هم حي گروه بای از اعضایکيوب حداقل يوتي آموزش بخش یبرا •
 کي جاديا": ٤٫٣ یابيدست: د بهينگاه کن. ديبرو My Account ۀوب به صفحيوتيدر حساب . ليم. یج

 ".ني آنلایِدئوهايو": ١٫٩ یبهره جوئ: ز بهي و ن"ليميحساب ا

 را ن صورت شرکت کنندگانير ايدر غ. س بوک داشته باشديد حساب فيک نفر در گروه باي حداقل  •
 . آن را باز کنند"،یاجتماع یها شبکه یابزارها": ١٫٣د تا با مرور راهکار ي کنیيراهنما

  .ل داشته باشنديم. ید حساب جي آموزش بخش وبلاگ هم بایبرا •
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 ر يتصاواز شترک  مۀاستفاد: ٢٫١راهکار 
 کرده  که در  استفاده یري سازمان درست کرده از تصاوی که برایيبروشورها  گزارشها وۀشه درهميعا

(Creative Commons)سازمان خودش در ۀ درباریري خواهد با منتشر کردن تصاویاکنون م.  نصب شده است 
  .د اطلاعات ادا کنديکر سهمش را در توليفل

  تيفعال

  قهي دق٣٠

 .ديبرو/http://www.flicker.com به .دينترنت اکسپلورر را باز کنيا •

 یبرنامه ها. راستيصاوته اشتراک گذاشتن  بیج براي رای از ابزارهایکيکر يفل 
 . وجود دارندGoogl’s Pisca’s Web , PhotoBucket ز مانندي نیگريد

 .ديني برگزیک نام کاربريکر ي ارائه شده در فلۀويبه ش. دي خود ثبت ورود کنیاهوي یبا رمز کاربر •

د يرندارند،از آنان بخواهاگ .اهو داشته باشنديد نشان يکر باي کار کردن با فلیشرکت کنندگان برا •
د يبنگر. دي کنیياز آنهارا گام به گام راهنمايکه قبل ازشروع جلسه حساب باز کنند و درصورت ن

 ."ليميک حساب ايجاد يا": ٤٫٣ یابيبه دست

 .ديني خود برگزۀاني رای را از رویعکس. ديک کني کلUpload Photos  یرو •

اگر . ديد آن را دانلود و نصب کني توانی شما م.ر داردي نصب تصاوی برایکر ابزار مستقليفل •
 .دين ابزاراستفاده کنياد است از ايد زيد بگذاري خواهی که میريتعداد تصاو

 عنوان ید و جلويک کنيکل» یخصوص «ینه هاي را در بخش گز(private) ی خصوصۀدگم •
 .دي علامت بزن(Visible to Friends) دوستان یفقط برا

 .ننديده شما را ببير برگزي دهد تصاوید امکان ميده اي که برگزیشاني و خوکر تنها به دوستانيفل •

•  Contacts > Invite Youe Friendsديک کنيرا کل. 

د يک کنيرا کلSend . ديرا علامت بزنThis Person is a Friend . دي را وارد کنیل دوستيميآدرس ا •
 .نديتا دوستتان عکس را بب

 .نندي شما را  ببید عکسهايف کرده اي که تعری توانند در حدودیدوستان شما م •

 .ديم کنيتنظ" عموم "یش آن را براين بار نمايد، اي را نصب کنیگريعکس د •

 .ده به حق نشر استيد که چسبيک کني را کلEditد وي عکس بروۀبه صفح •

 .ديرا بزنSave . ديد انتخاب کنيد عکس را منتشر کني خواهی را که تحت آن میمجوز •

•  Attribution-Noncommercial_No derivatives Licence ک مجوز است و قابل ي
 ".نير آنلاياقتن تصاوي": ١٫٨یيد به بهره جوينگاه کن.  شتر مواقعياستفاده در ب
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 یجي ترویت هاي فعالیبرا نيآنلا ريتصاو: ٢٫٢راهکار 

 ی برایله ايز وسير نيده که در آن ها تصويکر دي را در فلی گوناگونین هايشه شرح کمپيعا
 که سازمان قرار یني کمپۀ مشابه درباریل است تا کارياو ما. ن بوده استي اهداف کمپیمعرّف

 یشه ميعا. زنان استی مالی توانمند سازین براين کمپيا. است به راه اندازد انجام دهد
  ست؟ ين چيام کمپير در کارآ تر کردن پيخواهد بداند که نقش تصاو

  تيفعال

  قهي دق٦٠

 .ديشگر بزرگ نشان دهي نمایر موفق بوده اند روي از تصاوین را که با  بهره جوئيچند کمپ •

 حبشه با استارباکس ۀ از مخالفت کشاورزان قهوی مصوّر در هوادارینيسازمان آکسفم کمپ •
 /http://www.flicker.com/groups/starbucksphotopetition/poolبرگذار کرده است 

 که ی وبگاهیک روز، روي در ی تظاهرات جهانیي برپای گوگل براۀاه با نقشکر همرير فليتصاو •
 /http://standagainstpoverty.org.ن منظور درست شده قرار گرفته استيبه هم

.  ستيط زي محی مردمان در باره  چالش های آگاه سازین عکس براي بهترۀمسابق •
.http://www.flicker.com/groups/thenatureconservancy/ 

 

  ین هايژه کمپين ها به وير در انواع کمپي از تصاوی بهره جوئۀ بالقویامدهاي پۀد درباريبحث کن •
 .یجيترو

ا ي زنان، و ی مالی مانند توانمند سازیين هاي کمپۀم شوند و درباريشرکت کنندگان به چند گروه تقس •
 .ند پردازین ها به بحث و تبادل رأين کمپير در ايحقوق زنان و نقش تصاو

 و اجرا  ین جلسه طراحين در اي کمپی برگذاری را برایدر حد زمان در نظر گرفته شده پروژه ا •
 .ديکن

.  ده گرفتي مصّور استفاده شد این آکسفم که در آن از پلاکاردهاي کمپۀ توان از نمونیم 
ا تک ي ید و با آن گروهيسي پلاکارد بنوین روي مناسب با هدف کمپید جمله اي توانیم

 . دين نشان دهي کمپید و آن ها را هنگام برگذاريريعکس بگتک 

 که در ی گروهیمثلا برا.  موضوعات مختلف انجام دادی توان برایکار را م نيهم 
 . کنندیت مي زنان فعالی مالین توانمند سازيکمپ

 توان یم.  اعلاناتین دارد مانند تابلوي استفاده در کمپیز براي نیگري دیکر ابزارهايفل 
 .گر در مواقع گوناگون استفاده کردي دیآن ها همراه با ابزارهااز 

 What Can We DO With Flicker Photo :د بهيگرنگاه کني امکانات دیبرا 
(http://flicker.com/photos/cogdog/٢٦٥٢٧٩٩٨٠) 
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 . گر نشان دهدي دیا حساب هايکر يرد و آن ها را در حساب  فلي بگیا گروهي ی فردیهر گروه عکس ها •

: د بهينگاه کن. اهو استيه حساب يکر  داشته باشد که شبيد حساب فليک نفر از هر گروه بايحداقل  •
  ".ليميا حساب جاديا": ٤٫٣ یابيدست

 .دينيرا بب" ري مشترک از تصاوۀاستفاد: "٢٫١ش عکسها راهکار ي نمایبرا •

 در ین و دومي کمپ موضوعۀ درباریاول.  خود دو نوع برچسب بزنندید به عکسهايگروه ها با •
 . خود استفاده خواهد کردیم عکس هاي تنظین برچسب ها براياز اWLP سازمان .  WLP ۀبار

 .ديگر گفت و گو کني دیا ابزارهاين به موضوع وين کمپيم اي امکان تعمۀدربار •

ک وبلاگ ي یاگر شرکت کنندگان مشغول طراح.( ک وبلاگ ادغام کردي توان در ین را ميکمپ •
 ).نندي، را بب"ی وبلاگسازۀجلس: "٢٫٥ توانند راهکار ی م اندیگروه

 هدف ۀ  در باریش آگاهي افزایل شود که براي خاص تبدی وبگاه گروهی تواند به بازویکر ميفل •
  . جاد شده استي ای مشخصیا موضوعي
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 ني آنلایدئوهاياز راه و یجيترو یت هايفعال: ٢٫٣راهکار  
شتر يب.  مستند استیلم هاي از جمله مطالب و فیداري د-یناگون صوت گوی پرونده هایشه دارايسازمان عا

ن سازمان توان يت دارند قابل استفاده است، اما وب گاه اي مشابه فعالۀني که در زمی افرادیل ها براين فايا
ن مستندات را به اشتراک بگذارد و به دنبال يل است ايشه مايعا. دئو ها را ندارديش وي نصب و نمایفن
 یوب هم به گوشش خورده است و ميوتياو نام .  استیري تصو-ی مشترک کردن مستندات صوتیزارهااب

  .ز بدانديخواهد کاربرد آن را ن

  تيفعال

  قهي دق٦٠

 .دينيوب مربوط به حقوق بشر را ببيوتي یدئويچند و •

:  همراهین هاي از دوربیمبارزه با نقض حقوق بشر با بهره جوئ •
http://polismalaysia.blogpost.com/ 

 /http://hub.witness.org. خاصیوب حول محور موضوعيوتي یدئوهاي ویگردآور •

:  خاصی سازمانیدئوهايش کارها و ويره و نمايذخ •
.http://www.youtube.com/user/learningpartnership 

وب يوتين در ي زمۀارانِ کري یقه ايک دقي یلم هاي فۀمسابق •
http://www.youtube.com/user/friendsoftheearth 

 استفاده ی روشهاۀم شوند و هر گروه به گفت و گو و تبادل نظر درباري تقسیيشرکت کنندگان به گروه ها •
 . ن بپردازدي آنلایدئوهايمشترک از و

 را که در یکين کار ي ای مختلف برایوه هايان شياز م. دنو استيک ويع يهدف ساختن سر •
 ۀ درباریقه ايک دقيلم يک في به عنوان نمونه، ساختن. ديه قابل انجام است انتخاب کن کوتایزمان

 . زنانیاسيمشارکت س

لم کوتاه يک في همراه، ین هاي و دوربیلم بردارين في شامل دوربیيدئوي وین هايبا استفاده از دورب •
 .ديدرست کن

 نيدر ا. شان نداشته باشنديا به نشان دادن چهره هیلي از شرکت کنندگان تمایممکن است برخ •
 .ا قلم هايش دستهاو يد مثل نماي مناسب استفاده کنین هايصورت از جانش

 .ش باشدين نماياز به تمريد نيشا •

 .ديک کني کلMy Account > Upload New Video یرو •

ه  د بينگاه کن. اهو استيوب داشته باشد که مانند حساب يوتيد حساب ي از افراد گروه بایکيحداقل  •
 ." ني آنلایدئوهايو: "١٫٩ یو بهره جوئ" ليميحساب ا کي جاديا: "٤٫٣ یابيبخش دست

 .دين کنييدئو را تعيعنوان، محتوا، برچسب ها، و نوع و. ديني نصب کردن برگزی را برایيدئويل ويک فاي •
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 .شند بایابيافت و دستي قابل بازید که به آساني انجام دهیدئو ها را طوري ویح و طبقه بنديتوض •

 ی از آن را می خصوصیرد و به شما امکان بهره جوئي پذیدئو ها را ميشتر انواع ويوب بيوتي •
 ٢٥تنها ( را تماشا کنند محدود است ی خصوصیدئويک وي توانند ی که میاما تعداد افراد. دهد

 ا پاکيش يرايدئوها، امکان وين گونه وير اي نوشته شده در زیام هاين در مورد پيهمچن). عضو
 .دئو داده شده استيامها به صاحب وين پيکردن ا

 .دي کنیوب را بررسيوتي مانند یامکانات ابزارهائ •

ن کار مورد ي ای براینيچ ساختار معيه. دئو را دارديهر کس امکان ساختن و انتشار مطالب و •
 . ک گروه منسجم به وجود آورديدئوها ي توان در اطراف ویحتا م. ستياز نين

 جدا ی است برایگريملاک د)  فاوا (ی و اطلاعاتی ارتباطی هایستفاده از فن آورزان اينوع و م •
گر، آنان که به دانش بهره يبه سخن د. (have-nots)» ندارها«از (haves) » داراها«کردن 

ن ي که از چنیهستند و آن هائ» دارا« دارند ی ها و ابزارها دسترسین فن آوري از ایوئج
  . »ارندند« محروم اند یامکانات
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 یسازمان یاجتماع یها شبکه: ٢٫٤راهکار 
افت يس بوک دري فۀ شبکی از اعضایيرا دعوت نامه هاياخ.  س بوک شدهي است که عضو فیشه مدتيعا

 ین گروه ها با سازمان معتبر خاصي از ایبعض.  خوانندیت گروه خود فرا ميکرده است که او را به عضو
. افته انديرفته است به سرعت گسترش يت شان را پذيشه عضويکه عا ی از شبکه هائیبرخ. ارتباط دارند

  . سازمان خود درست کندی را برای مشابهۀل است شبکي مایو

  تيفعال

  قهي دق٦٠

 :ديبا چند پرسش جلسه را شروع کن •

 داند؟ي سازمانها مفی برای اجتماعی شبکه هایا ابزارهايآ •

 کنند چطور؟يت مي فعالیو عدالت اجتماعشبرد حقوق زنان ي پی که برای سازمان هائۀدربار •

 ن ابزارها دارد؟ي از ای بر روش بهره جوئیريت سازمان تاثي و موقعی کارۀنيا زميآ •

 .دي مستقل باز کنۀ دو پنجریس بوک را روي فی آمارۀدو صفح •

http://midnightexcess.files.wordpress.com/٢٠٠٧/١١/fb_stats_update١.jpg 

http://www.appropriateit.org/٢٠٠٧/١١/facebook-statistics/ 

 .دين کنييا تعر" راد نامعلومفا"  از زنان و ین آمار درصد بالائيدر ا •

 .ديگر نشان دهي دۀ جداگانۀرا در دو پنجر س بوکيدو گروه عضو ف •

 Support Women’s Right to Nationality and Full Citizenship) در لبنان(

http://apps.facebook.com/causes/view_cause/١٧٤٨٦?h=plw&recruiter_id=٢٣٠٣٠١ 

 Support the monk’s protest in Burma) در جهان جنوب(

http://www.facebook.com/group.php?gid=٢٤٩٥٧٧٧٠٢٠٠ 

ص را ک موضوع خايس بوک امکان تجمع گرو ه ها و افراد علاقه مند حول ي مانند فیيابزارها •
علاقه مند به حقوق بشر در سراسر  یلبنان جوامع. ( آورندی گسترده تر فراهم میت هاي فعالیبرا

 )جهان

به عنوان ( معاصر قرار گرفته اند یدادهاي از رویر برخي را که تحت تأثین ابزارها افراديا •
خش و نشر  پیزد که امکانات خود را براي انگیبرم) ی بودائی راهبه هاینمونه، جنبش اعتراض

 . ار اعتراض کنندگان قرار دهنديام در اختيپ

س بوک يل است در في که مای نوع گروهۀم شوند و هر گروه درباري تقسیيشرکت کنندگان به گروه ها •
 .جاد کند به بحث و تبادل نظر بپردازديا
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س ي در فی توانند گروهی تمرکز داشته اند می موضوع خاصۀش درباريچنانچه گرو ه ها از پ •
 خورد ی از افراد گروه میکي را که به درد سازمان ی توانند موضوعیا ميجاد کنند يبوک ا

 .ندنانتخاب ک

د و چند نفر از دوستان را به يفزائي را به آن ها بیريد، تصاوي کنیاز را جمع آوريتمام اطلاعات  مورد ن •
 .د يگروه دعوت کن

 در یحساب اعضاء از کي چياگره. ديکن کيکل  Groups > Create a Groupبر .  دي شوکس بويوارد ف •
 یها شبکه یابزارها: "١٫٣ راهکار: به حساب نيا کردن باز یبرا که ديکن شنهاديپ ندارد، بوک سيف

 .  بازگردند" یاجتماع

 .      وندنديبپ شما دبهيکن دعوت دوست چند از و ديفزائيب را ريتصاو. ديآور فراهم را لازم اطلاعات •

 . دي مناسب بحث را آغاز کنیت شد، با گذاشتن عکسها گروه درسیوقت •

د و ين ابزار گفت و گو کني از ای بهره جوئی چگونگۀ ابزار گروه درباری هایي توانای پس از بررس •
 .ديسي تخته بنویشنهاد ها را رويپ

دادها، يرو: جــاد کــرد؟ي تـوانا اۀک شبــکي توان یر چـگونه ميب کردن امــکانات زيبا ترک •
 نصب شده و یام هايدئوها، پير، وي مشاوره، تصاویئت هايخبار، کنش گران، کارمندان، ها
ک يجاد ي این امکانات براي از ایب کردن و بهره جوئين روش ترکي بهترۀدربار. امي پیوارهايد

 .دي استوار گفت و گو کنی مجازۀجامع

 محتوا، شروع بحث و  ۀيسئول ته میک گروه کدام اند؟چه کسانيت يريجاد و مدي ایمنابع لازم برا •
 پاسخ دادن به پرسش ها خواهند بود؟

شان را باهم يج گفت و گوهايس بوک و نتايشان با فيند  و تجربه هاي شرکت کنندگان دوباره گرد هم آۀهم •
  . سنديان گذارند و بر تخته بنويدر م



٢١ 

 

 یسي و وبلاگ نویوبلاگ ساز: ٢٫٥راهکار 
 

 یگري دی وبلاگ هاین وبلاگ سوفيق اياز طر.  او فرستاده استیرا برا ی وبلاگی از دوستان سوفیکي
 و ی اجتماعی، گفتمان هایاسي چون مسائل سین وبلاگها متنوع اند و موضوع هائيمطالب ا. دا کردهيرا پ

 مرتب به وبلاگ ی دارند و سوفیيوايسندگان قلم شي از نویبرخ. رنديگ ی را در بر میحتا مسائل شخص
  .سدي درست کند و در آن بنویز وبلاگي خودش نیل است برايزند و مايآنها سر م

  تيفعال

  قهي دق٣٠

 .دي برو/http://www.blogger.comبه . ديورر را باز کنلنترنت اکسپيا •

•  Blogger.comدر وب یا خاطره نگاري وبلاگ، بلاگ در وب، یزباني می از ابزارهایکي 
 .Wordpress   و   Movable Typeگر عبارت اند از يج دي رایابزارها. ستا

 ۀر همي راکه زید و نامياطلاعات لازم را وارد کن .ديل وارد شبکه شويم. ی جۀ و گذرواژیبا نام کاربر •
 . دينيدار خواهد شد برگزيتان پدينوشته ها

 کيجاديا: "٤٫٣  یابيستد به دينگاه کن.  استین بخش ضروري ایل براي میداشتن حساب ج •
 ."ليميحساب ا

 .  مناسب استیقي نام حقی حرفه ای کارهای نام مستعار و برای شخصی وبلاگ هایبرا •

 .ديبسازURL ک يد و يک عنوان به وبلاگ بدهي •

 .را نهURLر داد اما يي توان تغیشه مين را هميعناو •

 .دي شکل وبلاگ انتخاب کنی برایالگوئ •

 .ر دادييان تغتو یشه ميالگو را هم هم •

 .افت مطالب شماستي درۀوبلاگ شما ساخته شده است و آماد •

 آنچه در الگو هست، ی تازه، ورایراتييد تغياما اگر بخواه.  استین سادگيساختن وبلاگ به هم •
 : د بوديخواهر ي زۀ با برنامیشتر و آشنائيازمند کار بيد نيجاد کنيدر شکل آن ا

HTML ( HyperText Markup Language) 

 .ديسيدو پاراگراف بنو. ديني خود برگزۀ نوشتی برایعنوان.ديک کني کلStart Posting بر  •

 .د کردي است که بعد حذف خواهینيام تمريک پين يا •

•  Post Optionsحات يبخش توض. ديرا باز کن)Comment (دير فعال کنيا غيد فعال و ي توانیرا م .
 .د همانطور که هست باشديبگذار
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گفت و گوها و تبادل .  استیسي وبلاگ نوۀ تجربین بخشهاي از مهمتریکيحات ي  توضبخش •
 است که مزاحمان و هرزه ی از بخش هائیکين حال ي دهد اما در عی مین بخش روينظرها در ا

 .هوده و نامطلوب در آن بگذارندي کوشند تا مطالب بیان ميگو

•  Publish Postديوشته را بخوانوند، ني پیبا زدن رو.ديک کنيرا کل. 

. ستي ساخت وبلاگ دشوار نیبخش فن. ديوسته ايسان پي بزرگ وبلاگ نوۀاکنون شما هم به جامع •
 . و نوشتن مرتب در آن اصل کار استینگهدار

 .سندي بنوی خود مطالبید تا در وبلاگ هاين کنيي شرکت کنندگان تعی کوتاه برایفرصت •

راهکار (و  ")یاشتراک ابي صفحه: "١٫١ر راهکا (یاگر شرکت کنندگان در جلسات بخشها •
 نوشتن در ی آن بخشها برای توانند از محتوایهم شرکت داشته اند، م")رسانه خوانها: "١٫٢

 ی برای گوگل مطالبی توانند در موتور جستجویصورت م نير ايدر غ. وبلاگ استفاده کنند
 . خود به دست آورندۀي اولینوشته ها

ن يرند، بنابراي گیگران قرار مي درنگ در دسترس دین نوشته ها بيا لازم است که یادآورين يا •
  . ديسي نوید چه ميمواظب باش
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 یوبلاگ گروه: ٢٫٦راهکار 
.  استیرات اجتماعييجاد تغي این براي نوی های از فن آوریشگامان بهره جوئي از پیکيشه يسازمان عا

ن يز به اي نیگريافته است که افراد دي در گوناگونین باره در انجمنهايشه هنگام سخن گفتن در ايعا
 ین افراد گروهي از ایکي.  پردازندیگر ميکدي منابع با ۀل به مبادليميموضوع علاقه مندند و با استفاده از ا

شه ين نام در فکر عايا.  استیرات اجتماعيي تغی برای کرده است که نامش هواداران فن آوریرا معرف
 خود را یافته هاين ي آخری درست کنند و هر کسیداده که وبلاگ گروهشنهاد ي پیگريد. حک شده است
  . شده استین وبلاگيشه داوطلب ساخت چنيعا.  در آن قرار دهدیورا فنیهايدر مورد نوآور

  تيفعال

  قهي دق٣٠

 . بسازدیک وبلاگ گروهيم شوندو هر گروه يشرکت کنندگان به چهار گروه تقس •

 .اشته باشدسنده مطلب دي از دو نویهر وبلاگ •

 .ثبت ورود کند/http://www.blogger.com   گروه دریر اجرايمد. ديورر را باز کنلاکسپ •

•  Blogger.comدهدیار باشد مي بسی اعضایز که داراي را نیامکان ساخت وبلاگ گروه  .
ن را يري تواند ساینام دارد و م" Administrator"ر ي اندازد مدی که وبلاگ را راه میشخص

 . مشارکت کنددعوت  به

نگاه .  استBlogger ی برایل و ناميم.یک حساب جيازمند داشتن ي شروع به کار نیر برايمد •
 ."ليميحساب ا کي جاديا: "٤٫٣ یابيد به دستيکن

 .ديک کنيقرار دارد کل) Dashboard(  که در داشبُردCreate a Blog  یرو •

. دينيد ببي گذاشتن مطلب در آنها دارۀ را که اجازیيد فهرست وبلاگهاي توانین داشبُرد ميدر ا •
 داشته یا تخصصي و ید وبلاگ شخصي توانید ميبه هر تعداد که بخواه.  وجود نداردیتيمحدود
 . ار شماستي نوشتن در اختی است که برایت مربوط به وقتيتنها محدود. د يباش

 .دينک کي کلStart Posting ید، پس از انتخاب الگو روينيبرگزURL ک يک نام و ي •

 .دي مشارکت دعوت کنید برايلي را که مایسندگانيوبلاگ آماده است، نو •

 .دي برو Settings/Permissions/Add Authors سرلوح بهی رو •

گرچه از . ديل آنها به گروه اضافه کنيمي گروه را با اضافه کردن آدرس ای دو نفر از اعضایکي •
، ورود به xxx@yahoo.com از جمله با دي دعوت کنیليميد با هر آدرس اي توانیسندگان مينو

 . ل استي میازمند داشتن حساب جيبلاگر ن

وند مناسب را بزنند و يرفتن دعوت نامه پي پذیبرا.  کنندیل خود را بررسيمي گروه صندوق ای اعضاۀهم •
 .شبُرد بپردازندا فهرست دیثبت ورود کنند و به بررس در وبلاگ

 .دي خواهند دDashboard د را هم در فهرستي جدیوبلاگ گروه •
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 .ديک کني کل New Postیرو •

ش ي نمای مختلف گروهیسنده هايد چگونه مطالب نوينيد تا ببيسي بنوی را در وبلاگ گروهیمطلب •
 ی هستند که محتوایيد واژه هايبرچسبها کل. دي مطلبتان برچسب بگذاریبرا.  شوندیداده م

 را که برجسب مشترک ی وبلاگ خود به خود مطالبۀبرنام. کنندي می را دسته بندمطالب وبلاگ
 ی که در جست و جوی خواننده ای دهد و مرور آنها را برایک گروه قرار ميکسان دارند در يو 

 . کندی مشابه است آسان مینوشته ها

 که در یدئوئي وید وبه جست و جوي بروhttp://www.youtube.comد و به ي باز کنیدي جدۀپنجر •
 .  دي موضوع وبلاگ است بپردازۀبار

 بلاگر ۀد و در پنجري کنی نام  دارد کپ Blogger’s post  کهی متن پنجره اۀدئو همي وۀ صفحیرو •
 .ديد و مقاله را چاپ کنيبچسبان

 ی توان رسانه هاین روش ميبا هم. ديوب را در وبلاگتان قرار داده ايوتي یدئويک وياکنون شما  •
ا يو ) http://www.flicker.com( کري جا داد، از جمله فلیک مطلب وبلاگي را در یگريد

 .را) slideshare)http://www.slideshare.net از یريتصاو

 .ديني که چاپ شده اند ببیب زماني افراد گروه را به ترتید تا نوشته هايک کنيکلView Blog  یرو •

سندگان يتواند برعهده داشته باشد تا از جمله بتواند به  نو یز مير نقش کنترل کننده را نيمد •
  .ستيگوشزد کند که مطلبشان مرتبط با موضوع ن
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  نيآنلا مطالب یايمزا و ها چالش: ٢٫٧ راهکار
 بابت نيا از شهيعا.  کنندی میسينو وبلاگ  گوناگونی موضوعهاۀبار در شهيعا سازمان  کارکنانۀهم
  ازمطالبی ناشیامدهايپ رامتوجه همه است ليما حال نيدرع  رسد امایوخوشحال به نظر م زده جانيه

 ی نوشتارهایدهاينبا و دهايبا و مطالب تي اولوۀدربار که دهد لي تشکیا تهيکم  خواهدیم.کند شده چاپ
  .رديبگ ميتصم وبلاگ نيا

  تيفعال

  قهي دق٦٠

 ۀ کند که درباری را بازی مشورتۀتيک کميهر گروه نقش . م شونديشرکت کنندگان به چهار گروه تقس •
 .کنديم مي را تنظی قواعدی سازمانیسي وبلاگ نویدهايد و نبايبا

 :ر اندي به قرار زی مشورتیته هاين کمين مورد توجه ايعناو •

 و ني آنلایمني ایدر چه موارد. ني آنلایمنيژه اي و به ویمني مسائل مربوط به ایبررس -یمنيا •
 و محل کار خود را منتشر یا درست است که آدرس پستيمشابه اند؟ به عنوان نمونه، آ نير آنلايغ
 را که از خدمات سازمان بهره گرفته است اعلام یا درست است که نام و مشخصات فرديد؟ آيکن
ت ياز حق مالک  است؟یت آن با چه کسيرد مسئوليد قرار گي آماج تهدین شخصياگر چن د؟يکن
 د کرد؟ ي خواهی مطالب سازمان خود در وبلاگ چگونه پاسداریومعن

اگرمشخصات . دين مرور کني فردمحور آنلای مجازیايم را بر اساس دنين حريا -یم خصوصيحر •
 افراد را یم خصوصيا حريد آي کنی کارکنان و هواداران سازمان را علنی و حرفه ایشخص

 خود و اعضا و هواداران سازمانتان را یوصم خصيد حري توانید؟ چطور ميخدشه دار نکرده ا
 د؟يمحفوظ نگه دار

ن است ي در ای مشارکتی اجتماعی رسانه هاۀت عمديمز. دي کنین را بررسي آنلایا محتو-محتوا •
د بلافاصه در دسترس يلي را که ماید اطلاعاتي توانید مي ثبت نام را زدۀن که دگميکه به محض ا
ده شود، ي در آن دیزين آميا توهيف يا مطلب سخيل اگر واژه ن حايامّا، درع. ديهمگان قرارده

 یدادين روي از چنیريشگي پیبرا.  توانند به اعتبار وبلاگ سازمان لطمه زنندین رسانه ها ميهم
 زنان یت دارد که صدايد؟ چقدر اهمي کنیشنهاد مي وبلاگ پی کنترل محتوای برایچه رهنمودهائ
ن يد چني توانیچگونه م ر شده در وبلاگ  منعکس شود؟شان در مطالب منتشيو نقطه نظر ا

 د؟يج کنيق و تروي را تشویروند

 توانند در محتوا و مطالب ی میري چه تأثین و مقررات دولتيد که قواني کنیبررس - ین دولتيقوان •
ژه اگر انتشار مطالب ممنوع شده سازمان شما را با يدرج شده در وبلاگ شما داشته باشند، به و

س بوک ممنوع يه استفاده از فيراً در کشور سوريبه عنوان نمونه، اخ.  کندی روبرو میتمخاطرا
 د؟ي آماده شده ایم هائين تحري مقابله با چنیا برايآ. اعلام شده است

 یيهر گروه سخنگو .ه کنديدها تهيدها، و نبايشنهادها و باي فهرست کردن پی سه نمودار برایهر گروه •
  .ندي خود برگزی هایريم گيج تصمي خواندن نتایبرا
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  ليميکاربرد هدفمند ا: ٣راهکار 
  اهداف

 یکي الکترونی خبرنامه های کاربرد سازمانیبررس •

   سازمانی برایي ابتدایکي الکترونۀک خبرناميجاد يا •

  م و ابزارهايمفاه

،  ی سازی آگاه،ی مالین اخبار به علاقه مندان خود، درخواست کمک  هاي رساندن آخری از سازمانها برایاريبس
ش روز افزون يل افزاي از دلایکي.  کنندی استفاده میکي الکترونیشان، ازخبرنامه هايج هدف هايغ و ترويو تبل

ف ي است که بخواهد با طی هر سازمانی  گوناگون آن برای به ابزارهایابين خبرنامه ها، امکان دستياستفاده از ا
  .  ارتباط باشدنه درين هزي از هواداران خود با کمتریعيوس

 است از جمله         یگان، قابل دسترسيا به راي مخـــتلف، یمت هاي در بازار به قــی گوناگونی  ابزارها و برنامه ها
Graphic mailsو Google groupsۀنيهز.  کندی هم اضافه میغاتي تبلیک آگهي یکيام الکتروني   که به هر پ 

ن برنامه ها و ابزارها را ي از ای فهرستی دیدر س.  دلار است٦٠٠ تا ١٠ن ين برنامه ها بي استفاده از اۀماهان
شان ي انتخاب ابزار مناسب هدف هاین رهنمود سازمان ها را برايا. دي توان دیشان مي هایژگيهمراه با بها و و

  .  کندی میراهنمائ

  لگري تسهیمادگآ

 یشگر، آن را روي نمایش روي نمایابر . موجود استی دی در سیکي الکترونی خبرنامه هاینمونه ها •
 .ديکن لگر دانلودي تسهۀانيرا

 .ننديد تا شرکت کنندگان در طول جلسه آن را ببيک را چاپ کني الکترونیچند نمونه از خبرنامه ها •

د که قبل يچ کدام ندارند، از آنان بخواهياگر ه. ل داشته باشدي مید حساب جيک نفر از هر گروه بايحداقل  •
د ينگاه کن. دي کنیياز آنها را گام به گام راهنماي باز کنند و در صورت نیسه حساباز شروع جل

  ."ليميک حساب ايجاد يا: "٤٫٣ یابيدست:به
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 یکي الکترونی خبرنامه هایبررس: ٣٫١راهکار 
ن خبرنامه ها يداند که ا یاو م.  ره کرده استيگر را ذخي دی سازمان هایکي الکترونیشه خبرنامه هايعا

 یدادهاي پول، و اعلام روی گردآوری، تقاضای اقدامات فوری اخبار، درخواست براۀرندير گدر ب
 دارند یين خبرنامه هاياز به چنيدهد، آنها ن یشه انجام مي که سازمان عایبا توجه به نوع کار. گوناگون اند

ن و يکند تا بهتر ی مره شده را مروري ذخیشه خبرنامه هايعا. شتر باشدي ها و بیژگين ويکه شامل تمام ا
  .ن آنها را بشناسديبدتر

  تيفعال

  قهي دق٣٠

 .ديش دهيشگر نماي نماۀ صفحی را روی دی سی از خبرنامه هایبرخ •

 .ن خبرهايتازه تر •

 .ی فوریبرداشتن گام ها •

 .یدرخواست کمک مال •

 .دادهاياعلام رو •

 :ديکنر گفت و گو ي موارد زۀدربار. ی خبرنامه ها به قصد شروع کار گروهیبررس •

 ن کرده است؟يا هدف را تاميآ. ن خبرنامه چه بودهيهدف از ارسال ا •

 ن خبرنامه به آن اندازه جذاب بوده است که خوانده شود؟يا ايآ •

 . کنندی از خبرنامه را بررسیم شوند و هر گروه نوعيشرکت کنندگان به چهار گروه تقس •

 .ديا سه نمونه از خبرنامه ها را به هر گروه بدهيدو  •

 :دير بحث کني موارد زۀهر گروه در باردر  •

 امد؟يد و از کدام خوشش ني را پسندیک از افراد چه نکاتيهر  •

 ده است؟يهدف رس نيا به اين خبرنامه چه بوده و آيهدف از ا •

  جالب بود که خوانده شود؟ی کافۀن نامه به اندازيا ايآ •

 ش؟يا محتواين نامه مهم تر بود يظاهر ا •

ک خبرنامه جالب خواهد ي در یگر چه نکاتي دید که در کشور و فضائيکنن مطلب بحث ي اۀدربار •
 بود؟

 .ن نشان دهديريهر گروه فهرست خود را به سا •
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ن فهرست ين خطاها را در اين روشها و مهمتريد و بهتري جمع کنیتمام فهرست ها را در فهرست مشترک •
 .دياوريمشترک ب

 بر یکي الکترونی خبرنامه هاین اثر گذارزايک جامعه در مي ی فرهنگی نقش ارزش هاۀدربار •
 که خطاب یکي الکترونی درخواست نامه های شمالیکاي مثال در آمریبرا. ديمخاطبان بحث کن

در اروپا . ج استي شوند رایسندگان آن، فرستاده مي نویبه شخص قانون گذار اند و پس از امضا
  . وجود نداردین رسميچن
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 یکيترون الکۀ خبرنامۀيته: ٣٫٢راهکار 
ن خبرنامه ها در حال ي ای چگونگۀدربار.  هوادارانش خبرنامه بفرستدی خواهد برایشه ميسازمان عا

ن گونه نامه ها کار ي از ایشه همکارانش را قانع کرده است که ارسال انبوهيعا.  هستندیريم گيتصم
افزون .  کندیهمه دشوار م یرد و هم کار فرستادن آن ها را براي گیاد مي زیرا هم وقتيز ست،ي نیدرست
 یبه نظر م. د اندازديرندگان را نسبت به قصد فرستنده به تردي نامه ممکن است گین، فرستادن انبوهيبر ا
ن ي در عیو.  بپردازدی راه حل بهتری کند تا به جست و جویشه توانسته است سازمان را راضيد که عايآ

  .  نوشت و فرستادیکي الکترونیآن نامه ها است که بتوان با کمک یافتن ابزاريحال در فکر 

  تيفعال

  قهي دق٣٠

 .دي آنان را بسنجینه هاي ها و هزیيتوانا. ديچند ابزار ارسال خبرنامه را مرور کن •

 یابزارها"  با عنوان ی گزارشی موجود است که بر مبنای دیسه ها بر سين مقاي از ایده ايچک •
     :در" .یکي الکترونۀارسال خبرنام

http://idealware.org/articles/fgt_email_newsletter_tools.php ن يکل ا.  استمدهآ
 .افتي توان ی می دیگزارش را هم در س

 .م آورندک خبرنامه را گرد هي ۀيم شوند تا ابزار تهيشرکت کنندگان به گروه ها تقس •

 .ديد ديروش استفاده از ابزار را خواه" ،یکي الکترونۀنوشتن خبرنام: "٣٫٣در راهکار  •

 .ديثبت ورود کن com.google.groups://http/در . ديبروGoogle Groups به  •

د که يست از آنان بخواهي ننياگر چن. ل داشته باشدي مید حساب جيک نفر از هرگروه بايحداقل  •
. دي کنیياز آنها را گام به گام راهنماي باز کنند و در صورت نیقبل از شروع جلسه حساب

 ."ليميک حساب ايجاد يا: "٤٫٣یابيدست

 .ديک کنيکلCreate a Group  یرو •

 .دين کنيي را تعی دسترسید و ملاک هايسي بنویح کوتاهيل و توضيمينام، آدرس ا •

تنها «: دي کنین صفحه انتخاب مي است که در همینه هائين گزي از مهمتریکي ی دسترسۀاجاز •
افت يا گوگل حق انتشار فهرست دريو آ» .رندگان محدودي گیبرا«ا ي» ،ی همگانی آگاهیبرا

 ؟ا نهيکنندگان را دارد 

 .دي را بزن (create my group)د ويپ کني بعد تاۀرا در صفح) یت شناسيهو(verification ۀکلم •

 دارند تا مطمئن ی نامه بر مۀت فرستندي و احراز هوی شناسائیگر برايک گام ديشتر ابزارها يب •
 . ک دستگاه هرزه نگاري است و نه یقيشوند فرستنده شخص حق

 .ديرندگان خبرنامه کنيد وارد فهرست گي بعد باۀ گروه ه را در مرحلیک اعضايآدرس الکترون •
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ام خوش آمد يک پيرندگان با ارسال ينده به فهرست گريبلافاصله پس از اضافه کردن نام گ •
 .دين خبرنامه افزوده ايافت کنندگان ايرا به فهرست در د که نام اويح دهيتوض

 .ديره کني ذخی بعدۀ استفادیام خوش آمد را براين پياد است ايرنده ها زياگر تعداد گ •

 به است یابتدائ ۀخبرنام کي و دارد اختصاص اعلانات پخش به تنها شما ۀخبرنام که آنجا از •
 . ديندار یازيگرنيد یگامها برداشتن

  

  کيالکترون یها خبرنامه یابزارها یمعرّف
 ./http://www.phpList.com د بهيبرو •

o ز خبرنامه ها  این نوع نامه ها آن گونه که نوعييتع : هم دارد مانندیگري دی هایين ابزار توانايا
 یم) ات موسسانيه(گر ي دی متفاوت را به گروهی، و نوع)عموم(رندگان يک گروه از گيرا به 

 یفرستادن نامه در زمان ( ی خبرنامه را باز کرده است؛ زمانبندیکه چه کس نيا: یريگيفرستد؛ پ
 . که در گوگل وجود نداردیگريو امکانات د) نيمع

 . متعدد استیزمند برداشتن گام هااي نphpList   انندشرفته مي پیم کردن ابزارهايتنظ •

o شتر ابزارها خود آموز و راهنما دارند و گام به گام روش يب. انتخاب ابزار خود گام نخست است
 . دهندیح ميم ابزار را توضيتنظ

 ی برایافت کنندگان نامه شوند؛ الگوئيد وارد فهرست دري بایکي الکترونیآدرس ها 
 به مشترک خبرنامه در یي خوش آمد گوی برایام هائيپ  انتخاب شود؛ديشکل خبرنامه با
ست،  يافت آن نيل به دريگر ماي که دی از مشترکی سپاسگزاریز برايو ن زمان ثبت نام،

 .د نوشته و بطور خودکار فرستاده شونديبا

 . انتشار و ارسال استی بالا، خبرنامه آماده برایپس از انجام کارها 

 .شترکردن تعداد مشترکان استي بی گوناگون برایدر نهاد ها یکي الکترونۀ خبرنامغي تبلیگام بعد •

o نام و آدرس یگر فهرست هايد و در دي فرستی که میل هائيميخبرنامه را در وبگاه سازمان، در ا 
 .ديغ کني و تبلیمناسب معرف

.  امکان جذّاب کندن خبرنامه است تا آن را در حدي ای نوشتن محتواین گام، آموختن روشهايمهمتر •
 ."یکي الکترونۀنوشتن خبرنام: "٣٫٣راهکار د به يبنگر

 جالب از ابزار ۀشامل چند نمون IdealWare؛ و  گزارش ی دی نوشتن خبرنامه در سیرمزها: منابع افزوده
  .  خبرنامهۀيته
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 یکي الکترونیخبرنامه هانوشتن : ٣٫٣راهکار 
 کمک ی، تقاضای خبرها، درخواست اقدامات فوریرده است، براه کي خبرنامه تهیشه چهار الگويسازمان عا

ه ي مناسب و جذّاب تهین الگوها خبرنامه هايک از اي هر ید براياکنون با .دادهاي، و اعلان برنامه ها و رویمال
 . شده استیکيک خبرنامه الکتروني ۀي تهۀکند آماد ی کار هر گروه، گمان می نمونه هایشه پس از بررسيعا. کرد

  تيفعال

  قهي دق٣٠

" یکي الکترونیخبرنامه ها ليه و تحليتجز: "٣٫١ که در راهکار یيشرکت کنندگان به همان گروه ها •
 .درست کرده بودند، بازگردند

 درست کرده یکي الکترونۀن خطاها در ساختن خبرنامين روشها و بدتري را که از بهتریفهرست جامع •
 .ننديببش دهند تا همه آن را يبودند دوباره نما

 .دييافزاياز قلم افتاده را به آن ب د، مواردي داری دی سی که روی منبعیاز رو •

 .سديک خبرنامه بنويهر گروه  •

 .شتر نداشته باشديا سه پارگراف بيدو  •

 .ستي محتواست؛ شکل اش مهم نۀن دربارين تمريا •

د يم کرديتنظ") یکيلکترون اۀک خبرنامي ۀيته: "٣٫٢راهکار ( که در بخش قبل یبا استفاده از ابزارهائ •
 .دي سازمان تان ارسال کنی اعضاین خبرنامه را برايا

 . کنند و نظر بدهندیگر را بررسيکدي ۀ چاپ شدۀگروه ها دوبه دو خبرنام •

  .افتي توان ی می دی را در سیکي خبرنامه الکترونۀي تهی ترفندهاۀ در باریبرگه ا: منابع افزوده
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   واژه پرداز هدفمند ازۀاستفاد: ٤راهکار 
  اهداف

 . روزانهی کارهای هموارسازی کاربرد واژه پردازها برای روش هایبررس •

 ی حرفه ای و روندهای کاریازهاي نی واژه پرداز تا پاسخگوی گسترش برنامه هایآموختن چگونگ •
  .باشند

  م و ابزارهايمفاه

شنهاد  يک پي نوشتن یلا برامث.  دارندمدرک انواع ۀي تهی برایشتر افراد وسازمانها روال کار خاصيب
 به  یگريسد، دي نویک نفر آن را مي: کننديه مي مختلف آن را متخصصان مختلف تهی، بخش هایرسم

ن روند يچن. کنند یش ميراي آن را قبل از ارسال، مطالعه و وی پردازد و سرانجام گروهیمرورش م
دانستن امکانات واژه پرداز و . ش آمده استي گوناگون پینه هاي به درجات مختلف و در زمیهمکار

  شود،یهم زمان انجام کار کوتاه م: د واقع شودي تواند مفی ها از دو سو مین گونه همکاريدر ا کاربرد آن
:  از واژه پردازها، در بازار فراوان اند به عنوان نمونهیبرخ.  آسان تری حرفه امدرکک ي ۀيو هم ته

Microsoft Word, OpenOffice Writer, Microsoft Works Word Processor  و  Google Docs.شتر يب
 ی براGoogle Docs کنند و از  یه گزارش و مقاله استفاده مي نگارش و تهیکروسافت براي ماۀاز برناممردم 
م ين دو برنامه استفاده خواهين بخش از همي این هايما هم در تمر. مدرکا ي مقاله ۀين هنگام تهي در آنلایهمکار
 گــزارش، و ۀي تهی براOpenOffice Writer ژهيست به ويــده ني فـایز بيگر ني دی ابزارهـایامّـا، بررسـ .کرد

Zoho Writerن ابزاري در آنلای همکاری برا .  

  لگري تسهیآمادگ

د که الگوها ين، مطمئن شويبنابرا. ستندي شوند نیانه نصب مي که در رای برنامه هائیالگوها جزء اصل •
ن نبود، ياگر چن.  شده اندیر بهره برداۀ آمادی آموزشۀ کارگاه در روز قبل از جلسیانه هاي راۀدر هم

 .ديآنها را نصب کن

 ليفان يا.  وجود دارندی دی، در سی سفارشین هاي و گزارش و تمرمدرک ۀي تهی برای ضروری هاليفا •
  . دي دانلود کنی آموزشیانه هايک از راين، در هريش از شروع تمريها را، پ
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  ن ي در آنلامدارک ۀي تهی برایهمکار: ٤٫١راهکار 
او اغلب . ند نبودهي داشته است، خوشامدرکک ي ۀي در تهی گروهیشه هنگام همکاري که عایتجربه ا
، یراتييز پس از وارد کردن تغيآنان ن.  فرستدیگر مي افراد دی برای مرور و بررسیبرا رامدارک 
رات را بخواند و يين تغيرد تا تمام اي گی میاديشه زمان زي عایبرا. ند فرستی او باز پس می را برامدارک
رااغلب، ي مرور کنندگان هم زمان بر است زین کار برايا.  را با هم ادغام و سازگار کندیهمگ
  . کنند ین را تکرار ميشي مرورکنندگان پیشنهادهايحات، و پيتوض

  تيفعال

  قهي دق٣٠

 .ديل خود ثبت ورود کني مید و با حساب جيوارد شو com.google.docs://http/به •

 . ديداشته باش (GTalk) تاک یا جيل ي میک حساب جيد ي استفاده از ابزار بایبرا •

ر؟ يا خيدارند ل ي می افراد کارگاه حساب جۀد که همينيبب. دي بگذاری بررسی را برایزمان کوتاه •
 .د تا آن را باز کندي نداشت کمکش کنیاگر کس

 . کارگاه فاوایده ها و دستور کار براياد به نام ي درست کنیدي جدۀپروند •

کند تا همه بتوانند با هم ي درست می اصلليفاک يلگر يد که تسهيبه شرکت کنندگان اطلاع ده •
 کنند تا ساختن ی همراهليفان يجاد اير در الگي توانند با تسهیشرکت کنندگان م.  آن کار کنندیرو
 .شان آسان تر شوديل مشابه برايفا

 .  دو موضوعیکيد، همراه با چند عنوان بخش و يپ کني را تای آغاز گفت و گو، متن مقدمه ایبرا •

 را مرتب مدرکد ي دهی که شما در متن میرييپس ازهر تغ Google Docs د کهيتوجه کن •
ن برنامه دعوت ي در ای همکاری، چند نفر از شرکت کنندگان را برایبعددر گام . کند یره ميذخ
 . ديکن

 .ديهمکاران را وارد کن- نام شرکت کنندگانShare ک کردن يپس از کل •

با .  کنندیافت مي درمدرک ۀي مشارکت در تهیل دعوت نامه را برايميشرکت کنندگان از راه ا •
 .  آغاز خواهد شدیوند همکاري پۀزدن بر دگم

ن ي شرکت داد اما در امدرکن ي اۀي توان تمام شرکت کنندگان را به عنوان همکار در تهیم •
 . خواهد گرفتیشترين وقت بيصورت تمر

د تا يم شوند و سپس چهار همکار را هم اضافه کنيد شرکت کنندگان به چهار گروه تقسيشنهاد کنيپ •
 .بزارها را داشته باشند مهارت ها و استفاده از ایريادگين کردن، يهمه امکان تمر

 . کنندمدرکل اند وارد ي را که مایراتييشرکت کنندگان تغ •

 .ده خواهند شدير دي با تاخیرات بلافاصله و برخيي تغینترنت، برخيبسته به نوع اتصال به ا •
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شگر ي نمایرو. ديلگر است دنبال کني که متعلق به تسهمدرک از ی نسخه ایرات انجام شده را از روييتغ •
 .ننديرات را ببييد تا همه تغي دهنشان

• insertديسيک جمله بنوي را در مورد یو نکاتد ي را بزن. 

 از مطالب ی جلب توجه شرکت کنندگان به برخی است برایآسان  راه comment)( اظهار نظر کردن  •
 .ازمند اصلاح استي که نمدرک

 .ديک کنيکل(Revisions) ش يراي لوح ویرو •

با استفاده از .  کندی وارد شده است فهرست ممدرکک ي را که در یاترييک تغيکايش يرايلوح و •
 را که حذف شده یراتيي و تغیا متن اصليسه کرد ي را مقامدرکک ي ۀ توان دو نسخین لوح ميا

 . اند بازگرداند

 .ديک کنيکلCompare Checked  ۀ دگمیرو. ديسه کنيدو نسخه را مقا •

رات ييهر رنگ مختص تغ.  شودینشان داده م مختلف یرات آن با رنگ هايي و تغمدرک •
 . ک همکار استيواردشده توسط 

 .دي برگردی قبلۀد تا به نسخيک کني کلBack to Revision History یرو •

  Back to Editing ا   ي  Back to RevisionHistoryی اصلاح شده روۀن نسخيدن آخري دیبرا •
   یاني از نسخ میکيمکن است به خطا با ره شده مي ذخۀصورت  نسخ نير ايدر غ. ديک کنيکل
 .ن شوديگزيجا

 .ديک کني کلRevision Number ی رو •

 . شودیبرگردانده م ی از نسخ قبلیکي به  مدرکRevert to this oneک کردن يبا کل •

. را دارند)  نسخیشماره گذار ( ی و نسخه گذاریابي امکان ردی واژه پردازیشتر نرم افزارهايب •
 ."راتيي و چسباندن  تغیابيرد : "٣٫١ یه جوئبهر: د بهيبنگر

 .ديک کني کل Publish یرو •

 وب گذاشت تا در دسترس یا رويک وبلاگ منتشر کرد و يما در ي توان مستقی را ممدرکن ي ا •
 ید که تنها کسيتوجه داشته باش"). یسي و وبلاگ نویوبلاگ ساز: "٢٫٥راهکار (همگان باشد 

 . تواند آن را منتشر کندیم) نين تمريدر الگر يتسه(  است مدرککه مالک 

م يتنها مالک حق تصم.  اسناد استی بر روی در کار اشتراکیدي از نکات کلیکي" تيمالک"  •
 از آن مدرک حق حذف کل یا پس گرفتن اجازه به افراد را داراست و حتّي نسبت به دادن یريگ

 . اوست

 .دي ثبت خروج کنGoogle Docs از  •

د، به ي اجازه را فراهم نسازی بیابيد تا امکان دستي را از برنامه ها ثبت کنشه خروج  خوديهم •
 .ديل متصل هستي میو ج  Google Docs که به یژه در موارديو
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 واژه پرداز به یشتر از ابزارهاي هر چه بیور  بهرهی روش هاۀ دهد درباریاگر وقت جلسه اجازه م •
 :دي گفت و گو کنی گروهیژه در کارهايو

 د؟ي آیش مي پمدرکک ي ی بر رویاز به کار گروهي نی موارددر چه •

 .م دستور کاري تنظیا برايداد يک روي یگران براي با دیزيبرنامه ر 

 . که مؤلفان گوناگون داردیم گزارشيتنظ 

 .گري فرد دی با همکارینوشتن مطلب •

 ست؟ي اسناد چۀي در تهیب همکاريا و معايمزا •

 . پردازندی ممدرکش يرايچند نفر همزمان به نوشتن و و 

 .ک فرد خواهد بودي با یم نهائيتصم 

 . کاغذ و دست به دست گرداندن به صرفه تر استیاز چاپ کردن رو 

ب،  ين ترتيبه ا.  به نوبت شرکت داشته باشندمدرکش يراي توانند در نوشتن و ویهمه م 
د گر، تکرار نخواهي دی را، در شکل هایگريرات دييک از شرکت کنندگان تغيچيه

 . کرد

 یکي الکترونی دارند و خواهان همکارینترنتي همکاران حساب اۀن است که هميفرض ا 
  .  هستند
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  ی سفارشیالگوها: ٤٫٢راهکار 
.  فرستدیگرسازمان ها مي متعدد به همکاران و مشاوران سازمان و دیل هايمي، ای مسائل مالۀسارا دربار

 یل است بجاياو ما.  کندین مسائل فرستاده شروع مي همۀر که قبلاً دربایليمي کردن از ایکارش را با کپ
ند و  ند هربار از آن استفاده کنز بتوانيش ناناريه کند تا نه تنها خود بلکه دستي تهیر الگوئي وقت گۀوين شيا

  . ک دست تر شوديز آسان تر و يکارشان ن

  تيفعال

  قهي دق٣٠

 .ديکروسافت ورد را باز کنيما •

د يني بین الگوها را که مناسب کارتان مي از ایکي.  متعدد استیوها الگین برنامه دارايا •
وه آشنا ين شي که با ایهنگام. ديقه  و سازگار با هدفتان اصلاح کنيد و آن را براساس سلينيبرگز
گر مانند نوشتن گزارش ي مقاصد دیز برايل و نيمي ای برایتان آسانتر است که الگوهائيد برايشد
 . ديه کني تهمدرک ۀيا تهيو 

 My Computer  یرا از روChoose Template . ديد باز کني جدمدرکد تا يبرو File > New به  •
 .ديانتخاب کنProfessional Letter  یو الگو

 مطلوب شان را انتخاب ی توانند الگوهایشرکت کنندگان م. دي نامه شروع کنیکار را با الگو •
 .کنند

د و آدرس ي آدرس فرستنده را بزنۀدگم. ديسيبنو Company Name Hereنام سازمان خود را در  •
 .ديخودتان را وارد کن

 که شما انتخاب ی که از همان الگوئیگرانيد. دي از واژه ها و جملات الگو را عوض کنیبرخ •
پ ي اطلاعات را تاۀد ماندي که شما داده ایراتيي توانند ضمن حذف تغی کنند مید استفاده ميکرده ا

 .ندکن

 . الگویحروف و شکل بند د، مانند نوعي را هم وارد الگو کنیگري دینه هايد گزي توانیشما م •

 .دي بدهليفا به ینام. ديبرو File > Save As > Document Template به •

مدارک د که يتوجه داشته باش.  ديک الگو نوشته اي را به عنوان یمدرکب ين ترتيبه ا •
 dot.  یاني شوند و الگوها با نشان پایره ميذخ.  docیانيکروسافت ورد با نشان پايما

د تا آنها هم بتوانند ين صحبت کنيريد با ساي که درست کرده ای مشتراک از الگوئۀ استفادی راه هاۀدربار •
 . استفاده کنندی نامه نگاریاز همان برا

 .ديگران بفرستي دید و براي  حفظ کنUSBا يسک ي را در دdot. ۀپروند: راه خوب •

 .دي است بفرستی سازمانی نامه هاۀي که خواهان تهیل به هرکسيمي  را با اdot.  ۀپروند: راه بهتر •
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 یرييد تا همه بتوانند از آن، با هر تغي مشترک حفظ کنۀک پوشي را در dot.  ۀپروند: ن راهيبهتر •
 . خواهند، استفاده کنندیکه م

 .به کار بردل ها و مدارک يفا ۀتوان در مورد هم ین روش اشتراک الگوها را ميبهتر •

 .دي را ببندمدرک •

 .ديسي بنوین الگو نامه ايبا استفاده از هم. دي نامه درست کرده اۀي تهی برایاکنون شما الگوئ •

 .افتيد ي خواهNew Document تازه  را در یالگو. دي درست کنید تا نامه ايبرو  File>Newبه •

 . ن الگو آدرس قبلاً نوشته شده استيدر ا. دي انتخاب کنی نامه نگارین الگو را برايهم •

 .ديره کنيذخ desktop ینامه را رو. ديسي بنوید و نامه ايک کنيد کلي جدی الگویرو •

 .ره خواهد شدي ذخیانين الگو و با نشان پاي بر اسا س همینامه ا •

  .دي را ببندمدرکپس از اتمام نگارش نامه  •
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  یسفارش یآرائسبک و صفحه : ٤٫٣راهکار 
 ی را صرف ظاهر آنها میاديپ کردن متن نامه زمان زيپس از تا. ه گزارش استاد شده استي در تهیوفس

رات ييا تغي حروف و ۀر اندازيياز به تغينمدارک  یجا به جا.  و قابل ارائه شوندیکند تا کاملا حرفه ا
 خواهد بداند ی دهد اما میم مد انجايار آنچه را که باي و دقت بسی با بردباریسوف. ل داردين قبي از ایگريد

   هم انجام دهد؟مدرکرات را در سطح يين تغي هست که ایراه

  تيفعال

  قهي دق٣٠

 .ديپ کني در چند پاراگراف و با چند عنوان تایمتن. دي برو  File > New Documnetبه •

 که در ی  آماده اۀ توانند از پروندی در زمان میي صرفه جویشرکت کنندگان برا •
 .  است استفاده کنند Training > Worldۀپوش

 .فعال شده باشد) ی شکل دهیابزارها(د که جعبه ابزار يمراقب باش •

 .ديم کني آن را به عنوان سر فصل تنظی فهرست انتخابی سرفصل از روی از شکل هایکي با انتخاب  •

.  داردمدرکه ي گوناگون در تهیکند و استفاده ها ی می بازی نقش مهممدرکک ي یشکل ده •
 یر همزمان جنبه هاييت تغي و به قابلمدرککسان ماندن ظاهر ي به ی نمونه، شکل دهیبرا

 ی اساسیز نقشي فهرست مطالب نۀيسرفصل ها در ته.  کندی آن کمک میگوناگون شکل ده
 ").ی و شکل دهیصفحه بند: "٣٫٤   یبهره جوئ(دارند 

 .دين روند را تکرار کنيز هميگر نياقل دو سرفصل د  حدیبرا •

ر کرده ييد نظرتان تغيفرض کن. ديک نوع شکل را انتخاب کرده اي چند سرفصل یاکنون شما برا •
 .دير دهييد شکل را تغي خواهیو م

 هر نوع ی برای معمولی دارد که در الگوهایکروسافت ورد چند مدل سرفصل و شکل بنديما •
 .  شوندیافت مي یمدرک

 .دي را انتخاب کنMoreان فهرست مدل ها ياز م •

 .ديک کني کل Heading Name > Modifyی روی شکل بندینه هاين گزيدرب •

  Automatically update و Add to Template  یرو. دي بدهیر در شکل بندييچند تغ •
 .ديرا بزنOK د  و يک کنيکل

ه ين الگو تهي اۀ که برپانمدارکتمام  .د درآمده اندياکنون تمام سرفصل ها به شکل جد 
 . شکل را خواهند داشتنيز هميشوند ن

ر الگو يي انجام شود و در سطح تغمدرکن ير شکل تنها در ايين تغيد اي خواهیاگر م 
 .ديرا لغو کنAdd to Template  ۀنينباشد، گز
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را انتخاب Page Manager PDF Writer  ان چاپگرهايد و از مي برو File > Print به •
 .ديرا بزنok د و يکن

 .ديرا انتخاب کنDesktop  پرونده ۀري محل ذخیبرا •

 . آن باز شودPDF د تا نوع  يک کنيره شده دوبار کلي ذخمدرک یرو •

.   شوندی مختلف خدشه دار میانه هاي هنگام انتقال به رایرات در شکل بندييگهگاه  تغ 
، حروف و زبان ی در شکل بندیريي مانع هر تغPDF  به  نوع  مدرکک يل کردن يتبد

 .  شودی ممدرک

  .ديا ببندوُرد ر •
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   و گزارش هایمستندساز: ٤٫٤راهکار 
 ی کند بهره میه مي که دفتر کارش تهی اسنادۀکروسافت در همي ماۀ برنامی از امکانات شکل بندیسوف
ق، استفاده ي جست و جو و تحقۀنيژه در زمين برنامه، به ويگر ايل است بتواند از امکانات دي مایو. برد
  .  استی پژوهشیهامدرک ۀي تهیامکانات تازه براافتن ي یاو در جست و جو. کند

  تيفعال

  قهي دق٤٥

 .دي   بروStart > Programs > Microsoft Office > Wordبه  •

ن ابزارها و ي از یبرخ. قات داردي انجام تحقی برایشرفته اي پیکروسافت ورد ابزارهاي ماۀبرنام •
 .ديدا کنيک گزارش پي ۀيعملکردشان را در ته

 .ديز کنبا Training > Word را در ی پژوهشیا گزارش هۀپوش •

دا ي پیقيتحقمدارک  برنامه را در مورد یژگيک ويهر گروه . ديم کنيشرکت کنندگان را به چهار گروه تقس •
ان ير شرکت کنندگان در مي خود را با سایسپس آموخته ها. اموزديز بيکند و روش کار آن را ن

 .بگذارد

 .مدرکان ي فهرست اعلام در پا- گروه اول •

 .مدرک جدول آمار -گروه دوم •

 . گري دیدر بخش ها.وند ارجاعاتي پی برامدرک در یابي بخش صفحه -گروه سوم •

 .ک از آنهاي هری و افزودن پانوشت برامدرک بخش درست کردن -گروه چهارم •

 : د بهيبرومدارک  ی صفحه بندیدن خود آموز و چگونگي دیبرا •

Help > Microsoft Office Word Help > Table of Contents > Formatting  

 دارد که یي هایم بندياب، و تقسير، صفحه ين خودآموز جدول تصاوي، ایل کار گروهي تسهیبرا •
 . کندی گروه را آسانتر میکارها

 . سکّه اندک ي ید که دو رويم شدن گفت و گو کنيگران سهي آموختن و آموخته ها را با دۀدربار •

  کنند؟یدا ميگران به هم ربط پيچطور آموختن و اشتراک آن با د •

شتر گسترش ي خود رابا آموختن بید آموخته هاي توانی، چطور مین جلسات آموزشيپس از اتمام ا •
 د؟يده

  د؟يک کني خود شریگران را در آموخته ها و مهارت هايد دي توانیچگونه م •
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  گزارش ۀارائ: ٥راهکار 
 اهداف

 .ک گزارشي ۀ ارائیت هاي بردن به کاربرد و مزیپ •

 .دي استفاده از اسلایوه هاين شيک گزارش و آموختن بهتري ۀ ارائین روش هاي بهتریبررس •

 . ک گزارشي ی مؤثر و حرفه اۀه و ارائي تهیآموختن روش ها •

  

  م و ابزاريمفاه

از .  شودی مهم شمرده میها از مهارت یکيسخن گفتن در مقابل جمع، چه بزرگ و چه کوچک ، امروز 
د که سخنان يه کني تهیدهائي کند اسلایک گزارش به شما کمک مي مربوط به ارائه ین رو، برنامه هايهم

 مخاطبان مفهوم تر ید براي کنی را که ارائه میر مطالبياستفاده از تصو. شما را جالب تر و مؤثرتر کنند
 مرتبط با هم را نشان داد و  ید کرد، داده هايشتر تاکيهم ب نکات می توان روید ها ميبا کمک اسلا.  کندیم

  . ده را ساده کرديچيمطلب پ

 و  Microsoft PowerPoint, zoho Show  : گزارش دردسترس اند ازجملهۀ ارائی برایادي زیبرنامه ها
OpenOffice Impress .یخش آموزشن بي این هاي تمریج است، برايار راينت بسي پاور پوۀاز آنجاکه برنام 

  .م کردين برنامه استفاده خواهيما از ا

  

 لگري تسهیآمادگ

 ۀروز قبل از شروع جلسه هم. افتي توان ی می دین بخش را در سي این هاي تمری لازم برایپرونده ها •
 .دي کارگاه دانلود کنیانه هاي رایآنها را رو

 ۀاني راین نمونه ها را تنها رويا.  اندی قابل دسترسی دی آماده شده هم در سید هاي اسلاینمونه ها •
 .ديلگر بگذاريتسه
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  گزارشۀ ارائۀ عمدی هایژگيو: ٥٫١راهکار 
 یه گذاران احتمالي از سرمای گروهی سازمانش درست کند و براۀ را درباریيدهاي خواهد اسلایشه ميعا
ر ي سالانه، تاثۀها، بودجش، انواع برنامه يدايخ پي تارۀ، سخنرانان  درباری قبلی هایدر سخنران. ش دهدينما

حات لازم ي را که شامل عکس وگزارش عملکرد و توضیي سازمان سخن گفته و بروشورهایبرنامه ها
د يش اسلاين عناصر را در نماي اۀ خواهد همیشه مياکنون عا. ن شرکت کنندگان پخش کرده انديبود ب

  .نت ارائه دهديبگنجاند و به کمک پاور پو

  تيفعال

 قهي دق٤٥

 .دي جوامع عرب را مرور کنی انسانۀ توسعۀ در بار٢٠٠٢د گزارش سال ياسلا •

 یاد ارتباط با جمعجي ای است برایوه اي است، شی ارتباطۀ رسانید در واقع نوعيش اسلاينما •
، و ی توان از آن به منظور آموزش، اطلاع رسانیگر مي دی ارتباطۀمانند هر رسان. بزرگ
 . استفاده کرد خاصیا هدفيغ آرمان يج و تبليترو

 .دي درست کنیدي اسلا٦ش يک نماينت، ي پاور پوۀ از برنامیريبا بهره گ •

 مطالب  ۀ ساختار و فشردید، کارتان را با طرّاحيت داريدها محدوديکه در تعداد اسلا از آنجا •
 .ديشروع کن

 .دي گزارش بحث کنۀ فشردۀدر بار •

:  داردیيک داستان چه بخش هاي. ديشيندي کوتاه بۀک مقاليا يک داستان ي ۀ در باریبه گزارش •
 .یريجه گيا نتيان يمقدمه، بدنه، و پا

 ۀان مطلب و بدني مقدمه و پاۀ پرحرارت در باریو بحث ديم کني ترسیک طرح کلي تخته یرو •
 .دي آن راه اندازیاصل

 .  گزارش خود کار کنندی طرح کلۀشرکت کنندگان دربار •

 یست بلکه فشرده کردن مطالب و طراحينرم افزار ن گزارش استفاده از ۀن بخش ارائيسخت تر •
 .د استيش اسلاي نمایمحتوا

 .ديبرو File > New > From Design Templateد و به ينت را باز کني پاور پو •

 دهايش اسلاي نماید از آنها براي توانیم. ش آماده شده داردي از پی الگوینت تعدادي پاور پوۀبرنام •
 .دياستفاده کن

 رسالت سازمان را ۀد و فشرديک کني  کلSubtitleبر . ديد و نام سازمان را اضافه کنيبرو  Titleیرو •
 .ديسيدر آن بنو

 .دي آید بدنه به حساب نمي اسلا٦ از یکي گزارش است و ۀ شروع ارائۀن در واقع صفحيا •

 .ديد و متن مقدمه را وارد کنيبزن < Insert > New Slideیرو •
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 که شما ید عنوانياسلا.  عنوان و محتوا-د استي دو نوع اسلایدارانت ي پاورپوۀش ساختي پیالگو •
د هم شامل ي که هم اکنون وارد کردیدياسلا. رعنوان استيد شامل عنوان و زيه کرده بوديقبلاً ته

.  گزارشی گنجاندن مطالب متن اصلی مناسب برا(power points) یعنوان است و هم نقط ها
 محتوا ی گوناگون مناسب برایدر سمت راست الگوها. شوند یده ميد ديدر سمت چپ دو اسلا

 . دي انتخاب کنی متفاوتی از الگویديد اسلاي توانید ميلياگر ما. قرار گرفته اند

 .ديره کنيتان را ذخي کارهاCtrl+sد که با فشردن ياد داشته باشي به  •

 .ديپ کني آن تاد را درين اسلاي دومیمحتوا. ديک کني راست کلSelect New Slide یبر رو •

 .Ctrl+m یبيد ترکي وجود دارد از جمله زدن کلی مختلفید راه هايد جديک اسلايجاد ي ایبرا •

 .ديب اضافه کنين ترتيجه را هم به همي  و نت٥ و ٤، ٣ یدهاياسلا •

 متن ی مطالب، محتوایطرح کل–ب انجام گرفته است ين ترتي گزارش به اۀ ارائی اصلیکارها •
 .د و ارائه گزارشيش اسلاي محتوا، نمایدهاي، اسلاد عنواني، اسلایاصل

 .دينيش آنها را ببيد نماي توانیاکنون م. دها آماده اندياسلا •

د و هر پنج ين صفحه را بزنيي در پاSlide Show ۀمگد. ديک کنيد عنوان در سمت چپ کلي اسلای رو •
 .دينيد را ببياسلا

 .دي گزارش انتخاب کنۀه عنوان ارائه دهند بیدها هم آماده است داوطلبيش اسلاياکنون که نما •

.  ديت ما ارائه کني جلب حمایم و گزارش را برايه گذاران هستي از سرماید که ما عده ايتصور کن •
 .ميده اي دینين چني اید که ما قبلا ارائه هايتوجه داشته باش

 گزارش ۀ ارائۀ نحوۀه گذاران دربارياز سرما.  کندیدها ارائه مي گزارش را با کمک اسلایداو طلب •
  خواهند بود؟یه گذاريا حاضر به سرمايآ .دي کنینظرخواه

د که ي بگویمثلا اگر کس. ديسي تخته بنوید و رويل کني تبدی آنها را به موارد عملیپاسخ ها •
ش يد و بعد نظر او را در مورد بهتر کردن نمايلش را بپرسيست دلي نیه گذاريحاضر به سرما

 .ديا شويد جوياسلا

 .ديارش را به بحث بگذارزختار ارائه گسا •

د که يا نه؟ به خاطر داشته باشيام شما در مخاطبان کمک کردند ي پیر گذاريد به تأثي اسلا٦ن يا ايآ •
شه ي کوتاهتر همین رو ارائه گزارش هاياز هم.  کنندیشتر مردم از کم بودن وقتشان شکوه ميب

 .بهتر است

 .ديد بهتر کني اسلا٦ن يت کار را با هميفيد کي توانیچطور م •

 :ديش اسلاي نماین روش هايبهتر •

 . دي کنند استفاده نکنید را مشکل ميدن اسلاي فشرده شده که فهمیاز متن ها 

 . بردیقه زمان مين سه تا چهار دقيد بيش هر اسلاينما 
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 ر، و جداول در ارائه گزارش يمتن، تصاو: ٥٫٢راهکار 
ن سازمان ياز ا. شودیانه صاحب نظر محسوب مين در خاور م موضوع حقوق زناۀشه در باريسازمان عا

زان يم دارد تا ميشه تصميعا. ارائه کندیت زنان مطالبي وضعۀ درباری جهانیدعوت شده تا در کنفرانس
ن ي ای عمومۀ توسعیسه کند و نشان دهد که براين، و اردن را مقايسواد زنان در سه کشور لبنان، فلسط

  .  داشته باشدیشتريد شتاب بيان با زنیکشورها، سواد آموز

  تيفعال

  قهي دق٤٥

ن ارائه ي که به کار ایرين پوشه آمار و تصاويدرا. د ي را باز کنTraining > PowerPoint ۀ پوش •
 .د موجودندي آیم

.  شده استی زنان  گردآوری  آموزش و همکارین المللين مطالب از وبگاه سازمان بيا •
http://www.learningpartnership.org/ 

د ي بای ارائه گزارش انتخاب کنند اما هر گزارشی را برایگري توانند کشور دیشرکت کنندگان م •
 .سه کنديدست کم سه کشور را با هم مقا

 .دي را باز کنPowerPoint ۀ برنام •

ن ييپس از تع. ديک متن داشته باشير، و ک نموداير، يک تصويد ين گزارش باي ارائه ایبرا •
 . جذاب باشدی کافۀ گزارش به اندازۀد که ارائي کنید ها، سعي اسلایواتمح

 .دي را بکشی تخته طرح کلیرو •

ت يل اهميدلا: ٣ آنها؛ ی آمارۀسي کشورها و مقاۀد مقدمه دربارياسلا:٢د عنوان؛ ياسلا: ١ •
ر و يتصاو :٥ کند؛ یان و مردان را روشن م زنی باسوادۀ که عمق فاصلینمودار:٤؛ یباسواد

 .شنهاد هايپ

 .دير دهيي حروف هر دو را تغۀشکل و انداز. ديسيد اول بنوير عنوان گزارش را در اسلايعنوان و ز •

 متن حروف مورد ۀين است که پس از تهيراه نخست ا. کار را انجام داد ني توان ایبه دو روش م •
  ۀن است که پس از انتخاب متن دگميراه دوم ا. ديکن انتخاب ی شکل بندۀنظر را از جعب

Format>Font ديرات را وارد کنييد و تغيرا بزن. 

 .ديد بگذارين اسلاي در ای مربوط به سه کشور را در جدولیآمار اصل. دي وارد کنیديد جدياسلا •

ا اکسل يرد و  مانند ویگري دۀا از برناميد و ينت درست کني پاور پوۀد در برنامي توانیجدول را م •
 .دينت کني و وارد پاور پویکپ

جاد شده انجام ي جدول اید روي توانید مي را که بخواهیراتيين است که تمام تغيت روش دوم ايمز •
 . ديه انجام دهي اولۀد در برنامياز را باير مورد نيين است که تغي ضعف راه دوّم اۀنقط. ديده

 .ديدر ستون دوم بگذارت آن را ينام کشور را در ستون نخست، و جمع •
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ر آن يدر ز" ت دارد؟ي اهمیچرا درصد باسواد: " ديعنوان آن را بگذار. دي وارد کنیديد جدياسلا •
 .دياوريل خود را بي از دلایفهرست

د ي توانی برنامه است، اما مۀش ساختيره ، پي مانند رنگ و اندازه و غیتما م مشخصات ظاهر •
 .دير دهييآنها را تغ

 .دي بگذار بزرگسالانیدرصد باسواد: عنوان آن را. ديوارد کن یديد جدياسلا •

• Excelدي سه کشور نامبرده شده بسازی برایقيک نمودار تطبي. دي را باز کن. 

ن ي ای طراحیبرااست  آمده Training > PowerPoint اکسل در ۀ که در پروندیاز آمار •
 .  دينمودار استفاده کن

 .ديبچسبان"  بزرگسالانیدرصد باسواد" د يد و در اسلاي کنین نمودار را کپيا •

ر و يک تصوين ي است بیچه تفاوت. ديازمائي مختلف را بینه هايد و گزي استفاده کن   Paste Specialاز •
 اء آمده در اکسل؟ياش

. ديک کني آنها دوبار کلیدن تفاوت ها روي دید، براينت چسباندياء را در پاور پوينکه اشيپس از ا •
.  گنجاندینه را، در گزارش ارائه شده مي اکسل، از جمله اعداد پس زمۀ صفحۀاء اکسل همياش

 . بودجهۀيد، به عنوان نمونه، هنگام تهي عموم فاش کنید اعداد را برايگهگاه ممکن است نخواه

 در سمت یگرير دي در سمت راست و تصویري را که تصوی صفحه اید و محتواي وارد کنیديد جدياسلا •
 .ديچپ دارد وارد کن

 .ديپ کني بهتر کردن وضع سواد را تایوه هاي از شی فهرستی چند رده ایبا وارد کردن نقط ها •

 .  شودید قبليد مشابه اسلاين اسلايد که اير دهيي تغی را طوریشکل بند •

 .دي سمت چپ  بگذارۀر در جعبيک تصوي File > Insert > Picture یک کردن رويبا کل •

ر اندازه بهتر است که يي تغیمعمولا برا.   آنهاستۀم اندازير تنظي حسّاس در چسباندن تصاوۀنکت •
 از اضلاع یکياگر تنها . د يد بکشيا درون اسلايرون ير را به طرف بي از اضلاع تصویکيکُنج 

 . خوردیر به هم ميد، تعادل تصويرا اصلاح کن

 .اضلاع را از یکيد و هم يهم کُنج را بکش. دير اندازه را امتحان کنييهر دو روش تغ •

 .دييفزايخ و ساعت هم به آنها بيتار. ديدها بگذاري اسلایشماره برا •

 . خ باشندي شماره و تاری داراۀد انجام شوند تا همين ها در سطح الگوها  باين تمريا •

 یکي موجود یان الگوهاياز م .ديني را برگزSlide Designد و يک کنيدها راست کلي از اسلایکي ی رو •
 .ديرا انتخاب کن

 .  مانندی هستند که رنگ و اندازه و شکل حروف در آنها ثابت میش ساخته اي پینها الگوهايا •

 .دياز است انجام دهي در مطالب گزارش نیشتريرات بيياگر به تغ •
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 . ديک کني آن راست کلی رویک شئي اصلاح یبرا •

 . وجود نداردید مشکليد تا مطمئن شويد ها را اجرا کنيش اسلايک بار نماي •

 . کنندیر شرکت کنندگان نقش دعوت شدگان به کنفرانس را بازي داوطلب گزارش را ارائه کند و ساکي •

 . گزارش مطرح کنندۀ ارائۀ نحوۀشان را در باريشرکت کنندگان در کنفراانس آرا •

 کردند؟ چطور ی موفق بود؟ نمودارها کمکیت باسواديد اهمي ارائه گزارش در تأئۀن نحويا ايآ •
  موثر تر کرد؟ توان آن رایم

.   را روشن کردی توان مطلبیشتر بهتر مير و زمان بيد ها و تصاويش تعداد اسلايمعمولا با افزا •
 از مهارت ها رساندن مطلب در زمان محدود یکياما با توجه به زمان کوتاه ارائه گزارش، 

 .است

• PowerPointدي را ببند.  
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  ممتاز گزارش کي یها یژگيو: ٥٫٣ راهکار
 هم متوسط  و یبرخ. ، بوده استی عالی موفق و حتی متعدد، از جمله گزارش هاید گزارش ها شاهیسوف
ن است که چه ي ارائه دهد تمرکزش بر ایشتري بی خواهد گرارش هایاکنون که م. گر خسته کنندهي دیبرخ
  .   بدتری کنند و چه عواملیک گزارش را بهتر مي ۀ ارائۀ نحویعوامل

  تيفعال

  قهي دق٤٥

 .م شونديسقکنندگان به چهار گروه تشرکت  •

» نتيک پاور پوي یمرگ هنگام تماشا«Death by Power Point نند که ي را ببیديش اسلايدو گروه نما
 .نام دارد

 . دي توان دی می دیاف در س. ید. یش را به صورت پين نمايا •

را » ن الملليسال عفو بسربازان خُرد « Amnesty’s Child Soldiers یديش اسلايگر هم نمايدو گروه د
 .مشاهده کنند

  در دسترس استی دیاف در س . ید. ليفاک يش هم به شکل ين نمايا •

ه يده تهي که دیيدهاي نکات قوت و ضعف اسلاۀد در باري اسلا٦ تا ٤ن ي بیديش اسلايک نماي یهر گروه •
 .کند

 .نام گذاشت" دي ساخت اسلاین روش هايبهتر" توان  ین گزارش را ميا •

 .ديش ها درست کني نمای نکات مثبت و منفۀ درباری کلید که اول طرحياد داشته باشيبه  •

 . کنندیر شرکت کنندگان در نقش همکار باز يسا. ش دهدي خود را نمایدهايقه اسلاي دق٥هر گروه در  •

 .دي نکات قوت و ضعف ارائه گزارش گروه ها صحبت کنۀدربار •

 . ديه ها به بحث پرداز ارائی و محتوایدرمورد اثر ساختار، طراح •
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 ر متحرکي، و تصاویالگو، دگرگون: ٥٫٤راهکار 
 یگريهمکاران د.  متحرک دارد معروف شده استیدي اسلایشهاي نماۀي که در تهیشه به خاطر تبحّريعا

ش ي خواهد نمای که میاو به همکار. شه را ندارنديکنند اما مهارت عا ین کار را ميهم هستند که هم
شه به ي عایهماني مۀک جلسيشنهاد کرده است که در ين همکار هم پي کند و ایت کند کمک م درسیدياسلا

  .ردي پذیشه ميعا.  که علاقه مند به آموختن ترفندها هستند، آموزش دهدیهمکاران

  تيفعال

 قهي دق٣٠

 یدر س. ( دي را باز کنTraining > PowerPoint > ICT as a Strategic Tool یديش اسلاي نما •
 .دينين را ببيد آغازيد و سه اسلايآن را اجرا کن).  شودیافت مي ید

در . ( دي  را باز کنTraining > PowerPoint > Campaign Presentation یديش اسلاي نما •
 .دينين را ببيد آغازيد و سه اسلايآن را اجرا کن).  هم موجود استی دیس

 ی موضوعات مختلفۀو گرچه دربارک سازمان ساخته شده اند يدها توسط ين اسلايهر دو ا •
 . دارندی مشترکیهايژگيهستند، اما و

ن صفحات و ي بیکدستي متفاوت استفاده کرده اند اما در هرکدام یک از الگوهايهر  
 .ان استي مطلب نماۀ ارائیروش ها

 .کنند یک کردن حرکت مير متحرک اند و با کليهم متون و هم تصاو 

 .دين کني آن تمرید رويد تا بتواني درست کنی کپۀک نسخي کدام از هر. ديد را ببنديهر دو اسلا •

ر متحرک ي خود را با تصاوی گزارش سفارشید الگوين گزارش گنجانده اي که در ایمياز مفاه •
 . ديبساز

 .دي بروView > Master > Slide Master به  •

د ي شروع کنی خالۀفحبا ص .ديد انجام دهي خواهی است که میيشتر کارهاي بۀنت شالودين پاورپويا •
 .ديد واردکني را که دوست داریراتييد و تغي مورد نظر خود را بسازیو الگو

البته  .دها منتقل خواهد شدير اسلاين شالوده و الگو وارد شود بلافاصله به ساي که در ایرييهر تغ •
 .د خواهد بودي همان اسلاید اثرش تنها بر رويد بدهيک اسلاي در سطح یريياگر تغ

•   Slide Master  دوباره  .ديد هــا را عـوض کني از اسلایکيرنگ، اندازه و عنــوان . ديرا ببند  
Slide Masterد را يد و اسلاي عنوان انتخاب کنی برای متفاوتۀاکنون رنگ و انداز. دي را باز کن

 .ديببند

 انتخاب کرده یلد اصي اسلای دارند که برایدها رنگ و اندازه ايد که اکنون تمام اسلايتوجه کن •
ات را حفظ کرده يهمان خصوص دير داده بودييد تغي که در سطح اسلایديد و تنها آن اسلايبود
 .است
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 د؟ياد گرفتين ها چه ين درس و تمرياز ا •

 .دي بدهSlide Master ید اصلي در سطح اسلایراتيي تغیاز لحاظ  طرح و شکل بند 

 ید، به خصوص در مورد نکاتيهرنديي و طرح را تغی شکل بندید عاديدر سطح اسلا 
 .نير کنند مانند عناوييد تغيکه بعدا با

 .دي بروSlide Show > Transitionبه  •

د يج ناپديد به تدريک اسلايد که يد انتخاب کني توانیم .شود ید انجام ميانتقالات در سطح اسلا •
 . ورق بخوردیا ناگهانيشود و 

 .دينن انتقال را انتخاب کيد آغازي چند اسلایبرا •

 .ديبرو Slide Show > Custom Animationبه  •

 توان یعلاوه بر آن م. ک عنصر را هم داردير در سطح يينت امکان تحرّک و تغي پاور پوۀبرنام •
 ورق د توانید ميک اسلايمثلا .  کردیک جزء را طراحي مختلف ورود و خروج یبا تحرک ها

. ن امر صادق استي متن هم همۀ بدنیبرا. د شوديبخورد و وارد شود اما موقع خروج کم کم ناپد
 .ديد آن را برجسته نشان دهي توانید مي دهی از متن می که به قسمتیبا نوع حرکت

 .دي بگذاریه تحرکات مختلفيد اولي چند اسلایبرا •

 .ديره کني خود را ذخیدهاياسلا •

 .ديره نکني ذخیل اصلي فاید که رويدقت کن •

 .ديد را اجرا کنيش اسلاينما •

 . که به کار برده صحبت کندی تعداد و انواع حرکات و انتقالاتۀروه دربارهر گ •

 .ن تحرکات را داردين و متنوع تريشتريت بيد که قابليش دهي را نماینتيپاور پو •

 د و چرا؟ي آی تر به نظر میک حرفه ايکدام .ديسه کنير را با هم مقايش اخيدو نما •

 .دي آی تر به نظر میحرّک دارد و حرفه اک نوع تي در مجموع تنها ید اصليش اسلايمان •

 .رسد ی به نظر نمی آموزش مناسب است، اما حرفه ای که حرکاتش متنوع است، برایدياسلا •

  آن کدام اند؟ید هايد و نبايبا  کنند؟ی میک گزارش را حرفه اي ارائه یچه عناصر:  بحثی برایپرسش •

 .سدي تخته بنویعناصر را رو نيلگر ايش تسهد تا در نقين شرکت کنندگان انتخاب کني از بیداوطلب •

ک نوع يا دو رنگ، يک يا دو نوع حرف، يک يد، ي در شکل و حجم مطلب در هر اسلایکنواختي •
د، فشرده ين هر اسلايي بالا و پایدها، وجود لوح هاي اسلایمدل تحرّک و انتقال، شماره گذار

 .مناسبر ي خواندن، و تصاوی مناسب حروف براۀنبودن متن، انداز
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ت نشده ين رعاين تمريک از عناصر مهم در ارائه گزارش، که خوب ارائه دادن آن است، در اي •
 ".یل گري ارائه گزارش و تسهیمهارت ها: "٣٫١ یمبان: د بهيشتر بنگري اطلاعات بیبرا. است

• PowerPointدي را ببند. 
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 یوب سازمان: ٦راهکار 
  اهداف

 .ی مهم وبگاه سازمانی اجزایبررس •

 .ک وبگاهي و ساخت ی طراحیدگيچي پدرک •

  . ص منابعيک وبگاه و تخصي ۀ و ساخت پروژیطراح •

  م و ابزاريمفاه

 را یراعناصر متعدديست زيده ايچيدرست کردن وبگاه ، چه چند صفحه باشد، چه چند صد صفحه، کار پ
  :ن عناصر عبارت اند ازي ازایبرخ. د در ساخت آن در نظر داشتيبا

 را ی چه طرحی طراح؟(host) یزبانيد کرد؟ چه نوع مي وبگاه استفاده خواهیزينامه ر در بریاز چه زبان
 ی وبگاه را میچه کس(  تيري، مد) انتخاب کرد؟یزبان کارآ تري توان میچطور م/ د؟ چرا يدوست دار

 ی مغيدر کجاها  تبل (یابيبازار)  آن را به روز خواهد رساند؟ی گذارد؟ کی مطالب آن را میسازد؟ چه کس
  . شودی سودآورۀ وبگاه ها حرفیي ها باعث شده که ساختن و برپایدگيچين پيا) شود؟ و چطور؟

ن بخش، آشنا يهدف ا. مي پردازیه در ساخت وبگاه مي اولی گام های و آماده سازین بخش به طراحيدر ا
خت آن، قادر  ساختن وبگاه است تا در صورت اقدام به سای لازم برایساختن شرکت کنندگان با گام ها

  . پروژه خطا نکنندۀن زمان ، بودجه ، و دامني کنند و در تخمیباشند پروژه را سرپرست
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  نيآنلا (petition) ۀ درخواست نامیامضا: ٦٫١راهکار 
سازمان . ح کرده استين را تشريد آنلاي جدیژگيافت کرده که در آن چند ويشه دريل از عايميک اي یسوف
شه ي و عای سوفیسازمانها. ت آغاز کرده استي تابعۀ سطح منطقه را دربار دری سراسرینيشه کمپيعا

ر اعلام ياخ ني  با کمپی خواهد بطور رسمی مین رو سوفي داشته اند، و ازهمیادي زی هایهمکار
جاد ي ایراني زنان ایون امضايليک مين ي کمپین براي آنلایونديشه پينها عاي اۀافزون بر هم.  کندیهمبسنگ

  . کندینترنت بررسين را در اين کمپي خواهد ای میسوف. کرده است

  تيفعال

  قهي دق٣٠

• Internet Explorerدي را باز کن. 

 .ديبرو ./http://www.learning partnership.org/citizenshipبه

 ی از اجزایکين به عنوان ي درآنلای عمومی از درخواست هایجي تروین هاي از کمپیاريبس •
  ین درخواست ها خطاب به قانون گذاران و شامل تقاضايگهگاه ا. رندي گین بهره ميمهم کمپ

 یا گروهي از حرکت یباني اعلام پشتیز براي موارد نیدر برخ.  خاص استیر قانونييتغ
 .  خاص استیا گروهي ازجنبش و یبانيگر هدف پشتي دیدر موارد. مشخص است

 .دي را که افراد نوشته اند بخوانیبانيشت پیام هاي از پیبرخ .ديک کني کلEndorsementوند ي پیرو •

 ی مردمیباني و پشتی نشان دادن همبستگی کنند عموما برای که شهروندان امضا میيدرخواستها •
 . کوشندی مین جارير قوانيي تغی است که برایياز سازمانها

ت ين را مرور کنند تا با هدف ها و فعالي مربوط به کمپۀ توانند چند صفحیشرکت کنندگان م •
 .ش آشنا شونديها

 .ديک کني، کلیابيراه  ۀاستوان در سمت راست Sign the Petitionوند ي پیبر رو •

 که یشرکت کنندگان. ديپ کني تایبانيل خود را همراه با اعلام پشتيمي، آدرس اینام، نام خانوادگ •
 . گران نظاره کنندي توانند از پشت سر دیندارند م یعموم ن درخواستي ایل به امضايتما

 ی که معرفیل دوستيميآدرس ا درخواست به. ديک کني کلTell a Friend ید ثبت، رويي تاۀدر صفح •
 . شودید فرستاده ميکرده ا

ن يوند ايگر گذاشتن پيراه د.  دهندین روش کنشگران به سرعت به دوستان خود اطلاع ميبا ا •
 .درخواست در وبگاه است

• http://www.learningpartnership.org/citizenship/about/camaign-signatures/ را 
 .دينيد تا نام امضا کنندگان را ببيباز کن

 باشد و چه فرم یک درخواست اجتماعيد، چه مربوط به يجاد کنينترنت اي ای که رویهر فرم •
ت ين تابعيل است که کمپين دليبه هم.  شودی هرز نگاران مۀسرعت آماج حملثبت نام، به 

 . کندین ثبت کند هرزنامه ها را از آن غربال مي را در آنلایکه فهرست اسام نيمعمولا قبل از ا
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ن يدر ا).  آمده استی دی آن در سۀنمون.( دي نشان دهیشگر اصلي نمای را رویکي الکترونۀخبرنام •
 .شان طرح شده استي به امضا کنندگان  و حفظ ارتباط با ای رسانیاهخبرنامه روش آگ

 آگاه یگر براي دیبلکه استفاده از ابزار. ستيصرفاٌ گرفتن امضا ن ن گونه درخواست هايهدف ا •
 . استیا موضوع واحدين کنشگران و علاقه مندان به هدف ي شهروندان و حفظ ارتباط بیساز

 را که ید و مقاله اي بروhttp://www.learningpartnership.org/en/advocacy/alert یرو •
ر يين تغين کمپيهدف ا. ديده است مرور کني رسیراني زنان ای به امضایون نفريليک مين ي کمپۀدربار
 .ران استين ضد حقوق زن در ايقوان

رات و اصلاحات است يي انجام تغی، تقاضای عمومی درخواست هایگر از کاربردهاي دیکي •
 . ودادگاه هاین دادرسين، بهتر کردن آئير قوانييغمانند ت

 .ران را امضا کنندي زنان ایون امضايليک مين يکمپ  توانندیل ميشرکت کنندگان در صورت تما •

ن نوع تلاش ي به ای در کمک رسانیر فن آوريد و تاثين به بحث پردازي آنلایجي تروین هاي کمپۀدربار •
 .دي کنی را بررسی اجتماعیها

ن، ي آنلای عمومیمانند وبگاه، درخواست ها( توان همزمان به کار برد ی را می مختلفیابزارها •
 .ن موثر تر شوديتا کمپ) ليميا

 در خدمت به یاز فن آور.  سنجندین آن ميدن به اهداف نخستيزان رسين را با ميک کمپيت يموفق •
 . د بهره گرفتيهدف با
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  ني آنلاۀ درخواست نامۀيته: ٦٫٢راهکار
ن، توانسته درخواست ي آنلاۀک برنامي از یشه چگونه با بهره جوئياهد بوده که سازمان عا شیسوف
.  استی مبارزه با خشونت خانگی برایني کمپی هم در حال راه اندازیسازمان سوف . درست کندینترنتيا

. ان بگذاردين کار با او در مي کاربرد ابزار اۀ خود را درباریکند تا دانسته ها یشه خواهش مياو از عا
 لازم یشروع کند و پس از کسب مهارت ها نيگان و آنلايک ابزار راي با یکند که سوف یشنهاد ميشه پيعا

  . آوردی رویک ابزار سفارشيبه استفاده از 

  

  تيفعال

 قهي دق٣٠

 . دي برو/http://citizenspeak.org د و بهي اکسپلورر را باز کن •

ن ي آنلایجي تروین هاي کمپی  در خدمت سازمانها هستند تا آنها را در راه اندازی متعددیابزارها •
ن بخش ما ي ایبرا . موجود استی دی آنها در سیوندهاين ابزارها و پي از ایفهرست .کمک کنند
 .م کرديگان است استفاده خواهي که راcitizenspeakاز ابزار 

 :دي بروs’Care٢ گاه دادخواستبه  بخش حقوق بشر در وب •

http://www.thepetitionsite.com/human-rights/hottest. 

جاد کردن و سپس  يدهند و امکان اي هم هستند که خدمات مشابه ارائه میگري دیوبگاه ها •
 از یکيشرکت کنندگان با .  آورندی مرتبط با هم را فراهم می عمومی درخواست هایگردآور
ن ي ای بعدی گام هایبرا . توانند کار کنندی مPetitionSiteا يو  CitizenSpeak یوبگاه ها

 . حرکت مشابه اندۀوي استفاده شده اما هر دو در شCitizenSpeak ن ازيتمر

اطلاعات لازم را وارد  .ديد تا مراحل ثبت نام را بگذرانيک کنيکل New User?Register here یرو •
 .دياب باز کند و حسيريط را بپذيد، شرايکن

ک ي است تا از وجود یگريد یمني اۀوين روند، شيا.  شوندیل فرستاده ميميگذرواژه ها با ا •
 .نان حاصل شودي اطمیقيشخص حق

 .ديد تا از کاربرد ابزار مطمئن شوي راه اندازیشين آزمايک کمپي •

 .دين را وارد کنيد و عنوان کمپي بزنCreate Campaign ی رو •

ل اش در بخش يميارسال خواهد شد که آدرس ا" مخاطب" باشد که به گروه یمل متند شايل بايميام ايپ •
Send Message Toره شده استي  ذخ. 

 یل هايمي اۀهم. دي  بگذارSend Message Toل تان را در يميد آدرس ايتوان یشما هم م •
ام ها يه پد شد کين متوجه خواهين آدرس فرستاده خواهند شد و بنابرايمربوط به درخواست به ا

 .  شوندیچگونه فرستاده م
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 . مهم استی مفهوم-ندگان مجلس اندي که معمولاً نما–ام ي پۀرندي گیمخاطب به معنا •

ن يد از ايتوان یشما م. کند یوند آن را هم معلوم ميپ URL یبرنامه با درست کردن درخواست •
URLدين استفاده کني آنلایگر فضاهاي در وبگاه ها، بلاگ ها و د . 

 .  امضا کنندید تا درخواست را همراه با اظهار نظريدگان بخواهنن چند نفر از شرکت کاز •

کند که  یدرست م"  هم بگویبه دوست" به نام ید به طور خودکار واحدي که به کار برده ایابزار •
 .د استين مفيج کمپيغ و تروي تبلیبرا

د يبرو View Campaign Report به. ديک کني کلCitizenSpeak در  Manage Campaign  ی رو •
 .دينيو مشخصات امضاکنندگان را بب

ن يشرفت کمپيزان پيد ميد تا بتوانيل امضا کنندگان را نگه داريمين است که آدرس ايراه درست ا •
 . ديزي به آن ها بپرهی در پی پیل هايمياز فرستادن ا. ديان بگذاريرا با آن ها در م

 .ديه است باز کنت رفSend Message To را که به صندوق بخش ینامه هائ •

 . استگان مشخصات مربوط به امضا کنندۀ همیتان فرستاده که حاوي برایليميبرنامه ا •

ل ها را به آدرس خودشان بفرستند يميت امضا کنندگان، بهتر است که سازمان ها اي حفظ امنیبرا •
مضا کنندگان را از  ای توان مشخصات فردی مین صورتيدر چن. یو نه به آدرس مخاطب اصل

 .ام فرستاديل ها زدود و سپس نامه ها را به آدرس مخاطبان پيميا

نش ي گزی برایيده هاي اۀز درباري، و نیجي تروین هاي کمپی برای عمومی درخواست هایاي مزاۀدربار •
 . ديمخاطبان مناسب، گفت و گو کن
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   وبگاهن ساختی برایزيبرنامه ر: ٦٫٣راهکار 
داند  ی نمیکس .ش ساخته شده وشامل  چند صفحه استي دارد که چند سال پیاه وبگیسازمان سوف

اما .  سازمان بسازدی برایديم دارد وبگاه جدي تصمیسوف. ن صفحات را به روز کنديچگونه مطالب ا
 یزيک  وبگاه آشنا شود تا بتواند برنامه ري ساختن یوه هاي، نخست باشیش از هر اقدامي خواهد پیم

  . انجام دهدیرا به درست

  تيفعال

  قهي دق٣٠

 .ديسيشرفت کار را بنويک وبگاه و فراگرد پي ساختن ی تخته ، قطعات لازم برایرو •

 نقشه .١

 ست؟ين وبگاه چيقصد ازساختن ا: اهداف 

 ی به چه اطلاعاتیابي دستی است؟مخاطبان برای چه کسانین وبگاه برايا: مخاطبان 
 هستند؟ منابع و یلي و تحصیتي و جنسید؟ از چه گروه سنين وبگاه خواهند رسيبه ا
 ست؟ يآنان چ) ی پژوهشی و توانائینترنتيارتباطات ا (ی فنی هایتوانائ

ن مطالب و يا اي باشد؟ آیچه مطالب و داده هائ ید حاويوبگاه با: محتوا و مطالب 
  گذاشتن در وب اند؟ یدئو، آماده براير، متن، ويداده ها، از جمله تصو

 یازيش عکس نيا به نماي مثال آیاز هست؟ براي نیيلکردهاچه عم به: هايژگيو 
رفتن درخواست اشتراک درخبرنامه هست؟ امکان جستجو در ي به پذیازين هست؟

 د ابزار لازم چطور؟ يانبار داده ها، خر

ست؟ ي آن چURLد باشد؟ نام دامنه و يزبان کجا بايسِرور م: ر ساخت هايمنابع و ز 
  خواهد بود؟ی آن چه کسید کرد؟ مسئول نگهدار خواهیت را طراحي سایچه کس

 طرح .٢

 آسان  یابيهدف باز . کردن و برچسب زدن مطالبیطبقه بند:  اطلاعاتیمعمار 
کاربرد مطالب و داده ها  ).افتيمخاطبان چگونه داده ها را خواهند .(داده هاست

 ست؟يچ

ر نظر  وبگاه دیک طرح جذّاب برايم ياد شده را هنگام ترسيموارد  ۀهم: طرح 
 .  ديداشته باش

 ساختن .٣

 HTML.(دي وبگاه را بسازیسي برنامه نوی از زبان هایکيبا  -یسيبرنامه نو 
CSS ا  ي PHP .(متعدد در ساخت وبگاه به کار برده یگان و تجاري رایابزارها 

 . شوندیم
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به عنوان . ديد و به کار بريق کنيز با هم تلفياز را نيگر مورد ني دیابزارها: قيتلف 
 . دئو باشديش دادن ويازمند نمايونه، ممکن است وبگاه ننم

 .ديد و به روز نگه داريات را در وبگاه بگذاريمحتو : مطالبیبارگذار 

 .دي آن مطمئن شوی هایژگيوۀ همید تا از درستييازمايوبگاه را ب: شيآزما 

 یراه انداز .٤

 .شروع کار وبگاه 

ل، در يميبا ا. ديغ کنيبگاه تبل وۀ مختلف درباریاز راه ها:  وبگاهۀغ در باريتبل 
 . ات سازمانيداد ها و در نشريا در روين و ي آنلایخبرنامه ها

 ینگهدار .٥

ن به  ي نوی هایوبگاه را با گنجاندن مطالب تازه و توانائ:  وبگاهیبه روز رسان 
 . ديروز نگه دار

 که یت کساني از هوی آگاهی برایريک ابزار اندازه گياز  -یري و اندازه گیابيرد 
 توانند شمار علاقه ین گونه ابزار ميا. دي شوند و تعدادشان استفاده کنیوارد آن م

 . دا کننديمندان به مطالب خاص را پ

ت ياگر متوجه فعال.دي سِرور را نظارت کنیت هاي و فعالیبانيمنابع پشت: رساختاريز 
 . دي کنیريگيد، پي شدیمشکوک

 اهداف، ۀ هرگروه با بحث و تبادل آراء درباریاعضام شوند، يشرکت کنندگان به چهار گروه تقس •
 .  وبگاه گفت و گو کنندیرساخت هاي ها، منابع، و زیژگيمخاطبان، مطالب، و

 :ر خواهد بودي زیت هاي شوند شامل نهادها و فعالی که ساخته میيوبگاه ها •

 یات آن سازمان اطلاعیت هاي فعالۀ صفحه که دربار٢٥ با کمتر از یک وبگاه سازماني .١
 .منتشر کند

 که برنامه ها و ی موسسه اۀ صفحه  دربار١٠٠ش از ي گسترده با بیک وبگاه سازماني .٢
 .  گوناگون و متعدد داردیت هايفعال

 سازمان را  یقات عموميکه بتواند انتشارات و حاصل تحق ني آنلای سازمانۀک کتابخاني .٣
 . هستندی و هم چند رسانه اpdfنوع اسناد هم  . ره کنديذخ

ار يگر منابع سازمان را در اختيدات و ديانتشارات، تول ن کهي آنلایک فروشگاه سازماني .٤
 /http://www.urban.org: داران قرار دهديخر

 ها، منابع، یژگياهداف، مخاطبان، مطالب، و:  ساختۀ برنامۀ گوناگون و عناصر متشکلیبخش ها •
دن يچسبانده شوند تا همه قادر به د کاغذ مناسب نوشته و بر تخته ی وبگاه رویرساخت هايو ز

 .آنها باشند

 . کنندی هر گروه را بررسیشرکت کنندگان نقشه ها •
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   وبگاهی هایژگيو: ٦٫٤راهکار 
ند ي بی وبگاه سازمانش مناسب می را که برایيهايژگي چند وبگاه فعّال ویم دارد با بررسي تصمیسوف
  . نديبرگز

  تيفعال

  قهي دق٣٠

  .دين کنيي وبگاه سازمان را تعی مطلوب برایهايژگيه و چهار وبگایپس از بررس •

o مانند ( ردي گی است که در محتوا انجام میت هائي فعالۀها، که از محتوا مجزا هستند، شامل هميژگيو
مانند : م کاربران وبگاه انجام دهندي خواهی است که میز کارهائيو ن) جستجو، خبردادن به دوست

  . ت در وبگاهيرفتن عضوي کمک، پذی درخواست، اهدایامضا

 http://www.learningpartnership.org/citizenship:وبگاه کوچک .١

 الگو یز براين نيگان آنلايک طرح راي. ت وبگاه استيري مدی براWordPressابزار  •
 . همکار استیان ها سازمی از سِرورهایکيزبان وبگاه، يم. دارد

گران، ي دین، ارسال مطلب براي درخواست آنلایجستجو، امضا:  آن شاملیهايژگيو •
 . استRSSو و ير، آرشيتصاو

 ./http://www.learningpartnership.orgوبگاه بزرگ  .٢

• Drupal یژگي ویبرخ.  آن استیحتوات وبگاه و ميري مدیگان برايستم رايک سي 
 ۀ خارج از وبگاه اشتراک خبرنامی برنامه ها. جستجویگر مانند توانائي دیها

 ی الگوها را طراحیکيک شرکت گرافي.  کنندیت ميريدئو را مديک، صدا و ويالکترون
 .  وبگاه را برعهده داردیزبانيک سِرور مي. کرده است

ن، ي درخواست آنلایامضا)  و فرانسهیربع( وبگاه یشامل جستجو، زبان ها هايژگيو •
  ی و کمک هایکي الکترونۀت خبرنامير، و عضوي، صوت وتصوpdf نشر بصورت 

 . استیمال

 /http://www.urban.org:ني و منابع آنلاۀکتابخان .٣

• CommonSpot یابخش ه.  وبگاه استیت محتوايري مدی برای تجارۀک برنامي 
 اطلاعات، و ی، معماریطراح.   استی خارجۀک برناميگر مانند جستجو، که يد

 وبگاه را برعهده یزبانيسازمان م.  استیک شرکت خارجي ۀ وبگاه بر عهدۀتوسع
 . دارد

 . استRSS، و pdfر، نشر مطالب به صورت  يجستجو، تصاو:  آن شاملی هایژگيو •
 . شودی میمحتوا در سطوح گوناگون طبقه بند

 /http://www.store-leaf.org:نيفروشگاه آنلا. ٤ 
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 وساخت آن را شرکت یاهو ساخته شده  و طراحي فروشگاه ی الگویفروشگاه رو •
 . کندی میزبانياهو ميوبگاه را سِرور .  انجام داده استیگريد

د، تجارت ي آن شامل سبد خریهايژگيو. یح، دسته بنديمحتوا شامل نام کالا، توض •
 .است ني آنلای مالی، و اهدایکيالکترون
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   وبگاهن ساختمقدمات: ٦٫٥راهکار 
 ساختن یاز براي خواهد منابع مورد نی برده است و میک وبگاه پي ساخت ی هایدگيچي  اکنون به پیسوف
  .ک وبگاه را فراهم آوردي

  تيفعال

  قه ي دق٣٠

ت يري مدیبرا" ر پروژهيمد"ک ي:  مختلف وبگاه خواهد کردی بخش هاۀر را مسئول ادایهر گروه فرد •
متخصص "کي وبگاه؛  ی و ارتباطات درونی شکل ظاهری طراحیبرا" مهندس طراح"کيوبگاه؛ 
 مطالب و آزمودن آنها را یکه بارگذار" ات وبگاهيمسئول محتو" ک ي و یسي برنامه نویبرا" توسعه

 .عهده دار است

 . خواهند کردین نقش ها را بازين، شرکت کنندگان همين تمريدر طول ا •

 وبگاه انجام یز، و نگهداري، ساختن، تجهی طراحۀد در چهار مرحلي که بایي از کارهایگروه ها فهرست •
 .ه کننديشوند ته

ن مرحله شامل ابزارها، منابع و عناصر يا. دي بالا، سازمان دهۀموارد را بر اساس چهار مرحل •
 :ر خواهد بوديز

 . لازمی انسانیروي و نن سازمای و خارجینابع داخلم 

 .د داشته باشدي که وبگاه بایي هایژگيو 

 .  نرم افزار و سخت افزار مناسبین کردن مشخصات فنييدرصورت امکان، تع 

از ي را که نیکنند و منابع و ابزار یفا مي ایفه ايد بدانند در هر مرحله چه وظيک از افراد بايهر  •
 . اضافه کنندی اصلدارند به فهرست

امّا . ک از مراحل اجرا مورد استفاده خواهند بودي نقش ها و وظائف در هرۀهم: اشاره 
 آن مرحله ی اصلیازهاي به نیزان حضور و دخالت مسئولان در هر مرحله بستگيم

 . خواهد داشت

 دي نداشته باشد اما بای طراحۀ در مرحلیس ممکن است نقشيبه عنوان نمونه، برنامه نو 
. د کنديي مرور و تایش در گام بعديت هاي مسئولی اجرایج آن مرحله را برايدست کم نتا

 .شنهاد کنديص دهد و پين است که بتواند اصلاحات لازم در برنامه را تشخيده آل ايا

 ی برایزيبرنامه ر: "٦٫٣د و به موارد بخش راهکار يسي چسبنده بنوی کاغذهایاد شده را رويموارد  •
 .دييفزايب" ساخت وبگاه

 .  کنندی میگر را بررسي دی در گروه هاۀه شدي تهی هر گروه فهرست هایاعضا •

د است گفت و گو و آنها ي کار شما هم مفیر گروه ها که براي سای از فهرست های مواردۀدربار •
  .ديرا به فهرست خود اضافه کن
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  نينو یا هها و موضوع یورافن: ٧راهکار 
.  نو سرو کار داردیم تازه و ابزارهاير و تحول است و با مفاهييره در حال تغست که همواينه اي زمیورافن

 موضوع ها و  "ی بخش نهائ– و راهکارها ی، بهره جوئیابي دست--ن رهنمود يک از سه بخش ايدر هر
  .  پردازدی در هر بخش می ابتکاری های از فن آوری شماریبه بررس" ني نوی هایورافن

  اهداف

 . یابي از ردیرين و جلوگي آنلایت هاي فعالیابي ردیآموختن روش ها •

 .رمحدودي محدود و غیط هاي در محی فنیت هاي فعالی چگونگیبررس •

 .ني آنلایک گپ گروهين شرکت کننده در ين چندي بیآموختن هماهنگ •

  

  م و ابزارهايمفاه

ک ي ک بهيتباطات   اریل برقراري تسهین تنها برايو گفتگو در آنلا  گپی و برنامه های آنیام هايپ
 ین امکان بخصوص در موارديا. دن سازی را هم فراهم می گروهین برنامه ها امکان گفتگويا. ستين

ل يپ و هات مياهو، اسکاي مانند یيابزارها.کاربرد دارد که افراد گروه درنقاط گوناگون جهان پراکنده اند
نه ارتباطات يشگام در زميم کرد که پيخواهپ استفاده ين بخش ما از اسکايدر ا.ن امکان را دارنديهم هم
  .  استیري و تصویصوت

  لگري تسهیآمادگ

 . دي کارگاه دانلود و نصب کنیانه هايک از راي هریرا رو(Prioxy)  و(Tor)"تور "ۀبست •

 ۀهم یرو" Tor" تورۀي افزاۀد آن را با دگمي است و بایر فاکس ضرورين دو برنامه فايش اي نمایبرا •
 .ديه آن را ندارند، نصب کن کیيانه هايرا

د با مرور بخش بهره ين صورت باير ايپ داشته باشد، در غيد حساب اسکايک نفر در گروه بايحداقل  •
  .ن حساب را باز کننديا" ،یو فراخوان صوت نترنتي در ای گپ زدن گروهۀبرنام: "٥٫٢  یجوئ
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  تال در همه جايجي دیردپا: ٧٫١راهکار 
ن يموضوع ا.  کندیه همکاري در کشور همسایگرياست تا با سازمان دشه خواسته يسازمان از عا

 ی مجبوربه حذف برخیر دولت محلي اخی هایرين سازمان به سبب سخت گيا.  حقوق بشر استیهمکار
ت ها را در يو فعال  خود را گسترش دهدیبري خوهد که بخش سایش شده است اما همچنان ميتهاياز فعال
دارد تا  ني آنلایابي ردیازبه آموختن روش هاين سازمان نين رو اياز هم.  کندیري گیک پيبرنتي سایفضا

  .در امان بماند

  تيفعال

  قه ي دق٣٠

 شود؟ ی میابين شما ردي آنلایتهايچقدر از فعال: ديک پرسش آغاز کنيبا  •

مه د، هي کرده ای که وب گذرانیا زمانيد و ي که زده ایيدهايتمام کل.  استیابي قابل ردیهر حرکت •
 . شوندیثبت م

 هارا مرور یابيست چند نمونه از رديد کننده  نيدهد و تي پلیزه هاي از انگی ها ناشیابيشتر رديب •
 .ديابي تازه دست ی هاید تا به آگاهيکن

 .دي برو View > Explorer Bar > History به. ديباز کن اکسپلورر را •

 یل دسترسي تسهیکار برا نيا. ده استره شين مکان ذخي شما در ایسه هفته از دوران وب گذران •
د و با زدن حرف يپ کنيد تاي خواهیکه آدرستان را م یمانند وقت.(  شما به آن وبگاه استۀدوبار

 .) شودیش داده مياوّل آدرس به طور خودکار نما

م ي تنظۀمگ دی، رو Generalدر لوح . دي برو Tools > Internet Options یدر اکسپلورر،  رو •
ره ي ذخید تا پرونده هايبزن View Files ی دگمه هایرو. ديک کنيکلBrowsing History ر يز

 . شوندیره مين جا ذخي در هم(cookies) ناخواسته یام هايپ. دينيشده را بب

 .ره شده انديذخTemporary Internet Files  ۀ در پوشی متعددیهام يفا •

 شما ۀاني رای نرم افزار آنها را بر رویرنامه ها اندک اند که بی ناخواسته شامل اطلاعاتیام هايپ •
 آنهاست نگه ی را که مربوط به کار شما با برنامه هاین برنامه ها اطلاعاتيا.  کنندی میگذاريجا
 هم یگري و گذرواژه است اما ممکن است اطلاعات دیاغلب اطلاعات نام کاربر.  دارندیم

 ی دستور برجای انجام ای برایک کوکي" اورير بمرا به خاط"د ي گوئی میاگر به برنامه ا. باشد
 .  گذاردیم

  More Info about youی روIPپس از مرور آدرس . ديبرو http://www.whatsmyip.org به •
 .ديک کنيدر بخش چپ کل

 شما ۀاني به را--Internet Service Provider ISPنترنتي ای شرکت خدماتۀليبوسIP آدرس  •
 ثبت است که در چه یير کند، اما در جايي ممکن است گهگاه تغIP نکه يباا. ابدي یاختصاص م

 .افتهيص يبه کدام کاربر تخصIP  چه یخيتار
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نترنت را ي است که حق استفاده از ایت کسيافتن از هوينان ين آدرس اطمي وجود ایل اصليدل •
 .  استیت ضرورنترني کار ای براIP  یآدرس ها. دهيخر

 . تمام صفحات خود دارندی رویابيک برنامه رديا ي و یابيک رمز رديشتر وبگاه ها يب •

 . بروند uk.co.bbc/www://http/د به ينند باي خواهند برنامه را ببیاگر شرکت کنندگان م •

، ی کنند چه کسانیابي توانند ردین وبگاه مرايگر مدي دیزم هايبا مکانIP ب کردن آدرس يبا ترک •
 . ده اندي دی چه مدتی را برای، چه مطالبیاز کجا، با چه ابزار

 شوند تا یل ميه و تحلي، تجزGoogle Analytics مانند یي با برنامه هاینين چنياطلاعات ا •
 .  داشته باشندیکاربرها تجربه بهتر

ا يآ. به وجود آمده اند" کيمقاصد ن " ی برایابي ردیها از ابزاریبرخ: یهي  بدیگر با پاسخي دیپرسش •
 ند؟ي جویک از آنها بهره ميشه به مقاصد ني کاربران همۀ آن است که همین به معنايا

م آگاه ي گذاری به جا میبرنتي سای که در فضایيد از رد پاهايبه عنوان کنشگران حقوق بشر با •
 .ميامان بمانم تا در ي زدودن آنها را بدانیم و روش هايباش

 یتاليجي دیزدودن ردپا: "٧٫٢ زدودن رد پاها در راهکار ی ترفندهاۀشتر در بارياطلاعات ب •
  .آمده اند" ی خودیتاليجي دیپنهان کردن ردپا: "٧٫٣و راهکار " یخود
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   تاليجيد یردپا زدودن: ٧٫٢ راهکار
ا ينترنت بگردد و يا در ايد رود تا نامه بفرستيبر کافه ها ميگر، معمولا به ساي دی در شهرهایسوف
  آنها را پاک کرده است؟ۀا هميش به جا گذاشته ي از کارهایا ردينگران است که آ. قاتش را ادامه دهديتحق
 ی که در نامه ها رد و بدل می از اطلاعاتی ندارند اما برخیتي به مسائل امنی او ربطیکه کارها نيبا ا

 یتي امنی از ترفندهایم گرفته است فهرستيتصم. ن نگران استيم هیفتد و برايد به دست هرکس بيکند، نبا
  . خود درست کندی، برای عمومۀانيلازم، پس از هر بار استفاده از را

  تيفعال

  قه ي دق٣٠

د انجام دهند، ي بای خود در محل عمومی زدودن رد پای که برای از کارهائیشرکت کنندگان فهرست •
 .درست کنند

 کار با ید هايد و نبايبا. دي، استفاده کن" در همه جایتاليجي دیردپا: "٧٫١از فهرست راهکار  •
 .ديفزائي را به آن بی عمومیانه در فضاهايرا

 .ن کننديره را تمريخچه و غي کنند تا زدودن تاری توانند سعیشرکت کنندگان م •

 :شروع فهرست •

 .دي را نده خودۀد واژي کلۀري ذخۀ  اجازی به برنامه ای عمومۀانيک رايچ گاه در يه •

 .دي خروج از برنامه ها ثبت خروج کنیشه برايهم •

 .دي ها را پاک کنیخچه مرور وب ، و کوکي فرم ها، تاریتمام داده ها •

 ديک کني کل Browsing Historyرا در Delete ۀدگم. ديبرو Tools > Options به 
 .دي بزن کاملی پاکسازیرا براDelete All . دينيره شده را ببيو تمام اطلاعات ذخ

 .ديد پاک کنيره کرده باشيانه ذخي را که ممکن است در سخت افزار رای پرونده هائۀهم •

 . دارند ی از مکالمات نگه میخچه اي گپ تاریبرنامه ها •

 .دي کنی را هم حتما خالیز، زباله دانيپس از پاک کردن همه چ •

 .دي بحث کنیمني و ایابي در ردی مفهوم پاکسازۀدربار •

 ی عمومیانه هايد ها در استفاده از رايد و نباي از بایست اما فهرستي نیتي امنیرهان کارها، کايا •
 .است

انه انجام داده ي رای را که شما رویيتوانند اطلاعات کارها یگران هم ميد که دياد داشته باشيبه  •
ن پنها: "٧٫٣ خود را در بخش راهکار  تاليجي دی پنهان کردن کارهایروشها. د به دست آورنديا

  .دياموزيب"  تاليجي دیکردن ردپا
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  تال يجي دیپنهان کردن ردپا: ٧٫٣راهکار 
 که است دهيشن اندازند، یم راه ها نيکمپ گونه نيا که یوافراد یبشر حقوق یگرسازمانهايازد شهيعا

 نيهم از. شود یم دنبال نديناخوشا و مزاحم یها وبرنامه افراد توسط آنها یتهايفعال ازموارد یاريدربس
  .کند یريهاجلوگ وبرنامه گروهها نگونه یا ازنفوذ که کند هيته یيراهنما تا دارد ميتصم رو
  قهيدق ٣٠

 م؟يشو یم چطوردنبال •

o دو) بشر حقوق مدافعان ميوحر یتاليجيد تيامن ( یراهنما در نترنتيا نظارت و مراقبت ازبخش 
 قابل ريز ونديپ راه از وهم دارند ودجو ید یدرس رهميتصو دو نيا. ديده نشان ررايتصو

 :اند یدسترس

http://info.frontlinedefenders.org/manual/en/esecman/chapter٥_٢.html  

  ISPکند بيتعق را شما ینترنتيا ارتباطات تواند یم. 

 یايدن با کشور ارتباطات گلوگاه در و یمل سطح در شما ینترنتيرفتارا بر نظارت 
 .رديگ یم صورت ISP توسط و خارج

o ISPنقاط در اي و ینترنتيا ارتباطات در که را یتبادلات تمام ،یتيامن/ یاطلاعات وعوامل ها 
 .رنظردارنديز رند،يگ یم صورت یابيريمس

 م؟يکن فرار ريفراگ نظارت نيا از چطور •

o م مدافعان ي و حریتاليجيت ديامن ( ی درراهنماینترنتي ایشگرهاياز بخش دورزدن سانسور و پالا
ر يوند زي موجودند و هم از پی دیرهم درسين دو تصويا. ديررا نشان دهيودو تص) حقوق بشر
 : هستندیقابل دسترس

http://info.frontlinedefenders.org/manual/en/esecman/chapter٦_٢.html 

 .دي را دور بزنینترنتيک سرِور قابل اعتماد سانسور ايبااستفاده از •

 .ديان کنپنه Tor  ۀنترنت را در شبکيحضور خود در ا •

o ینهايدرتمر. دارند  وجودیشگيهم نظارت نيا دست از شدن  پنهانی برایادي زیراهها 
 .ديکن نيتمر  رای دولتیسانسورها  دورزدنیرراههايز

 .ديرامرورکنIP آدرس. ديروب http://www.whatsmyip.orgهب •

o  یادآوري یرا برا" ه جاتال درهميجي دیرد پا: "٧٫١راهکار IPدي آن مرورکنی وکاربردها. 

o ن آدرسيق هميش کردن از طري دنبال کردن و پالایشترروشهايبIPاست . 

 را /http://whatsmyip.org دينيبرگز را زبان. ديرو ب/ http://www.anonymouse,org: به •
 .ديکن کيکلSurf anonymously  ۀمگ دیورو ديکن پيتا
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  . ديکن کيکل Surf یرو و دي  برو/http://www.the-cloak.com  به •
http://whatsmyip.org/ۀمگ دیرو و ديکنک ي را کلا Start Surfingدي بزن. 

o ب کنند توانند چهار کشور مختلف را انتخایشرکت کنندگان کارگاه م. 

 .ديک کنيکلMeeting Planner  ید و رويبرو /http://www.worldtimeserver.com به  •

 .دي بزنsubmitید و  رويد و زمان را در روزنگار انتخاب کنينيچهار کشور مورد نظر را برگز •

o به رنگ سبز مشخص شده ظاهر  ) ٥:٣٠ -٩:٣٠" ( روز"، که در آن ی ساعت٢٤ک روزنگار ي
 .ديمناسب را انتخاب کنزمان .  شودیم

 : کنندی را طراحی بعدیشرکت کنندگان گام ها •

o ر؟يا خيد زمان مناسب است ينيد و ببي هر سه نفر  نامه بفرستیبرا 

o دي بگذاری همه مناسب است قرار تماس کنفرانسی که برایدر روز و ساعت. 

o ديز گرد خبر دهي شرکت کنندگان مۀ کنفرانس را به همیيخ و ساعت نهايتار. 

o از دارد آن را نصب کندي نید تا اگر کسي همه بفرستیپ را براي اسکاۀوند دانلود برناميپ. 

o دييازماي ارتباط و صدا را بی، با تک تک افراد برقراریقبل از تماس جمع. 

o قه آغاز جلسه را به ي دق١٥ تا ١٠ن يقبل از شروع کنفرانس علاوه بر فرستادن دستور جلسه، ب
 .دي بگذاریف کردن مسائل فنخوش آمد گفتن و بر طر

o دي شرکت کنندگان را به کنفرانس وارد کنۀن شده همييدر وقت تع. 

.  کندیز گرد را بازي از افراد میکيم شوند و هر گروه نقش يشرکت کنندگان کارگاه به چهار گروه تقس •
 .ز گرد خواهد بودي مۀن افراد است که گردانندي از ایکيشه يعا

o جلسه استۀشه هماهنگ کننديد که عاي کنیادآوري شرکت کنندگان ۀبه هم . 

o ن يعناو.  حق ارث زنان استۀز گرد بحث درباري می برایزين جلسه برنامه ريدستور کار ا
 .دين کنيي سخنران ها را تعیب نسبي ها و ترتیسخنران

 .ن ارث در گوگل جست و جو کندي قوانۀهر گروه دربار •

 .دا کندياحث را پ مبی هماهنگید راهکارهايشه بايگروه عا •

 . تماس کنفرانس را شروع خواهد کردیهماهنگ کننده با برقرار •

o  یبه راهنمائن صورت ير ايدرغ.پ داشته باشديد حساب اسکايک نفر در هر گروه بايحداقل  
 . د حساب باز شوديبا" ،ی گپ و فراخوان صوتۀبرنام: "٥٫٢افت   يبخش ره

 .ديک کنيرا کلCalls > Start a Skype Conference Call  شروع تماس یبرا •

 .ديرا بزن Chats > Start Group Chat  ی گپ گروهیبرا •
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، و حفظ نوبت سخن گفتن شرکت کنندگان است و یلگر، مسئول وقت نگهداريهماهنگ کننده  مانند تسه •
 .ر مناسب جهت دهديد بحث را در مسيبا

 .دين صحبت کن و ابزار گپ در سازمان خودتای تماس کنفرانسیاي مزاۀدربار •

o اي نقاط دنۀگران در همي با دی تماسها و همکاری  و هماهنگیزيبرنامه ر. 
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  ني از راه کنفرانس آنلایهمکار: ٧٫٤راهکار 

داده "  زنانیداري و بیحقوق شهروند "ین الملليز گرد در کنفرانس بي می برگزاری برایشنهاديشه پيعا
ن ارث ي قوانۀز گرد دربارين مياند که با شرکت در ارفته ي مختلف پذی زن از کشورهاۀسه کوشند.است

ز گرد، ين ميم اي تنظیبرا.رفته انديشه را برگذارکنندگان کنفرانس پذيشنهاد عايپ. کشورشان گفت و گو کنند
 ی برگذاری گپ برایل است از ابزار ارتباطين مايد با شرکت کنندگان تبادل نظر کند و بنابرايشه بايعا

  . کندی بهره جوئیجلسات آماده ساز

  تيفعال

  قه ي دق٦٠

 .ديشنهاد کني برگذار کردن کنفرانس پیخ و ساعت برايچند تار •

ن ين، اوليبنابرا. شه از اردن هستنديه، و عايجريل، ني هند، برزیز گرد از کشورهايشرکت کنندگان در م •
 در مناطق  باشد کهی شرکت کنندگانی است که مناسب برایخ و ساعت هائيگام توافق بر سر تار

 .   برندیگوناگون جهان به سر م

 . توانند چهار کشور مختلف را انتخاب کنندیشرکت کنندگان کارگاه م •

 .ديک کنيکلMeeting Planner  ید و رويبرو /http://www.worldtimeserver.com به  •

 .دين بزsubmitید و  رويد و زمان را در روزنگار انتخاب کنينيچهار کشور مورد نظر را برگز •

به رنگ سبز مشخص شده ظاهر  ) ٥:٣٠ -٩:٣٠" ( روز"، که در آن ی ساعت٢٤ک روزنگار ي •
 .ديزمان مناسب را انتخاب کن.  شودیم

 : کنندی را طراحی بعدیشرکت کنندگان گام ها •

 ر؟يا خيد زمان مناسب است ينيد و ببي هر سه نفر  نامه بفرستیبرا •

 .دي بگذاریرار تماس کنفرانس همه مناسب است قی که برایدر روز و ساعت •

 .ديز گرد خبر دهي شرکت کنندگان مۀ کنفرانس را به همیيخ و ساعت نهايتار •

 .از دارد آن را نصب کندي نید تا اگر کسي همه بفرستیپ را براي اسکاۀوند دانلود برناميپ •

 .دييازماي ارتباط و صدا را بی، با تک تک افراد برقراریقبل از تماس جمع •

قه آغاز جلسه را به ي دق١٥ تا ١٠ن يع کنفرانس علاوه بر فرستادن دستور جلسه، بقبل از شرو •
 .دي بگذاریخوش آمد گفتن و بر طرف کردن مسائل فن

 .دي شرکت کنندگان را به کنفرانس وارد کنۀن شده همييدر وقت تع •

.  کندید را بازز گري از افراد میکيم شوند و هر گروه نقش يشرکت کنندگان کارگاه به چهار گروه تقس •
 .ز گرد خواهد بودي مۀن افراد است که گردانندي از ایکيشه يعا
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 . جلسه استۀشه هماهنگ کننديد که عاي کنیادآوري شرکت کنندگان ۀبه هم •

ن يعناو.  حق ارث زنان استۀز گرد بحث درباري می برایزين جلسه برنامه ريدستور کار ا •
 .دين کنيي سخنران ها را تعیب نسبي ها و ترتیسخنران

 .ن ارث در گوگل جست و جو کندي قوانۀهر گروه دربار •

 .دا کندي مباحث را پی هماهنگید راهکارهايشه بايگروه عا •

 . تماس کنفرانس را شروع خواهد کردیهماهنگ کننده با برقرار •

  یبه راهنمائن صورت ير ايدرغ.پ داشته باشديد حساب اسکايک نفر در هر گروه بايحداقل  •
 . د حساب باز شوديبا" ،ی گپ و فراخوان صوتۀبرنام: "٥٫٢ت   افيبخش ره

 .ديک کنيرا کلCalls > Start a Skype Conference Call  شروع تماس یبرا •

 .ديرا بزن Chats > Start Group Chat  ی گپ گروهیبرا •

ست و ، و حفظ نوبت سخن گفتن شرکت کنندگان ایلگر، مسئول وقت نگهداريهماهنگ کننده  مانند تسه •
 .ر مناسب جهت دهديد بحث را در مسيبا

 .دي و ابزار گپ در سازمان خودتان صحبت کنی تماس کنفرانسیاي مزاۀدربار •

  .اي نقاط دنۀگران در همي با دی تماسها و همکاری  و هماهنگیزيبرنامه ر •
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٢....................................................... فهرست آموزشی:١٫٠پيوست   
٥.................................. شده آماده از پيشدستور کارهای: ٢٫٠پيوست  . 

  ٦............................... کارگاه سه روزۀ آموزشهای مبانی:٢٫١   پيوست 
٩..............................روزۀ آموزشهای متوسط  کارگاه دو:٢٫٢   پيوست   
١١..........................روزۀ آموزش های پيشرفته  کارگاه سه:٢٫٣   پيوست   
١٣..........................روزۀ آموزش واژه پردازی  کارگاه دو:٢٫٤   پيوست   
١٥......های جداول محاسباتیروزۀ آموزش برنامه   کارگاه سه:٢٫٥   پيوست   
١٧.......................جالبروزۀ آموزش ابزارهای   کارگاه دو:٢٫٦   پيوست   
١٩......................کمپين ترويجیروز فاوا در انستيتوی   سه:٢٫٧   پيوست   
٢٢.....................روز در انستيتوی تحقيق و مستندسازی  دو:٢٫٨   پيوست   

٢٤..........................ايميلینباطات ارروز در انستيتوی   دو:٢٫٩ست    پيو  
  ٢٦............مربيان در انستيتوی آموزشی هروز آموزش سه: ٢٫١٠  پيوست  

  ٢٨..................................فهرست نيازهای کارگاه آموزشی :٣٫٠پيوست 
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٢ 
 

فهرست آموزشی: ١٫٠پيوست   
 
 تجربۀ گذراندن اين دورۀ آموزشی را برای تسهيل گر دلپذير و پيشرفتهمادگی نظم يافته و برنامه ريزی آ

:ير بر اين اساس تنظيم شده استفهرست زمانبندی ز. کارآ ميکند  
 

 يک ماه قبل از شروع جلسۀ آموزشی
مطلع  در جلسه و تدارکات ضروری شرکت کنندگانعلت برگذاری جلسه، اهداف از  .١

 .شويد
 ند؟ اکدامنتايچ نهائی مورد نظر برگزاری اين آموزش چيست؟ هدف از  •
 ؟چيستشرکت کنندگان چه افرادی هستند؟ سطوح مهارتی آنها  •
 دورۀ آموزشی برای چند روز برنامه ريزی شده است؟اين  •
 در چه مکانی اين دوره برگزار می شود؟ •
 

از " پرسش نامۀ ورودی برای شرکت کنندگان ": ٤٫٠پيوست "با فرستادن فرم  .٢
 .نيازهای آموزشی آنان مطلع شويد

 .يدآگاه شودربارۀ ميزان آشنايی افراد با رايانه ها و اهداف آموزشی ايشان بيشتر  .١
  

از منابع، ساختار " فهرست نيازهای کارگاه آموزشی": ٣٫٠با مراجعه به فرم پيوست  .٣
 .فنی،  و سيستمهای موجود در محل برگزاری کارگاه مطلع شويد

o نجره تر، و پينمايش دهنده ها، چاپگر ها، سی دی را تعداد رايانه ها،: سخت افزار
 .USBحافظۀ همراه های اتصال های 

o تریف های عامل، مرورگرها، برنامه های دسيستم: نرم افزار. 
o رايانه های شبکه بندی شده، سرعت اينترنت: اتصال. 
o تخته، ماژيک و غيره: ساير. 
 

 "گام های لازم برای آموزش همگذاری يک دورۀ آموزشی  "هشت مرحلۀ ابتدايی بخش  .٤
 .آتيه و يک دستور کار متناسب برای کارگاه کنيدرا مرور 
o عطيلات محلی، زمان های استراحت، و زمان لازم برای اجرای فراموش نکنيد که ت

 .پروژۀ نهايی را در نظر بگيريد
و بعد از ظهر، بحانه برای صوقت  دقيقه ٢٠بهترين روش، در نظر گرفتن  �

 . دقيقه برای صرف نهار است٦٠و 
o با آنها شروع کنيد. استچند دستور کار از پيش آماده در اين پيوست آمده . 

آموزش ها بر مبنای سطح مهارتی شرکت : محور-های مهارتدستور کار �
 .کنندگان در نظر گرفته شده اند

چند ابزار / جلسات بر مبنای آموختن يک: محور-دستور کارهای ابزار �
 .خاص طراحی شده اند

يک و يا بردهای مشخص بر اساس کار: محور-دستورکارهای موضوع �
 .موضوع اجتماعی

o تبط با موضوعات کارگاه را جمع آوری کنيدنمونه ها و مطالب آموزشی مر. 
 



 

٣ 
 

کاغذ، قلم، ماژيک، تخته، ( نرم افزار، سخت افزار، لوازم تحريرازجمله : بع مورد نياز دورهمنا  .٥
 .يدپيش از آغاز کار فراهم آور  را)و روزنگار آموزشی

  
 يک هفته قبل از شروع جلسۀ آموزشی

، فرم های ارزيابی پايان "ی دوران آموزشارزيابی پايان": ٥٫٠با استفاده از بخش پيوست  .١
 .دوره را آماده کنيد

 مورد نياز آموزش، مانند کتابچۀ اموزشی، دستور کارها، فايل های نمونه، و فرم هایتمام ابزار .٢
از همۀ آنها روی سی دی و يا  نيز و يک کپی نرم افزارقرار دهيدهای ارزيابی را در پوشه ای 

 .يدبگذار. بی. اس.يو
 . دستور را مرور کنيد و چنانچه نيازی بود آن را تغيير دهيديک دور .٣
  

 يک روز قبل از شروع جلسۀ آموزشی
 .آنها مطمئن شويدکارآئی و از بيازمائيد تمام رايانه های مکان برگزاری کارگاه را  .١

 .تما م رايانه ها را روشن و ثبت ورود کنيد •
o وقتن به هر رايانه، در با نوشتن رمز ورود هر رايانه روی کاغذ و چسباندن آ 

 .شروع کار کارگاه صرفه جويی کنيد
 .فايل های لازم برای آموزش را روی تک تک رايانه ها بگذاريد •

o به ياد داشته باشيد که . اين فايل ها را تنها روی يک محل مرکزی شبکه نگذاريد
 فايل ها را روی تمام رايانه ها کپی. شبکه هر لحظه ممکن است دچار اشکال شود

 .کنيد
 .از نصب تمام نرم افزارهای مورد نياز بر روی تک تک رايانه ها اطمينان حاصل کنيد •
 .اتصال شبکه به اينترنت و چاپگر را بيازماييد •
و مطمئن شويد که درست  نمايشگر اصلی را که به رايانۀ تسهيل گر متصل است امتحان کنيد •

 .کار ميکند
o ديک لامپ اضافه برای نمايشگر داشته باشي. 

ی درهامانند .(مطمئن شويد که تمام دستگاه ها حداقل يک راه برای انتقال اطلاعات دارند •
 ).خروجی و يا سی دی رايتر

 
 .استمطمئن شويد که تمام ابزارهای کمک آموزشی  لازم در اختيارتان  .٢

 .يدبازرسی کنصندلی ها را ميز و تمام نيازهای عمومی مانند چراغ ها، هوا، و  •
 .فراهم آوريدک و تمام ابزار نوشتن تسهيل گر را تخته و ماژي •

به تعداد نفرات، بسته های آموزشی را آماده کنيد که در هر کدام دو دفترچه و نسخۀ چاپی متون  .٣
 .باشدوجود داشته مورد استفاده در طول آموزش 

 .تدارکات زمان های استراحت مانند چای و نهار مطمئن شويدفراهم بودن دربارۀ  .٤
 در آغاز جلسه به همۀ وعمومی لازم مانند دستشويی ها و راه پله ها را ياد بگيريد مکانهای  .٥

 .کنندگان اعلام کنيد شرکت
 .برای انتهای برنامۀ آموزشی برنامه ريزی کنيد .٦

 کنندگان تچه کسانی دريافت خواهند کرد؟ چه کسانی آنها را به شرک: گواهی اتمام دوره •
 خواهند داد؟

 ؟ چطورفعاليت تکميلی برای اين دورهبه گری نياز است؟ ی ديئگردهم آبه آيا  •
 
  



 

٤ 
 

 روز اوّل جلسۀ آموزشی
 

 . باشيدکلاس در از رسيدن اولين شرکت کنندهو پيش کمی زودتر از زمان شروع  .١
 .تمام رايانه ها را روشن کنيد •
 .خش کنيدپبسته های آموزشی را  •
 

 .کنيدکمک در پيداکردن جا  ورود شرکت کننده ها به آنها هنگام .٢
 .مطمئن شويد هر شرکت کننده يک بستۀ آموزشی دريافت کرده است •
 

 .معرفی کنيدشرکت کنندگان خود را بعنوان تسهيلگر به  .٣
ی ها، زمان های استراحت، دستور کارها، و برنامۀ ئدستشو: شامل: تدارکات را اعلام کنيد •

 .آن روز
 

 .از افراد بخواهيد خود را معرفی کنند .٤
 .را توضيح دهيداستفاده از آن هيم اين دفترچۀ آموزشی و روش مفا) ٤٫١مبانی (  •
 .برای خودتان سطح مهارت هر شرکت کننده و تسلط زبانی اورا، يادداشت کنيد •
 

 .به جا کنيد اگر لازم بود، صندلی ها را جا .٥
 .د بخواهيد دستيار شما باشندنکسانی که سطح مهارتی پيشرفته داراز  •

o دارند، از جمله هنگام انجام تمرين ها، به کمک بيشترآنها را با افرادی که نياز  
 .جفت کنيد

 .بينند قبل از شروع اولين مطلب، مطمئن شويد که همه به راحتی صفحۀ نمايش را می .٦
 .اندازه و شفافيت تصويری صفحه نمايش را تنظيم کنيد •
بتوانند آن را به آسانی اندازه و شفافيت مکان نما، و سرعت حرکت آن را تنظيم کنيد تا همه  •

 .دنبال کنند
  

از اتمام دورۀ آموزشیپس يک هفته   
 .ارزيابی تسهيلگر را پُر کنيد- فرم خود .١
 .يدمطرح کندستور کار اجرا شده اگر پيشنهاد بهتری برای تغيير آن داريد پس از مرور  .٢
  .د، ذخيره کني استدست آمدهه تمام موارد و مطالب جديد آموزشی را که در طول اين کارگاه ب .٣

 :اگر امکان دارد منابع آموزشی را روی محل ذخيرۀ عمومی زير به اشتراک بگذاريد •
http://www.learningpartnership.org/ictmanual 

  .با ساير تسهيل گران  در ميان بگذاريدآموخته ايد اين کارگاه  ها و دانش هائی را که در درس .٤
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  شدهآماده از پيش دستور کارهای: ٢٫٠پيوست 
 دستور کارهای اين بخش، تنها نمونه ای از جلسات آموزشی هستند که سطوح مختلف دانش، ابزارهای 

متناسب با شرايط شرکت کنندگان  .گوناگون، و موضوعات متفاوت اجتماعی در آنها گنجانده شده اند
.کارگاه خود، اين دستور کارها را تغيير دهيد  

 
محور-دستورکارهای مهارت  

اين نوع آموزش به توانايی های . کت کنندگانی که ميانگين سطح مهارت شان يکی استآموزش برای شر
.مهارتی استفاده از ابزار می انجامد  

 . روزه٣ کارگاه آموزش ابتدايی  .١
 . روزه٢کارگاه آموزش سطح ميانی  .٢
 .رفتهشکارگاه سه روزۀ آموزش های پي .٣
  

  محور-دستور کارهای ابزار
 مانند ورد و يا اکسل، و يا روی ابزارهای مشابه ،ندنک تمرکز میخاص ار  ابزبر که ،اين روش آموزشی

مانند بخش ابزارهای جالب؛ به منظور بدست آوردن مهارت کاری حداکثر در يک فرصت کوتاه آموزشی 
.می شودبرده کار ه ب  

 .واژه پردازی دو روزه کارگاه آموزش  .١
 .صفحات جداول محاسباتی دو روزهکارگاه آموزش  .٢
  .ابزارهای جالب روزۀ آموزش دواه کارگ .٣
  

محور-دستورکارهای موضوع  
در سازمان های ديگر مورد توجه است تا شرکت مشابه در اين روش آموزش، نحوۀ استفاد از ابزارهای 

. ها آشنا شوند آن باکنندگان با بهترين روش استفادۀ هدفمند  
 .فاوا در سه روز برای کمپين های ترويجی  .١
 . مستند سازیدو روز تحقيق و .٢
 .دو روز ارتباطات الکترونيکی .٣
  .سه روز آموزش تسهيل گران .٤
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:٢٫١پيوست        
   کارگاه سه روزۀ آموزشهای مبانی  

 
 روز نخست

 
 معرفی رايانه ها
 اينترنت و ايميل

 
 صبح

        جلسۀ آغازين
  مراسم آشنايی: ١٫١مبانی  •
  افعاليت های انرژِی زا و گزارش ه: ١٫٢مبانی  •

 
        معرفی رايانه ها 

 اجزای اصلی يک دستگاه رايانه: ١٫١دستيابی •
  اصطلاحات و ويژگی های رايانه: ١٫٢دستيابی •

 
        اينترنت و وب     

  دستيابی به وب: ٢٫١دستيابی •
  در جست و جوی اطلاعات: ٢٫٢دستيابی •

 
        جستجوی آنلاين  

  در جستجوی اطلاعات: ٣٫١دستيابی •
 يافتن اطلاعات معتبر و دقيق: ٣٫٣دستيابی •
 بعد از ظهر

        مرور ابتدايی
 web domain) (روش خواندن دامنۀ وب : ٢٫٣دستيابی •
  زنان و وب: ٢٫٤دستيابی •

 
        نتايج جستجو 

  روش های جستجو: ٣٫٢دستيابی •
  جستجوی رسانه های ديگر: ٣٫٤دستيابی •

 
   ايميل     

  مزايای ايميل: ٤٫١دستيابی •
  نکات اساسی ارسال ايميل: ٤٫٢دستيابی •

 
ارسال و دريافت ايميل         

  ايجاد يک حساب ايميل: ٤٫٣دستيابی •
  ارسال و دريافت ايميل:٤٫٤دستيابی •
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جلسهپايان        

  روزنگار آموزشی: ٤٫١مبانی  •
 آموختن مادام العمر: ٤٫٢مبانی  •
  
 روز دوّم

 
و صفحات جداول محاسباتی معرفی واژه پردازها  

 
 صبح

   ويژگيهای واژه پردازی    
  مبانی واژه پردازی: ٥٫١دستيابی •
  مدرکطراحی يک : ٥٫٢دستيابی •
  ذخيره و ساماندهی پرونده ها: ٥٫٤دستيابی •

 
  بروشورهاتهيه      

  طراحی بروشور:٥٫٣دستيابی •
  هاالگوتصاوير، جداول، و : ٥٫٥دستيابی •

 
       امنيت و حريم شخصی

   پشتيبانذخيرۀ داده ها و نسخۀ: ٧٫١دستيابی •
  ايميل و استفاده ايمن از آن: ٧٫٢دستيابی •

 
 بعد از ظهر

       آشنايی با صفحات جداول محاسباتی
  ويژگی های صفحات جداول محاسباتی: ٦٫١دستيابی •
  محاسبات ساده: ٦٫٢دستيابی •

 
       ويژگی های صفحات جداول محاسباتی

  جداسازی و مرتب کردن داده ها: ٦٫٣دستيابی •
  الب بندی و چاپ صفحات محاسبات جدولیق: ٦٫٤دستيابی •

 
جلسهپايان         

مزايای بهره گيری : ٤٫٤مبانی  و تجربه های آموخته شدهاشتراک دانش: ٤٫٣مبانی  •
 ازابزارهای فن آوری
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 روز سوّم
 پروزه های اينترنتی
 و واژه پردازی

 
 صبح
پروژۀ گروهی        

 کمپين های ترويجی : ٢٫١مبانی  •
  رنامه ريزی يک کمپينب: جلسۀ الف
  Iاجرای کمپين : جلسۀ ب
  IIاجرای يک کمپين : جلسۀ پ
  کمپينئۀ گزارش های ارا: جلسۀ ت

 
 بعد از ظهر

 
   بيرون از جلسهفردی       پروژۀ
  واژه پردازی: ٢٫٥مبانی  •

 
       پايان جلسه   

 وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  يبان گرفتنانتقال و پشت: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •

 
 
 
 



 

٩ 
 

  :٢٫٢پيوست 
 کارگاه دوروزۀ آموزشهای متوسط

 
 روز نخست

 ايميل، فهرست های پستی، و اينترنت
 

 صبح
       جلسۀ آغازين

  مراسم آشنايی: ١٫١مبانی  •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

 
يل        ويژگی های پيشرفتۀ ايم  

  ايميل های پيشرفته: ٢٫١بهره جوئی •
  امضا و نشانه ها: ٢٫٢بهره جوئی •

 
       ساماندهی ايميل ها

  ساماندهی و جستجوی ايميل ها: ٢٫٤بهره جوئی •
  رديابی ايميل ها و وظيفه آفرينی: ٢٫٥بهره جوئی •

 
    فهرست های پستی   

  خبرنامه های الکترونيکی و فهرست آدرس ها: ٢٫٦بهره جوئی •

 
د از ظهربع  

       توانايی های مرورگر
  افزايه های مرورگر : ١٫١بهره جوئی •
  به روز رسانی مرورگرهای وب و ديگر ابزارها : ١٫٢بهره جوئی •
  ساماندهی برگزيده ها و صفحه ياب ها: ١٫٦بهره جوئی •

 
توانايی های جستجو        

  جستجو در درون يک وبگاه: ١٫٤بهره جوئی •
  شرفتهجستجوی پي: ١٫٥بهره جوئی •

 
       جستجو برای تصاوير و ويدئو

  يافتن تصاويرِ آنلاين: ١٫٨بهره جوئی •
  ويدئوهایِ آنلاين: ١٫٩بهره جوئی •

 
       ارتباطات آنلاين

  برنامۀ گپ زدن گروهی در اينترنت : ٥٫٢بهره جوئی •
 

  جلسهپايان      
   دانش در اشتراک: ٤٫٣مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •
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 روز دوّم
ژه پردازی و صفحات جداول محاسباتیوا  

 
 صبح
ويژگی های واژه پردازی        

  صفحه بندی و شکل دهی: ٣٫٤بهره جوئی •
  رد يابی و چسباندن تغييرات  : ٣٫١بهره جوئی •
   به ياری الگوهای پيش ساخته مدارکتهيۀ : ٣٫٢بهره جوئی •

 
       ويژگی های صفحات جداول محاسباتی

  چيدهمحاسبات پي: ٤٫١بهره جوئی •
  نمودارها و نقشه ها : ٤٫٢بهره جوئی •
  برنامه ريز–ساير کاربردها: ٤٫٣بهره جوئی •

 
       امنيّت و حريم شخصی

  وال-ابزارهای ضد ويروس و فاير: ٥٫١بهره جوئی •
 

 بعد از ظهر
پروژه های فردی        

  صفحات جداول محاسباتی: ٢٫٦مبانی  •
 

پايان جلسه        
 ی ازابزارهای فن آوریمزايای بهره گير: ٤٫٤مبانی  •
   و تسهيلگریگزارشمهارت های ارائه : ٣٫١مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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:٢٫٣ پيوست   
روزۀ آموزش های پيشرفته  کارگاه سه    

 روز نخست
 کاربرد هوشمندانۀ اينترنت و ايميل

 
 صبح

       جلسۀ آغازين
  مراسم آشنايی: ١٫١مبانی  •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

 
)فاوا(لاعاتی طوری های ارتباطی و اا      فن  

نمونه ای روی سی دی (  با کمک فاوا یترويجفعاليت های اشتراک اطلاعات و : ارائه •
 )موجود است

  
اينترنت و وب جهانی        

  صفحه ياب اشتراکی: ١٫١راهکار  •
  رسانه خوان ها: ١٫٢ راهکار  •

زارهای اينترنت      اب  
  همکاری از طريق کنفرانس آنلاين: ٧٫٤راهکار  •
 بعد از ظهر

       ايميل پيشرفته
  دفتر آدرس ها و تقويم: ٢٫٣بهره جوئی •

I استفادۀ هدفمند از ايميل       
  رد يابی و چسباندن تغييرات  : ٣٫١بهره جوئی •
   به ياری الگوهای پيش ساخته مدارکتهيۀ : ٣٫٢بهره جوئی •

 
II    استفادۀ هدفمند از ايميل     

 نامه های دستجمعی و برچسب ها: ٣٫٣بهره جوئی  •
 

       پايان جلسه
  آموختن مادام العمر: ٤٫٢مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 روز دوّم

 واژه پردازی و ابزارهای ارائه
 

 صبح
       استفادۀ هدفمند واژه پردازی

  مدارکيۀ همکاری آنلاين  دربارۀ ته:٤٫١راهکار  •
  الگوهای سفارشی: ٤٫٢راهکار  •
  سبک و صفحه بندی سفارشی: ٤٫٣راهکار  •
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  گزارش      ارائه
  ويژگی های عمدۀ ارائۀ گزارش : ٥٫١راهکار  •
  متن، تصاوير، و جداول در گزارش: ٥٫٢راهکار  •

 
های حرفه ایگزارش      ارائه   
  ويژگی های يک گزارش ممتاز: ٥٫٣راهکار  •

 
يم شخصی      امنيت و حر  

  ردپای ديجيتال در همه جا: ٧٫١راهکار  •
  زدودن ردپای ديجيتال : ٧٫٢راهکار  •

 
 بعد از ظهر

  گزارشمهارت های ارائه     
   و تسهيلگریگزارشمهارت های ارائه : ٣٫١مبانی  •

      وب مشارکتی
  استفاده مشترک از تصاوير: ٢٫١راهکار  •
  یتصاوير آنلاين برای هدف های ترويج: ٢٫٢راهکار  •

 
      پايان جلسه

  اشتراک دانش: ٤٫٣مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 روز سوّم
  مطلبيی برای ارائهپروزه ها

 
 صبح

       آمادگی برای پروژۀ گروهی
  ارائۀ مطلب: ٢٫٧مبانی  •

 
  گزارش      ارائۀ گروهی

  ارائۀ مطلب: ٢٫٧مبانی  •
 

 بعد از ظهر
)دنباله( گزارش      ارائۀ گروهی   

  ارائۀ مطلب: ٢٫٧انی مب •
 

       پايان جلسه
 

  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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:٢٫٤   پيوست   
  کارگاه دوروزۀ  آموزش واژه پردازی  

 
 روز نخست

هاالگوطراحی، شکل دهی و   
 

 صبح
  آغازين     جلسۀ
  مراسم آشنايی: ١٫١مبانی  •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

 
      آشنايی با واژه پردازی  

  مبانی واژه پردازی: ٥٫١دستيابی •
  مدرکطراحی يک : ٥٫٢دستيابی •
   هافايلو ساماندهی کردن ذخيره : ٥٫٤دستيابی •

 
      طراحی و شکل دهی

  طراحی بروشور:٥٫٣دستيابی •
  هاالگوتصاوير، جداول، و : ٥٫٥دستيابی •

 
 بعد از ظهر

حرفه ایمدارک ساخت        
نامه های دستجمعی و برچسب ها: ٣٫٣  بهره جوئی   

 
های سفارشیالگو  

  الگوهای سفارشی: ٤٫٢راهکار  •
  سبک و صفحه بندی سفارشی: ٤٫٣راهکار  •

 
      پست کردن با کمک واژه پرداز ها

ی و برچسب هانامه های دستجمع: ٣٫٣  بهره جوئی   
 

پايان جلسه       
  آموختن مادام العمر: ٤٫٢مبانی  •
  اشتراک دانش: ٤٫٣مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 روز دوّم

آنلاين و پروژه های نهايیواژه پردازی   
 

 صبح
      اينترنت و همکاری های خارجی
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  رد يابی و چسباندن تغييرات  : ٣٫١بهره جوئی •
  مدارکين  دربارۀ تهيۀ همکاری آنلا:٤٫١راهکار  •

 
      مستند سازی و گزارش

 نامه های دستجمعی و برچسب ها: ٣٫٣بهره جوئی  •
  مستندسازی و گزارش ها: ٤٫٤راهکار  •

 
 بعد از ظهر

پروژۀ فردی        
  واژه پردازی: ٢٫٥مبانی  •

 
       پايان جلسه

  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  ل و پشتيبان گرفتنانتقا: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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:٢٫٥پيوست      
  وزۀ آموزش برنامه های جداول محاسباتیر  کارگاه سه  

 
 روز نخست

 ويژگی ها، محاسبات و شکل دهی
 

 صبح
       جلسۀ آغازين

  مراسم آشنايی: ١٫١مبانی  •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

 
     آشنايی با صفحات جداول محاسباتی  

  ويژگی های صفحات جداول محاسباتی: ٦٫١دستيابی •
 

محاسبه به کمک صفحات جداول محاسباتی        
  محاسبات ساده: ٦٫٢دستيابی •
 جداسازی و مرتب کردن داده ها: ٦٫٣دستيابی •

    
 بعد از ظهر

چاپ صفحات جداول محاسباتی        
  اپ صفحات محاسبات جدولیقالب بندی و چ: ٦٫٤دستيابی •

 
       صفحات جداول محاسباتی پيچيده

  محاسبات پيچيده: ٤٫١بهره جوئی •
 

       ياد گيری و مشارکت
  آموختن مادام العمر: ٤٫٢مبانی  •
  اشتراک دانش: ٤٫٣مبانی  •

 
       پايان جلسه

روزنگار آموزشی: ٤٫١مبانی     
 
 

 روز دوّم
 نمودارها و گراف ها، پروژه های نهايی

 
 صبح
  نمودار و کارهای گرافيکیتهيۀ     

  نمودارها و نقشه ها : ٤٫٢بهره جوئی •
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  کاربردهای ديگر اکسل
  برنامه ريز–ساير کاربردها: ٤٫٣بهره جوئی •

 
    

 بعد از ظهر
       پروژۀ فردی

  صفحات جداول محاسباتی: ٢٫٦مبانی  •
 

سه      پايان جل  
  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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: ٢٫٦پيوست      
روزۀ آموزش ابزارهای جالب کارگاه دو     

 
 روز نخست

وبلاگ ها، تصاوير، و ويدئو ها: وب مشارکتی  
 

 صبح
      جلسۀ آغازين

  مراسم آشنايی: ١٫١ی مبان •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

 
انتشار آنلاين با کمک وبلاگ ها       

  وبلاگ سازی و وبلاگ نويسی: ٢٫٥راهکار  •
 

  پروژهبخش اوّل     
  وبلاگ نويسی و رسانه های مشارکتی: ٢٫٤مبانی  •

 
      اشتراک تصاوير

  يافتن تصاويرِ آنلاين: ١٫٨بهره جوئی •
  استفاده مشترک از تصاوير: ٢٫١اهکار ر •
  تصاوير آنلاين برای هدف های ترويجی: ٢٫٢راهکار  •

 
 بعد از ظهر

      ويدئو های آنلاين
  ويدئوهایِ آنلاين: ١٫٩بهره جوئی •

  ترويج از راه ويدئوهای آنلاين : ٢٫٣راهکار   •
 

      انتشار آنلاين با کمک وبلاگ ها
  وبلاگ گروهی: ٢٫٦راهکار  •

 
جلسهپايان   

  اشتراک دانش: ٤٫٣مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 

 روز دوّم
 شبکه های اجتماعی

ی دربارۀ وب مشارکتیيو پروژه ها  
 

 صبح
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   جلسۀ آغازين     
 ی زا و گزارش هاژِفعاليت های انر: ١٫٢مبانی  •
 چالش ها و مزايای مطالب آنلاين: ٢٫٧راهکار  •
•   

     
  شبکه های اجتماعی

وّم پروژه     بخش د  
 

     بعد از ظهر
       بخش سوّم پروژه

     
پايان جلسه    

  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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:٢٫٧   پيوست   
   روز فاوا در انستيتوی کمپين ترويجی  سه  

 
 روز نخست

 دستيابی و اشتراک اطلاعات
 

 صبح
جلسۀ آغازين       

  مراسم آشنايی: ١٫١مبانی  •
 فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

      
  ی ترويج فعاليت های فاوا و
  )ديده می شودنمونه روی سی دی ( ی هدفمند برای برگزاری کمپين هاراعنوان ابزه فاوا ب: ارائه •
       

  ينبرنامه ريزی و کمپ
  برنامه ريزی کمپين: کمپين های ترويجی، بخش نخست: ٢٫١مبانی  •

     
    تحقيق و همکاری

  صفحه ياب اشتراکی: ١٫١راهکار  •
  مدارکهمکاری آنلاين  دربارۀ تهيۀ :٤٫١راهکار  •

 
 بعد از ظهر

کمپين های ترويجی و تصاوير:       ابزارهای جالب  
  يافتن تصاويرِ آنلاين: ١٫٨بهره جوئی •
  استفاده مشترک از تصاوير: ٢٫١راهکار  •

 
ويدئو های آنلاين:       وب مشارکتی  

  ويدئوهایِ آنلاين: ١٫٩بهره جوئی •

 
       پايان جلسه

  آموختن مادام العمر: ٤٫٢مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 روز دوّم

 درخواست ها، ويدئو ها و شبکه های اجتماعی
 

 صبح
      برگزاری يک کمپين

  Iاجرای کمپين :  کمپين های ترويجی، بخش دوّم:٢٫١مبانی  •
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وبگاه ها       
  برنامه ريزی برای ساخت وبگاه: ٦٫٣راهکار  •
  ويژگی های وبگاه: ٦٫٤راهکار  •

 
درخواست های آنلاين       

 امضای درخواست نامۀ  آنلاين: ٦٫١راهکار  •
  تهيۀ درخواست نامۀ آنلاين : ٦٫٢راهکار •

 
      امنيت و حريم شخصی

  ردپای ديجيتال در همه جا: ٧٫١ر راهکا •
 زدودن ردپای ديجيتال: ٧٫٢راهکار  •
•   

 
 بعد از ظهر

اشتراک تصاوير:       ابزارهای جالب  
  تصاوير آنلاين برای هدف های ترويجی: ٢٫٢راهکار  •

 
ئو های کمپيندوي: وب اشتراکی        

  ترويج از راه ويدئوهای آنلاين : ٢٫٣راهکار   •
 

که های اجتماعیشب:       وب اشتراکی  
  ابزارهای شبکه های اجتماعی: ١٫٣راهکار  •
  شبکه های اجتماعی سازمانی : ٢٫٤راهکار  •

 
       پايان جلسه

  اشتراک دانش: ٤٫٣مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 

 روز سوّم
کاربرد فاوا در کپين های ترويجیپروزه هايی برای   

 
 صبح

      ساختن يک وبلاگ
  I گ سازی و وبلاگ نويسیوبلا: ٢٫٥راهکار  •

 
وبلاگ پيشرفته       

  وبلاگ گروهی: ٢٫٦راهکار  •
 برگزاری کمپين 

       IIارائۀ کمپين : بخش سوّم کمپين های ترويجی،: ٢٫١مبانی  •
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 بعد از ظهر
کمپين ترويجیگزارش      ارائۀ   
  ارائۀ کمپين: کمپين های ترويجی، بخش چهارم: ٢٫١مبانی  •

 
پايان جلسه       

  مزايای بهره گيری ازابزارهای فن آوری: ٤٫٤نی مبا •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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: ٢٫٨   پيوست   
  روز در انستيتوی تحقيق و مستندسازی دو   

 
 روز نخست

 جستجو، ساماندهی و مستندسازی اطلاعات
 

 صبح
 جلسۀ آغازين

  شنايیمراسم آ: ١٫١مبانی  •
 فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

  فاوا برای تحقيق و مستند سازی
نمونه ای روی سی دی ( عنوان يک ابزار برای تحقيق و مستند سازی ه فاوا ب : گزارشارائه •

  )می توان يافت
  
  رهای جالب برای دسترسی به اطلاعاتاابز

  رسانه خوان ها: ١٫٢راهکار  •
  فعّالياب صفحه : ١٫٧بهره جوئی •
        

  
  تعيين موضوع تحقيق: بخش اوّل پروژه

  انتخاب موضوع تحقيق: تحقيق و مستندسازی، بخش نخست: ٢٫٢مبانی  •
 

 بعد از ظهر
  جستجو و ساماندهی  پيشرفته     

  جستجوی پيشرفته: ١٫٥بهره جوئی •
 يافتن اطلاعات معتبر و دقيق: ٣٫٣دستيابی •
  ا و صفحه ياب هاساماندهی برگزيده ه: ١٫٦بهره جوئی •

 
همکاری درمستند سازی        
  مدارکهمکاری آنلاين  دربارۀ تهيۀ :٤٫١راهکار  •
  صفحه ياب اشتراکی: ١٫١راهکار  •

 
  گزارشی در  مستندساز

   به ياری الگوهای پيش ساخته مدارکتهيۀ : ٣٫٢بهره جوئی •
  الگوهای سفارشی: ٤٫٢راهکار  •
   هافايلذخيره و ساماندهی : ٥٫٤دستيابی •

 
يافتن اطلاعات:      بخش دوّم پروژه   

  يافتن اطلاعات و مطالب: تحقيق و مستندسازی، بخش نخست: ٢٫٢مبانی  •
 

پايان جلسه        
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  مزايای بهره گيری ازابزارهای فن آوری: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •

  
 روز دوّم

تندسازی و ارائهپروژه های مس  
 

 صبح
مؤثّر يک گزارش     ارائه   

  ويژگی های عمدۀ ارائۀ گزارش : ٥٫١راهکار  •
  متن، تصاوير، و جداول در گزارش: ٥٫٢راهکار  •
  ويژگی های يک گزارش ممتاز: ٥٫٣راهکار  •

 
مستندسازی اطلاعات:      بخش سوّم پروژه  

ندسازی اطلاعات و مطالبمست: تحقيق و مستندسازی، بخش سوم: ٢٫٢مبانی           
 

 بعد از ظهر
ارائۀ اطلاعات:     بخش چهارم پروژه  

  نمايش اطلاعات: تحقيق و مستندسازی، بخش چهارم: ٢٫٢مبانی      •
   

      پايان جلسه                 
  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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: ٢٫٩پيوست    
ايميلی باطات تراوز در انستيتوی  دو     

 
 روز نخست

 ايميل و فهرست های پستی پيشرفته
 

 صبح
  جلسۀ آغازين     

  مراسم آشنايی: ١٫١مبانی  •
  فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •

     
  فن آوری های اطلاعاتی و ارتباطی 

نمونه ای روی سی دی ( ی برای برقراری ارتباطات کارآعنوان ابزاره فاوا ب : گزارشئهارا •
 )می توان يافت

•   
  تصاوير در ارتباطات ايميلی:     ابزارهای جالب

 يافتن تصاويرِ آنلاين: ١٫٨بهره جوئی •

  استفاده مشترک از تصاوير: ٢٫١راهکار  •
 

انتخاب موضوع:     بخش اوّل پروژه   
  انتخاب موضوع ارتباط الکترونيکی: رتباطات ايميلی، بخش نخستا: ٢٫٣مبانی  •

 
 بعد از ظهر

     ايميل پيشرفته 
  اآدرسهامضا و : ٢٫٢بهره جوئی •
  ساماندهی و جستجوی ايميل ها: ٢٫٤بهره جوئی •
  رديابی ايميل ها و وظيفه آفرينی: ٢٫٥بهره جوئی •

 
آدرس هافهرست        

  کی و فهرست آدرس هاخبرنامه های الکتروني: ٢٫٦بهره جوئی •

 
امنيت و حريم شخصی      

  ايميل و استفاده ايمن از آن: ٧٫٢دستيابی •
 

يافتن مطالب و اطلاعات:     بخش دوّم پروژه  
  يافتن اطلاعات و مطالب: ارتباطات ايميلی، بخش دوّم: ٢٫٣مبانی  •

 
  پايان جلسه     

  مزايای بهره گيری ازابزارهای فن آوری: ٤٫٢مبانی  •
  انتقال و پشتيبان گرفتن: ٤٫٣مبانی  •
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  ارزيابی پايانی دوران آموزش: ٤٫١پيوست  •
 

 روز دوّم
 خبرنامه های الکترونيکی، پروژه هايی برای ارتباطات ايميلی

 
 صبح

خبرنامه های الکترونيکی      
  تجزيه و تحليل خبرنامه های الکترونيکی: ٣٫١راهکار  •
  ونيکیرساختن خبرنامۀ الکت: ٣٫٢راهکار  •
  نوشتن خبرنامۀ الکترونيکی: ٣٫٣راهکار  •

 
  پروژۀ نوشتن ايميل: بخش سوّم پروژه    

  نوشتن پيام ارتباط ايميلی: ارتباطات ايميلی، بخش سوم: ٢٫٣مبانی  •
 

 بعد از ظهر
نشان دادن پيام ايميل: بخش چهارم پروژه      

  نمايش پيام ارتباط ايميلی: ارتباطات ايميلی، بخش چهارم: ٢٫٣مبانی  •
 

    ايان جلسهپ    
  وریامزايای بهره گيری ازابزارهای فن: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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:٢٫١٠ پيوست    
مربيان در انستيتوی آموزشی هروز  آموزش سه    

 
 روز نخست

 وب مشارکتی و مهارت های تسهيل گری
 

 صبح
نجلسۀ آغازي      

  مراسم آشنايی: ١٫١مبانی  •
 فعاليت های انرژِی زا و گزارش ها: ١٫٢مبانی  •
•  

      فن آوری های اطلاعاتی و ارتباطی
 )تمی توان يافنمونه ای روی سی دی ( عنوان يک ابزار هدفمند ه فاوا ب :ارائه •
•   

  ويدئو های آنلاين:     ابزارهای جالب
  ويدئوهایِ آنلاين: ١٫٩بهره جوئی •

  ن های  تسهيل گریفوت و ف    
  مهارت های ارائه دادن و تسهيلگری: ٣٫١مبانی  •

  
 بعد از ظهر

تصاوير آنلاين:     ابزارهای جالب   
  يافتن تصاويرِ آنلاين: ١٫٨بهره جوئی •
 استفاده مشترک از تصاوير: ٢٫١راهکار  •
•   

      وب مشارکتی
  وبلاگ سازی و وبلاگ نويسی: ٢٫٥راهکار  •

 
      پايان جلسه

  آموختن مادام العمر: ٤٫٢مبانی  •
  روزنگار آموزشی: ٤٫١مبانی  •

 
 روز دوّم

 همگذاری و ارائۀ آموزش
 

 صبح
   همگذاری و آموزشI:     پروژۀ گروهی بخش 

 همگذاری آموزش: ٣٫٢مبانی  •
 

     حريم شخصیيمنی وا
 آنتی ويروس و فاير وال  : ٥٫١بهره جوئی  •
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 ردپای ديجيتال در همه جا  : ٧٫١راهکار  •
 یزدودن ردپای ديجيتال خود: ٧٫٢راهکار  •

  
  بعد از ظهر

  
  ارائۀ يک برنامه آموزشی : II پروژۀ گروهی، بخش 

  یزدودن ردپای ديجيتال خود  : ٧٫٢راهکار : ٣٫٣مبانی  •
 

ۀ پايانی جلس  
 مشارکت در دانش : ٤٫٣مبانی  •
 ار آموزشیگروزن: ٤٫١ مبانی  •

  
  روز سوم

  پروژۀ نهائی آموزش سفارشی
  

  صبح
 : Iی بخش پروژۀ  فرد

   آماده شدن برای جلسۀ آموزشی سفارشی 
 ساختن و تسهيلگری يک جلسۀ آموزشی ويژه : ٣٫٤مبانی  •

 
   :II بخش پروژۀ فردی

  ارائۀ جلسۀ آموزشی سفارشی 
 ساختن و تسهيلگری يک جلسۀ آموزشی ويژه : ٣٫٤مبانی  •

   
 بعد از ظهر

:بخش سوّم پروژۀ فردی        
    II آموزشی سفارشی       ارائۀ جلسۀ   

 ساختن و تسهيلگری يک جلسۀ آموزشی ويژه : ٣٫٤مبانی  •
 

 پايان جلسه
  مزايای بهره گيری ازابزارهای فن آوری: ٤٫٤مبانی  •
  انتقال و پشتيبان گرفتن: ١٫٣مبانی  •
  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست  •
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  کارگاه آموزشی فهرست نيازهای : ٣٫٠پيوست   
  آموزشی فن آوری های اطلاعاتی و ارتباطاتی کارگاه های

 فهرست ارزيابی امکانات کارگاه
 

 سخت افزار
  تعداد رايانه ها--
  تعداد چاپگرها--
  برای اين آموزش موجود است؟گيا نمايشگر بزرآ --
؟ابزار لازم برای نوشتن فراهم شده است آيا --  
  آيا اين آزمايشگاه دوربين های وب دارد؟ چند عدد؟--
و يا ميکروفن رايانه ها را دارد؟ چند عدد؟  آيا اين آزمايشگاه بلندگو--  
.لطفا مشخص نماييد) مانند اسکنر(  ساير سخت افزارها --  

 نرم افزار
  آيا تمام رايانه ها نرم افزار يکسان دارند؟--

:بنويسيدتعداد رايانه هايی که نرم افزارهای زير را دارند،   
 

 سيستم های عامل
• Windows XP Professional edition 
• Windows XP Home edition 
• Windows ٢٠٠٠ 
• Windows ME 
•  Windows ٩٨ 
• Mac OS ٩ 
• Mac OS 
 ساير  ---------- ---- ---------- ---- -------- •

 
 

:برنامه های مرورگر و نسخۀ نرم افزاری آنها  
• Internet Explorer ٧.x 
• Internet Explorer ٦.x 
• Internet Explorer ٥.x and below 
• Firefox ٢.x 
• Firefox ١.x and below 
  ساير ------------------------------------ •

:بسته های نرم افزاری  
• Microsoft Office (Outlook, Word, Excel, PowerPoint ) Version #----? 
• Adobe Acrobat Reader 
  ساير ------------------------------------ •
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ونيکی رتباط الکترا  
:کنفرانس های آنلاين  

زير استفاده کرده است؟های آيا کسی از کارگاه فعلی برای منظور  
  گپ آنلاين---
)مانند اسکايپ(کنفرانسهای آنلاين ---  
کنفرانس آنلاين ويدئويی---  

 
:لاعات عمومیاط  

  ........د؟می شوقطع برق چند بار نوسان پيدا می کند يا بکلی  ---
........؟يافت می شودور در محل آيا يک ژنرات---  

 
:نکات و اطلاعات ديگر  

محدوديتی وجود افزايه ها و يا ابزارهای ديگر روی رايانه کردن آيا برای دانلود 
.....................................؟دارد  

 ؟وجود داردمحدوديتی آيا برای ذخيره سازی اطلاعات توسط شرکت کنندگان 
............................................  

 
: توضيحات اضافی  

 
....................................................................................................................................

....................................................................................................................................

.................................................................................................................................... 
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پرسش نامۀ ورودی برای شرکت کنندگان: ٤٫٠پيوست   
 

 دربارۀ خودتان
 ....................................................... :نام کامل .١
 :جنسيت .٢
 �  زن •
 �  مرد •

 
 : هائی می دانيدزبانچه  .٣
  ..........زبان مادری •
 ............................... دوّم) های(زبان •
•  
 :شغل .٤
 �کنشگر اجتماعی  •
 � هنرمند •
 � کارمند رسمی •
 � کارآفرين •
 � خانه دار •
 � خبرنگار •
 � تری دادگسوکيل •
 � پزشک •
 �گر سياست •
 � استاد/ معلّم •
 � محقّق •
 �وردانش/ نويسنده  •
 � دانشجو •
      .......................................ساير •
 
 :زمينه های مورد علاقه .٥
 � یترويجفعاليت های  •
 � کشاورزی •
 � فرهنگ و هنر •
  � تجارت •
 � بانکداری •
 � ارتباطات •
 �حکومت / کراسیودم •
 � اقتصاد •
 � تحصيلات •
 � حيط زيستم •
 �توسعه جنسيت و  •
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  � جنسيتیخشونت  •
  �روائی جهان  •
 � جمعيت و بهداشت •
 �انسانی ايمنی  •
 � فن آوری اطلاعاتی •
 � توسعۀ بين المللی •
  � قانون •
 � رهبری •
 � صلح و حل اختلاف •
  �پناهندگی  •
 � موعل •
 � حقوق زنان •
 --------- ---------- ---- ----ساير •

   
 :ميکنيددر چه محلی از رايانه استفاده  .١
 خانه •
 دفتر •
 کافۀ اينترنتی •
 :برنامه هايی که در هر يک از مکان های زير بکار می بريد .٢

  خانه 
 برنامه های دفتری ويندوز •
 ابزارهای اينترنتی •
 برنامه های ايميلی •
  ابزار های ويژۀ ديگر •
  دفتر
 برنامه های دفتری ويندوز •
 ابزارهای اينترنتی •
 برنامه های ايميلی •
  ابزار های ويژۀ ديگر •

  
  کافۀ اينترنتی

 برنامه های دفتری ويندوز •
 ابزارهای اينترنتی •
 برنامه های ايميلی •
  ابزار های ويژۀ ديگر •

 
  ........................................:آشنايی داريدبا آن ها که  عامل های سيستم .٣
  ..........................: می بريدکاره رهای نرم افزاری که بابرنامه ها و ابز .٤
  ................:در هر يک از مکانهای زير چند ساعت با رايانه کار می کنيد .٥
 :مهارت های تايپی .٦
 .با سرعت بالا :تايپ فارسی •
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 .به کندی –تايپ فارسی  •
 .تايپ فارسی با واژه های لاتين •
 .با سرعت بالا –تايپ انگليسی  •
 .یکندبه  –تايپ انگليسی  •
 -------- ----------:ساير •

  
  ساعت٥تا  •
  ساعت١٠ تا ٥بين  •
  ساعت٢٠ تا ١٠ •
   ساعت٢٠بيش از  •
  دفتر
  ساعت٥تا  •
  ساعت١٠ تا ٥بين  •
  ساعت٢٠ تا ١٠ •
   ساعت٢٠بيش از  •

  
  کافۀ اينترنتی

  ساعت٥تا  •
  ساعت١٠ تا ٥بين  •
  ساعت٢٠ تا ١٠ •
   ساعت٢٠بيش از  •

 
  دربارۀ اهداف آموزشی شما

 ؟يدبرست آوردی سبه چه دانتظار داريد از اين دوران آموزشی  .١
 -- ----- ----------- ---- -------- 
 

 چه مطالبی در اين برنامۀ آموزشی برای شما مهم تر است؟ .٢
- ---- ---------- 
- ---- ---------- 

 
 اين آموزش چطور به شما کمک خواهد کرد؟ .٣

- ---- ---------- 
- ---- ---------- 

 
 چه برنامه ای برای کاربرد اين آموزش داريد؟ .٤

- ---- ---------- 
------- ---- ---- 

 
  .پرسش و يا ساير نکات .٥

- ---- ---------- 
- ---- ----------  
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  ارزيابی پايانی دوران آموزش: ٥٫٠پيوست 
 

در ضمن . اين ارزيابی به منظور بررسی ميزان تطابق اين دورۀ آموزشی با نيازهای شما تهيه شده است
 از زمان و دقتی که در سپاسبا . جاد کردشايد به نفع شرکت کنندگان دوره های آينده  بتوان تغييراتی را اي

.کنيد پر کردن اين فرم ارزيابی صرف می  
.در پاسخ به پرسش های زير، دور عددی که وضعيت شما را نشان ميدهد دايره بکشيد  

 
 عناوين

 دستور کارها و برنامه های آموزشی اين دورۀ آموزشی 
کاملا 
 موافقم

قدری  
 موافقم

کاملا  
 مخالم

  

 .منطقی بود. الف ١ ٢ ٣ ٤ ٥
 .مناسب بود. ب ١ ٢ ٣ ٤ ٥
تعداد عناوين آموزشی مناسب . پ ١ ٢ ٣ ٤ ٥

 .بود
 . بودمنيازهايناسب برای م. ت ١ ٢ ٣ ٤ ٥

 
:نکات  

- ---------- ---- ---------- 
 

 ارائه ها
 ارائه های آموزشی

کاملا 
 موافقم

قدری  
 موافقم

کاملا  
 مخالفم

  

١ ٢ ٣ ٤ ٥ a. ی را داشتسطح مناسبی از سخت. 
١ ٢ ٣ ٤ ٥ b. مناسبی مثال و دياگرام داشت تعداد. 
١ ٢ ٣ ٤ ٥ c. قادر به دنبال کردن و انجام تمرين ها بودم. 
١ ٢ ٣ ٤ ٥ d. از هر عنوان آموزشی کمک یبه درک بهتر 

 .کرد
١ ٢ ٣ ٤ ٥ e. کردرا برآورده  منيازهاي.  

 
:نکات  

- ---------- ---- ---------- 
 

 فعاليت ها
هی و فردی کارگاهاليت های گروفع  

کاملا 
 موافقم

قدری  
 موافقم

کاملا  
فممخال

  

 .تسهيلگربه روشنی فعاليت ها را توضيح داد. الف ١ ٢ ٣ ٤ ٥
 .زمان مناسبی برای تمرين ها بود .ب ١ ٢ ٣ ٤ ٥
١ ٢ ٣ ٤ ٥ a. از موضوع آموزشی کمک کردیبه درک بهتر . 
١ ٢ ٣ ٤ ٥ b. مهارت های عملی کار را به من ياد داد. 
١ ٢ ٣ ٤ ٥ c. جالب بودند.  



 

٣٤ 
 

 
:نکات  

- ---------- ---- ---------- 
 

 تسهيل گران
 تسهيل گران

کاملا 
 موافقم

قدری  
 موافقم

کاملا  
مخالفم

  

 .ندهد بودتسهيل گران متعّ. الف ١ ٢ ٣ ٤ ٥
 . برای آموزش ايجاد کرده بودمساعدیفضای . ب ١ ٢ ٣ ٤ ٥
 .به پرسش های من پاسخ می داد. پ ١ ٢ ٣ ٤ ٥
 .کرد توانائی انديشه گری مرا بيشتر. ت ١ ٢ ٣ ٤ ٥

 
:نکات  

- ---------- ---- ---------- 
 

  بازخورد عمومی
 ؟آيا اين دورۀ آموزشی مطابق با انتظارات شما بود .١

 -- ----- -------- 
- ---- ---------- 

 
 ؟تر از همه بودارزنده کدام بخش آموزشی، عنوان، و يا بحث  .٢

- ---- ---------- 
------- ---- ---- 

 
 ؟ارزش تر از همه بودکم  ،کدام بخش آموزشی، عنوان، و يا بحث .٣

- ---- ---------- 
- ---- ---------- 

 
 يد؟  هست،و يا مباحث مرتبط ديگریدوره اين علاقه مند به آموزش بيشتر در مبحثی از آيا  .٤

- ---- ---------- 
- ---- ---------- 

 
به چگونه  دانش و مهارتی را که آموخته ايد ويست شرح دهيد که برداشت شما از اين دوره چ .٥

  ؟خواهيد کردديگران منتقل 
- ---- ---------- 
- ---- ---------- 

  .لطفا ساير نکات ديگری که به نظرتان ميرسد در اين قسمت بنويسيد .٦
- ---- ---------- 
- ---- ---------- 

 
 



 

٣٥ 
 

-------- ----- ---------- -- )اختياری( نام   
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